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Advanced Guide Troubleshooting

Contents > Overview of the Machine

Overview of the Machine 
This section shows the component names of the machine and describes the basic operations you need
to know before using it.

Main Components

Front View

Rear View

Inside View

Operation Panel

How to Navigate Menus on the LCD

Selecting Menus on the HOME Screen

Selecting Setting Items

Other Operations
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Main Components 
Front View

Rear View

Inside View
Operation Panel

 Front View 

(1) Document Cover
Open to load an original on the Platen Glass.

(2) Paper Support
Raise and tip back to load paper in the Rear Tray.

(3) Paper Guides
Slide to align with both sides of the paper stack.

(4) Rear Tray
Load photo paper or envelopes which you can use on the machine. Two or more sheets of the same size

and type of paper can be loaded at the same time, and fed automatically one sheet at a time.

See Loading Paper .

(5) LCD (Liquid Crystal Display)
Displays messages, menu selections, and the operation status. You can also preview photos on the LCD

before printing.

 Note

 The LCD will turn off if the machine is not operated for about 5 minutes. To restore the

display, press any button except the ON button or perform the print operation.

(6) Operation Panel
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Use to change the settings of the machine or to operate it.

See Operation Panel .

(7) Wi-Fi lamp
Lights or flashes in blue to indicate the wireless LAN status.

Lights : Wireless LAN active is selected.

Flashes : Printing or scanning over wireless LAN. Also flashes while searching for wireless LAN access

point during setup and when connecting to the access point.

(8) Paper Output Tray
Opens automatically when printing or copying starts and printed paper is ejected.

(9) Output Tray Extension
Open to support the printouts. Open it when printing or copying.

(10) Platen Glass
Load an original to copy or scan.

(11) Cassette
Load A4, B5, A5, or Letter-sized plain paper and insert it into the machine. Two or more sheets of the same

size of plain paper can be loaded at the same time, and fed automatically one sheet at a time.

See Loading Paper .

(12) Direct Print Port
Connect a PictBridge compliant device such as a digital camera or the optional Bluetooth Unit BU-30* to print

directly.

See Printing Photos Directly from Your Digital Camera or Mobile Phone .

You can also insert a USB flash drive to this port.

See Inserting the USB Flash Drive.

* The Bluetooth Unit is not available in some countries or regions depending on the local laws and

regulations. For details, contact the service center.

 Warning

 Do not connect any equipments other than PictBridge compliant devices, the optional

Bluetooth Unit BU-30, and USB flash drives to the Direct Print Port of the machine. This

may cause fire, electric shock, or damage to the machine.

 Important

 Do not touch the metal casing.

 Do not use the USB cable longer than around 10 feet / 3 meters to connect any PictBridge

compliant device to the machine since it may affect the operation of other peripheral

devices.

(13) Card Slot Cover
Open to insert a memory card.
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See Inserting the Memory Card .

 Rear View 

(14) USB Port
Plug in the USB cable to connect the machine with a computer.

 Important

 Do not touch the metal casing.

 Do not plug in or unplug the USB cable while the machine is printing or scanning originals

with the computer.

(15) Rear Cover
Detach to remove jammed paper.

(16) Power Cord Connector
Plug in the supplied power cord.

 Inside View 

(17) Ink lamps
Light or flash red to indicate the ink tank status.

See Checking the Ink Status.

(18) Print Head Lock Lever
Locks the Print Head into place.

 Important

 Do not raise this lever after installing the Print Head.

(19) Print Head Holder
Install the Print Head.

(20) Scanning Unit (Cover)
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Scans originals. Open it to replace ink tanks, to check ink lamps, or to remove jammed paper inside the

machine. When opening the Scanning Unit (Cover), lift it with the Document Cover closed.

(21) Card Slot
Insert a memory card.

See Inserting the Memory Card .

(22) Access lamp
Lights or flashes to indicate the memory card status.

See Inserting the Memory Card .

 Note

 For details on installing the Print Head and ink tanks, refer to the printed manual: Getting
Started.

 Operation Panel 

(1) ON button
Turns the power on or off. Before turning on the power, make sure that the Document Cover is closed.

 Important

Disconnecting the power plug

 When disconnecting the power plug after turning off the power, be sure to confirm that

the Power lamp is not lit. If the power plug is disconnected from the wall outlet while the 

Power lamp is lit or flashing, the machine may become unable to print properly since the

Print Head is not protected.

(2) Buttons to use when navigating menus on the LCD
See How to Navigate Menus on the LCD .

(3) [+] [-] buttons
Specifies the number of copies to copy or print.

(4) Stop button
Cancels operation when a print, copy, or scan job is in progress.

(5) Alarm lamp
Lights or flashes orange when an error, such as paper-out or ink-out, occurs.

(6) Power lamp
Lights green after flashing when the power is turned on.

(7) Color button
Starts color printing, copying, or scanning.
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(8) Black button
Starts black & white copying, scanning, etc.

(9) OK button
Selects a menu or setting item. See How to Navigate Menus on the LCD .

Resolves an error when printing is in progress or resumes the machine's normal operation after removing

jammed paper.
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Contents > Overview of the Machine  > How to Navigate Menus on the LCD

How to Navigate Menus on the LCD 
This machine allows you to print photos on a memory card or USB flash drive, make copies, or scan an

original without a computer. To operate the machine, you can turn around the Easy-Scroll Wheel on the

Operation Panel or press the , , , or  button on the Easy-Scroll Wheel  to navigate menus or

select setting items on the LCD, then press the OK button.

This section describes the basic operation to navigate menus on the HOME screen and to select setting

items necessary for printing.

Using the Easy-Scroll Wheel (B)

The Easy-Scroll Wheel  is used to select menus or setting items.
The Easy-Scroll Wheel  can be used in two ways. You can operate the machine either way.

(D) Turn around the Easy-Scroll Wheel  with your finger to select items.
Or

(E) Press the , , , or  button to select items.

When it is indicated in this guide that the , , , or  button can be used, it is also described in the

operation procedure, i.e., "the Easy-Scroll Wheel  (the  or  button)".

 Selecting Menus on the HOME Screen 
The HOME screen will appear when the power is turned on or when the HOME button is pressed.
To start printing photos on a memory card or USB flash drive, copying, or scanning, select menus on the 
HOME screen.

1. Press the HOME button (A).

The HOME screen will appear.
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2. Turn around the Easy-Scroll Wheel (B) to select the menu to use, and press the 

OK button (C).

You can also use the  or  button on the Easy-Scroll Wheel  (B) to select the menu.

The selected menu screen will appear.

The following menus are available on the HOME screen.

Copy :
You can change copy scale or erase dark frame or shade of bound part

when copying a book. And also you can copy an original in various layouts.

See Copying.

Memory card 

:

You can print photos saved on a memory card of your digital camera or USB

flash drive.

See Printing from a Memory Card.

Easy photo

reprint :

You can scan printed photos and print them easily. You can also specify

the number of copies for each photo.

See Printing Photos from Printed Photos .

Settings :
You can maintain the condition of the machine, configure wireless LAN,

change settings of the machine, or print the template forms such as

notebook paper, etc.

See When Printing Becomes Faint or Colors Are Incorrect , Cleaning the

Paper Feed Roller, Machine Settings, or Printing the Template Forms such as

Notebook Paper .

Photo index

sheet :

You can easily print photos on a memory card or USB flash drive using the

Photo Index Sheet.

See Using Photo Index Sheet to print.

Scan :
You can forward scanned data to your computer or save them on a

memory card or USB flash drive inserted into the machine with the

Operation Panel.

See Scanning.

 Selecting Setting Items 
The displayed screen varies depending on the menu you selected, but the operation is the same.

This section describes the procedure to select a setting item, using the operation to change the print

quality on the print confirmation screen in Select and print of Memory card as an example.

1. Use the Easy-Scroll Wheel (the  or  button) (B) to select Standard, and press

the OK button (C).
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2. Use the Easy-Scroll Wheel (the  or  button) to select High (quality-priority), and

press the OK button.

The screen will return to the print confirmation screen in Select and print.

 Other Operations 

 Selecting Items at the Bottom of the LCD
You can use the two Function buttons (F) to select items displayed at the bottom of the LCD.

You can press the right Function button to select the item on the right, and the left Function button to

select the item on the left. The displayed items vary depending on the screen.
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 Returning to the Previous Screen
You can press the Back button (G) to return to the previous screen.

 Performing the Frequently-Used Functions with Easy
Operation
You can use the NAVI button (H) to perform the frequently-used functions easily, just by following the

instructions displayed on the screen. You can also display the information on the functions or

instructions on how to load paper.

1. Press the NAVI button (H).

The NAVI screen will appear.

 Note

 When you press the Back button while the NAVI screen appears, the HOME screen will

appear.

2. Use the Easy-Scroll Wheel (the  or  button) to select the item, and press the 

OK button.

Follow the instructions on the LCD.

 Canceling Printing, Copying, or Scanning
You can press the Stop button (I) to cancel a print, copy, or scan job in progress.
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Printing from a Memory Card 
You can preview each photo from a memory card or USB flash drive on the LCD, to select and print the

desired photo.
You can also print your favorite photos in various layouts or use them for making a calendar or sticker.

Printing Photos Saved on the Memory Card / USB Flash Drive

Changing the Settings

Using Various Functions

Printing Photos in Various Layouts

Changing the Display

Cropping Photos / Searching Photos by a Specified Date

Correcting Images

Printing Photos with Shot Date or File Number

Inserting the Memory Card

Before Inserting the Memory Card

Inserting the Memory Card

Removing the Memory Card

Inserting the USB Flash Drive

Inserting the USB Flash Drive

Removing the USB Flash Drive
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Printing Photos Saved on the Memory Card / USB Flash Drive
Preview each photo from the memory card or USB flash drive on the LCD, to select and print the desired

photo.

This section describes the procedure to print borderless photos on 4" x 6" / 10 x 15 cm photo paper.

For the operation, see the notes and operation procedure described in the reference page.

You need to prepare:

A memory card with saved photos. See Before Inserting the Memory Card .

A USB flash drive with saved photos. See Inserting the USB Flash Drive .

Paper for photo printing. See Media Types You Can Use .

1. Prepare for printing.

(1) Turn on the power.
See Operation Panel .

(2) Load paper.
See Loading Paper .

Here we load 4" x 6" / 10 x 15 cm photo paper in the Rear Tray.

 Note

 Load A4 or Letter-sized plain paper in the Cassette. Load other sizes or types of paper in

the Rear Tray.

(3) Open the Paper Output Tray gently, and open the Output Tray Extension.
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2. Insert a memory card or USB flash drive.

(1) Select Memory card  on the HOME screen, and press the OK button.
See Selecting Menus on the HOME Screen.

(2) Select Select and print , and press the OK button.

(3) Insert the memory card or USB flash drive.

Memory card:

Insert it WITH THE LABELED SIDE FACING TO THE LEFT into the Card Slot. For the types of memory card

compatible with the machine and locations to insert them, see Inserting the Memory Card .

USB flash drive:

Insert it into the Direct Print Port. See Inserting the USB Flash Drive.

The photo selection screen will appear.
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(A) USB Flash Drive

(B) Memory Card

 Note

 The screen can also be changed to the photo selection screen in Select and print of

Memory card by inserting a memory card or USB flash drive while the HOME screen or

any screen of Copy and Easy photo reprint appears.

 You can also select useful printing functions other than Select and print.

See Using Various Functions .

 Do not insert memory card and USB flash drive at the same time. Also do not insert two or

more memory cards at the same time.

 When Read/write attribute is set to Writable from USB PC or Writable from LAN PC, you

cannot print image data from the memory card using the Operation Panel on the machine.

To print image data from the memory card, select Advanced settings in Device settings of

Settings on the HOME screen, and set Read/write attribute to Not writable from PC. 

* The image data on the USB flash drive can be printed.

For details, refer to the on-screen manual: Advanced Guide .

3. Select photos to print.

(1) Use the Easy-Scroll Wheel (the  or  button) (C) to display the photo to

print.

 Note

  may appear on the LCD while reading photos. If you use the Easy-Scroll Wheel  (the 

 or  button) to display the photo while  appears on the LCD, the desired photo may

not be selected.

(2) Press the [+] or [-] button (D) to specify the number of copies.

(3) Repeat the procedures of (1) and (2) to specify the number of copies for each

photo.

 Note

Other options

 To change the display of photos, see Changing the Display.

 To crop photos (Trimming), see Cropping Photos / Searching Photos by a Specified Date .

 To search photos by a specified date (Search), see Cropping Photos / Searching Photos

by a Specified Date .

(4) Press the OK button (E).
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The print confirmation screen will appear.

4. Start printing.

(1) Confirm the page size, media type, print quality, etc.
Here we confirm that 4"x6" (10x15cm) is selected for Page size and the type of loaded photo paper for

Media type.

To change the settings, use the Easy-Scroll Wheel  (the  or  button) (F) to select the item to change,

and press the OK button (G).

See Selecting Setting Items  and Changing the Settings.

 Note

 When Plain paper is selected for Media type and A4 or 8.5"x11" (LTR) for Page size,

Cassette will appear for Paper source.

When other sizes or types of paper are selected, Rear tray will appear.

Confirm that the selected paper is loaded in the correct paper source.

(2) Confirm the number of sheets to be used for printing the selected photos.

(3) Press the right Function button (H) to select Check photo, and confirm the

selected photos and number of copies for each photo.
Press the OK button (G) to return to the print confirmation screen.

(4) Press the Color button (I).
The machine starts printing photos.

 Note

 If you press the left Function button (J) to select Advanced, Date setting, File no.setting and

Auto photo fix will appear. 

You can correct photos automatically or manually if you select the Auto photo fix.

See Using Various Functions .

 Press the Stop button to cancel printing.

 Printing does not start if you press the Black button.

 You can display the Memory card menu screen and select other useful printing functions, if

you press the Back button after printing is completed. If you press the HOME button or

remove the memory card or USB flash drive, the HOME screen will appear.

 To remove the memory card, see Removing the Memory Card .

To remove the USB flash drive, see Removing the USB Flash Drive .
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 Changing the Settings 
You can use the Easy-Scroll Wheel  (the  or  button) to change the print settings such as page size,
media type, or print quality to print.

For the setting operation, see Selecting Setting Items .

(1) Page size
Select the page size of the paper to print: 4"x6" (10x15cm), A4, etc.

(2) Media type
Select the media type of the paper to print: Plus Glossy II, Plain paper, etc.

 Note

 If you do not select the page size and media type correctly, the machine may feed paper

from the wrong paper source or may not print with the proper print quality.

See Paper Source to Load Paper .

(3) Print quality
Adjust the print quality: High(quality-priority) or Standard.

(4) Borderless print
Select bordered or borderless print: Bordered or Borderless.

 Note

 When Plain paper is selected for Media type, you cannot select Borderless.

 If the ratio of the height to the width differs from the image data when Borderless is

selected, a portion of the image may not be printed depending on the size of the media

used.

(5) Paper source
The paper source for the selected page size and media type appears on the screen.

When A4 or Letter-sized plain paper is selected, Cassette will appear.

When other sizes or types of paper are selected, Rear tray will appear.

Confirm that the selected paper is loaded in the paper source displayed on the screen.

For details on the paper source setting, refer to the on-screen manual: Advanced Guide .

 Note

 The settings of the page size, media type, print quality, image correction, borderless print,

etc.are retained, and these settings will appear next time when the Memory card menu is

selected even if the power is turned off and on.

 Combination of some items cannot be specified depending on the function.

Using Photo Index Sheet to print

Thumbnails of photos on the memory card or USB flash drive are printed on A4 or Letter-sized paper

(this printed sheet is called Photo Index Sheet). You can select photos, number of copies, page size, etc.

on this sheet, and print them.

Select Photo index sheet  on the HOME screen, and Index sheet print . For details on the

operation, refer to the on-screen manual: Advanced Guide .
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Contents > Printing from a Memory Card > Using Various Functions

Using Various Functions 

You can print photos in various ways when you select Memory card  on the HOME screen. You can

also use the useful functions to print photos.

For details, refer to the on-screen manual: Advanced Guide.

 Printing Photos in Various Layouts 
You can select various layouts on the Memory card menu screen. You can also select DPOF print.

Layout print Sticker print Captured info print

 

Photo index print Print all photos  

 

ID photo size print Calendar print  

 Changing the Display 
You can change the display of photos by pressing the left Function button when Change display appears

at the bottom of the screen. You can also select Slide show.

Thumbnail display Full-screen display Enlarged display

 Cropping Photos / Searching Photos by a Specified Date 
You can specify the function by pressing the right Function button when Edit appears at the bottom of the

screen.
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Wide (16:9) Standard (4:3)

Trimming

Search

 Correcting Images 
You can correct images by pressing the left Function button to select Auto photo fix when Advanced

appears at the bottom of the screen. You can correct images automatically or manually, such as

adjusting brightness, contrast, and color hue, or add effects to images.

Auto photo fix ON (Default)

 Printing Photos with Shot Date or File Number 
You can print photos with shot date or file number by pressing the left Function button to select Date

setting or File no.setting when Advanced appears at the bottom of the screen.

Date setting File no.setting
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Advanced Guide Troubleshooting

Contents > Printing from a Memory Card > Inserting the Memory Card

Inserting the Memory Card 

 Before Inserting the Memory Card 
The following types of memory cards and image data are compatible with the machine.

 Important

 If you took and saved photos on a type of memory card that does not guarantee the operation on

your digital camera, the image data may be unreadable on the machine or damaged. For information

on memory cards that your digital camera guarantees operation, refer to the instruction manual

supplied with your digital camera.

 Format the memory card with a digital camera compliant with the Design rule for Camera File system

(Exif 2.2/2.21 compliant), TIFF (Exif 2.2/2.21 compliant). The memory card may not be compatible

with the machine if it is formatted on a computer.

 Memory Cards that Do Not Require a Card Adapter

 SD Secure Digital memory card

 SDHC memory card

 MultiMediaCard

 MultiMediaCard Plus

  

 Compact Flash (CF) Card

Supports Type I/II (3.3 V)

 Microdrive

  

 Memory Stick

 Memory Stick PRO

 Memory Stick Duo

 Memory Stick PRO Duo

 Memory Cards that Require a Card Adapter

 Important

 Be sure to attach the special card adapters to the following memory cards before inserting to

the Card Slot.

If one of the following memory cards is inserted without the card adapter, you may not be able

to remove the memory card. In this case, refer to " Troubleshooting" in the on-screen manual: 

Advanced Guide .

  

 miniSD Card *1

 miniSDHC Card *1

  

 microSD Card *1

 microSDHC Card *1

  

 xD-Picture Card *2

 xD-Picture Card Type M *2

 xD-Picture Card Type H *2
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 RS-MMC *3

  

 Memory Stick Micro *4

*1 Use the special "SD Card Adapter".

*2 Requires purchase of a separate compact flash card adapter for xD-Picture Card.

*3 Use the special card adapter.

*4 Use the special Duo size adapter or full size adapter. 

 Printable Image Data
This machine accepts images taken with a camera compliant with the Design rule for Camera File
system (Exif 2.2/2.21 compliant), TIFF (Exif 2.2/2.21 compliant). Other image or movie types such as

RAW images cannot be printed.

 Inserting the Memory Card 

 Important

 When a memory card is inserted into the Card Slot, the Access lamp is lit. When the Access lamp

is flashing, the machine is accessing the memory card. In this case, do not touch the area around

the Card Slot.

 Note

 When Read/write attribute is set to Writable from USB PC or Writable from LAN PC, you cannot print

image data from the memory card or save scanned data on the memory card using the Operation

Panel of the machine. After using the Card Slot as the memory card drive of a computer, remove

the memory card, select Advanced settings in Device settings of Settings on the HOME screen,

then set Read/write attribute to Not writable from PC. For details, refer to the on-screen manual: 

Advanced Guide .

 When you use a computer to edit or enhance photos saved on a memory card, be sure to print them

from the computer. If you use the Operation Panel, the photos may not be printed properly.

1. Prepare your memory card.

Attach a special card adapter if your memory card requires one.

See Memory Cards that Require a Card Adapter .

2. Turn on the power, and open the Card Slot Cover.
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3. Insert only one memory card into the Card Slot.

The location to insert a memory card varies depending on each type of memory card. Insert your memory card

straightforward WITH THE LABELED SIDE FACING TO THE LEFT into the Card Slot, according to the insert

location in the figure below.

When the memory card is inserted properly, the Access lamp (A) will light up.

Be sure to attach the card adapter for memory card with the mark  (asterisk), and then insert it into the Card

Slot as shown below.

For Memory Stick Duo, Memory Stick PRO Duo,

or Memory Stick Micro (with the Duo size adapter) :

  

For SD Secure Digital memory card, SDHC memory card, MultiMediaCard, MultiMediaCard Plus,

miniSD Card , miniSDHC Card ,

microSD Card , microSDHC Card ,

Memory Stick, Memory Stick PRO,

Memory Stick Micro (with the full size adapter) ,

or RS-MMC:

  

For Compact Flash (CF) Card, Microdrive,

xD-Picture Card , xD-Picture Card Type M , or xD-Picture Card Type H :

  

 Important

 Part of the memory card will protrude from the Card Slot, but do not force it into the slot any

further. This can damage the machine or the memory card.

 Make sure that the memory card is correctly oriented before inserting it into the Card Slot. If

you force the memory card into the Card Slot in the wrong orientation, the memory card or the

machine can be damaged.

 Do not insert more than one memory card at a time.
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4. Close the Card Slot Cover.

 Removing the Memory Card 

 Important

 If you used the Card Slot as the memory card drive of a computer, you must perform the "safe

removal" operation on your computer before physically removing the memory card from the

machine.

- In Windows, if you are connecting the machine with a USB cable, right-click the removable disk

icon and click Eject. If Eject does not appear on the screen, make sure that the Access lamp is

lit, and then remove the memory card. If you used the Card Slot via the LAN, you do not need to

perform the "safe removal" operation on your computer.

- In Macintosh, drag  (Mount drive) into the Trash.

1. Open the Card Slot Cover.

2. Make sure that the Access lamp is lit, and remove the memory card.

Hold the part of the memory card that is protruding and remove it straightforward from the machine.

 Important

 Do not remove the memory card while the Access lamp is flashing. The Access lamp flashes

while the machine is reading or writing data from/to the memory card. If you remove the

memory card or turn off the power while the Access lamp is flashing, the data saved on the

memory card can be damaged.

3. Close the Card Slot Cover.
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Contents > Printing from a Memory Card > Inserting the USB Flash Drive

Inserting the USB Flash Drive 

 Inserting the USB Flash Drive 

 Note

Before inserting the USB flash drive

 If your USB flash drive cannot be inserted into the Direct Print Port of the machine, you may be

required to use an extension cable for the USB flash drive. Purchase it at electronics retail stores.

 Some USB flash drives may have recognition problem, and these devices may not guarantee proper

operation of the machine.

 You may not be able to use USB flash drives with security function.

1. Insert the USB flash drive into the Direct Print Port.

Make sure that the USB flash drive is correctly oriented before inserting it straightforward into the Direct Print

Port.

 Removing the USB Flash Drive 

1. Make sure that the machine is not reading or writing data from/to the USB flash
drive.

Check if the reading or writing operation is completed on the LCD.

 Important

 Do not remove the USB flash drive or turn off the power while the machine is operating.

 Note

 If your USB flash drive has the access lamp, refer to the instruction manual supplied with the

USB flash drive to check if the reading or writing operation is completed on the USB flash

drive.

2. Remove the USB flash drive.

Hold the USB flash drive and remove it straightforward from the machine.

Page 27 of 949 pagesInserting the USB Flash Drive



      

Page top

Page 28 of 949 pagesInserting the USB Flash Drive



Advanced Guide Troubleshooting

Contents > Copying

Copying 
You can copy in the various methods such as enlarging/reducing or copying two original pages onto a

single sheet of paper.

Making Copies

Changing the Settings

Using Various Copy Functions
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Making Copies 
This section describes the procedure to copy a document of A4 size on plain paper.

For the operation, see the notes and operation procedure described in the reference page.

You need to prepare:

Originals to copy. See Originals You Can Load .

Paper for printing. See Media Types You Can Use .

1. Prepare for copying.

(1) Turn on the power.
See Operation Panel .

(2) Load paper.
See Loading Paper .

Here we make sure that A4 plain paper is loaded in the Cassette.

 Note

 Load A4, B5, A5, or Letter-sized plain paper in the Cassette. Load other sizes or types of

paper in the Rear Tray.

(3) Open the Paper Output Tray gently, and open the Output Tray Extension.

(4) Select Copy  on the HOME screen, and press the OK button.
See Selecting Menus on the HOME Screen.
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(5) Load an original on the Platen Glass.
See Loading Originals.

Load the original WITH THE SIDE TO COPY FACING DOWN and align it with the alignment mark  as

shown below.

Then close the Document Cover gently.

 Note

 For details on the types and conditions of the original which can be copied, see Originals

You Can Load .

2. Start copying.

(1) Confirm the page size, media type, magnification, etc.
Here we confirm that 100% is selected for Magnification, A4 for Page size, and Plain paper for Media type.

To change the settings, use the Easy-Scroll Wheel  (the  or  button) (A) to select the item to change,

and press the OK button (B).

See Selecting Setting Items  and Changing the Settings.

 Note

 When Plain paper is selected for Media type and A4, B5, A5, or 8.5"x11" (LTR) for Page

size, Cassette will appear for Paper source.

When other sizes or types of paper are selected, Rear tray will appear.

Confirm that the selected paper is loaded in the correct paper source.

 You can check the preview of print result if you press the right Function button (C) to

select Preview.

Refer to the on-screen manual: Advanced Guide .

 You can select various copy functions, such as Two-sided copy, Borderless copy, 2-on-

1 copy, and Frame erase, if you press the left Function button (D) to select Special copy.
See Using Various Copy Functions .
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(2) Press the [+] or [-] button (E) to specify the number of copies.

(3) Press the Color button (F) for color copying, or the Black button (G) for black &

white copying.
The machine starts copying.

Remove the original on the Platen Glass after copying is completed.

 Important

 Do not open the Document Cover or move the loaded original until copying is completed.

 Note

 Press the Stop button to cancel copying.

 Repeat the procedures from (5) of step 1 to copy another original.

You can exit the Copy menu and display the HOME screen if you press the HOME button.

 Changing the Settings 
You can use the Easy-Scroll Wheel  (the  or  button) to change the print settings such as page size,
media type, or print quality to print.

For the setting operation, see Selecting Setting Items .

(1) Magnification
Specify the enlargement/reduction manner. You can specify the copy scale by selecting the optional

number or the page size: A4 to A5, A4 to B5, etc. If you do not want to enlarge/reduce the page size,

select 100%.

For details, refer to the on-screen manual: Advanced Guide .

(2) Intensity
Specify the intensity when you want to make the darkened/lightened copy. You can also set the intensity to

automatically adjust according to the original.

For details, refer to the on-screen manual: Advanced Guide .

(3) Page size
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Select the page size of the paper to print: A4, 8.5"x11" (LTR), etc.

(4) Media type
Select the media type of the paper to print: Plain paper, Plus Glossy II, etc.

 Note

 If you do not select the page size and media type correctly, the machine may feed paper

from the wrong paper source or may not print with the proper print quality.

See Paper Source to Load Paper .

(5) Print quality 
Adjust the print quality according to the original to copy: High(quality-priority), Standard, etc. The available

print quality settings depend on the paper selected for Media type.

(6) Paper source
The paper source for the selected page size and media type appears on the screen.

When A4, B5, A5, or Letter-sized plain paper is selected, Cassette will appear.

When other sizes or types of paper are selected, Rear tray will appear.

Confirm that the selected paper is loaded in the paper source displayed on the screen.

For details on the paper source setting, refer to the on-screen manual: Advanced Guide .

 Note

 If Two-sided copy is selected, select A4 or 8.5"x11" (LTR) for Page size and Plain paper for

Media Type.

 If 2-on-1 copy or 4-on-1 copy is selected, select A4 or 8.5"x11" (LTR) for Page size.

 If Borderless copy is selected, select 8.5"x11"(LTR), A4, 4"x6"(10x15cm), or 5"x7"(13x18cm)

for Page size and any types of paper except Plain paper for Media type.

 If Borderless copy is selected, slight cropping may occur at the edges since the copied image

is enlarged to fill the whole page.

 The settings of the page size, media type, print quality, automatic intensity, etc. are retained,

and these settings will appear next time when the Copy menu is selected even if the power is

turned off and on.

 Combination of some items cannot be specified depending on the function.

 If you select Fast (speed-priority) with the media type set to Plain paper and the quality is not

as good as expected, select Standard or High(quality-priority) and then try copying again.
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Advanced Guide Troubleshooting

Contents > Copying > Using Various Copy Functions

Using Various Copy Functions 
You can make various kinds of copies if you press the left Function button to select Special copy at the
bottom of the Copy screen.

For details, refer to the on-screen manual: Advanced Guide.

Two-sided copy Borderless copy

2-on-1 copy

4-on-1 copy

Image repeat Frame erase

Trimming Masking
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Advanced Guide Troubleshooting

Contents > Printing Photos from Printed Photos

Printing Photos from Printed Photos 
You can reprint printed photos in various layouts.

Reprinting Printed Photos

Using Various Functions

Printing Photos in Various Layouts

Correcting Images
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Advanced Guide Troubleshooting

Contents > Printing Photos from Printed Photos  > Reprinting Printed Photos

Reprinting Printed Photos 
Reprint printed photos.
This section describes the procedure to scan printed photos and print them on 4" x 6" / 10 x 15 cm photo

paper.

 Note

 You cannot save scanned images with this function.

To save scanned images, see Scanning.

You need to prepare:

Printed photos.

Paper for photo printing. See Media Types You Can Use .

1. Prepare for reprinting printed photos.

(1) Turn on the power.
See Operation Panel .

(2) Load paper.
See Loading Paper .

Here we load 4" x 6" / 10 x 15 cm photo paper in the Rear Tray.

(3) Open the Paper Output Tray gently, and open the Output Tray Extension.

(4) Select Easy photo reprint  on the HOME screen, and press the OK button.

(5) When the guidance screen appears, press the OK button again.

2. Load photos on the Platen Glass to scan.
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(1) Open the Document Cover.

(2) Load the photos WITH THE SIDE TO SCAN FACING DOWN on the Platen

Glass.
See Loading Originals.

(A) To load four photos on the Platen Glass

(B) To load two photos on the Platen Glass

 Note

 Place the photo(s) at least 0.4 inches / 10 mm away from and in square with the edges of
the Platen Glass.

 When loading two or more photos at the same time, place them at least 0.4 inches / 10 mm

apart from each other. If photos are placed closer, they may be scanned as a single
image.

 The Skew Correction function automatically compensates for photos placed at an angle of

up to approximately 10 degrees.

 Slanted photos with a long edge of 7.1 inches / 180 mm or more cannot be corrected.

 If  appears on the preview screen, check the followings and reset the photos properly

to scan them again.

- The slant is not too large.

- The photos are not placed too close to the edge of the Platen Glass.

 Photos smaller than approximately 1 inch / 25 mm square will not be scanned properly.

 The types of photos listed below may not be scanned properly.

- Photos that are non-rectangular or irregular shaped (such as cut out photos)

- Photos that are entirely white

- Photos that have white surrounds

 The borders of bordered photos may not be scanned properly. Crop photos if necessary.

Refer to the on-screen manual: Advanced Guide .

(3) Close the Document Cover gently, and press the OK button.
The machine starts scanning.

 Important

 The photos are rescanned before printing starts. Do not open the Document Cover or move the

loaded photos until printing is completed.

3. Specify the number of copies.

(1)  Select Select and print , and press the OK button.

 Note

 You can also select useful printing functions other than Select and print.

See Using Various Functions .

(2) Use the Easy-Scroll Wheel (the  or  button) to display a photo to print.

(3) Press the [+] or [-] button to specify the number of copies.
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 Note

 If  appears next to the photo on the screen, it may not have been scanned properly.

Press the Back button, and press the left Function button to select Rescan. Confirm the

message, and repeat the procedures from step 2 to scan the photo again.

Other options

 To change the display of photos, see Changing the Display.

(You can also select Full-screen display and Enlarged display other than Normal screen

display.)

 To crop of photos (Trimming), see Cropping Photos / Searching Photos by a Specified 

Date.

(4) Repeat the procedures of (2) and (3) to specify the number of copies for each

photo.

(5) Press the OK button.

4. Start printing.

(1) Confirm the page size, media type, print quality, etc.
Here we confirm that 4"x6" (10x15cm) is selected for Page size and the type of loaded photo paper for

Media type.

 Note

 To change the settings, select each item, and press the OK button.

See Changing the Settings.

 The settings of the page size, media type, print quality, etc. are retained, and these

settings will appear next time when the Easy photo reprint menu is selected even if the

power is turned off and on.

(2) Confirm the number of sheets to be used for printing the selected photos.

 Note

 You can correct photos automatically or manually, if you press the left Function button to

select Advanced.

See Using Various Functions .

(3) Press the Color button to print in color, or the Black button to print in black &

white.
The machine starts printing.

Remove the photos on the Platen Glass after printing is completed.

 Note
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 Press the Stop button to cancel printing.

 You can exit the Easy photo reprint menu and display the HOME screen, if you press the 
HOME button after printing is completed. Confirm the message and select Yes to delete the

scanned image data.
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Advanced Guide Troubleshooting

Contents > Printing Photos from Printed Photos  > Using Various Functions

Using Various Functions 
This section introduces a few of the useful functions in the Easy photo reprint menu.

For details, refer to the on-screen manual: Advanced Guide.

 Printing Photos in Various Layouts 
You can select a layout and print photos other than Select and print.

Sticker print Print all photos

 Correcting Images 
You can correct images by pressing the left Function button when Advanced appears at the bottom of the

screen. You can correct images automatically or manually, such as adjusting brightness, contrast, and

color hue, or apply the fade restoration.

Brightness Contrast
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Advanced Guide Troubleshooting

Contents > Scanning

Scanning 
You can forward scanned data to your computer, and edit or process them with the supplied software

application. You can also save scanned data on a memory card or USB flash drive inserted into the

machine.

Forwarding Scanned Data to the Computer

Preparing for Scanning with the Operation Panel

Forwarding Scanned Data to the Computer

Using Various Scan Functions
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Advanced Guide Troubleshooting

Contents > Scanning > Forwarding Scanned Data to the Computer

Forwarding Scanned Data to the Computer 
You can forward scanned data to the computer with the USB cable or via a network.

This section describes the procedure to detect the type of original automatically with Auto scan, and

forward the scanned data to the computer connecting with the USB cable, according to the settings

specified with MP Navigator EX.

For other operations to save scanned data on a memory card or USB flash drive and to scan originals

from the computer, refer to the on-screen manual: Advanced Guide .

 Important

 Please note that Canon shall not be liable for any damage or loss of the data for any reason

whatsoever, even within the warranty period of the machine.

 Note

 You can select Auto scan only when forwarding scanned data to the computer with the USB

cable. 

 The machine can detect the types of original with Auto scan: photo, postcard, business card,

magazine, newspaper, text document, and DVD/CD. For other originals, select the type of originals

to scan them.

 Preparing for Scanning with the Operation Panel 
Before scanning originals, confirm the following:

 Are the necessary software applications (MP Drivers and MP Navigator EX) installed? 
Install MP Drivers and MP Navigator EX from the Setup CD-ROM  when it has not been installed or

has been uninstalled. To install MP Drivers and MP Navigator EX, select MP Drivers and MP

Navigator EX in Custom Install.

 Are the type of original and processing method specified with MP Navigator EX?

When you forward scanned data to the computer with the Operation Panel, you can specify the

settings such as the type of original and processing method in Preferences of MP Navigator EX.

For details on the settings, refer to the on-screen manual: Advanced Guide .

 Does the original to be scanned meet the requirements for the original to be loaded on the Platen

Glass? 

For details, see Originals You Can Load .

 If the Machine Is Connected via USB
Confirm that the connection with USB cable between the machine and the computer is physically

secure.

 Important

 Do not plug in or unplug the USB cable while the machine is scanning originals with the

computer.

 If the Machine Is Connected over a Network
When you use a computer connected over a network, confirm the following:

 Is the machine selected in the settings screen of the Canon IJ Network
Scan Utility (Windows) or Canon IJ Network Scanner Selector
(Macintosh)?

For details on the setting procedure, refer to the on-screen manual: Advanced Guide .

 Is the Canon IJ Network Scan Utility/Canon IJ Network Scanner
Selector running?
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For details, refer to the instructions for scanning over a network in the on-screen manual: 
Advanced Guide .

 If You Are Using Mac OS X v.10.3.9
You need to set MP Navigator EX as the starting software application in Image Capture under
Applications of Mac OS X.

(1) Select Applications on the Go menu, and double-click the Image Capture icon.

(2) Click Options at lower left of the scanner window, select MP Navigator EX 3 in

Application to launch when scanner button is pressed, then click OK.
To quit Image Capture, select Quit Image Capture on the Image Capture menu.

 Note

 If Options does not appear, select Preferences on the Image Capture menu, click Scanner, and

click Use TWAIN software whenever possible to clear the option. Then quit Image Capture and

restart it.

 Forwarding Scanned Data to the Computer 

1. Select the scan operation.

(1) Turn on the power.
See Operation Panel .

(2) Select Scan  on the HOME screen, and press the OK button.

(3) Use the Easy-Scroll Wheel (the  or  button) to select PC , and press
the OK button.
The computer selection screen will appear.

(4) Use the Easy-Scroll Wheel (the  or  button) to select the computer to

forward scanned data, and press the OK button.
Here we select USB.

The document type selection screen will appear.

 Note

 For the network connection, select the computer name to forward scanned data in the list.

 For the connection via USB only, only USB appears on the LCD.

(5) Use the Easy-Scroll Wheel (the  or  button) to select the type of original, and

press the OK button.
Here we select Auto scan.

 Note

 If the computer connected over a network is selected in (4), Auto scan does not appear

on the LCD.

 The type of original other than Auto scan is Document and Photo. If you select other than

Auto scan, you can save all scanned data in a PDF file, attach it to a mail, or open it with a

software application.
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For details, refer to the on-screen manual: Advanced Guide .

2. Load an original on the Platen Glass.

Make sure to load the original correctly according to the type of original that you have selected. 

See Loading Originals.

3. Press the Color or Black button to start scanning.

MP Navigator EX will be started, the original will be scanned according to the settings specified with MP

Navigator EX, and then the scanned data will be forward to the computer.

Scanning... will appear while scanning the original.

If you want to scan another original, load it on the Platen Glass, and press the Color or Black button again.

Remove the original on the Platen Glass after scanning is completed.

 Important

 Do not turn off the power while the machine is operating.

 Do not open the Document Cover or move the loaded original until scanning is completed.

 Note

 Press the HOME button to exit the Scan menu and display the HOME screen.

 Note

 The position or size of the original may not be scanned correctly depending on the type of original.

If the scan is not performed correctly, refer to the on-screen manual: Advanced Guide  to change
the settings in Document Type and Document Size of MP Navigator EX to match the original and

scan it again.

When the program selection screen appears:

The program selection screen may appear after performing step 3. 

If the program selection screen appears, select MP Navigator EX Ver3.0 and click OK.

To start MP Navigator EX automatically without displaying the program selection screen, follow the

procedure below.

 For Windows Vista users, refer to "For Windows Users" in " Troubleshooting" of the on-screen
manual: Advanced Guide .

 For Windows XP users, select MP Navigator EX Ver3.0 as the software application to be used in

the program selection screen, select Always use this program for this action, then click OK.
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Advanced Guide Troubleshooting

Contents > Scanning > Using Various Scan Functions

Using Various Scan Functions 
You can forward the data scanned with the machine to a computer, and also save them on a USB flash

drive or memory card inserted into the machine.

For details, refer to the on-screen manual: Advanced Guide.

 Selecting a Device to Save the Scanned Data
You can select the device to save scanned data as processing method as shown below.

USB flash drive Memory card 

 Selecting Various Processing Methods
To forward the scanned data to the computer, you can select the processing method for scanned

data if other than Auto scan is selected for the type of original.

Save to PC Save as PDF file Attach to E-mail Open with application

 Note

 Options for scan operation can be specified with MP Navigator EX. 

For details, refer to the on-screen manual: Advanced Guide .
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Advanced Guide Troubleshooting

Contents > Printing from Your Computer

Printing from Your Computer 
This section describes the procedure to print documents or photos with a computer.
You can easily print photos taken with your digital camera by using Easy-PhotoPrint EX supplied with the

machine.

Printing Photos (Easy-PhotoPrint EX)

Using Various Functions of Easy-PhotoPrint EX

Printing Documents (Windows)

Printing Documents (Macintosh)

For Mac OS X v.10.5.x

For Mac OS X v.10.4.x or Mac OS X v.10.3.9

      

Page top

Page 46 of 949 pagesPrinting from Your Computer



Advanced Guide Troubleshooting

Contents > Printing from Your Computer  > Printing Photos (Easy-PhotoPrint EX)

Printing Photos (Easy-PhotoPrint EX) 
Print image data saved on your computer by using Easy-PhotoPrint EX supplied with the machine.

This section describes the procedure to print borderless photos on 4" x 6" / 10 x 15 cm photo paper.

For details on Easy-PhotoPrint EX, refer to the on-screen manual: Advanced Guide .

 Note

 The screens used in this section are for printing with Windows. The operations are also the same

for printing with Macintosh.

 Install Easy-PhotoPrint EX from the Setup CD-ROM  when it has not been installed or has been

uninstalled. To install Easy-PhotoPrint EX, select Easy-PhotoPrint EX in Custom Install.

1. Prepare for printing.

(1) Make sure that the machine is turned on.
See Operation Panel .

(2) Load paper.
See Loading Paper .

Here we load 4" x 6" / 10 x 15 cm photo paper in the Rear Tray.

 Note

 Load A4 or Letter-sized plain paper in the Cassette and other sizes or types of paper

such as photo paper in the Rear Tray.

(3) Open the Paper Output Tray gently, and open the Output Tray Extension.

2. Start Easy-PhotoPrint EX, and select Photo Print.

(1) Start Easy-PhotoPrint EX.

   

Double-click  (Easy-PhotoPrint EX) on the desktop.

 Click Here: Easy-PhotoPrint EX
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Select the Go menu, Applications, Canon Utilities, Easy-PhotoPrint EX, then double-click Easy-

PhotoPrint EX.

 Note

   

 To start Easy-PhotoPrint EX from Solution Menu, double-click  (Solution Menu) on the

desktop and click  (Print photos or albums, etc.).

See Solution Menu .

 To start Easy-PhotoPrint EX from the Start menu, select All Programs (or Programs), Canon

Utilities, Easy-PhotoPrint EX, then Easy-PhotoPrint EX.

   

 To start Easy-PhotoPrint EX from Solution Menu, click  (Solution Menu) in the Dock and

click  (Print photos or albums, etc.).

See Solution Menu .

(2) Click Photo Print.

 Note

 You can select Album, Calendar, Stickers, etc., besides Photo Print.

See Using Various Functions of Easy-PhotoPrint EX.

3. Select a photo to print.

(1) Select the folder in which images are saved.

(2) Click the image to print.
The number of copies appears as "1", and the image you selected appears in the selected image area (A).

You can select two or more images at the same time.

 Note

 To print two or more copies, click  (Up arrow) to change the number of copies.

 To cancel the selection, click the image to cancel in the selected image area and click 

(Delete Imported Image). You can also use  (Down arrow) to change the number of

copies to zero.

 You can also correct or enhance the selected image. 

See Using Various Functions of Easy-PhotoPrint EX.

(3) Click Select Paper.
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4. Select the loaded paper.

(1) Make sure that your machine's name is selected in Printer.

(2) Make sure that Automatically Select is selected in Paper Source.

 Note

 For details on other settings for Paper Source, refer to the on-screen manual: Advanced
Guide.

(3) Select the size and type of the loaded paper in Paper Size and Media Type.
Here we select 4"x6" 10x15cm in Paper Size and the type of the loaded photo paper in Media Type.

 Note

 If you select A4 or Letter-sized plain paper when Automatically Select is selected in Paper

Source, the machine feeds the paper from the Cassette. If you select other sizes or types

of paper such as photo paper, the machine feeds the paper from the Rear Tray.

If you select the wrong page size or media type, the machine may feed paper from the

wrong paper source or may not print with the proper print quality. 

(4) Click Layout/Print.

5. Select a layout and start printing.

(1) Select the layout of the photo.
Here we select Borderless (full).

The preview will appear in the selected layout for confirmation of the required print result.

 Note

 You can change the direction of photo or crop photos (trimming) to print.

For details on the operation, refer to the on-screen manual: Advanced Guide .
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(2) Click Print.

 Note

   

 To cancel a print job in progress, press the Stop button on the machine or click Cancel Printing

on the printer status monitor. After canceling the print job, blank sheets of paper may be

ejected.

To display the printer status monitor, click Canon XXX Printer (where " XXX" is your machine's

name) on the taskbar.

   

 Click the printer icon in the Dock to display the list of print jobs in progress.

 To cancel a print job in progress, select the desired job in the Name list and click Delete.

To temporarily stop a job in progress, click Hold. To temporarily stop all the jobs in the list, click

Pause Printer (or Stop Jobs). After canceling the print job, blank sheets of paper may be

ejected.
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Advanced Guide Troubleshooting

Contents > Printing from Your Computer  > Printing Photos (Easy-PhotoPrint EX)  >  Using Various Functions of Easy-
PhotoPrint EX

 Using Various Functions of Easy-PhotoPrint EX 
This section introduces a few of the useful functions of Easy-PhotoPrint EX.

For details, refer to the on-screen manual: Advanced Guide.

 Creating Your Own Prints
You can create an album or calendar using your photos.

 

 Album Calendar

 

 Stickers Layout Print

 Correcting Images
You can use Red-Eye Correction, Face Sharpener, Digital Face Smoothing, Brightness, Contrast,

etc. to adjust, correct, or enhance images automatically or manually.

 

 Brightness
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Advanced Guide Troubleshooting

Contents > Printing from Your Computer  > Printing Documents (Windows)

Printing Documents (Windows) 
This section describes the procedure to print a document of A4 size on plain paper.

For details, refer to the on-screen manual: Advanced Guide.

 Note

 Operations may vary depending on your software application. For details on the operation, refer to

the instruction manual of your application.

 The screens used in this section are for printing with Windows Vista operating system Ultimate

Edition (hereafter referred to as "Windows Vista").

1. Make sure that the machine is turned on.

See Operation Panel .

2. Load paper.

See Loading Paper .

Here we make sure that A4 plain paper is loaded in the Cassette.

 Note

 Load A4, B5, A5, or Letter-sized plain paper in the Cassette and other sizes or types of paper

such as photo paper in the Rear Tray.

3. Open the Paper Output Tray gently, and open the Output Tray Extension.

4. Create (or open) a document to print using an appropriate software application.

5. Open the printer driver setup window.

(1) Select Print on the File menu or the command bar in your software application.
The Print dialog box will appear.

(2) Make sure that your machine's name is selected.

 Note

 If another printer's name is selected, click and select your machine's name.

(3) Click Preferences (or Properties).
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6. Specify the required print settings.

(1) Select Business Document in Commonly Used Settings.

 Note

 When the print object such as Business Document or Photo Printing is selected in

Commonly Used Settings, the items in Additional Features will be selected automatically.

The settings suitable for the print object such as media type or print quality will also

appear.

 When you specify two or more copies in Copies, the Collate check box will be selected.

(2) Make sure of the displayed settings.
Here we make sure that Plain Paper in Media Type, Standard in Print Quality, A4 in Printer Paper Size, and

Automatically Select in Paper Source are selected.

 Note

 The settings can be changed.

However, after changing Printer Paper Size, confirm that the setting for Page Size on the

Page Setup sheet matches the setting set in the software application.

For details, refer to the on-screen manual: Advanced Guide .

 If you select A4, B5, A5, or Letter-sized plain paper when Automatically Select is selected

in Paper Source, the machine feeds the paper from the Cassette. If you select other sizes

or types of paper such as photo paper, the machine feeds the paper from the Rear Tray.

If you select the wrong page size or media type, the machine may feed paper from the

wrong paper source or may not print with the proper print quality.

(3) Click OK.

 Note

 For details on the printer driver functions, click Help or Instructions to view the online help or
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the on-screen manual: Advanced Guide . The Instructions button appears on the Quick Setup,

Main and Maintenance sheets if the on-screen manual is installed on your computer.

 You can name the changed settings and add to Commonly Used Settings.

For details, refer to the on-screen manual: Advanced Guide .

 If the Always Print with Current Settings check box is selected, the current settings will be

applied from the next print job onward. Some software applications may not have this

function.

 To display the preview to confirm the print result, select the Preview before printing check

box. Some software applications may not have a preview function.

 You can specify the detailed print settings on the Main sheet or Page Setup sheet.

For details, refer to the on-screen manual: Advanced Guide .

7. Start printing.

Click Print (or OK) to start printing.

 Note

 To cancel a print job in progress, press the Stop button on the machine or click Cancel Printing

on the printer status monitor. After canceling the print job, blank sheets of paper may be

ejected.

To display the printer status monitor, click Canon XXX Printer (where " XXX" is your machine's

name) on the taskbar.

 If printed ruled lines are misaligned or print results are unsatisfactory, adjust the print head

position.

See Aligning the Print Head .
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Advanced Guide Troubleshooting

Contents > Printing from Your Computer  > Printing Documents (Macintosh)

Printing Documents (Macintosh) 
This section describes the procedure to print a document of A4 size on plain paper.

For details, refer to the on-screen manual: Advanced Guide.

 Note

 Operations may vary depending on your software application. For details on the operation, refer to

the instruction manual of your application.

 For Mac OS X v.10.5.x 

1. Make sure that the machine is turned on.

See Operation Panel .

2. Load paper.

See Loading Paper .

Here we make sure that A4 plain paper is loaded in the Cassette.

 Note

 Load A4, B5, A5, or Letter-sized plain paper in the Cassette and other sizes or types of paper

such as photo paper in the Rear Tray.

3. Open the Paper Output Tray gently, and open the Output Tray Extension.

4. Create (or open) a document to print using an appropriate software application.

5. Open the Print dialog box.

Select Print on the File menu in your software application.

The Print dialog box will appear.

 Note

 If the dialog box below appears, click  (Down arrow).

6. Specify the required print settings.

(1) Make sure that your machine's name is selected in Printer.
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(2) Select the page size of the loaded paper in Paper Size.
Here we select A4.

(3) Select Quality & Media in the pop-up menu.

(4) Select the media type of the loaded paper to print in Media Type.
Here we select Plain Paper.

 Note

 If you select A4, B5, A5, or Letter-sized plain paper when Automatically Select is selected

in Paper Source, the machine feeds the paper from the Cassette. If you select other sizes

or types of paper such as photo paper, the machine feeds the paper from the Rear Tray.

If you select the wrong page size or media type, the machine may feed paper from the

wrong paper source or may not print with the proper print quality. 

(5) Make sure that Automatically Select is selected in Paper Source.

 Note

 For details on other settings for Paper Source, refer to the on-screen manual: Advanced
Guide.

(6) Select the print quality in Print Quality.
Here we select Standard.

 Note

 For details on the print quality, refer to the on-screen manual: Advanced Guide .

 Note

 For details on the printer driver functions, click  (Question) on the Quality & Media, Color

Options, Borderless Printing, or Duplex Printing & Margin screen.

 The preview appears on the left of the dialog box to confirm the print result. Some software

applications may not have a preview function.
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7. Start printing.

Click Print to start printing.

 Note

 Click the printer icon in the Dock to display the list of print jobs in progress.

 To cancel a print job in progress, select the desired job in the Name list and click Delete. To

temporarily stop a job in progress, click Hold. To temporarily stop all the jobs in the list, click

Pause Printer. After canceling the print job, blank sheets of paper may be ejected.

 If printed ruled lines are misaligned or print results are unsatisfactory, adjust the print head

position.

See Aligning the Print Head .

 For Mac OS X v.10.4.x or Mac OS X v.10.3.9 

 Note

 The screens used in this section are for printing with Mac OS X v.10.4.x.

1. Make sure that the machine is turned on.

See Operation Panel .

2. Load paper.

See Loading Paper .

Here we make sure that A4 plain paper is loaded in the Cassette.

 Note

 Load A4, B5, A5, or Letter-sized plain paper in the Cassette and other sizes or types of paper

such as photo paper in the Rear Tray.

3. Open the Paper Output Tray gently, and open the Output Tray Extension.

4. Create (or open) a document to print using an appropriate software application.

5. Specify the page size.

(1) Select Page Setup on the File menu in your software application.
The Page Setup dialog box will appear.

(2) Make sure that your machine's name is selected in Format for.

(3) Select the page size of the loaded paper in Paper Size.
Here we select A4.

(4) Click OK.
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6. Specify the required print settings.

(1) Select Print on the File menu in your software application.
The Print dialog box will appear.

(2) Make sure that your machine's name is selected in Printer.

(3) Select Quality & Media in the pop-up menu.

(4) Select the media type of the loaded paper in Media Type.
Here we select Plain Paper.

 Note

 If you select A4, B5, A5, or Letter-sized plain paper when Automatically Select is selected

in Paper Source, the machine feeds the paper from the Cassette. If you select other sizes

or types of paper such as photo paper, the machine feeds the paper from the Rear Tray.

If you select the wrong page size or media type, the machine may feed paper from the

wrong paper source or may not print with the proper print quality.

(5) Make sure that Automatically Select is selected in Paper Source.

 Note

 For details on other settings for Paper Source, refer to the on-screen manual: Advanced
Guide.

(6) Select the print quality in Print Quality.
Here we select Standard.

 Note

 For details on the print quality, refer to the on-screen manual: Advanced Guide .

 Note

 For details on the printer driver functions, click  (Question) on the Quality & Media, Color

Options, Special Effects, Borderless Printing, or Duplex Printing & Margin screen.

 To display the preview to confirm the print result, click Preview. Some software applications

may not have a preview function.
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7. Start printing.

Click Print to start printing.

 Note

 Click the printer icon in the Dock to display the list of print jobs in progress.

 To cancel a print job in progress, select the desired job in the Name list and click Delete. To

temporarily stop a job in progress, click Hold. To temporarily stop all the jobs in the list, click

Stop Jobs. After canceling the print job, blank sheets of paper may be ejected.

 If printed ruled lines are misaligned or print results are unsatisfactory, adjust the print head

position.

See Aligning the Print Head .
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Contents > Other Usages

Other Usages 
This section introduces the procedure to print the template forms such as the notebook, etc., the setting

items of the machine, and the function to print directly from a digital camera or mobile phone.

This section also introduces useful software applications you can use with the machine.

Printing the Template Forms such as Notebook Paper

Printing the Various Template Forms

Printing Photos Directly from Your Digital Camera or Mobile Phone

Printing Photos from a PictBridge Compliant Device

Printing Photos from a Wireless Communication Device

Machine Settings

Useful Software Applications

Solution Menu

My Printer

Easy-WebPrint EX
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Printing the Template Forms such as Notebook Paper 
This section describes the procedure to select and print the template forms.

You need to prepare:

A4, B5, or Letter-sized plain paper. See Media Types You Can Use .

1. Prepare for printing.

(1) Turn on the power.
See Operation Panel .

(2) Make sure that A4, B5, or Letter-sized plain paper is loaded in the Cassette.
See Loading Paper in the Cassette .

(3) Open the Paper Output Tray gently, and open the Output Tray Extension.

2. Select a template form.

(1) Select Settings  on the HOME screen, and press the OK button.

(2) Select Template print , and press the OK button.

(3) Use the Easy-Scroll Wheel (the  or  button) to select a template form to

print, and press the OK button.
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 Note

 For details on the available template forms, see Printing the Various Template Forms.

3. Start printing.

(1) Confirm the page size and two-sided copy settings.
To change the setting, use the Easy-Scroll Wheel  (the  or  button) to select the item to change, and

press the OK button.

 Note

 You can only select A4, B5, or 8.5"x11" (LTR) for Page size. B5 may not be available

depending on the selected template. The media type is limited to Plain paper and cannot be

changed.

(2) Press the [+] or [-] button to specify the number of copies.

(3) Press the Color or Black button.
The machine starts printing.

 Printing the Various Template Forms 
You can print the following templates with Template print.

 Notebook paper 1 

8 mm spacing 

 Notebook paper 2 

7 mm spacing 

 Notebook paper 3 

6 mm spacing 

 Graph paper 1 

Graph 5 mm 

 Graph paper 2 

Graph 3 mm 

 Checklist 

List with checkboxes 
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 Staff paper 1 

Staff paper 10 staves 

 Staff paper 2 

Staff paper 12 staves 

 Handwriting paper 

Rows of three lines 

 Weekly schedule 

Vertical type 

  

 Monthly schedule 

Calendar type 
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Printing Photos Directly from Your Digital Camera or Mobile
Phone 

 Printing Photos from a PictBridge Compliant Device 
You can connect the PictBridge compliant device to this machine with a USB cable that is recommended

by the device's manufacturer, and print saved images directly.

For details on how to print saved images connecting the PictBridge compliant device, refer to the on-

screen manual: Advanced Guide .

For details on the print settings on the PictBridge compliant device, refer to the instruction manual

supplied with the device.

Connectable devices:

Any PictBridge compliant device can be connected to this machine regardless of the manufacturer or

model as long as it is compliant with the PictBridge Standard.

 Important

 Do not use the USB cable longer than around 10 feet / 3 meters to connect any PictBridge compliant

device to the machine since it may affect the operation of other peripheral devices.

 Note

 PictBridge is the Standard to print your photos directly without using a computer, connecting a

device such as a digital still camera, digital camcorder, or camera-equipped mobile phone.

 (PictBridge) A device with this mark is PictBridge compliant.

Printable image data format:

This machine accepts images* taken with a camera compliant with the Design rule for Camera File

system and PNG files.
* Exif 2.2/2.21 compliant

 Note

 When printing from the PictBridge compliant device, set the print quality with the Operation Panel on

the machine. You cannot set the print quality on the PictBridge compliant device.

 Printing Photos from a Wireless Communication Device 
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If the optional Bluetooth Unit BU-30 is connected to the machine, you can print image data with wireless

communication from Bluetooth compatible mobile phones or computers.
For details on the operation, refer to the on-screen manual: Advanced Guide.
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Machine Settings 
This section describes the items you can set or change in Device settings of the Settings menu. For

details on setting or changing, refer to the on-screen manual: Advanced Guide.

 Plain paper feed settings 
Selects the paper source (Rear Tray or Cassette) in which you load plain paper. The machine feeds

plain paper from the Cassette by default. Use this setting to change the paper source for plain
paper to the Rear Tray. 

 Print settings 

Prevent paper abrasion 

Use this setting only if the print surface becomes smudged.

Extended copy amount 

Selects the amount of image that extends off the paper when making borderless copies.

Auto Photo Fix setting 

Selects whether or not to prioritize printing Exif information saved on a photo when Auto photo fix ON

is selected.

 LAN settings

WLAN active/inactive

Selects whether to activate or inactivate the wireless LAN.

Wireless LAN setup

Configures the wireless LAN connection according to an access point or connection environment. If

the access point supports the WPS (Wi-Fi Protected Setup), you can configure a wireless LAN

easily. The access point settings can also be configured manually.

For details, refer to the printed manual: Getting Started .

Confirm LAN settings

Displays the wireless LAN configurations of the machine on the LCD, or prints this information from

the machine.

Other settings

Configures other network settings including the printer's network name, IPv4/IPv6 settings, memory

card sharing, WSD (Web Services on Devices) setting, etc.

Reset LAN settings

Sets the machine network settings back to the default.

 Advanced settings 
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Date display 

Selects the format of date that is printed or displayed on the screen.

Read/write attribute 

Selects whether to use the Card Slot of the machine as the memory card drive of a computer.

Quiet mode 

Enables this function if you want to reduce the operating noise of the machine, such as when using

the machine at night (when copying, printing from the memory card, printing from the PictBridge

compliant device, printing with wireless communication, etc.).

Guide display settings 

Changes the time interval before the guide display, such as Change set. and Copy, appears at the

top of the LCD, or hides the guide display.

Key repeat 

Enables to increase or decrease numbers rapidly by pressing and holding down the button when

inputting numbers. When this setting is disabled, holding down the button is the same as pressing
it once.

 Mobile phone print setting 
Specifies paper or image correction when you print from the wireless communication device. This

setting appears only when the optional Bluetooth Unit is connected to the machine.

 Bluetooth settings 
Changes the Bluetooth settings, such as the device name or passkey. This setting appears only

when the optional Bluetooth Unit is connected to the machine.

 PictBridge print settings 
Specifies paper, print quality, etc. when you print from the PictBridge compliant device.

 Language selection 
Changes the language for LCD messages and menus.

 Reset setting 
Sets the machine settings back to the default. (However, the settings configured in the LAN settings,

the values set for the print head alignment, the settings for Read/write attribute, and the language

set in the Language selection will not be reset).
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Useful Software Applications 
The machine can be used with useful software applications such as Solution Menu, My Printer, and Easy
-WebPrint EX.

 Solution Menu 
With Solution Menu, you can start the software applications supplied with the machine or display the

operating instructions.

Double-click  (Solution Menu) on the desktop.

 Click Here: Solution Menu

Click  (Solution Menu) in the Dock.

* The screens below are for Windows Vista.

Click the button of a function to use.

After starting Solution Menu, click the button on the title bar to reduce the window size.

 Note

 Install Solution Menu from the Setup CD-ROM when it has not been installed or has been

uninstalled. To install Solution Menu, select Solution Menu in Custom Install.

 The buttons displayed on the screen may vary depending on the country or region of purchase.

   

 To start Solution Menu from the Start menu, select All Programs (or Programs), Canon Utilities,

Solution Menu, then Solution Menu.

   

 To start Solution Menu from the menu bar, select the Go menu, Applications, Canon Utilities, Solution

Menu, then double-click Solution Menu.

 My Printer 
With My Printer, you can display the printer driver setup window. It also provides you with the information

on how to take an action when you have trouble with the operation.

My Printer is not available in Macintosh.
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Double-click  (My Printer) on the desktop.

 Note

 You can also start My Printer from Solution Menu or the taskbar.

 Install My Printer from the Setup CD-ROM  when it has not been installed or has been uninstalled. To

install My Printer, select My Printer in Custom Install.

 To start My Printer from the Start menu, select All Programs (or Programs), Canon Utilities, My

Printer, then My Printer.

 Easy-WebPrint EX 
Easy-WebPrint EX provides quick and easy printing of web pages for Internet Explorer. You can print web

pages automatically resized to fit the paper width without cutting off the sides of pages, or preview and

select the desired web pages to print.

Easy-WebPrint EX is not available in Windows 2000 and Macintosh.

 Important

 It is unlawful to reproduce or edit the copyrighted work of another person without permission from

the copyright holder, except for personal use, use within the home, or other use within the limited

scope as defined by the copyright. Additionally, reproducing or editing photographs of people may

infringe on portrait rights.

When Easy-WebPrint EX is installed, it adds a toolbar to your Internet Explorer screen. The toolbar is

available whenever Internet Explorer is running.

The clip function, for example, allows you to clip desired parts of web pages and edit them to print.
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For details on printing web pages, click  (Help) to view the online help.

 Note

Installing Easy-Web Print EX

 If Easy-Web Print EX is not installed, the guidance for installation of Easy-Web Print EX may appear

from the taskbar on the desktop. 

To install Easy-Web Print EX, click the displayed guidance and follow the instructions on the screen.

 You can also install Easy-Web Print EX from the Setup CD-ROM . 

To install Easy-Web Print EX, select Easy-Web Print EX in Custom Install.

 To install Easy-Web Print EX on your computer, Internet Explorer 7 or later is required and the

computer must be connected to the Internet.
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Loading Paper / Originals 
This section describes types of paper or originals you can load, how to load printing paper in the Rear
Tray or Cassette, and how to load originals to copy or scan.

Loading Paper

Paper Source to Load Paper

Loading Paper in the Cassette

Loading Paper in the Rear Tray

Media Types You Can Use

Media Types You Cannot Use

Loading Originals

Loading Originals

How to Load Originals for Each Function

Originals You Can Load
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Loading Paper 
Paper Source to Load Paper

Loading Paper in the Cassette

Loading Paper in the Rear Tray

Media Types You Can Use

Media Types You Cannot Use

 Paper Source to Load Paper 
The machine has two paper sources to feed paper; Cassette and Rear Tray.

You can load paper in either one of the paper sources, depending on the page size and media type of

paper. Paper is fed from the Cassette or Rear Tray depending on the selection of the page size or media
type.

See Media Types You Can Use .

 Note

 When printing, select the correct page size and media type. If you select the wrong page size or

media type, the machine may feed paper from the wrong paper source or may not print with the

proper print quality. 

For details on how to load paper in each paper source, see Loading Paper in the Cassette  or 
Loading Paper in the Rear Tray .

 Loading Plain Paper in the Cassette
When you use A4, B5, A5, or Letter-sized plain paper, load it in the Cassette.

The machine feeds paper from the Cassette automatically by selecting plain paper (A4, B5, A5, or

Letter size) in the print settings with the Operation Panel or the printer driver when printing.

For details on how to change the paper source setting, refer to the on-screen manual: Advanced

Guide.

 Loading Photo Paper in the Rear Tray
When you use photo paper, load it in the Rear Tray.
The machine feeds paper from the Rear Tray automatically by selecting the media types other than

plain paper, such as photo paper, in the print settings with the Operation Panel or the printer driver

when printing.
When you use plain paper other than A4, B5, A5, or Letter size, also load it in the Rear Tray.
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 Loading Paper in the Cassette 
You can load only A4, B5, A5, or Letter-sized plain paper in the Cassette.

Load other sizes or types of paper in the Rear Tray.

See Media Types You Can Use .

 Note

 We recommend Canon genuine photo paper for printing photos.

For details on the Canon genuine paper, see Media Types You Can Use .

 You can use general copy paper.

For the page size and paper weight you can use for this machine, see Media Types You Can Use .

1. Prepare paper.

Align the edges of paper. If paper is curled, flatten it.

 Note

 Align the edges of paper neatly before loading. Loading paper without aligning the edges may

cause paper jams.

 If paper is curled, hold the curled corners and gently bend them in the opposite direction until

the paper becomes completely flat.

For details on how to flatten curled paper, refer to " Troubleshooting" in the on-screen manual: 

Advanced Guide .

2. Load paper.

(1) Pull out the Cassette from the machine.

(2) Load the paper stack WITH THE PRINT SIDE FACING DOWN and THE

LEADING EDGE TO THE FAR SIDE, and align it against the right side of the

Cassette.

(3) Slide the Paper Guide (A) to align with the mark of page size.
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The Paper Guide (A) will stop when it aligns with the corresponding mark of page size.

 Note

 There may be a little space between the Paper Guide (A) and the paper stack.

(4) Slide the Paper Guide (B) on the left to align completely with the side of the

paper stack.

 Note

 Do not load sheets of paper higher than the Load Limit Mark (C).

(5) Insert the Cassette into the machine.
Push the Cassette all the way into the machine.

3. Open the Paper Output Tray gently, and open the Output Tray Extension.

 Note

After loading paper

 When using the machine to copy or print without a computer, select the size and type of the

loaded paper for Page size and Media type of the print settings in each menu of the HOME

screen.
See Changing the Settings in "Printing Photos Saved on the Memory Card / USB Flash Drive" or

Changing the Settings in "Making Copies".

 When printing with a computer, select the size and type of the loaded paper in Printer Paper

Size (or Paper Size) and Media Type in the printer driver.
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See Printing Documents (Windows)  or Printing Documents (Macintosh) .
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 Loading Paper in the Rear Tray 
You can load photo paper or envelope in the Rear Tray.

 Loading Photo Paper

 Important

 If you cut plain paper into small size such as 4" x 6" / 10 x 15 cm, 4" x 8" / 101.6 x 203.2 mm, 5" x 7"

/ 13 x 18 cm, or 2.16" x 3.58" / 55.0 x 91.0 mm (Card size) to perform trial print, it can cause paper
jams.

1. Prepare paper.

See Prepare paper.  in "Loading Paper in the Cassette".

Align the edges of paper. If paper is curled, flatten it.

2. Load paper.

(1) Open the Paper Support, raise it, then tip it back.

(2) Open the Paper Output Tray gently, and open the Output Tray Extension.

(3) Slide the Paper Guides (A) to open them, and load the paper in the center of the

Rear Tray WITH THE PRINT SIDE FACING YOU.

 Important

 Always load paper in the portrait orientation (B). Loading paper in the landscape

orientation (C) can cause paper jams.

Page 77 of 949 pagesLoading Paper in the Rear Tray



(4) Slide the Paper Guides (A) to align them with both sides of the paper stack.
Do not slide the Paper Guides too hard. The paper may not be fed properly.

 Note

 Do not load sheets of paper higher than the Load Limit Mark (D).

 Note

After loading paper

 When using the machine to copy or print without a computer, select the size and type of the

loaded paper for Page size and Media type of the settings screen in each mode.

See Changing the Settings in "Printing Photos Saved on the Memory Card / USB Flash Drive" or
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Changing the Settings in "Making Copies".

 When printing with a computer, select the size and type of the loaded paper in Printer Paper

Size (or Paper Size) and Media Type in the printer driver.

See Printing Documents (Windows)  or Printing Documents (Macintosh) .

 Loading Envelopes
You can print on European DL and US Comm.Env.#10-sized envelopes.

The address is automatically rotated and printed according to the envelope's direction by specifying

with the printer driver properly.

 Important

 You can only print on envelopes with the computer.

 You cannot use the following envelopes.

- Envelopes with an embossed or treated surface

- Envelopes with a double flap (or sticker flaps)

- Envelopes whose gummed flaps are already moistened and adhesive

1. Prepare envelopes.

 Press down on all four corners and edges of the envelopes to flatten them.

 If the envelopes are curled, hold the opposite corners and gently twist them in the
opposite direction.

 If the corner of the envelope flap is folded, flatten it.

 Use a pen to press the leading edge in the inserting direction flat and sharpen the
crease.

The figures above show a side view of the leading edge of the envelope.

 Important

 The envelopes may jam in the machine if they are not flat or the edges are not aligned. Make

sure that no curl or puff exceeds 0.1 inches / 3 mm.

2. Load envelopes.

(1) Open the Paper Support, raise it, then tip it back.
See Load paper.  in "Loading Photo Paper" of "Loading Paper in the Rear Tray".

(2) Open the Paper Output Tray gently, and open the Output Tray Extension.
See Load paper.  in "Loading Photo Paper" of "Loading Paper in the Rear Tray".
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(3) Slide the Paper Guides (A) to open them, and load the envelopes in the center of

the Rear Tray WITH THE ADDRESS SIDE FACING YOU.
The folded flap of the envelope will be faced down on the left side.

Up to 10 envelopes can be loaded at once.

(4) Slide the Paper Guides (A) to align them with both sides of the envelopes.
Do not slide the Paper Guides too hard. The envelopes may not be fed properly.

(B) Rear side

(C) Address side

3. Specify the settings with the printer driver.

   

(1) Select Envelope in Commonly Used Settings on the Quick Setup sheet.

(2) Select DL Env. or Comm.Env.#10 in the Envelope Size Setting window.

(3) Select Landscape in Orientation.

   

(1) Select Envelope in Media Type.

(2) Select DL Envelope or #10 Envelope in Paper Size.

(3) Select the landscape orientation in Orientation.

 Important

 If you do not specify the envelope size or orientation properly, the address will be printed

upside down or will be turned to 90 degrees.

 Note

 In Windows, if the print result is upside down, open the printer driver setup window, select

Envelope in Commonly Used Settings, then select the Rotate 180 degrees check box in

Additional Features.

 For details on the printer driver settings, see Printing Documents (Windows)  or Printing

Documents (Macintosh) .
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 Media Types You Can Use 
Choose paper suitable for printing, for the best print results. Canon provides you various types of paper

to enhance the fun of printing, such as stickers as well as papers for photo or document. We

recommend the use of Canon genuine paper for printing your important photos.

 Media Types

Commercially available papers

Name of

Paper
<Model

No.>*1

Paper Load Limit
Paper Output

Tray Load

Limit

Settings in Media Type

Rear Tray Cassette
Operation

Panel

Printer

Driver

Plain Paper

(Recycled

paper)*2

Approx. 150

sheets*3

A4, B5, A5, and Letter /

8.5" x 11": Approx. 150

sheets

Approx. 50

sheets

Plain paper Plain Paper

Envelopes*4 10 envelopes Not loadable*5 *6 - Envelope

Canon genuine papers

Name of Paper

<Model No.>*1

Paper Load Limit Paper
Output Tray

Load Limit

Settings in Media Type

Rear Tray Cassette
Operation

Panel

Printer

Driver

For printing photos:

Photo Paper Pro

Platinum

<PT-101>*7

A4, Letter / 8.5" x 11", 5"

x 7" / 13 x 18 cm, and 8"

x 10" / 20 x 25 cm: 10

sheets

4" x 6" / 10 x 15 cm: 20

sheets

Not

loadable*5

*6 Pro Platinum Photo Paper

Pro Platinum

Photo Paper Pro
II

<PR-201>*7

Pro II Photo Paper

Pro II

Glossy Photo

Paper "Everyday

Use" 

<GP-501>*7

Glossy Photo

Paper

Glossy Photo

Paper

Photo Paper

Glossy

<GP-502>*7

Glossy Photo

Paper

Glossy Photo

Paper

Photo Paper Plus

Glossy II

<PP- 201>*7

Plus Glossy II Photo Paper

Plus Glossy II

Photo Paper Plus

Semi-gloss

<SG-201>*7

Plus Semi-

gloss

Photo Paper

Plus Semi-

gloss

Matte Photo

Paper

Matte Photo

Paper

Matte Photo

Paper
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<MP-101>

For printing business documents:

High Resolution

Paper

<HR-101N>*4

80 sheets Not

loadable*5

50 sheets - High

Resolution

Paper

For creating your own prints:

T-Shirt

Transfers

<TR-301>*4

1 sheet Not

loadable*5

*6 - T-Shirt

Transfers

Photo Stickers

<PS-101>*8, *9

1 sheet Glossy Photo

Paper

Glossy Photo

Paper

*1 Paper with a Model Number is Canon genuine paper. Refer to the instruction manual supplied with

the paper for detailed information on the printable side and notes on handling paper. For information on

the page sizes available for each Canon genuine paper, visit our website. You may not be able to

purchase some Canon genuine papers depending on the country or region of purchase. Paper is not

sold in the US by Model Number. Purchase paper by name.

*2 Proper feeding of paper may not be possible at the maximum capacity depending on the type of paper

or environmental conditions (either very high or low temperature or humidity). In such cases, reduce the

number of paper you load at a time to less than half (100% recycled paper can be used).

*3 A4, B5, A5, or Letter-sized plain paper can be loaded only when Rear tray is selected for Plain paper

feed settings in Device settings of the Settings menu.
For details on the settings, refer to the on-screen manual: Advanced Guide.

*4 Available only when printing from your computer.

*5 Feeding this paper from the Cassette can damage the machine. Always load in the Rear Tray.

*6 We recommend that you remove the previously printed sheet from the Paper Output Tray before

continuously printing to avoid blurs and discoloration.

*7 When loading paper in stacks, the print side may become marked as it is fed or paper may not feed

properly. In this case, load one sheet at a time.

*8 When scanning printed photos to print onto sticker paper, be sure to select Sticker print in Easy photo

reprint. If Sticker print is selected, the type of paper cannot be selected.

See Printing Photos in Various Layouts .

When printing photos saved on a memory card or USB flash drive onto sticker paper, be sure to select

Sticker print in Memory card. If Sticker print is selected, the type of paper cannot be selected.

See Printing Photos in Various Layouts .

When printing photos saved on your mobile phone onto sticker paper, select Stickers for the page size in

Mobile phone print setting. Refer to the on-screen manual: Advanced Guide.

*9 You can easily specify print settings for sticker paper with Easy-PhotoPrint EX provided on the Setup

CD-ROM. Install it on your computer.

 Note

 To specify the page size and media type when printing photos saved on a PictBridge compliant

device or mobile phone, refer to the on-screen manual: Advanced Guide .

 Page Sizes
You can use the following page sizes.

 Note
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 You can load plain paper of the following page sizes in the Cassette:

A4, B5, A5, and Letter sizes

Plain paper of other sizes cannot be loaded in the Cassette. Load them in the Rear Tray.

 In Macintosh, Choukei 3 and Choukei 4 are not available.

Standard sizes:

 Letter (8.50 x 11.00 inches / 215.9 x 279.4 mm)

 Legal (8.50 x 14.00 inches / 215.9 x 355.6 mm)

 A5 (5.83 x 8.27 inches / 148.0 x 210.0 mm)

 A4 (8.27 x 11.69 inches / 210.0 x 297.0 mm)

 B5 (7.17 x 10.12 inches / 182.0 x 257.0 mm)
 4" x 6" (4.00 x 6.00 inches / 10 x 15 cm)

 4" x 8" (4.00 x 8.00 inches / 101.6 x 203.2 mm)

 5" x 7" (5.00 x 7.00 inches / 13 x 18 cm)

 8" x 10" (8.00 x 10.00 inches / 20 x 25 cm)

 L (3.50 x 5.00 inches / 89.0 x 127.0 mm)

 2L (5.00 x 7.01 inches / 127.0 x 178.0 mm)

 Hagaki (3.94 x 5.83 inches / 100.0 x 148.0 mm)

 Hagaki 2 (7.87 x 5.83 inches / 200.0 x 148.0 mm)

 Comm.Env.#10 (4.12 x 9.50 inches / 104.6 x 241.3 mm)

 DL Env.(4.33 x 8.66 inches / 110.0 x 220.0 mm)

 Choukei 3 (4.72 x 9.25 inches / 120.0 x 235.0 mm)

 Choukei 4 (3.54 x 8.07 inches / 90.0 x 205.0 mm)

 Youkei 4 (4.13 x 9.25 inches / 105.0 x 235.0 mm)

 Youkei 6 (3.86 x 7.48 inches / 98.0 x 190.0 mm)

 Card (2.16 x 3.58 inches / 55.0 x 91.0 mm)

 Wide (4.00 x 7.10 inches / 101.6 x 180.6 mm)

Non-standard sizes:

You can also specify a custom size within the following range.

 Minimum size: 2.17 x 3.58 inches / 55.0 x 91.0 mm (Rear Tray)

5.83 x 8.27 inches / 148.0 x 210.0 mm (Cassette)

 Maximum size: 8.50 x 26.61 inches / 215.9 x 676.0 mm (Rear Tray)

8.50 x 11.69 inches / 215.9 x 297.0 mm (Cassette)

 Paper Weight

17 to 28 lb / 64 to 105 g/m2 (except for Canon genuine paper)

Do not use heavier or lighter paper (except for Canon genuine paper), as it could jam in the machine.

 Notes on Storing Paper
 Take out only the necessary number of paper from the package, just before printing.

 To avoid curling, when you do not print, put unused paper back into the package and keep it on a

level surface. And also, store it avoiding heat, humidity, and direct sunlight.

 Notes on Paper for Full-page Borderless Printing
 You cannot use A5, B5, and Legal-sized paper, and envelopes for full-page borderless printing.

 You can use plain paper for full-page borderless printing only when printing from a computer.

However, this may result in lower print quality. We recommend using plain paper for a trial print.
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 Media Types You Cannot Use 
Do not use the following types of paper. Using such paper will cause not only unsatisfactory results, but

also the machine to jam or malfunction.
 Folded, curled, or wrinkled paper

 Damp paper

 Paper that is too thin (weighing less than 17 lb / 64 g/m 2)

 Paper that is too thick (weighing more than 28 lb / 105 g/m 2, except for Canon genuine paper)

 Paper thinner than a postcard, including plain paper or notepad paper cut to a small size (when

printing on paper smaller than A5)
 Picture postcards
 Postcards affixed with photos or stickers

 Envelopes with a double flap (or sticker flaps)

 Envelopes with an embossed or treated surface

 Envelopes whose gummed flaps are already moistened and adhesive
 Any type of paper with holes

 Paper that is not rectangular

 Paper bound with staples or glue

 Paper with adhesives

 Paper decorated with glitter, etc.
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Loading Originals 
Loading Originals
How to Load Originals for Each Function

Originals You Can Load

This section describes the procedure to load originals on the Platen Glass.
You may have to load the original in a different position depending on the function you selected in Copy,

Easy photo reprint, or Scan. Load the original in the correct position according to the selected function. If

you do not load the original correctly, it may not be scanned properly.

 Important

 After loading the original on the Platen Glass, be sure to close the Document Cover before starting

to copy or scan.

 Loading Originals 
You can load originals to copy or scan on the Platen Glass.

1. Load an original on the Platen Glass.

(1) Open the Document Cover.

 Important

 Do not place any object on the Document Cover. It will fall into the Rear Tray when the

Document Cover is opened and cause the machine to malfunction.

(2) Load the original WITH THE SIDE TO COPY OR SCAN FACING DOWN on the

Platen Glass.
Make sure the proper position to load the original for each function.

See How to Load Originals for Each Function .

 Important

 Do not place any objects weighing more than 4.4 lb / 2.0 kg on the Platen Glass.

 Do not press or put weight on the original with pressure exceeding 4.4 lb / 2.0 kg. Doing so

may cause the scanner to malfunction or the Platen Glass to break.
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2. Close the Document Cover gently.
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 How to Load Originals for Each Function 

 Load originals to make copy

 Select in the Scan menu
- USB flash drive or Memory card to scan originals

- PC to scan magazine, newspaper, or text document

 Scan magazine, newspaper, or text document with a software
application on a computer
Load the original WITH THE SIDE TO READ FACING DOWN to be aligned with the alignment mark 

.

 Important

 The machine cannot scan the shaded area (A) (0.04 inches / 1 mm from the edges of the

Platen Glass).

 Load printed photos in Easy photo reprint 

 Select PC in the Scan menu and scan printed photo, postcard,
business card, or DVD/CD

 Scan printed photo, postcard, business card, or DVD/CD with a
software application on a computer
Load the original WITH THE SIDE TO SCAN FACING DOWN in an appropriate way according to the

number of originals.
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Load only one original

Load the original at least 0.4 inches / 10 mm away from the edges of the Platen Glass.

Load two or more originals

Place two or more originals at least 0.4 inches / 10 mm away from the edges of the Platen Glass

and at least 0.4 inches / 10 mm apart from each other.

(A) 0.4 inches / 10 mm

 Note

 The Skew Correction function automatically compensates for the originals placed at an angle

of up to approximately 10 degrees.

 Slanted photos with a long edge of 7.1 inches / 180 mm or more cannot be corrected.
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 Originals You Can Load 
You can copy or scan the following originals.

Types of originals: Text document, magazine, or newspaper

Printed photo, postcard, business card, or DVD/CD

Size (W x L): Max. 8.5 x 11.7 inches / 216 x 297 mm

 Note

 When loading a thick original such as a book on the Platen Glass, you can load it by removing the

Document Cover from the machine. 

For details on how to remove or attach the Document Cover, refer to the on-screen manual: 

Advanced Guide .
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Routine Maintenance 
This section describes the procedure to replace ink tanks when they run out of ink, to clean the machine

when the print result is faint, or to take an action when paper does not feed properly.

Replacing an Ink Tank

Replacing Procedure

Checking the Ink Status

When Printing Becomes Faint or Colors Are Incorrect

Printing the Nozzle Check Pattern

Examining the Nozzle Check Pattern

Cleaning the Print Head

Cleaning the Print Head Deeply

Aligning the Print Head

Cleaning the Paper Feed Roller

Cleaning the Pad in the Cassette
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Replacing an Ink Tank 
When ink runs out while printing is in progress, an error message will appear on the LCD or your
computer screen. Make sure which ink tank has run out of ink and replace it with a new one.

 Note

 If the error message appears, confirm the displayed message and take an appropriate action.

For details, refer to "An Error Message Is Displayed on the LCD" in " Troubleshooting" of the on-

screen manual: Advanced Guide .

 For information on the compatible ink tanks, refer to the printed manual: Getting Started.

 If print results become faint or white streaks appear despite sufficient ink levels, see When Printing

Becomes Faint or Colors Are Incorrect .

 Replacing Procedure 
When the ink tanks run out of ink, follow the procedure below to replace them.

 Important

Handling ink

 To maintain optimal print quality, we recommend the use of specified Canon brand ink tanks. Refilling

the ink is not recommended. 

 If you remove an ink tank, replace it immediately. Do not leave the machine with ink tanks removed.

 Use new ink tanks for replacement. Installing used ink tanks may cause the nozzles to clog.

Furthermore, with such ink tanks, the machine will not be able to inform you when to replace the ink

tanks properly.

 Once an ink tank has been installed, do not remove it from the machine and leave it out in the open.

This will cause the ink tank to dry out, and the machine may not operate properly when it is

reinstalled. To maintain optimal printing quality, use an ink tank within six months of first use.

 Note

 Color ink may be consumed even when printing a black-and-white document or when black-and-

white printing is specified.

Every ink is also consumed in the standard cleaning and deep cleaning of the Print Head, which

may be necessary to maintain the machine's performance. When an ink tank is out of ink, replace it

immediately with a new one.

1. Make sure that the power is turned on, and open the Paper Output Tray gently.

2. Lift the Scanning Unit (Cover) until it stops.

The Print Head Holder moves to the replacement position.
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 Caution

 Do not hold the Print Head Holder to stop or move it forcibly. Do not touch the Print Head Holder

until it stops completely.

 Important

 Do not place any object on the Document Cover. It will fall into the Rear Tray when the

Document Cover is opened and cause the machine to malfunction.

 Be sure to lift the Scanning Unit (Cover) with the Document Cover closed.

 Do not touch the metallic parts or other parts inside the machine.

 If the Scanning Unit (Cover) is left open, the Print Head Holder moves to the right. In this case,

close and reopen the Scanning Unit (Cover).

 Note

 The machine may make operating noise when the Print Head Holder moves to the replacement

position.

3. Remove the ink tank with the lamp flashing fast.

Push the tab (A) and lift the ink tank to remove.

Do not touch the Print Head Lock Lever (B).

 Important

 Handle the ink tank carefully to avoid staining of clothing or the surrounding area.

 Discard the empty ink tank according to the local laws and regulations regarding disposal of

consumables.

 Note

 Do not remove two or more ink tanks at the same time. Be sure to replace ink tanks one by one

when replacing two or more ink tanks.

 For details on ink lamp flashing speed, see Checking the Ink Status.
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4. Prepare the new ink tank.

(1) Take a new ink tank out of its package, pull the orange tape ( ) in the direction

of the arrow to peel it off, then remove the film ( ).

 Important

 Make sure that the film is completely removed from the air hole (C).

If the air hole is blocked with the remaining film, ink may leak out or may not eject properly.

(2) Hold the orange protective cap (D) as indicated in the figure below, then twist

and remove it from the bottom of the ink tank.
Remove the protective cap while holding it to prevent the ink from staining your fingers.

Discard the protective cap once it is removed.

 Important

 Do not touch the electrical contacts (E) on the ink tank. It can cause the machine to

malfunction or become unable to print.

 Important

 If you shake the ink tank, the ink may spill out and stain your hands and the surrounding area.

Be careful to handle the ink tank.

 Do not squeeze the side of ink tanks as this may cause the ink to leak out.

 Be careful not to stain your hands and the surrounding area with ink on the removed

protective cap.

 Do not reattach the protective cap once you have removed it. Discard it according to the local

laws and regulations regarding disposal of consumables.

 Do not touch the open ink port once the protective cap is removed, as this may prevent the ink

from being ejected properly.
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5. Install the new ink tank.

(1) Insert the front end of ink tank into the Print Head at a slant.
Make sure that the position of the ink tank matches the label.

(2) Press the mark  (Push) on the ink tank until the ink tank snaps firmly into

place.
Make sure that the ink lamp lights up red.

 Important

 You cannot print if the ink tank is installed in the wrong position. Be sure to install the ink tank in

the correct position according to the label on the Print Head Holder.

 You cannot print unless all the ink tanks are installed. Be sure to install all the ink tanks.

6. Lift the Scanning Unit (Cover) slightly, and then close it gently.

 Note

 If the error message appears after the Scanning Unit (Cover) is closed, refer to "

Troubleshooting" in the on-screen manual: Advanced Guide .

 When you start printing after replacing the ink tank, the machine starts cleaning the Print Head

automatically. Do not perform any other operations until the machine completes the cleaning of

the Print Head.

 If printed ruled lines are misaligned or the print head position is misaligned, adjust the print head

position.

See Aligning the Print Head .

 The machine may make noise during operation.
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 Checking the Ink Status 
You can check the ink status on the LCD or with ink lamps.

 With the LCD on the Machine

(1) Make sure that the power is turned on, and press the HOME button.

(2) Press the left Function button.
Check if any symbol (A) appears on the remaining ink volume screen.

Sufficient ink is left for printing if no symbol appears.

The ink with  (Ink low) is running low. You can continue printing for a while, but we recommend you to

have a new ink tank available.

 Note

 You can also check the ink status on a screen of the LCD displayed while printing.

 With Ink Lamps

(1) Make sure that the power is turned on, and open the Paper Output Tray gently.

(2) Lift the Scanning Unit (Cover) until it stops.
See Lift the Scanning Unit (Cover) until it stops. in "Replacing Procedure".

(3) Check the ink lamps.
Close the Scanning Unit (Cover) after confirming the ink lamp status.

 Ink lamp is on
The ink tank is correctly installed and there is sufficient ink left for printing.

 Ink lamp is flashing
Flashing slowly (at around 3-second intervals)

 ...... Repeats

Ink is low. You can continue printing for a while, but we recommend you to have a new ink tank available.

Flashing fast (at around 1-second intervals)

 ...... Repeats

The ink tank is installed in the wrong position or it is empty. Make sure that the ink tank is installed in the
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correct position as indicated by the label on the Print Head Holder. If the position is correct but the lamp

flashes, the ink tank is empty. Replace it with a new one.

 Ink lamp is off
The ink tank is not installed properly or the function for detecting the remaining ink level is disabled. If the ink

tank is not installed properly, press the mark  (Push) on the ink tank until the ink tank clicks into place. If it

does not click into place, make sure that the orange protective cap has been removed from the bottom of

the ink tank. If the function for detecting the remaining ink level is disabled, replace the ink tank with a new

one.
See Replacing Procedure.

If the ink lamp is still off after reinstalling the ink tank, there has been an error and the machine cannot print.

Check the error message displayed on the LCD.

Refer to "Troubleshooting" in the on-screen manual: Advanced Guide .
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When Printing Becomes Faint or Colors Are Incorrect 
If print results are blurred or colors are not printed correctly, the pint head nozzles are probably clogged.

Follow the procedure below to print the nozzle check pattern, check the print head nozzle condition, then

clean the Print Head.

If printed ruled lines are misaligned or print results are otherwise unsatisfactory, aligning the Print Head

may improve print quality.

 Important

 Do not rinse or wipe the Print Head and ink tanks. This can cause trouble with the Print Head and ink

tanks.

 Note

Before performing maintenance
 Open the Scanning Unit (Cover) and make sure that all lamps on the ink tanks are lit red.

If not, see Checking the Ink Status and take an appropriate action.

 Increasing the print quality in the printer driver settings may improve the print result.

For details, refer to the on-screen manual: Advanced Guide .

 When the Print Results Are Blurred or Uneven:

Step 1 
See Printing the Nozzle Check Pattern.

See Examining the Nozzle Check Pattern.

After cleaning the Print Head, print

and examine the nozzle check

pattern.

If there are missing lines or horizontal white streaks in

the pattern:

Step 2
See Cleaning the Print Head .

If the problem is not resolved after cleaning the Print Head

twice:   

  

Step 3
See Cleaning the Print Head Deeply .

  

 Note

 When you have performed the procedure until step 3 and the problem has not been resolved, turn

off the power and clean the Print Head deeply again after 24 hours. If the problem is still not

resolved, the Print Head may be damaged. Contact the service center.

 When the Print Results Are Not Even such as the Ruled Lines
Are Misaligned:

See Aligning the Print Head .     
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 Note

 You can also perform the maintenance operations from your computer.

For details, refer to the on-screen manual: Advanced Guide .
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 Printing the Nozzle Check Pattern 
Print the nozzle check pattern to determine whether the ink ejects properly from the print head nozzles.

 Note

 If the remaining ink level is low, the nozzle check pattern will not be printed correctly. Replace the

ink tank whose ink is low.

See Replacing an Ink Tank.

You need to prepare: a sheet of A4 or Letter-sized plain paper

1. Make sure that the power is turned on.

2. Make sure that one or more sheets of A4 or Letter-sized plain paper are loaded in
the Cassette.

3. Open the Paper Output Tray gently, and open the Output Tray Extension.

4. Print the nozzle check pattern.

(1) Select Settings  on the HOME screen, and press the OK button.
The Settings screen will appear.

(2) Select Maintenance , and press the OK button.
The Maintenance screen will appear.

(3) Select Nozzle check pattern, and press the OK button.

The pattern print confirmation screen will appear.

(4) Select Yes, and press the OK button.
The nozzle check pattern will be printed and two pattern confirmation screens will appear on the LCD.

5. Examine the nozzle check pattern.

See Examining the Nozzle Check Pattern.
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Check Pattern

 Examining the Nozzle Check Pattern 
Examine the nozzle check pattern, and clean the Print Head if necessary.

1. Check if there are missing lines in the pattern (1) or horizontal white streaks in the
pattern (2).

(A) No missing lines/No horizontal white streaks

(B) Lines are missing/Horizontal white streaks are present

2. Select the pattern that is closer to the printed nozzle check pattern on the
confirmation screen.

For (A) (no missing lines or no horizontal white streaks) in both (1) and (2):

(1) Select All A and press the OK button.
The cleaning is not required. 

(2) Confirm the message and press the OK button. 
The screen will return to the Maintenance screen.

 Note

 Press the HOME button to exit the Settings menu and display the HOME screen.
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For (B) (lines are missing or horizontal white streaks are present) in (1) or (2), or in both (1) and 

(2):

(1) Select Also B and press the OK button.
Clean the Print Head. The cleaning confirmation screen will appear.

(2) Select Yes and press the OK button.
The machine starts cleaning the Print Head.

See Cleaning the Print Head .
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 Cleaning the Print Head 
Clean the Print Head if lines are missing or if horizontal white streaks are present in the printed nozzle

check pattern. Cleaning unclogs the nozzles and restores the print head condition. Cleaning the Print

Head consumes ink, so clean the Print Head only when necessary.

You need to prepare: a sheet of A4 or Letter-sized plain paper

1. Make sure that the power is turned on.

2. Make sure that one or more sheets of A4 or Letter-sized plain paper are loaded in
the Cassette.

3. Open the Paper Output Tray gently, and open the Output Tray Extension.

4. Clean the Print Head.

(1) Select Settings  on the HOME screen, and press the OK button.
The Settings screen will appear.

(2) Select Maintenance , and press the OK button.
The Maintenance screen will appear.

(3) Select Cleaning, and press the OK button.

The confirmation screen will appear.

(4) Select Yes, and press the OK button.
The machine starts cleaning the Print Head.

Do not perform any other operations until the machine completes the cleaning of the Print Head. This takes

about 1 minute 30 seconds.

The pattern print confirmation screen will appear.

(5) Select Yes, and press the OK button.
The nozzle check pattern will be printed.

5. Examine the nozzle check pattern.
See Examining the Nozzle Check Pattern.

 Note

 Press the HOME button to exit the Settings menu and display the HOME screen.

 If the problem is not resolved after cleaning the Print Head twice, clean the Print Head deeply.
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See Cleaning the Print Head Deeply .
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Deeply

 Cleaning the Print Head Deeply 
If print quality does not improve by the standard cleaning of the Print Head, clean the Print Head deeply.

Cleaning the Print Head deeply consumes more ink than the standard cleaning of the Print Head, so

clean the Print Head deeply only when necessary.

You need to prepare: a sheet of A4 or Letter-sized plain paper

1. Make sure that the power is turned on.

2. Make sure that one or more sheets of A4 or Letter-sized plain paper are loaded in

the Cassette.

3. Open the Paper Output Tray gently, and open the Output Tray Extension.

4. Clean the Print Head deeply.

(1) Select Settings  on the HOME screen, and press the OK button.
The Settings screen will appear.

(2) Select Maintenance , and press the OK button.
The Maintenance screen will appear.

(3) Select Deep cleaning, and press the OK button.

The confirmation screen will appear.

(4) Select Yes, and press the OK button.
The machine starts cleaning the Print Head deeply.

Do not perform any other operations until the machine completes the deep cleaning of the Print Head. This

takes about 2 minutes.

The pattern print confirmation screen will appear.

(5) Select Yes, and press the OK button.
The nozzle check pattern will be printed.

5. Examine the nozzle check pattern.

See step 1 in Examining the Nozzle Check Pattern.

If a particular color is not printed properly, replace the ink tank of that color.

See Replacing an Ink Tank.
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If the problem is not resolved, turn off the power and clean the Print Head deeply again after 24 hours.

If the problem is still not resolved, the Print Head may be damaged. Contact the service center.

 Note

 Press the HOME button to exit the Settings menu and display the HOME screen.
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 Aligning the Print Head 
If printed ruled lines are misaligned or print results are otherwise unsatisfactory, adjust the print head

position.

 Note

 If the remaining ink level is low, the print head alignment sheet will not be printed correctly. Replace

the ink tank whose ink is low.

See Replacing an Ink Tank.

 The print head alignment pattern is printed in black and blue. 

You need to prepare: a sheet of A4 or Letter-sized plain paper*

* Be sure to use paper that is white and clean on both sides.

1. Make sure that the power is turned on.

2. Make sure that one or more sheets of A4 or Letter-sized plain paper are loaded in
the Cassette.

3. Open the Paper Output Tray gently, and open the Output Tray Extension.

4. Print the print head alignment sheet.

(1) Select Settings  on the HOME screen, and press the OK button.
The Settings screen will appear.

(2) Select Maintenance , and press the OK button.
The Maintenance screen will appear.

(3) Select Auto head align, and press the OK button.

The confirmation screen will appear.

(4) Select Yes, and press the OK button.
The print head alignment sheet will be printed.
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 Important

 Do not touch any printed part on the print head alignment sheet.

 Be careful not to get the print head alignment sheet dirty. If the sheet is stained or

wrinkled, it may not be scanned properly.

(5) When the message "Did the patterns print correctly?" appears, confirm that the

pattern is printed correctly, select Yes, then press the OK button.

5. Scan the print head alignment sheet to adjust the print head position.

(1) Load the print head alignment sheet on the Platen Glass.
Load the print head alignment sheet WITH THE PRINTED SIDE FACING DOWN and align the mark  on the

upper left corner of the sheet with the alignment mark .

(2) Close the Document Cover gently, and press the OK button.
The machine starts scanning the print head alignment sheet, and the print head position will be adjusted

automatically.

When adjusting the print head position is completed, remove the print head alignment sheet on the Platen

Glass.
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 Important

 Do not open the Document Cover or remove the print head alignment sheet on the Platen

Glass until adjusting the print head position is completed.

 If the massage "Failed to scan." appears, press the OK button and confirm the following:

- The Platen Glass and print head alignment sheet are not dirty.

- The print head alignment sheet is placed in the correct position with the printed side

facing down.

Refer to "Troubleshooting" in the on-screen manual: Advanced Guide .

 Note

 Press the HOME button to exit the Settings menu and display the HOME screen.

 If the print results are still not satisfactory after adjusting the print head position as

described above, adjust the print head position manually from a computer.

For details, refer to the on-screen manual: Advanced Guide .

 To print and check the current head position adjustment values, select Head alignment print

in the Maintenance menu.
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Cleaning the Paper Feed Roller 
If the Paper Feed Roller is dirty or paper powder is attached to it, paper may not be fed properly.

In this case, clean the Paper Feed Roller. Cleaning will wear out the Paper Feed Roller, so perform this

only when necessary.

You need to prepare: three sheets of A4 or Letter-sized plain paper

1. Make sure that the power is turned on.

2. Open the Paper Output Tray gently, and open the Output Tray Extension.

3. Select Roller cleaning.

(1) Select Settings  on the HOME screen, and press the OK button.
The Settings screen will appear.

(2) Select Maintenance , and press the OK button.
The Maintenance screen will appear.

(3) Select Roller cleaning, and press the OK button.

The confirmation screen will appear.

(4) Select Yes, and press the OK button.

(5) Select the paper source to clean (Rear tray or Cassette), and press the OK
button.

4. Clean the Paper Feed Roller without paper.

(1) Follow the message to remove paper in the paper source you selected in (5) of

step 3.

(2) Press the OK button.
The Paper Feed Roller will rotate as it is cleaned.

5. Clean the Paper Feed Roller with paper.

(1) Make sure that the Paper Feed Roller has stopped rotating, then follow the

message to load three sheets of A4 or Letter-sized plain paper in the paper

source you selected in (5) of step 3.

(2) Press the OK button.
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The machine starts cleaning.

The cleaning will be completed after the paper is ejected.

 Note

 Press the HOME button to exit the Settings menu and display the HOME screen.

If the problem is not resolved after cleaning the Paper Feed Roller, contact the service center.
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Advanced Guide Troubleshooting

Contents > Routine Maintenance  > Cleaning the Pad in the Cassette

Cleaning the Pad in the Cassette 
If the Pad in the Cassette is smeared with paper powder or dirt, two or more sheets of paper may be

ejected. Follow the procedure below to clean the Pad in the Cassette.

You need to prepare: cotton swab

1. Pull out the Cassette from the machine, and remove all the papers.

2. Clean the Pad (A) sideways with a moistened cotton swab.

 Important

 After cleaning the smeared Pad, dry it completely.

If the problem is not resolved, contact the service center.
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Advanced Guide Troubleshooting

Contents > Appendix

Appendix 

Legal Limitations on Use of Your Product and Use of Images

Tips on How to Use Your Machine
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Advanced Guide Troubleshooting

Contents > Appendix > Legal Limitations on Use of Your Product and Use of Images

Legal Limitations on Use of Your Product and Use of Images 
It may be unlawful to make copies of, scan, print, or use reproductions of the following documents.

The list provided is non-exhaustive. When in doubt, check with a legal representative in your jurisdiction.

 Paper money

 Money orders

 Certificates of deposit

 Postage stamps (canceled or

uncanceled)

 Identifying badges or insignias

 Selective service or draft papers

 Checks or drafts issued by

governmental agencies

 Motor vehicle licenses and

certificates of title

  Traveler's checks

 Food stamps

 Passports

 Immigration papers

 Internal revenue stamps (canceled or

uncanceled)

 Bonds or other certificates of indebtedness

 Stock certificates

 Copyrighted works/works of art without

permission of copyright owner
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Advanced Guide Troubleshooting

Contents > Appendix > Tips on How to Use Your Machine

Tips on How to Use Your Machine 
This section introduces the tips on how to use your machine and for printing with optimal quality.

 Ink is used for various purposes. 

 How is ink used for various purposes other than printing?

Ink may be used for purposes other than printing. Ink is not only used for printing, but also for

cleaning the Print Head to maintain the optimal printing quality.

The machine has the function to automatically clean the ink jet nozzles to prevent clogging. In the

cleaning procedure, ink is pumped out from the nozzles. Used ink for nozzle cleaning is limited to a

small amount.

 Does black-and-white printing use color ink?

Black-and-white printing may use ink other than black ink depending on the type of printing paper or

the settings of the printer driver. So, color ink is consumed even when printing in black-and-white.

 Why does the machine have two black ink tanks?

There are two kinds of black ink in the machine: dye ink (BK) and pigment ink (PGBK).

The dye ink is used mainly for printing photos, illustration, etc., and the pigment ink is used for text-

based documents. Each has different purposes so that even if one runs out, another will not be

used instead. If either of them runs out, the ink tank replacement is required.

These two inks are automatically used depending on the type of printing paper or the settings of the

printer driver. You cannot change the usage of these inks yourself.

 Ink lamp indicates when ink is running low.

The inside of the ink tank consists of (A) the part where ink is preserved and (B) the sponge with

absorbed ink.

When the ink (A) runs out, the ink lamp flashes slowly to indicate that the ink is running low. Then,

when the ink (B) runs out, the ink lamp flashes fast to indicate that the ink tank needs to be replaced

with a new one.

See Replacing an Ink Tank.

 Printing on special paper: How to print with optimal quality!? 

 Tip!: Check the machine status before printing!

 Is the Print Head OK?

If print head nozzles are clogged, print will be faint and papers will be wasted. Print the nozzle

check pattern to check the Print Head.

See When Printing Becomes Faint or Colors Are Incorrect .
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 Is the inside of the machine smeared with ink?

After printing large quantities of paper or performing borderless printing, the area where papers

go through may get smeared with ink. Clean the inside of your machine with the Bottom Plate

Cleaning.
Refer to the on-screen manual: Advanced Guide .

 Tip!: Check how to load the paper correctly!

 Is the paper loaded in the correct orientation?

When loading paper in the Rear Tray or Cassette, make sure the orientation of paper.

Rear Tray Cassette 

 To load paper in the Rear Tray, load paper

with the printing side facing you.

 To load paper in the Cassette, load paper with the

printing side facing down.

 Is the paper curled?

The curled paper causes paper jam. Flatten the curled paper, then reload it.
Refer to "Troubleshooting " in the on-screen manual: Advanced Guide .

 Tip!: After loading paper, be sure to specify the paper settings!

After loading paper, be sure to select the loaded paper for Media type with the Operation Panel or
Media Type with the printer driver. If the type of paper is not selected, you may not be able to get the

satisfactory print result.

See Loading Paper .

There are various types of paper: paper with special coating on the surface for printing photos with

optimal quality and paper suitable for documents. Media type of the Operation Panel or Media Type

of the printer driver has different settings for each type of paper in advance (such as using ink,

ejecting ink, or distance from nozzles) so that you can print on each paper with the optimal image

quality. You can print with different settings in Media type (or Media Type) suitable for each type of

loaded paper.

 Use the Stop button to cancel printing! 

 Tip!: Never press the ON button!

If you press the ON button while printing is in progress, the print data sent from the computer
queues in the machine and you may not be able to continue to print.

Press the Stop button to cancel printing.

 Note

 If you cannot cancel printing by pressing the Stop button while printing from a computer, open

the printer driver setup window to delete the unnecessary print jobs from the printer status

monitor (Windows).

 Does the machine need to be handled with care when using or
transporting? 
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 Tip!: Do not use or transport the machine vertically or slanted!

If the machine is used or transported vertically or slanted, the machine may become damaged or

ink may leak from the machine. 

Be sure not to use or transport the machine vertically or slanted.

 Tip!: Do not place any object on the Document Cover!

Do not place any object on the Document Cover. It will fall into the Rear Tray when the Document

Cover is opened and cause the machine to malfunction.
Also, place the machine where objects will not fall on it.

 Tip!: Carefully choose the area to place the machine!

 Note when you place the machine near other electrical appliances such
as fluorescent lamps

Place the machine at least 5.91 inches / 15 cm away from other electrical appliances such as

fluorescent lamps. If the machine is placed closer to those, it may not be able to work properly

due to fluorescent noises.

 Note when you use the machine on wireless LAN

Since the microwave oven and the wireless LAN system use the same frequency bandwidth, the

microwave oven can be the potential source of interference when the microwave oven is on.

Placing this machine close to microwave oven may result in the poor status of radio.

 How to maintain the optimal printing quality? 

The key to printing with the optimal printing quality is to prevent the Print Head from drying or clogging.

Always follow the following steps for optimal printing quality.

 Follow the procedure below to disconnect the power plug. 

1. Press the ON button on the machine to turn it off.

2. Make sure that the Power lamp is not lit.

3. Disconnect the power plug from the wall outlet, or turn off the extender cable connector. 
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If you press the ON button to turn off the power, the machine caps the Print Head (nozzles)

automatically to prevent from drying. If you disconnect the power plug from the wall outlet or turn

off the extender cable connector before the Power lamp is turned off, the Print Head will not be

capped properly and this will cause drying or clogging.

To disconnect the power plug, be sure to follow this procedure.

 Print periodically!

Just as the tip of a felt pen becomes dry and unusable if it has not been used for a long time,

even if it is capped, the Print Head too, may become dried or clogged if the machine has not

been used for a long time.

We recommend you to use the machine at least once a month.

 Note

 Depending on the type of paper, ink may blur if you trace the printed area with a highlight pen or

paint-stick, or bleed if water or sweat comes in contact with the printed area.

 Colors are uneven, and print results are blurred. 

 Tip!: Print the nozzle check pattern to check if the nozzles are
clogged.

If the print head nozzles are clogged, colors may become uneven or the print results may be blurred.

In this case

Print the nozzle check pattern

Check the printed check pattern to see if the nozzles are clogged.

See When Printing Becomes Faint or Colors Are Incorrect .
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Printing Photos

Starting Easy-PhotoPrint EX

Selecting a Photo
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Creating an Album

Starting Easy-PhotoPrint EX

Selecting the Paper and Layout

Selecting a Photo

Editing

Printing

Printing Calendars

Starting Easy-PhotoPrint EX

Selecting the Paper and Layout

Selecting a Photo

Editing

Printing
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Starting Easy-PhotoPrint EX
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Printing Layout
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Editing
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Correcting and Enhancing Photos
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Using the Red-Eye Correction Function

Using the Face Brightener Function
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Using the Face Sharpener Function

Using the Digital Face Smoothing Function

Using the Blemish Remover Function

Adjusting Images

Correct/Enhance Images Window

Questions and Answers

How Can I Move (or Copy) the Saved File?

Which Side of the Displayed Image Does the Printing

Start from?

How Do I Print with Even Margins?

What Is "C1" or "C4"?

Photo Print Settings

Printing Vivid Photos

Reducing Photo Noise

Cropping Photos (Photo Print)

Printing Dates on Photos (Photo Print)

Printing Multiple Photos on One Page

Printing an Index

Printing ID Photos (ID Photo Print)

Printing Photo Information

Saving Photos

Opening Saved Files

Other Settings

Changing Layout

Changing Background

Adding Photos

Swapping Positions of Photos

Replacing Photos

Changing Position, Angle and Size of Photos

Cropping Photos

Framing Photos

Printing Dates on Photos

Attaching Comments to Photos

Adding Text to Photos

Saving

Setting Holidays

Setting Calendar Display

Opening Saved Files

Printing with Other Application Software

Various Printing Methods

Printing with Easy Setup

Setting a Page Size and Orientation

Setting the Number of Copies and Printing Order

Setting the Stapling Margin

Borderless Printing

Fit-to-Page Printing

Scaled Printing

Page 121 of 949 pagesMP560 series Advanced Guide



Page Layout Printing

Poster Printing

Booklet Printing

Duplex Printing

Stamp/Background Printing

Registering a Stamp

Registering Image Data to be Used as a Background

Printing an Envelope

Switching the Paper Source to Match the Purpose

Displaying the Print Results before Printing

Setting Paper Dimensions (Custom Size)

Changing the Print Quality and Correcting Image Data

Selecting a Combination of the Print Quality Level

and a Halftoning Method

Printing a Color Document in Monochrome

Specifying Color Correction

Optimal Photo Printing of Image Data

Adjusting Colors with the Printer Driver

Printing with ICC Profiles

Adjusting Color Balance

Adjusting Brightness

Adjusting Intensity

Adjusting Contrast

Simulating an Illustration

Representing Image Data with a Single Color

Presenting Image Data with Vivid Colors

Smoothing Jagged Outlines

Changing Color Properties to Improve Coloration

Reducing Photo Noise

Overview of the Printer Driver

Printer Driver Operations

Canon IJ Printer Driver

How to Open the Printer Driver Setup Window

Maintenance Tab

Canon IJ Status Monitor

Canon IJ Preview

Printing Using the Operation Panel of the Machine

Printing Lined Paper or Graph Paper

Printing Template Forms Such As Lined Paper or Graph

Paper

Printing from a Memory Card

Printing Photographs Saved on a Memory Card

Setting Items

Printing by Using the Photo Index Sheet

Using Useful Printing Functions

Printing Memory Card Photos in Various Layouts

Settings for Printing a Photo on a Memory Card
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Printing Several Photos on a Single Sheet of Paper
(Layout Print)

Printing on Stickers (Sticker Print)

Print all photos

Photo index print

DPOF print

Captured info print

Printing ID Photo-ID photo size print

Creating a Calendar-Calendar print

Using Useful Display Functions

Changing the Display

Printing a Specified Area (Trimming)

Searching for Photos with the Shooting Date

(Search)

Setting Up the Card Slot as the Memory Card Drive of the

Computer

Printing from a USB Flash Drive

Printing Photographs Saved on a USB Flash Drive

Setting Items

Printing by Using the Photo Index Sheet

Using Useful Printing Functions

Printing USB Flash Drive Photos in Various Layouts

Settings for Printing a Photo on a USB Flash Drive

Printing Several Photos on a Single Sheet of Paper
(Layout Print)

Printing on Stickers (Sticker Print)

Print all photos

Photo index print

DPOF print

Captured info print

Printing ID Photo-ID photo size print

Creating a Calendar-Calendar print

Using Useful Display Functions

Changing the Display

Printing a Specified Area (Trimming)

Searching for Photos with the Shooting Date

(Search)

Photo Printing from Printed Photo

Printing from Printed Photo

Setting Items

Using Useful Printing Functions

Special Printing of Photo

Settings for Printing a Scanned Photo

Printing on Stickers (Sticker Print)

Printing All Photos (Print All Photos)

Using Useful Display Functions

Changing the Display

Printing a Specified Area (Trimming)
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Printing Photographs Directly from a Compliant Device or a

Wireless Communication Device

Printing Photographs Directly from a Compliant Device

Printing Photographs Directly from a Compliant Device

About PictBridge Print Settings

Settings on a PictBridge Compliant Device

Settings on the Machine

Printing Photographs from a Wireless Communication Device

Printing via Bluetooth Communication

Printing through Bluetooth Communication

Changing the Bluetooth Settings

Setting the Page Size, Media Type, and Layout When

Printing from a Mobile Phone

Displaying the Mobile phone print setting screen

Scanning 

Scanning

Scanning Images

Scanning Images

Before Scanning

Placing Documents

Saving Scanned Data on the USB Flash Drive/Memory Card

Using the Operation Panel of the Machine

Saving Scanned Data on the USB Flash Drive/Memory

Card Using the Operation Panel of the Machine

Setting Items

Deleting Scanned Data on USB Flash Drive/Memory

Card

Forwarding Scanned Data to PC Using the Operation Panel of

the Machine

Forwarding Scanned Data to PC Using the Operation

Panel of the Machine

Appendix: Various Scan Settings

Network Scan Settings

Selecting a Response to Commands from the
Operation Panel Using MP Navigator EX

Scanning with the Bundled Application Software

What Is MP Navigator EX (Supplied Scanner Software)?

Let's Try Scanning

Starting MP Navigator EX

Scanning Photos and Documents

Scanning Multiple Documents at One Time

Scanning Images Larger than the Platen (Stitch

Assist)

Easy Scanning with One-click

Useful MP Navigator EX Functions

Correcting/Enhancing Images Automatically

Correcting/Enhancing Images Manually

Adjusting Images
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Searching Images

Classifying Images into Categories

Utilizing Images in MP Navigator EX

Saving

Saving as PDF Files

Creating/Editing PDF Files

Printing Documents

Printing Photos

Sending via E-mail

Editing Files

Setting Passwords for PDF Files

Opening/Editing Password-protected PDF Files

MP Navigator EX Screens

Navigation Mode Screen

Scan/Import Documents or Images Tab

View & Use Images on your Computer Tab

Custom Scan with One-click Tab

Photos/Documents (Platen) Screen (Scan/Import

Window)

Scan Settings Dialog Box (Photos/Documents)

Save Dialog Box

Save as PDF file Dialog Box

PDF Settings Dialog Box

Memory Card Screen (Scan/Import Window)

View & Use Window

Create/Edit PDF file Window

Print Document Dialog Box

Print Photo Dialog Box

Send via E-mail Dialog Box

Correct/Enhance Images Window

One-click Mode Screen

Auto Scan Dialog Box

Save Dialog Box (One-click Mode Screen)

Scan Settings Dialog Box

Save Dialog Box

Exif Settings Dialog Box

PDF Dialog Box

Save as PDF file Dialog Box

Mail Dialog Box

OCR Dialog Box

Custom Dialog Box

Preferences Dialog Box

General Tab

Scanner Button Settings Tab (Save)

Scanner Button Settings Tab (Attach to E-mail)

Scanner Button Settings Tab (Open with Application)

Appendix: Opening Files Other than Scanned Images
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Importing Images Saved on a Memory Card

Opening Images Saved on a Computer

Scanning with Other Application Software

What Is ScanGear (Scanner Driver)?

Scanning with Advanced Settings Using ScanGear

(Scanner Driver)

Starting ScanGear (Scanner Driver)

Scanning in Basic Mode

Scanning in Advanced Mode

Scanning in Auto Scan Mode

Scanning Multiple Documents at One Time with

ScanGear (Scanner Driver)

Correcting Images and Adjusting Colors with ScanGear

(Scanner Driver)

Correcting Images (Unsharp Mask, Reduce Dust
and Scratches, Fading Correction, etc.)

Adjusting Colors Using a Color Pattern

Adjusting Saturation and Color Balance

Adjusting Brightness and Contrast

Adjusting Histogram

Adjusting Tone Curve

Setting Threshold

ScanGear (Scanner Driver) Screens

Basic Mode Tab

Advanced Mode Tab

Input Settings

Output Settings

Image Settings

Color Adjustment Buttons

Auto Scan Mode Tab

Preferences Dialog Box

Scanner Tab

Preview Tab

Scan Tab

Color Settings Tab

Appendix: Useful Information on Scanning

Adjusting Cropping Frames

Resolution

File Formats

Color Matching

Canon IJ Network Scan Utility Screens

Canon IJ Network Scan Utility Menu and Setting Screen

Other Scanning Methods

Scanning with WIA Driver

Scanning Using the Control Panel (Windows XP Only)

Copying 

Printing Using the Operation Panel of the Machine
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Copying

Making Copies

Setting Items

Reducing or Enlarging a Copy

Changing Intensity Setting

Displaying the Preview Screen

Using Useful Copy Functions

Special Copy

Settings for Special Copy

Copying onto Both Sides of the Paper (Two-Sided

Copy)

Copying Two Pages to Fit onto a Single Page (2-on-1

Copy)

Copying Four Pages to Fit onto a Single Page (4-on-

1 Copy)

Copying without Borders (Borderless Copy)

Repeating an Image on a Page (Image Repeat)

Copying Thick Originals Such as Books (Frame

Erase)

Copying a Specified Area (Trimming)

Copying Images with Erasing a Part (Masking)

Troubleshooting 

Troubleshooting

Troubleshooting

If an Error Occurs

The Machine Cannot Be Powered On

An Error Message Is Displayed on the LCD

LCD Cannot Be Seen At All

An Unintended Language Is Displayed on the LCD

Cannot Install the MP Drivers

Cannot Connect to Computer with a USB Cable Properly

Printing or Scanning Speed Is Slow/Hi-Speed USB

Connection Does Not Work/"This device can perform

faster" Message Is Displayed

Print Results Not Satisfactory

Cannot Print to End of Job

Part of the Page Is Not Printed

No Printing Results/Printing Is Blurred/Colors Are Wrong/

White Streaks

Lines Are Misaligned

Printed Paper Curls or Has Ink Blots

Paper Is Smudged/Printed Surface Is Scratched

Back of the Paper Is Smudged

Vertical Lines Are Printed on the Sides of the Printout

Colors Are Uneven or Streaked

Printing Does Not Start

Copying/Printing Stops Before It Is Completed
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Machine Moves But Ink Is Not Ejected

Printing Speed Is Not as Fast as Expected

Print Head Holder Does Not Move to the Position for

Replacing

Paper Does Not Feed Properly

Paper Does Not Feed from the Paper Source Specified in the

Printer Driver

Paper Jams

Paper Is Jammed in the Paper Output Slot or the Rear
Tray

Paper Is Jammed inside the Machine at the Transport

Unit

Jammed Paper Is Not Removed out When Automatic

Duplex Printing

In Other Cases

Message Appears on the Computer Screen

Error Number: B200 A printer error has occurred. Turn the

printer off and unplug the power cord of the printer from

the power supply. Then contact the service center. Is

Displayed

Error Number: **** A printer error has occurred. Turn the

printer off and then on again. If this doesn't clear the error,

see the user's guide for more detail. Is Displayed

Writing Error/Output Error/Communication Error

Error Regarding Automatic Duplex Printing Is Displayed

Error Number: 300 Is Displayed

Error Number: 1700 Is Displayed

Ink Info Number: 1600 Is Displayed

Ink Info Number: 1683 Is Displayed

Ink Info Number: 1688 Is Displayed

Error Number: 2001 Is Displayed

Error Number: 2002 Is Displayed

Other Error Messages

The Inkjet Printer/Scanner/Fax Extended Survey Program

Screen Is Displayed

The Inkjet Printer/Scanner/Fax Extended Survey Program

Icon Appears

Cannot Print Properly with Automatic Duplex Printing

For Windows Users

Printer Status Monitor Is Not Displayed

Launching MP Navigator EX Whenever Pressing the
Color or Black Button on the Machine

Error Message Appears on a PictBridge Compliant Device

Cannot Print Properly from a Wireless Communication Device

Cannot Print Properly from a Photo Index Sheet

Failed to scan Photo Index Sheet. Is Displayed

Cannot print the selected photo. Is Displayed/Differ Photo

or Blank Is Printed out/Paper Feeds Before Printing Is

Complete

Cannot Remove a Memory Card

Problems with Scanning
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Scanner Does Not Work

ScanGear (Scanner Driver) Does Not Start

Error Message Appears and the ScanGear (Scanner

Driver) Screen Does Not Appear

Scan Quality (Image Displayed on the Monitor) Is Poor

Scanned Image Is Surrounded by Extra White Areas

Cannot Scan Multiple Documents at One Time

Cannot Scan Properly in Auto Scan Mode

Slow Scanning Speed

"There is not enough memory." Message Is Displayed

Computer Stops Operating during Scanning

Scanner Does Not Work After Upgrading Windows

Software Problems

E-mail Software Program You Want to Use Does Not

Appear in the Screen for Selecting an E-mail Software

Program

Scanned Image Is Printed Enlarged (Reduced)

Scanned Image Is Enlarged (Reduced) on the Computer
Monitor

Scanned Image Does Not Open

MP Navigator EX Problems

Cannot Scan at the Correct Size

Position or Size of the Image Cannot be Detected

Correctly When Scanning Using the Operation Panel

Document Is Placed Correctly, but the Scanned Image Is

Slanted

Document Is Placed Correctly, but the Orientation

Changes in the Scanned Image

If You Cannot Resolve the Problem

FAQs

Instructions for Use (Printer Driver)

General Notes (Scanner Driver)

Using Easy-PhotoPrint EX

Using MP Navigator EX

About Solution Menu
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Advanced Guide  > How to Use This Manual 

How to Use This Manual 

Operating the Contents Pane

Operating the Explanation Window

Printing This Manual

Using Keywords to Find a Document

Registering Documents to My Manual

Symbols Used in This Document

Trademarks

Page top
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Advanced Guide  > How to Use This Manual  > Operating the Contents Pane

Operating the Contents Pane

When you click a document title displayed in the contents pane found to the left of the on-screen manual,

the documents of that title are displayed in the explanation window on the right side.

When you click  found to the left of , the document titles found in the lower hierarchies are displayed.

Note 

Click  to close or display the contents pane.

Page top
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Advanced Guide  > How to Use This Manual  > Operating the Explanation Window

Operating the Explanation Window

(1) Click the green characters to jump to the corresponding document.

(2) The cursor jumps to the top of this document.

Page top
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Advanced Guide  > How to Use This Manual  > Printing This Manual

Printing This Manual

Click  to display the print pane to the left of the on-screen manual.

Note 

Click  to close or display the print pane.

When you click  and then click Page Setup, the Page Setup dialog box appears. You can then

easily set up the paper to be used for printing.

Click , and then click Print Settings to display the Print dialog box. When the dialog box is

displayed, select the printer to be used for printing. The Print Setup tab also allows you to select the

printer to be used.

After selecting the printer to be used, click Properties... to specify the print settings.

Click , and then click Option Settings to display the Option Settings dialog box. You can then set up

the printing operation.

Print document title and page number

When this check box is checked, the manual name and the page number are printed in the

header (top of the document).

Print background color and images

When this check box is checked, the background color and the image are printed. Some

images are printed regardless of whether this check box is checked or not.

Check number of pages to be printed before printing

When this check box is checked, the Print Page Count Confirmation dialog box is displayed

before printing starts. This dialog box allows you to check how many pages will be printed.

On the Document Selection tab, select the method for printing the document. The following four methods

of printing are available:

Print Current Document

Print Selected Documents

Print My Manual
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Print All Documents

Note 

You can select the type to be printed, and then easily specify print settings on the Print Setup tab.

Print Current Document

You can print the currently displayed document.

1. From Select Target, select Current Document

The title of the currently displayed document is displayed in the Documents to Be Printed list.

Note 

By selecting Print linked documents, you can also print documents that are linked to the current

document. The linked documents are added to the Documents to Be Printed list.

Click Print Preview to display and check what the print results will look like before you actually

print the document.

2. Click Print Setup tab

On the Page Setup tab, select the printer to be used and specify simple print settings, as necessary.

3. Click Start Printing

A message confirming the number of print pages is displayed.

4. Execute print

Confirm the number of pages to be printed, and then click Yes.

The documents that are currently displayed are printed.

Print Selected Documents

You can select and print the documents that you want printed.

1. From Select Target, select Selected Documents

The titles of all documents are displayed in the Documents to Be Printed list.

2. Select the documents to be printed

From the Documents to Be Printed list, select the title check boxes of the documents to be printed.

Note 

When you select the Automatically select documents in lower hierarchies check box, the check

boxes of all document titles found in the lower hierarchies are selected.

Click Select All to select the check boxes of all document titles.

Click Clear All to clear the check boxes of all document titles.

Click Print Preview to display and check what the print results will look like before you actually

print the document.

3. Click Print Setup tab

On the Page Setup tab, select the printer to be used and specify simple print settings, as necessary.

4. Click Start Printing

A message confirming the number of print pages is displayed.

5. Execute print
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Confirm the number of pages to be printed, and then click Yes.

All documents with selected check boxes are printed.

Print My Manual

You can select and print documents registered in My Manual.

For details about My Manual, see " Registering Documents to My Manual ."

1. From Select Target, select My Manual

The titles of the documents that have been registered to My Manual are displayed in the Documents

to Be Printed list.

2. Select the documents to be printed

From the Documents to Be Printed list, select the title check boxes of the documents to be printed.

Note 

Click Select All to select the check boxes of all document titles.

Click Clear All to clear the check boxes of all document titles.

Click Print Preview to display and check what the print results will look like before you actually

print the document.

3. Click Print Setup tab

On the Page Setup tab, select the printer to be used and specify simple print settings, as necessary.

4. Click Start Printing

A message confirming the number of print pages is displayed.

5. Execute print

Confirm the number of pages to be printed, and then click Yes.

All documents with selected check boxes are printed.

Print All Documents

You can print all documents of the on-screen manual.

1. From Select Target, select All Documents

The titles of all documents are displayed in the Documents to Be Printed list, and the check boxes

are automatically selected.

Note 

When you uncheck the check box of a document title, that document is not printed.

Click Select All to select the check boxes of all document titles.

Click Clear All to clear the check boxes of all document titles.

Click Print Preview to display and check what the print results will look like before you actually

print the document.

2. Click Print Setup tab

On the Page Setup tab, select the printer to be used and specify simple print settings, as necessary.

3. Click Start Printing

A message confirming the number of print pages is displayed.

4. Execute print
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Confirm the number of pages to be printed, and then click Yes.

All documents are printed.

Important 

A large amount of paper is necessary to print all documents. Before printing, be sure to check

the number of print pages displayed in the Print Page Count Confirmation dialog box.

The Print Preview dialog box allows you to scale the printing to the paper width or to set the

zoom rate. However, if the print data extends outside the paper because of the new zoom rate,

that portion of the document will not be printed on the paper.
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Using Keywords to Find a Document

You can enter a keyword to search for a target document.

All documents in the currently displayed on-screen manual are searched.

1. Click 

The search pane is displayed to the left of the on-screen manual.

Note 

Click  to close or display the search pane.

2. Enter a keyword

In Keyword, enter a keyword for the item to be checked.

When you want to enter multiple keywords, insert a space between the keywords.

Note 

You can enter up to 10 search keywords or up to 255 characters.

Uppercase and lowercase are not discriminated.
The program can also search for keywords that contain spaces.

A convenient way of quickly finding a document to be read is to enter keywords as described

below.
To learn how to operate a function you are using:

Enter the menu name displayed on the operation panel of this machine or on the computer

(for example, frame erase copy).

To find an explanation of the operation for a specific purpose:

Enter function + item to be printed (for example, print calendar).

3. Click Start Searching
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The search is started, and the titles of documents containing the keyword are displayed in the

search results list.

When you execute a search by entering multiple keywords, the search results are displayed as

shown below.

[Documents Containing Perfect Match] 

Documents containing the entire search character string (including spaces) exactly as entered
(perfect match)

[Documents Containing All Keywords] 

Documents containing all keywords that were entered

[Documents Containing Any Keyword] 

Documents containing at least one of the keywords that were entered

4. Display the document that you want to read

From the search results list, double-click (or select and press Enter) the title of the document you

want to read.

When the documents of that title are displayed, the keywords found on those documents are

highlighted.

Note 

If you modify the keyword entry and perform multiple searches, a search history remains. To delete

the search history, click  located to the right of Keyword, and select Clear History, which is

displayed.
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Registering Documents to My Manual

Register frequently read documents as My Manual documents so that you can refer to those documents

easily at any time.

1. Display the document

Display the document to be added to My Manual.

2. Click 

The My Manual pane is displayed to the left of the on-screen manual.

Note 

Click  to close or display the My Manual pane.

3. Register the document to My Manual

Click Add.

The title of the currently displayed document is added to List of My Manual.

Note 

You can also add documents to My Manual by the following methods. If you add a document to
My Manual, a  mark is displayed in the document icons in the contents pane.

From the Recently Displayed Documents list, double-click the document title that you want

to add to My Manual (or select the document and press Enter key) to display the title, and
then click Add.

Right-click the document title displayed in the contents pane or right-click the explanation

window, and then select Add to My Manual from the right-click menu.

In the contents pane, select the document title that you want to add to My Manual, and then
click Add to My Manual at the bottom right of the pane.
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4. Display My Manual

When you double-click (or select and press Enter) a document title displayed in List of My Manual,

that document is displayed in the explanation window.

Note 

To delete a document from List of My Manual, select that document title from the list, and then

click Delete (or press Delete).
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Symbols Used in This Document

 Warning 
Instructions that, if ignored, could result in death or serious personal injury caused by incorrect operation

of the equipment. These must be observed for safe operation.

 Caution 
Instructions that, if ignored, could result in personal injury or material damage caused by incorrect

operation of the equipment. These must be observed for safe operation.

 Important 
Instructions including important information.
Be sure to read these indications.

 Note 
Instructions as notes for operation or additional explanations.

Indicates operations in Windows.

Indicates operations in Macintosh.
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Trademarks

Microsoft is a registered trademark of Microsoft Corporation.

Windows is a trademark or registered trademark of Microsoft Corporation in the U.S. and/or other

countries.

Windows Vista is a trademark or registered trademark of Microsoft Corporation in the U.S. and/or

other countries.

Internet Explorer is a trademark or registered trademark of Microsoft Corporation in the U.S. and/or

other countries.

Macintosh, Mac, and AirPort are trademarks of Apple Inc., registered in the U.S. and other countries.

Bonjour is a trademark of Apple Inc., registered in the U.S. and other countries.

Adobe, Adobe Photoshop, Adobe RGB and Adobe RGB (1998) are either registered trademarks or

trademarks of Adobe Systems Incorporated in the United States and/or other countries.

Bluetooth is a trademark of Bluetooth SIG, Inc.,U.S.A. and licensed to Canon Inc.

Wi-Fi is a registered trademark of the Wi-Fi Alliance. The Wi-Fi CERTIFIED logo is a certification
mark of the Wi-Fi Alliance.

Exif Print

This machine supports Exif Print.

Exif Print is a standard for enhancing the communication between digital cameras and printers. By

connecting to an Exif Print-compliant digital camera, the camera's image data at the time of shooting is

used and optimized, yielding extremely high quality prints.
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Advanced Guide  > Printing from a Computer 

Printing from a Computer 

Printing with the Bundled Application Software

Printing with Other Application Software
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Printing with the Bundled Application Software 

What Is Easy-PhotoPrint EX?

Printing Photos

Creating an Album

Printing Calendars

Printing Stickers

Printing Layout

Correcting and Enhancing Photos

Questions and Answers

Photo Print Settings

Other Settings
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EX?

What Is Easy-PhotoPrint EX?

Easy-PhotoPrint EX allows you to create albums, calendars and stickers easily using photos taken with

digital cameras.

You can also print borderless photos easily.

Important

Easy-PhotoPrint EX does not support Windows 95, Windows 98, Windows Me, or Windows NT4.

Easy-PhotoPrint EX can only be used with Canon inkjet printers. It does not support some printers,

including Canon compact printers (SELPHY CP series).
If a printer that supports Easy-PhotoPrint EX is not installed, you cannot print items you create.

If Easy-PhotoPrint EX is installed on a computer that already has Easy-LayoutPrint installed, Easy-

LayoutPrint will be replaced by Easy-PhotoPrint EX.

Note

Printing on paper larger than A4 is available with supported printers only. See your printer manual

for details.

See Help of Easy-PhotoPrint EX for descriptions of Easy-PhotoPrint EX screens.

Click Help in a screen or dialog box, or select Easy-PhotoPrint EX Help... from the Help menu. Help

appears.

About Exif Print

Easy-PhotoPrint EX supports "Exif Print." Exif Print is a standard for enhancing the communication

between digital cameras and printers.

By connecting to an Exif Print-compliant digital camera, the image data at the time of shooting is used

and optimized, yielding extremely high quality prints.

Starting Easy-PhotoPrint EX from Other Applications
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Easy-PhotoPrint EX can be started from other applications.

See the application's manual for details on the procedure for starting.

The Photo Print function is available with the following applications:

MP Navigator EX Ver.1.00 or later

ZoomBrowser EX Ver.6.0 or later

Digital Photo Professional Ver.3.2 or later

Important

Easy-PhotoPrint EX is subject to the following restrictions when started from Digital Photo

Professional:
- Menu does not appear in the step button area on the left side of the screen.

- Images cannot be corrected/enhanced.

- Image display order cannot be changed.

- Edited images cannot be saved.

- Options other than Enable ICC Profile cannot be selected for Color correction for printing on

the Advanced tab of the Preferences dialog box. Therefore, you cannot use the Vivid Photo and

Photo Noise Reduction functions.

The Album function is available with the following applications:

MP Navigator EX Ver.1.00 or later

ZoomBrowser EX Ver.5.8 or later

Supported Image File Formats (Extensions)

BMP (.bmp)

JPEG (.jpg, .jpeg)

TIFF (.tif, .tiff)

PICT (.pict, .pct)

Easy-PhotoPrint image files (.epp)

Important

When selecting an image, if there is a TIFF file in the selected folder, the image may not be

displayed correctly or Easy-PhotoPrint EX may shut down depending on the TIFF format. In such

cases, move the TIFF file to another folder or recreate the file in a different file format, and then

select the folder again.

Note

The thumbnails of files in unsupported formats are displayed as  (Question Mark).

When Easy-PhotoPrint EX is started from Digital Photo Professional, all image files supported by

Digital Photo Professional will be displayed.

File Formats (Extensions) Supported by Easy-PhotoPrint EX

Easy-PhotoPrint EX Photo Print file (.el6)

Easy-PhotoPrint EX Album file (.el1)

Easy-PhotoPrint EX Stickers file (.el2)

Easy-PhotoPrint EX Calendar file (.el4)

Easy-PhotoPrint EX Layout file (.el5)
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Printing Photos

Easy-PhotoPrint EX allows you to print your favorite photos in a variety of layouts.

You can also create borderless photos easily.

Corrections suitable for photos will be applied automatically when printing.

Steps

1. Starting Easy-PhotoPrint EX

2. Selecting a Photo

3. Selecting the Paper

4. Printing

Try This

Correcting and Enhancing Photos

Printing Vivid Photos

Reducing Photo Noise

Cropping Photos (Photo Print)

Printing Dates on Photos (Photo Print)

Printing Multiple Photos on One Page

Printing an Index

Printing ID Photos (ID Photo Print)

Printing Photo Information

Saving Photos

Opening Saved Files

Questions and Answers

How Can I Move (or Copy) the Saved File?

Which Side of the Displayed Image Does the Printing Start from?

How Do I Print with Even Margins?
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Advanced Guide  > Printing from a Computer  > Printing with the Bundled Application Software > Printing Photos > Starting

Easy-PhotoPrint EX

Starting Easy-PhotoPrint EX

1. From the Start menu, select (All) Programs > Canon Utilities > Easy-PhotoPrint EX
> Easy-PhotoPrint EX.

Easy-PhotoPrint EX starts and Menu appears.
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Selecting a Photo

Selecting a Photo

1. Click Photo Print from Menu.

The Select Images screen appears.

Important

The thumbnails (reduced images) displayed in the screen may appear as follows:
- A black line appears along an edge of the image.

- An edge of the image appears cropped.

However, such images will be displayed normally when enlarged or previewed, and print

results will not be affected.

2. Select the folder that contains the image you want to print from the folder tree area.

The images in the folder will be displayed as thumbnails (miniatures).

Important

If Easy-PhotoPrint EX is started from another application (MP Navigator EX, ZoomBrowser EX

or Digital Photo Professional), the folder tree area will not be displayed.

The images opened in the application will be displayed as thumbnails.

3. Click the image you want to print.

The number of copies appears as "1" below the clicked image, while the selected image itself will

appear in the selected image area.

Note

To delete an image in the selected image area, select the image you want to delete and click 
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 (Delete Imported Image).

To delete all images from the selected image area, click  (Delete All Imported Images).

To print two or more copies of an image, click  (Up arrow) until the number of copies you

want is reached. To reduce the number of copies shown in the box, click  (Down arrow).

You can change the order of photos using the list located at the top right corner of the screen.

You can select the printing order from Sort by Date and Sort by Name.

Note

You can correct or enhance the selected image before printing.

Correcting and Enhancing Photos

See Help for details on the Select Images screen.
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Selecting the Paper

Selecting the Paper

1. Click Select Paper.

The Select Paper screen appears.

2. Set the following items according to the printer and paper to be used:

Printer

Paper Source

Paper Size

Media Type

Note

The paper sizes and media types may vary depending on the printer. See Help for details.

The paper sources may vary depending on the printer and the media type.

Note

You can print photos with more vivid colors or you can reduce the photo noise.

Printing Vivid Photos

Reducing Photo Noise
See Help for details on the Select Paper screen.
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Printing

1. Click Layout/Print.

The Layout/Print screen appears.

Important

The thumbnails (reduced images) displayed in the screen may appear as follows:
- A black line appears along an edge of the image.

- An edge of the image appears cropped.

However, such images will be displayed normally when enlarged or previewed, and print
results will not be affected.

2. Select a layout you want to use.

Click a borderless layout to print borderless photos.

Note

The layouts that can be selected may vary depending on the printer, paper size, and media
type.

3. Click Print.

Important

When you print on large size paper such as A3/A3+, some computers cannot print properly if you

print more than one page or copy at a time. It is recommended that you print page by page when

you print on such paper.

While printing on paper larger than A4 or printing high-resolution images, data may be printed only

to the middle if many images are printed at one time. In such cases, select the Spool print job page

by page checkbox in the Preferences dialog box, and then print again.
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To display the Preferences dialog box, click  (Settings) or select Preferences... from the File

menu.
The photo print settings will be discarded if you exit Easy-PhotoPrint EX without saving the settings.

It is recommended that you save the printed image if you want to print it again.

Saving Photos

When you print on a bordered layout, the margins on the left and right or the top and bottom may

become wider than the other.

How Do I Print with Even Margins?

Note

You can crop images or print dates on photos.

Cropping Photos (Photo Print)

Printing Dates on Photos (Photo Print)

You can correct or enhance the selected image before printing.

Correcting and Enhancing Photos

You can specify advanced Photo Print settings (number of copies, print quality, etc.) in the

Preferences dialog box.

To display the Preferences dialog box, click  (Settings) or select Preferences... from the File

menu.
See Help for details on the Layout/Print screen.
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Creating an Album

Easy-PhotoPrint EX allows you to create your own personalized photo album.

Steps

1. Starting Easy-PhotoPrint EX

2. Selecting the Paper and Layout

3. Selecting a Photo

4. Editing

5. Printing

Try This

Correcting and Enhancing Photos

Changing Layout

Changing Background

Adding Photos

Swapping Positions of Photos

Replacing Photos

Changing Position, Angle and Size of Photos

Cropping Photos

Framing Photos

Printing Dates on Photos

Attaching Comments to Photos

Adding Text to Photos

Saving

Opening Saved Files

Questions and Answers
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How Can I Move (or Copy) the Saved File?

What Is "C1" or "C4"?
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Starting Easy-PhotoPrint EX

Starting Easy-PhotoPrint EX

1. From the Start menu, select (All) Programs > Canon Utilities > Easy-PhotoPrint EX
> Easy-PhotoPrint EX.

Easy-PhotoPrint EX starts and Menu appears.
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Selecting the Paper and Layout

Selecting the Paper and Layout

1. Click Album from Menu.

The Page Setup screen appears.

2. Set the following items in the General Settings section:

Paper Size

Orientation

Cover

Double page album

Page number

Note

See Help on the paper size that can be selected.

You can select whether to display images on the inside of the front and back covers in the

Cover Options dialog box. To display the Cover Options dialog box, select Front or Front & Back
for Cover and click Options....

Select the Double page album checkbox to enable the spread page layout (consisting of two-

page master). In a double-page album, you can arrange an image across the left and right

pages.
You can customize the page numbers (position, font size, etc.) in the Page Number Settings

dialog box. To display the Page Number Settings dialog box, select the Page number checkbox

and click Settings....
You can customize the margins of the front cover, inside pages and back cover in the Margin

Settings dialog box. To display the Margin Settings dialog box, click Margins....

3. Select the theme you want to use from Theme in Sample Layout.
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4. If you want to change the layout, click Layout....

The Change Layout dialog box appears.

In the Change Layout dialog box, you can change the layout or select whether to print the date (on

which the picture was taken) on the photo.

Note

The layouts that can be selected may vary depending on the Paper Size, Orientation, Double

page album, or the type of page selected (front cover, inside pages or back cover).

You can customize the date (position, size, color, etc.) in the Date Settings dialog box. To

display the Date Settings dialog box, select the Print date checkbox in the Change Layout

dialog box and click Date Settings....

5. If you want to change the background, click Background....

The Change Background dialog box appears.

In the Change Background dialog box, you can paint the background in a single color or paste an

image file to it.

Note

See Help for details on the Page Setup screen.
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Selecting a Photo

Selecting a Photo

1. Click Select Images.

The Select Images screen appears.

2. Select the folder that contains the image you want to print from the folder tree area.

The images in the folder will be displayed as thumbnails (miniatures).

Important

If Easy-PhotoPrint EX is started from another application (MP Navigator EX or ZoomBrowser

EX), the folder tree area will not be displayed.

The images opened in the application will be displayed as thumbnails.

3. Select the image(s) you want to print, and click one of the buttons below.

To print on the front cover, click  (Import to Front Cover).

To print on the inside pages, click  (Import to Inside Pages).

To print on the back cover, click  (Import to Back Cover).

The selected image(s) are displayed in the selected image area.

You can also select the image(s) you want to print by dragging them into the selected image area.

Note

To delete an image in the selected image area, select the image you want to delete and click 

 (Delete Imported Image).
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To delete all images from the selected image area, click  (Delete All Imported Images).

Note

See Help for details on the Select Images screen.
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Editing

Editing

1. Click Edit.

The Edit screen appears.

2. Edit your album if necessary.

Changing Layout

Changing Background

Adding Photos

Swapping Positions of Photos

Replacing Photos

Changing Position, Angle and Size of Photos

Cropping Photos

Framing Photos

Printing Dates on Photos

Attaching Comments to Photos

Adding Text to Photos

Important

The edit information will be discarded if you exit Easy-PhotoPrint EX without saving the edited

album. It is recommended that you save the item if you want to edit it again.

The page numbers on the front and back covers of the album are displayed as follows:

C1: Front cover

C2: Inside the front cover

C3: Inside the back cover
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C4: Back cover

Saving

Note

See Help for details on the Edit screen.
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Printing

Printing

1. Click Print Settings.

The Print Settings screen appears.

2. Set the following items according to the printer and paper to be used:

Printer

Media Type

Copies

Paper Source

Print Quality

Borderless Printing

Note

The media types may vary depending on the printer and the paper size.

Duplex Printing appears if the selected printer and media type support duplex printing. Select

this checkbox to print on both sides of the paper.

Automatic appears if you select the Duplex Printing checkbox after selecting a printer that

supports automatic duplex printing and media type that supports duplex printing. Select this
checkbox to print on both sides of the paper automatically.

The paper sources may vary depending on the printer and the media type.

You can set a custom print quality level in the Print Quality Settings dialog box. To display the

Print Quality Settings dialog box, select Custom for Print Quality and click Quality Settings....

Select the Borderless Printing checkbox to print borderless photos.
You can specify the print range and the amount of extension for borderless printing in the Print

Settings dialog box. To display the Print Settings dialog box, click Advanced....

Page 164 of 949 pagesPrinting



3. Click Print.

Note

See Help for details on the Print Settings screen.
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Printing Calendars

Easy-PhotoPrint EX allows you to create your own calendar using your favorite photos.

Steps

1. Starting Easy-PhotoPrint EX

2. Selecting the Paper and Layout

3. Selecting a Photo

4. Editing

5. Printing

Try This

Correcting and Enhancing Photos

Changing Layout

Changing Background

Adding Photos

Swapping Positions of Photos

Replacing Photos

Changing Position, Angle and Size of Photos

Cropping Photos

Framing Photos

Printing Dates on Photos

Adding Text to Photos

Setting Calendar Display

Setting Holidays

Saving

Opening Saved Files
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Questions and Answers

How Can I Move (or Copy) the Saved File?
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Starting Easy-PhotoPrint EX

Starting Easy-PhotoPrint EX

1. From the Start menu, select (All) Programs > Canon Utilities > Easy-PhotoPrint EX
> Easy-PhotoPrint EX.

Easy-PhotoPrint EX starts and Menu appears.

Page top

Page 168 of 949 pagesStarting Easy-PhotoPrint EX



Advanced Guide  > Printing from a Computer  > Printing with the Bundled Application Software > Printing Calendars  >

Selecting the Paper and Layout

Selecting the Paper and Layout

1. Click Calendar from Menu.

The Page Setup screen appears.

2. Set the following items in the General Settings section:

Paper Size

Orientation

Start from

Period

Note

See Help on the paper size that can be selected.

You can add holidays to your calendar.

Setting Holidays

3. Select a layout for Design.

If necessary, make advanced settings on the calendar and set the background.

Note

You can customize the calendar display (font colors of the dates and days of the week, position
and size of the calendar, etc.).

Setting Calendar Display

You can paint the background in a single color or paste an image file to it in the Change

Background dialog box. To display the Change Background dialog box, click Background....

Note
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See Help for details on the Page Setup screen.
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Selecting a Photo

Selecting a Photo

1. Click Select Images.

The Select Images screen appears.

2. Select the folder that contains the image you want to print from the folder tree area.

The images in the folder will be displayed as thumbnails (miniatures).

3. Select the image(s) you want to print and click  (Import to Inside Pages).

The selected image(s) are displayed in the selected image area.

You can also select the image(s) you want to print by dragging them into the selected image area.

Note

To delete an image in the selected image area, select the image you want to delete and click 

 (Delete Imported Image).

To delete all images from the selected image area, click  (Delete All Imported Images).

Note

See Help for details on the Select Images screen.
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Editing

Editing

1. Click Edit.

The Edit screen appears.

2. Edit the calendar if necessary.

Changing Layout

Changing Background

Adding Photos

Swapping Positions of Photos

Replacing Photos

Changing Position, Angle and Size of Photos

Cropping Photos

Framing Photos

Printing Dates on Photos

Adding Text to Photos

Setting Calendar Display

Setting Holidays

Important

The edit information will be discarded if you exit Easy-PhotoPrint EX without saving the edited

calendar. It is recommended that you save the item if you want to edit it again.

Saving

Note
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See Help for details on the Edit screen.
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Printing

Printing

1. Click Print Settings.

The Print Settings screen appears.

2. Set the following items according to the printer and paper to be used:

Printer

Media Type

Copies

Paper Source

Print Quality

Borderless Printing

Note

The media types may vary depending on the printer and the paper size.

Duplex Printing appears if the selected printer and media type support duplex printing. Select

this checkbox to print on both sides of the paper.

Automatic appears if you select the Duplex Printing checkbox after selecting a printer that

supports automatic duplex printing and media type that supports duplex printing. Select this
checkbox to print on both sides of the paper automatically.

The paper sources may vary depending on the printer and the media type.

You can set a custom print quality level in the Print Quality Settings dialog box. To display the

Print Quality Settings dialog box, select Custom for Print Quality and click Quality Settings....

You can specify the print range and the amount of extension for borderless printing in the Print

Settings dialog box. To display the Print Settings dialog box, click Advanced....

3. Click Print.
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Note

See Help for details on the Print Settings screen.
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Printing Stickers

You can print your favorite photos on compatible sticker sheets.

Steps

1. Starting Easy-PhotoPrint EX

2. Selecting the Paper and Layout

3. Selecting a Photo

4. Editing

5. Printing

Try This

Correcting and Enhancing Photos

Adding Photos

Swapping Positions of Photos

Replacing Photos

Changing Position, Angle and Size of Photos

Cropping Photos

Framing Photos

Adding Text to Photos

Saving

Opening Saved Files

Questions and Answers

How Can I Move (or Copy) the Saved File?
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Starting Easy-PhotoPrint EX

Starting Easy-PhotoPrint EX

1. From the Start menu, select (All) Programs > Canon Utilities > Easy-PhotoPrint EX
> Easy-PhotoPrint EX.

Easy-PhotoPrint EX starts and Menu appears.
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Selecting the Paper and Layout

Selecting the Paper and Layout

1. Click Stickers from Menu.

The Page Setup screen appears.

2. Set the following items in the General Settings section:

Paper Size

Orientation

Print date

Use the same image in all frames

Note

Paper sizes other than Photo Stickers cannot be selected.

Select the Use the same image in all frames checkbox to use the same image in all the

frames on the page.
You can customize the date (position, size, color, etc.) in the Date Settings dialog box. To

display the Date Settings dialog box, select the Print date checkbox and click Date Settings....

Note

See Help for details on the Page Setup screen.
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Selecting a Photo

Selecting a Photo

1. Click Select Images.

The Select Images screen appears.

2. Select the folder that contains the image you want to print from the folder tree area.

The images in the folder will be displayed as thumbnails (miniatures).

3. Select the image(s) you want to print and click  (Import to Inside Pages).

The selected image(s) are displayed in the selected image area.

You can also select the image(s) you want to print by dragging them into the selected image area.

Note

To delete an image in the selected image area, select the image you want to delete and click 

 (Delete Imported Image).

To delete all images from the selected image area, click  (Delete All Imported Images).

Note

See Help for details on the Select Images screen.
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Editing

1. Click Edit.

The Edit screen appears.

2. Edit the stickers if necessary.

Adding Photos

Swapping Positions of Photos

Replacing Photos

Changing Position, Angle and Size of Photos

Cropping Photos

Printing Dates on Photos

Adding Text to Photos

Important

The edit information will be discarded if you exit Easy-PhotoPrint EX without saving the edited

stickers. It is recommended that you save the item if you want to edit it again.

Saving

Note

See Help for details on the Edit screen.
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Printing

Printing

1. Click Print Settings.

The Print Settings screen appears.

2. Set the following items according to the printer and paper to be used:

Printer

Media Type

Copies

Paper Source

Print Quality

Borderless Printing

Note

The media types may vary depending on the printer and the paper size.

The paper sources may vary depending on the printer and the media type.

You can set a custom print quality level in the Print Quality Settings dialog box. To display the

Print Quality Settings dialog box, select Custom for Print Quality and click Quality Settings....

You can adjust the printing position in the Adjust Print Position dialog box. To display the Adjust

Print Position dialog box, click Print Position....

You can specify the print range and the amount of extension for borderless printing in the Print

Settings dialog box. To display the Print Settings dialog box, click Advanced....

3. Click Print.

Note

See Help for details on the Print Settings screen.
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Printing Layout

You can add text to your favorite photos and print them in a variety of layouts.

Steps

1. Starting Easy-PhotoPrint EX

2. Selecting the Paper and Layout

3. Selecting a Photo

4. Editing

5. Printing

Try This

Correcting and Enhancing Photos

Changing Layout

Adding Photos

Swapping Positions of Photos

Replacing Photos

Changing Position, Angle and Size of Photos

Cropping Photos

Printing Dates on Photos

Adding Text to Photos

Saving

Opening Saved Files

Questions and Answers

How Can I Move (or Copy) the Saved File?
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Easy-PhotoPrint EX

Starting Easy-PhotoPrint EX

1. From the Start menu, select (All) Programs > Canon Utilities > Easy-PhotoPrint EX
> Easy-PhotoPrint EX.

Easy-PhotoPrint EX starts and Menu appears.
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Selecting the Paper and Layout

Selecting the Paper and Layout

1. Click Layout Print from Menu.

The Page Setup screen appears.

2. Set the following items in the General Settings section:

Paper Size

Orientation

Print date

Note

See Help on the paper size that can be selected.

You can customize the date (position, size, color, etc.) in the Date Settings dialog box. To

display the Date Settings dialog box, select the Print date checkbox and click Date Settings....

3. Select a layout from Layouts.

Note

The layouts may vary depending on the Orientation.

Note

See Help for details on the Page Setup screen.
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Selecting a Photo

Selecting a Photo

1. Click Select Images.

The Select Images screen appears.

2. Select the folder that contains the image you want to print from the folder tree area.

The images in the folder will be displayed as thumbnails (miniatures).

3. Select the image(s) you want to print and click  (Import to Inside Pages).

The selected image(s) are displayed in the selected image area.

You can also select the image(s) you want to print by dragging them into the selected image area.

Note

To delete an image in the selected image area, select the image you want to delete and click 

 (Delete Imported Image).

To delete all images from the selected image area, click  (Delete All Imported Images).

Note

See Help for details on the Select Images screen.
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Editing

1. Click Edit.

The Edit screen appears.

2. Edit the layout if necessary.

Changing Layout

Adding Photos

Swapping Positions of Photos

Replacing Photos

Changing Position, Angle and Size of Photos

Cropping Photos

Printing Dates on Photos

Adding Text to Photos

Important

The edit information will be discarded if you exit Easy-PhotoPrint EX without saving the edited layout.

It is recommended that you save the item if you want to edit it again.

Saving

Note

See Help for details on the Edit screen.
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Printing

1. Click Print Settings.

The Print Settings screen appears.

2. Set the following items according to the printer and paper to be used:

Printer

Media Type

Copies

Paper Source

Print Quality

Borderless Printing

Note

The media types may vary depending on the printer and the paper size.

Duplex Printing appears if the selected printer and media type support duplex printing. Select

this checkbox to print on both sides of the paper.

Automatic appears if you select the Duplex Printing checkbox after selecting a printer that

supports automatic duplex printing and media type that supports duplex printing. Select this
checkbox to print on both sides of the paper automatically.

The paper sources may vary depending on the printer and the media type.

You can set a custom print quality level in the Print Quality Settings dialog box. To display the

Print Quality Settings dialog box, select Custom for Print Quality and click Quality Settings....

Select the Borderless Printing checkbox to print borderless photos.
You can specify the print range and the amount of extension for borderless printing in the Print

Settings dialog box. To display the Print Settings dialog box, click Advanced....

3. Click Print.
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Note

See Help for details on the Print Settings screen.
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Enhancing Photos

Correcting and Enhancing Photos

You can correct and enhance images.

Click  (Correct/Enhance Images) in the Select Images or Edit screen, or in the Layout/Print screen of

Photo Print. You can make the following corrections and enhancements in the Correct/Enhance Images

window.

Important

For Photo Print, if you select Enable ICC Profile in the Advanced tab of the Preferences dialog box,

you cannot correct/enhance images.

Note

See "Correct/Enhance Images Window " for details on the Correct/Enhance Images window.

Auto Photo Fix

This function will automatically analyze the captured scene and apply suitable corrections.

Using the Auto Photo Fix Function

Red-Eye Correction Function

You can correct red eyes caused by a camera flash.

Using the Red-Eye Correction Function

Face Brightener Function

You can brighten dark faces caused by bright background.

Using the Face Brightener Function

Face Sharpener Function

You can sharpen out-of-focus faces in a photo.

Using the Face Sharpener Function

Digital Face Smoothing Function

You can enhance skin beautifully by removing blemishes and wrinkles.

Using the Digital Face Smoothing Function

Blemish Remover Function

You can remove moles.

Using the Blemish Remover Function

Image Adjustment

You can adjust brightness and contrast or sharpen the entire image.

You can also blur the outline of the subjects or remove the base color.
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Adjusting Images
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Enhancing Photos > Using the Auto Photo Fix Function

Using the Auto Photo Fix Function

Apply optimum corrections automatically to the photos used for an album, calendar, etc.

Important

The Auto Photo Fix function is not available for Photo Print. Photo Print allows you to automatically

apply suitable corrections to all photos when printing, by selecting Auto Photo Fix in Color correction

for printing on the Advanced tab of the Preferences dialog box. To display the Preferences dialog

box, click  (Settings) in the Layout/Print screen or select Preferences... from the File menu.

Once image is corrected with Auto Photo Fix and saved, it cannot be corrected again with Auto
Photo Fix.

Also, Auto Photo Fix may not be available for images edited using an application, digital camera,

etc. manufactured by other companies.

1. Select photos in the Select Images screen, then click  (Correct/Enhance
Images).

The Correct/Enhance Images window appears.

Note

You can also display the Correct/Enhance Images window by clicking  (Correct/Enhance

Images) in the Layout/Print or Edit screen. In that case, only the image displayed in Preview

can be corrected/enhanced.
See "Correct/Enhance Images Window " for details on the Correct/Enhance Images window.

2. Select the image you want to correct from the list displayed in the lower part of the
Correct/Enhance Images window.

The image appears in Preview.
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Note

If only one image is selected, the thumbnail does not appear below Preview.

3. Make sure that Auto is selected.

4. Click Auto Photo Fix, then click OK.

The entire photo is corrected automatically and the  (Correction/Enhancement) mark appears on
the upper left of the image.

Note

Click  (Compare) to display the images before and after the correction side by side so that

you can compare and check the result.

Click Reset Selected Image to undo the correction operation.

If you want to apply the correction to all the selected images at once, select the Apply to all

images checkbox.
Select the Prioritize Exif Info checkbox to apply corrections primarily based on the settings

made at the time of shooting.

Deselect this checkbox to apply corrections based on the image analysis results. It is

recommended that you normally select this setting.

5. Click Save Selected Image or Save All Corrected Images.

You can save corrected images as new files.

Note

To save only the image you like, click Save Selected Image. To save all images, click Save All

Corrected Images.

Only JPEG/Exif file format is available for corrected images.

6. Click Exit.

Important

The corrections will be lost if you exit before saving corrected images.
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Enhancing Photos > Using the Red-Eye Correction Function

Using the Red-Eye Correction Function

You can correct red eyes caused by a camera flash.

You can perform the Red-Eye Correction function either automatically or manually.

Note

Photo Print allows you to automatically correct red eyes when printing. To correct automatically,

select Enable Auto Photo Fix in Color correction for printing on the Advanced tab of the Preferences

dialog box and select the Enable Red-Eye Correction checkbox.

1. Select photos in the Select Images screen, then click  (Correct/Enhance
Images).

The Correct/Enhance Images window appears.

Note

You can also display the Correct/Enhance Images window by clicking  (Correct/Enhance

Images) in the Layout/Print or Edit screen. In that case, only the image displayed in Preview

can be corrected/enhanced.
See "Correct/Enhance Images Window " for details on the Correct/Enhance Images window.

2. Select the image you want to correct from the list displayed in the lower part of the
Correct/Enhance Images window.

The image appears in Preview.

Note

If only one image is selected, the thumbnail does not appear below Preview.
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Auto Correction

3. Make sure that Auto is selected.

4. Click Red-Eye Correction.

5. Click OK.

Red eyes are corrected and the  (Correction/Enhancement) mark appears on the upper left of

the image.

Important

Areas other than the eyes may be corrected depending on the image.

Note

Click  (Compare) to display the images before and after the correction side by side so that

you can compare and check the result.

Click Reset Selected Image to undo the correction operation.

If you want to apply the correction to all the selected images at once, select the Apply to all

images checkbox.

Manual Correction

3. Click Manual, then click Correct/Enhance.

4. Click Red-Eye Correction.

Note

Effect levels can be changed using the slider below Red-Eye Correction.

Move the cursor over the image. The shape of the cursor changes to  (Paintbrush).

5. Drag to select the red area you want to correct, then click OK that appears over the
image.
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Red eye is corrected and the  (Correction/Enhancement) mark appears on the upper left of the

image.

Note

Click Undo to undo the preceding correction operation.

6. Click Save Selected Image or Save All Corrected Images.

You can save corrected images as new files.

Note

To save only the image you like, click Save Selected Image. To save all images, click Save All

Corrected Images.

Only JPEG/Exif file format is available for corrected images.

7. Click Exit.

Important

The corrections will be lost if you exit before saving corrected images.
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Enhancing Photos > Using the Face Brightener Function

Using the Face Brightener Function

You can brighten dark faces caused by bright background.

Note

You can brighten dark photos caused by bright background automatically by selecting Auto Photo
Fix.

If the correction had not been made sufficiently, applying Face Brightener function is recommended.
Using the Auto Photo Fix Function

1. Select photos in the Select Images screen, then click  (Correct/Enhance
Images).

The Correct/Enhance Images window appears.

Note

You can also display the Correct/Enhance Images window by clicking  (Correct/Enhance

Images) in the Layout/Print or Edit screen. In that case, only the image displayed in Preview

can be corrected/enhanced.
See "Correct/Enhance Images Window " for details on the Correct/Enhance Images window.

2. Select the image you want to correct from the list displayed in the lower part of the
Correct/Enhance Images window.

The image appears in Preview.

Note

If only one image is selected, the thumbnail does not appear below Preview.

3. Click Manual, then click Correct/Enhance.
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4. Click Face Brightener.

Note

Effect levels can be changed using the slider below Face Brightener.

Move the cursor over the image. The shape of the cursor changes to  (Cross).

5. Drag to select the area you want to correct, then click OK that appears over the
image.

The entire image is corrected so that the selected area containing the face becomes brighter, and

the  (Correction/Enhancement) mark appears on the upper left of the image.

Note

You can also drag to rotate the selected area.

Click Undo to undo the preceding correction operation.

6. Click Save Selected Image or Save All Corrected Images.

You can save corrected images as new files.

Note

To save only the image you like, click Save Selected Image. To save all images, click Save All

Corrected Images.

Only JPEG/Exif file format is available for corrected images.

7. Click Exit.

Important

The corrections will be lost if you exit before saving corrected images.
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Enhancing Photos > Using the Face Sharpener Function

Using the Face Sharpener Function

You can sharpen out-of-focus faces in a photo.

You can perform the Face Sharpener function either automatically or manually.

1. Select photos in the Select Images screen, then click  (Correct/Enhance
Images).

The Correct/Enhance Images window appears.

Note

You can also display the Correct/Enhance Images window by clicking  (Correct/Enhance

Images) in the Layout/Print or Edit screen. In that case, only the image displayed in Preview

can be corrected/enhanced.
See "Correct/Enhance Images Window " for details on the Correct/Enhance Images window.

2. Select the image you want to correct from the list displayed in the lower part of the
Correct/Enhance Images window.

The image appears in Preview.

Note

If only one image is selected, the thumbnail does not appear below Preview.

Auto Correction

3. Make sure that Auto is selected.
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4. Click Face Sharpener.

Note

Effect levels can be changed using the slider below Face Sharpener.

5. Click OK.

The face is sharpened and the  (Correction/Enhancement) mark appears on the upper left of the

image.

Note

Click  (Compare) to display the images before and after the correction side by side so that

you can compare and check the result.

Click Reset Selected Image to undo the correction operation.

If you want to apply the correction to all the selected images at once, select the Apply to all

images checkbox.

Manual Correction

3. Click Manual, then click Correct/Enhance.

4. Click Face Sharpener.

Note

Effect levels can be changed using the slider below Face Sharpener.

Move the cursor over the image. The shape of the cursor changes to  (Cross).

5. Drag to select the area you want to correct, then click OK that appears over the
image.
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The facial area in and around the selected area is sharpened and the  (Correction/

Enhancement) mark appears on the upper left of the image.

Note

You can also drag to rotate the selected area.

Click Undo to undo the preceding correction operation.

6. Click Save Selected Image or Save All Corrected Images.

You can save corrected images as new files.

Note

To save only the image you like, click Save Selected Image. To save all images, click Save All

Corrected Images.

Only JPEG/Exif file format is available for corrected images.

7. Click Exit.

Important

The corrections will be lost if you exit before saving corrected images.
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Enhancing Photos > Using the Digital Face Smoothing Function

Using the Digital Face Smoothing Function

You can enhance skin beautifully by removing blemishes and wrinkles.

You can perform the Digital Face Smoothing function either automatically or manually.

1. Select photos in the Select Images screen, then click  (Correct/Enhance
Images).

The Correct/Enhance Images window appears.

Note

You can also display the Correct/Enhance Images window by clicking  (Correct/Enhance

Images) in the Layout/Print or Edit screen. In that case, only the image displayed in Preview

can be corrected/enhanced.
See "Correct/Enhance Images Window " for details on the Correct/Enhance Images window.

2. Select the image you want to enhance from the list displayed in the lower part of the
Correct/Enhance Images window.

The image appears in Preview.

Note

If only one image is selected, the thumbnail does not appear below Preview.

Auto Enhancement

3. Make sure that Auto is selected.
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4. Click Digital Face Smoothing.

Note

Effect levels can be changed using the slider below Digital Face Smoothing.

5. Click OK.

Skin is enhanced beautifully and the  (Correction/Enhancement) mark appears on the upper left

of the image.

Note

Click  (Compare) to display the images before and after the enhancement side by side so

that you can compare and check the result.

Click Reset Selected Image to undo the enhancement operation.

If you want to apply the enhancement to all the selected images at once, select the Apply to all

images checkbox.

Manual Enhancement

3. Click Manual, then click Correct/Enhance.

4. Click Digital Face Smoothing.

Note

Effect levels can be changed using the slider below Digital Face Smoothing.

Move the cursor over the image. The shape of the cursor changes to  (Cross).

5. Drag to select the area you want to enhance, then click OK that appears over the
image.
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Skin in and around the selected area is enhanced beautifully and the  (Correction/Enhancement)

mark appears on the upper left of the image.

Note

You can also drag to rotate the selected area.

Click Undo to undo the preceding enhancement operation.

6. Click Save Selected Image or Save All Corrected Images.

You can save enhanced images as new files.

Note

To save only the image you like, click Save Selected Image. To save all images, click Save All

Corrected Images.
Only JPEG/Exif file format is available for enhanced images.

7. Click Exit.

Important

The enhancements will be lost if you exit before saving enhanced images.
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Enhancing Photos > Using the Blemish Remover Function

Using the Blemish Remover Function

You can remove moles.

1. Select photos in the Select Images screen, then click  (Correct/Enhance
Images).

The Correct/Enhance Images window appears.

Note

You can also display the Correct/Enhance Images window by clicking  (Correct/Enhance

Images) in the Layout/Print or Edit screen. In that case, only the image displayed in Preview

can be corrected/enhanced.
See "Correct/Enhance Images Window " for details on the Correct/Enhance Images window.

2. Select the image you want to enhance from the list displayed in the lower part of the
Correct/Enhance Images window.

The image appears in Preview.

Note

If only one image is selected, the thumbnail does not appear below Preview.

3. Click Manual, then click Correct/Enhance.

4. Click Blemish Remover.
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Note

Move the cursor over the image. The shape of the cursor changes to  (Cross).

5. Drag to select the area you want to enhance, then click OK that appears over the
image.

Moles in and around the selected area are removed and the  (Correction/Enhancement) mark

appears on the upper left of the image.

Note

Click Undo to undo the preceding enhancement operation.

6. Click Save Selected Image or Save All Corrected Images.

You can save enhanced images as new files.

Note

To save only the image you like, click Save Selected Image. To save all images, click Save All

Corrected Images.

Only JPEG/Exif file format is available for enhanced images.

7. Click Exit.

Important

The enhancements will be lost if you exit before saving enhanced images.
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Enhancing Photos > Adjusting Images

Adjusting Images

You can make fine adjustments to the overall brightness, contrast, etc. of images.

1. Select photos in the Select Images screen, then click  (Correct/Enhance
Images).

The Correct/Enhance Images window appears.

Note

You can also display the Correct/Enhance Images window by clicking  (Correct/Enhance

Images) in the Layout/Print or Edit screen. In that case, only the image displayed in Preview

can be corrected/enhanced.
See "Correct/Enhance Images Window " for details on the Correct/Enhance Images window.

2. Select the image you want to adjust from the list displayed in the lower part of the
Correct/Enhance Images window.

The image appears in Preview.

Note

If only one image is selected, the thumbnail does not appear below Preview.

3. Click Manual, then click Adjust.

4. Move the slider of the item you want to adjust and set the effect level.

The following adjustments are available:

Brightness

Contrast
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Sharpness

Blur

Show-through Removal

Note

Click Defaults to reset all adjustments.

5. Click Save Selected Image or Save All Corrected Images.

You can save adjusted images as new files.

Note

To save only the image you like, click Save Selected Image. To save all images, click Save All

Corrected Images.

Only JPEG/Exif file format is available for adjusted images.

6. Click Exit.

Important

The adjustments will be lost if you exit before saving adjusted images.
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Enhancing Photos > Correct/Enhance Images Window

Correct/Enhance Images Window

You can correct/enhance images in this window.

To display the Correct/Enhance Images window, click  (Correct/Enhance Images) in the Select

Images or Edit screen, or in the Layout/Print screen of Photo Print.

(1)Toolbar

Toolbar

 (Zoom In/Zoom Out)

Displays the enlarged or reduced preview of the page.

 (Full Screen)

Displays the entire image in Preview.

 (Compare)

Displays the Compare Images window. You can compare the images before and after the correction/

enhancement side by side.
The image before the correction/enhancement is displayed on the left, and the image after the

correction/enhancement is displayed on the right.
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(2)Task Area

Available tasks and settings may vary between the Auto and Manual tabs.

Click Auto or Manual to display the corresponding tab.

Auto Tab

Select to correct automatically.

Auto Photo Fix

Applies automatic corrections suitable for photos.

Important

The Auto Photo Fix function is not available for Photo Print. Photo Print allows you to

automatically apply suitable corrections to all photos when printing. Select this option in Color

correction for printing on the Advanced tab of the Preferences dialog box. To display the

Preferences dialog box, click  (Settings) in the Layout/Print screen or select Preferences...

from the File menu.

Prioritize Exif Info

Select this checkbox to apply corrections primarily based on the settings made at the time of
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shooting.
Deselect this checkbox to apply corrections based on the image analysis results. It is

recommended that you normally select this setting.

Note

Exif is a standard format for embedding various shooting data in digital camera images
(JPEG).

For Photo Print, you can apply suitable corrections based on Exif information automatically

by selecting Enable Auto Photo Fix in Color correction for printing on the Advanced tab of the

Preferences dialog box and selecting the Prioritize Exif Info checkbox.

Red-Eye Correction

Corrects red eyes.

Note

For Photo Print, you can also correct red eyes by selecting Enable Auto Photo Fix in Color
correction for printing on the Advanced tab of the Preferences dialog box and selecting the

Enable Red-Eye Correction checkbox.

Face Sharpener

Sharpens out-of-focus faces.

You can adjust the effect level using the slider.

Digital Face Smoothing

Enhances skin beautifully by removing blemishes and wrinkles.
You can adjust the effect level using the slider.

Apply to all images

Automatically corrects all the images displayed in the list.

OK

Applies the selected effect to the selected image or all images.

Reset Selected Image

Cancels all corrections and enhancements applied to the selected image.

Save Selected Image

Saves the selected image in the list that applied corrections and enhancements.

Save All Corrected Images

Saves all the images that applied corrections and enhancements displayed in the list.

Exit

Click to close the Correct/Enhance Images window.

Manual Tab

Select to correct manually.

Use Adjust to adjust brightness and contrast, or to sharpen the entire image.

Use Correct/Enhance to correct/enhance specific areas.

Adjust
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Brightness

Adjusts the overall image brightness.

Move the slider to the left to darken and right to brighten the image.

Contrast

Adjusts the contrast of the image. Adjust the contrast when the image is flat due to lack of contrast.

Move the slider to the left to decrease and right to increase the contrast of the image.

Sharpness

Emphasizes the outline of the subjects to sharpen the image. Adjust the sharpness when the photo

is out of focus or text is blurred.

Move the slider to the right to sharpen the image.

Blur

Blurs the outline of the subjects to soften the image.
Move the slider to the right to soften the image.

Show-through Removal

Removes show-through of text from the reverse side or removes the base color. Adjust the show-

through level to prevent text on the reverse side of thin document or the base color of the document

from appearing on the image.
Move the slider to the right to increase the show-through removal effect.

Defaults

Resets each adjustment (brightness, contrast, sharpness, blur, and show-through removal).

Reset Selected Image

Cancels all adjustments applied to the selected image.

Save Selected Image

Saves the selected image in the list that applied adjustments.

Save All Corrected Images

Saves all the images that applied adjustments displayed in the list.

Exit

Click to close the Correct/Enhance Images window.

Correct/Enhance
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Red-Eye Correction

Corrects red eyes.
You can specify the area you want to apply the effect to. You can adjust the effect level using the

slider.

Note

For Photo Print, red eyes are automatically corrected when Enable Auto Photo Fix is selected in

Color correction for printing on the Advanced tab of the Preferences dialog box and the Enable

Red-Eye Correction checkbox is selected. To disable the automatic correction, deselect the
checkbox.

Face Brightener

Corrects the entire image so that the selected facial area is brightened.

You can adjust the effect level using the slider.

Face Sharpener

Sharpens out-of-focus faces.
You can specify the area you want to apply the effect to. You can adjust the effect level using the

slider.

Digital Face Smoothing

Enhances skin beautifully by removing blemishes and wrinkles.
You can specify the area you want to apply the effect to. You can adjust the effect level using the

slider.

Blemish Remover

Removes moles.
You can specify the area you want to apply the effect to.

OK

Applies the selected effect to the specified area.

Undo

Cancels the latest correction/enhancement.

Reset Selected Image

Cancels all corrections and enhancements applied to the selected image.

Save Selected Image

Saves the selected image in the list that applied corrections and enhancements.

Save All Corrected Images

Saves all the images that applied corrections and enhancements displayed in the list.
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Exit

Click to close the Correct/Enhance Images window.
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Questions and Answers

How Can I Move (or Copy) the Saved File?

Which Side of the Displayed Image Does the Printing Start from?

How Do I Print with Even Margins?

What Is "C1" or "C4"?
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> How Can I Move (or Copy) the Saved File?

How Can I Move (or Copy) the Saved File?

If you want to move (or copy) a file created and saved with Easy-PhotoPrint EX from one folder to another,

you need to move (or copy) the folder that was automatically created when originally saving that file as

well.

For example, when you save a file named "MyAlbum.el1," a folder named "MyAlbum.el1.Data" is

automatically created in the same folder that contains the "MyAlbum.el1" file. If you want to move (or copy)
the "MyAlbum.el1" file to another folder, move (or copy) the "MyAlbum.el1.Data" folder as well. The

"MyAlbum.el1.Data" folder contains the photos used in the album.

Note

The icons may vary depending on the items.

Important

Do not change the Data folder name; otherwise you will not be able to display the photos you edited
with Easy-PhotoPrint EX.
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> Which Side of the Displayed Image Does the Printing Start from?

Which Side of the Displayed Image Does the Printing Start
from?

As shown below, printing starts from the left side of the image displayed in the Layout/Print screen.

Outputs the paper in the direction as the arrow indicates.

See your printer manual for details on how to load paper (to print on the front/back, etc.).
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> How Do I Print with Even Margins?

How Do I Print with Even Margins?

When you print on a bordered layout, the margins on the left and right or the top and bottom may become

wider than the other, depending on the image and printer.

To always print with even margins, select the Always crop images when selecting a layout with margins

checkbox on the Advanced tab of the Preferences dialog box.

To display the Preferences dialog box, click  (Settings) in the Layout/Print screen or select

Preferences... from the File menu.

Crop the photo to apply even margins individually.

Cropping Photos (Photo Print)

Note

This setting is available for Photo Print only.

Page top

Page 218 of 949 pagesHow Do I Print with Even Margins?



Advanced Guide  > Printing from a Computer  > Printing with the Bundled Application Software > Questions and Answers
> What Is "C1" or "C4"?

What Is "C1" or "C4"?

When an album is printed, labels such as "C1" and "C4" are printed as page numbers.

The "C1" and "C4" represent the front cover and back cover, respectively.

C1: Front cover

C2: Inside the front cover

C3: Inside the back cover

C4: Back cover
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Photo Print Settings

Printing Vivid Photos

Reducing Photo Noise

Cropping Photos (Photo Print)

Printing Dates on Photos (Photo Print)

Printing Multiple Photos on One Page

Printing an Index

Printing ID Photos (ID Photo Print)

Printing Photo Information

Saving Photos

Opening Saved Files
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Printing Vivid Photos

Printing Vivid Photos

Select the Vivid Photo checkbox in the Select Paper screen to boost the colors in a photo before printing.

Important

This function is available only with a printer that supports Vivid Photo.

This function is not available when Enable ICC Profile is selected on the Advanced tab of the

Preferences dialog box.

Note

Even if you select the Vivid Photo checkbox, this effect applies only to the print result. The original

image or preview image will not be affected.
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Reducing Photo Noise

Reducing Photo Noise

When a photo is taken in a dark location such as night scene using digital camera, noise may appear in

the image.

Select the Photo Noise Reduction checkbox in the Select Paper screen to reduce noise in the image and

make the printed photos more vivid.

Important

This function is not available when Enable ICC Profile is selected on the Advanced tab of the

Preferences dialog box.

Note

When the noise is severe, change Normal to Strong.

The noise reduction effect applies only to the print result. The original image or preview image will
not be affected.
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Cropping Photos (Photo Print)

Cropping Photos (Photo Print)

Cropping a photo is the act of removing the unnecessary portions of the photo by selecting the

necessary portions.

Click  (Crop Image) in the Layout/Print screen or double-click the preview image.

Move the white frame to the portion to print and click OK.

Note

To move the cropping area, place the cursor within the white frame and drag it. Drag the white lines

to enlarge/reduce the cropping area.

Select the The Rule of Thirds checkbox to display white broken lines. To create a balanced

composition, drag any of the intersecting points (white squares) or white broken lines over the main

subject of the photo.
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The cropping effect applies only to the print result. The original image will not be cropped.

See Help for details on the Crop window.
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Printing Dates on Photos (Photo Print)

Printing Dates on Photos (Photo Print)

To print the date the photo was taken on the photo, click  (Date Settings) in the Layout/Print screen,

then select the Print date checkbox in the Date Settings dialog box.

Note

The date is displayed in the short date format (mm/dd/yyyy, etc.) specified in your operating system.

See Help for details on setting dates.
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Printing Multiple Photos on One Page

Printing Multiple Photos on One Page

You can print multiple photos on one page by selecting a multiple-photo layout in the Layout/Print screen.

Note

See the following section for details on how to select photos.
Selecting a Photo

The available number of photos and layout may vary depending on the media type.

Photos are arranged in the following order.
Example: Borderless (x4)

You can change the printing order in Printing Order on the Print tab of the Preferences dialog box.

You can select the printing order from By Date, By Name and By Selection.

To display the Preferences dialog box, click  (Settings) or select Preferences... from the File

menu.
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Printing an Index

Printing an Index

You can print an index of selected photos. An index print shows the thumbnails of the photos in one

page. It is convenient for managing your photos.

To print an index, select Index from the layouts in the Layout/Print screen.

Important

Index print will be disabled if you select any of the following paper sizes.

- Credit Card

You can print up to 80 images on one page.

Note

See the following section for details on how to select photos.

Selecting a Photo

Photos are arranged in the following order.
Example: Index (x20)

You can change the printing order in Printing Order on the Print tab of the Preferences dialog box.

You can select the printing order from By Date, By Name, and By Selection.

To display the Preferences dialog box, click  (Settings) or select Preferences... from the File

menu.
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Printing ID Photos (ID Photo Print)

Printing ID Photos (ID Photo Print)

You can print a variety of ID photos.

Important

The photo may not qualify as an official ID photo depending on its use.

For details, contact the party to whom you will be submitting the photo.

To print ID photos, select 4"x6" 10x15cm for Paper Size in the Select Paper screen, and select a layout of

the ID photo from the layouts in the Layout/Print screen.

Note

See the following section for details on how to select photos.

Selecting a Photo

Photos are arranged in the following order.

Example: ID Photo 3.5x4.5cm

You can change the printing order in Printing Order on the Print tab of the Preferences dialog box.

You can select the printing order from By Date, By Name, and By Selection.

To display the Preferences dialog box, click  (Settings) or select Preferences... from the File

menu.
ID photos can only be printed on 4"x6" 10x15cm paper.
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Printing Photo Information

Printing Photo Information

You can print the photo and the Exif information side by side.

To print them, select Letter 8.5"x11" or A4 for Paper Size in the Select Paper screen, and select Captured

Info from the layouts in the Layout/Print screen.

Note

See the following section for details on how to select photos.

Selecting a Photo

This function is available only on paper sizes Letter 8.5"x11" and A4.
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Saving Photos

Saving Photos

You can save edited photos. The information of cropping and layout can be saved.

Click Save in the Layout/Print screen.

When the Save As dialog box appears, specify the save location and file name, then click Save.

Important

If you edit a saved file and save it again, the file will be overwritten.

To save a file again with a new name or to a different location, select Save As... from the File menu

and save.

Note

Save will not be displayed in the Select Images or Select Paper screen.
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Opening Saved Files

Opening Saved Files

You can open files created with Easy-PhotoPrint EX.

1. Click Library from Menu.

The Open dialog box appears.

You can check files created and saved with Easy-PhotoPrint EX by icon view (only for Windows Vista)

or thumbnail view.

Important

When using 64bit Edition of Windows Vista or Windows XP, the contents of files cannot be

displayed on Explorer.

2. Select the file you want to open and click Open.

The Layout/Print screen appears.

Note

Easy-PhotoPrint EX supports the following file format (extension).
- Easy-PhotoPrint EX Photo Print file (.el6)

3. Edit the file if necessary.

Note

You can open files created with Easy-PhotoPrint EX with the following methods, besides from
Library in Menu.

- Double-click or click the file.

- From the File menu, click Open..., then select the file you want to edit.
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You can also open a recently used file by clicking the file name shown in the File menu.
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Other Settings

Changing Layout

Changing Background

Adding Photos

Swapping Positions of Photos

Replacing Photos

Changing Position, Angle and Size of Photos

Cropping Photos

Framing Photos

Printing Dates on Photos

Attaching Comments to Photos

Adding Text to Photos

Saving

Setting Holidays

Setting Calendar Display

Opening Saved Files
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Changing Layout

Changing Layout

You can change the layout of each page separately.

Select the page you want to change the layout of in the Edit screen, then click  (Change Layout).

Select the layout you want to use in the Change Layout dialog box and click OK.

Album

Important

If the new layout has a different number of frames per page from the current layout, the following will

happen:

If the number of layout

frames is increased

: Images will move from the subsequent pages to fill all the frames
in the new layout.

If the number of layout

frames is decreased

: Pages with the new layout will be added until all the images on the

pages with the current layout can be fitted.

If you change the current layout for the front or back cover to one that has fewer layout frames, any

image that does not fit in the new layout will be deleted, starting with the last image that was added

to the former layout page.

Note

The layouts that can be selected may vary depending on the Paper Size, Orientation, or the type of

page selected (front cover, inside pages or back cover).

Select the Apply to all pages checkbox to change the layouts of all pages to the one you newly

selected.

Calendar
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Important

The layouts of all pages are changed to the selected layout.

All images that do not fit in the new layout will be collected on the last page.

Note

The layouts that can be selected may vary depending on the Paper Size and Orientation.

Layout Print

Important

If the new layout has a different number of frames per page from the current layout, the following will

happen:

If the number of layout

frames is increased

: Images will move from the subsequent pages to fill all the frames

in the new layout.

If the number of layout

frames is decreased

: Pages with the new layout will be added until all the images on the

pages with the current layout can be fitted.

Note

The layouts that can be selected may vary depending on the Paper Size and Orientation.

Select the Apply to all pages checkbox to change the layouts of all pages to the one you newly

selected.
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Changing Background

Changing Background

You can change the background of each page.

Important

You cannot change the background of the Photo Print, Stickers, and Layout Print.

Click Background... in the Page Setup screen or select the page you want to change the background of in

the Edit screen, then click  (Change Background).

Note

The screens for Album printing are used as examples in the following descriptions. The screens

may vary depending on what you create.

Select the type of background you want to use in the Change Background dialog box.

When Select from samples is Selected

Select the image you want to use from Samples and click OK.

Note

Select from samples will be displayed only if Album has been selected.

Various backgrounds are available on our website besides those saved in the application.
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Click Search backgrounds... to access the Canon website from which you can download additional
materials for free.

Internet connection is required to access the website. Internet connection fees apply.

This function may not be available in some regions.

Exit Easy-PhotoPrint EX before installing backgrounds.

When Single color is Selected

Select the color you want to use from Standard color or Custom color and click OK.

When Image file is Selected

Set Image File Path and Image Layout, then click OK.
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Note

See Help for details on how to set the background in the Change Background dialog box.
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Photos

Adding Photos

You can add images to pages.

Select the page you want to add photos in the Edit screen, then click  (Add Image).

Note

The screens for Album printing are used as examples in the following descriptions. The screens

may vary depending on what you create.

Select the folder containing the image you want to add from the folder tree area on the left of the Add

Image dialog box, and select the image you want to add from the thumbnail window on the right.

Note

Click an image to select it (background turns blue) or deselect it (background turns white). You can

also select multiple images.

Select an option for Add to and click OK.

Important

You can add up to 20 images at one time to a single page.

Up to 99 of the same images can be added to all pages combined.

You cannot add two or more of the same image at one time. Add it one at a time.

When the number of pages increases due to added images, you cannot add images beyond page

400.

Note

In the Add Image dialog box, you can select all images at one time or change the display size and

order of the thumbnails. See Help for details.
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Swapping Positions of Photos

Swapping Positions of Photos

You can swap the positions of images.

Click  (Swap Image Positions) in the Edit screen.

Note

The screens for Album printing are used as examples in the following descriptions. The screens

may vary depending on what you create.

Select the target and source images you want to swap, then click Swap.

When you finish swapping all images you want to swap, click Back to Edit.
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Replacing Photos

Replacing Photos

You can replace an image with another image.

Select the image you want to replace in the Edit screen, then click  (Replace Selected Image).

Select the folder containing the image you want to replace with from the folder tree area on the left of the

Replace Image dialog box.

Select the image you want to replace with from the thumbnail window on the right of the screen and click
OK.

If you want to select from the images already imported, click the Imported Images tab and select the

image you want to replace with from the thumbnail window and click OK.

Important

You cannot select multiple images in the Replace Image dialog box.

Note

If you select multiple images in the Edit screen and use the replacement function, all the images

selected in the Edit screen will be replaced with the image selected in the Replace Image dialog
box.

When images are replaced, the following settings of the old image are inherited to the new image.

- Position
- Size

- Frame

- Position and size of the date

The cropping information and image orientation are not inherited.
In the Replace Image dialog box, you can change the display size and order of the thumbnails. See

Help for details.
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Changing Position, Angle and Size of Photos

Changing Position, Angle and Size of Photos

You can adjust the position, angle and size of images.

Select the image of which you want to change the position or size in the Edit screen and click  (Edit

Image) or double-click the image.

Set the Center Position, Rotation and Size, then click OK.

Note

You can also change the position and size of an image by dragging it in the Edit screen.

Select an image in the Edit screen, then click  (Free Rotate) and drag a corner of the image to
rotate it.

See Help for details on the position and size of images.
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Cropping Photos

Cropping Photos

Cropping an image is the act of removing the unnecessary portions of the image by selecting the

necessary portions.

Select the image you want to crop in the Edit screen and click  (Edit Image) or double-click the

image.

Click the Crop tab in the Edit Image dialog box.

Drag the white squares on the image to change the area to be cropped and click OK.

Note

See Help for details on cropping.
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Photos

Framing Photos

You can add frames to images.

Important

You cannot add frames to images in Photo Print, Stickers, and Layout Print.

Select the image you want to frame in the Edit screen and click  (Edit Image) or double-click the

image.

Click the Frame tab in the Edit Image dialog box.

Select the frame you want to use from Frames and click OK.

Important

You cannot print dates on framed photos.

Note

Select the Apply to all images in the page checkbox to add the same frame to all the images on a
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selected page at one time.

Various frames are available on our website besides those saved in the application.

Click Search frames... to access the Canon website from which you can download additional
materials for free.

Internet connection is required to access the website. Internet connection fees apply.

This function may not be available in some regions.

Exit Easy-PhotoPrint EX before installing frames.

Search frames... will be displayed only if Album has been selected.

See Help for details on frames.
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Dates on Photos

Printing Dates on Photos

You can print dates on images.

Select the image you want to print the date in the Edit screen and click  (Edit Image) or double-click

the image.

Click the Date tab in the Edit Image dialog box.

Select the Show date checkbox.

Set the Text Orientation, Position, Font Size and Color, then click OK.

Important

You cannot print dates on framed images.

Note

The date is displayed in the short date format (mm/dd/yyyy, etc.) specified in your operating system.

See Help for details on setting dates.
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Attaching Comments to Photos

Attaching Comments to Photos

You can attach comments to images and display them in your album. The photo name, shooting date

and comments are displayed (from top to bottom) in a comment box.

Important

You cannot attach comments to Photo Print, Calendar, Stickers, and Layout Print.

Select the image you want to attach comments to in the Edit screen and click  (Edit Image) or

double-click the image.

Click the Comments tab in the Edit Image dialog box.
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Select the Show comment box checkbox.

Select the checkboxes of the items you want to display, and enter comments.

Set the size and color of font, and position of the comments, etc., then click OK.

Note

See Help for details on comments.
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Text to Photos

Adding Text to Photos

You can add text to photos.

Click  (Add Text) in the Edit screen and drag the mouse over the area in which you want to add text.

Note

The screens for Album printing are used as examples in the following descriptions. The screens

may vary depending on what you create.

Select the Text tab in the Edit Text Box dialog box and enter text.

Note

In the Edit Text Box dialog box, you can change the position, angle and size of the text. You can also

set the color and line of the text box. See Help for details.

To change the entered text, select it and click  (Edit Text Box). The Edit Text Box dialog box

appears. You can change the text.
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Saving

You can save edited items.

Click Save in the Edit or Print Settings screen.

Note

The screens for Album printing are used as examples in the following descriptions. The screens

may vary depending on what you create.

When the Save As dialog box appears, specify the save location and file name, then click Save.

Important

If you edit a saved file and save it again, the file will be overwritten.

To save a file again with a new name or to a different location, select Save As... from the File menu

and save.

Note

Save will not be displayed in the Page Setup or Select Images screen.
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Holidays

Setting Holidays

You can add holidays to your calendar.

Click Set Holidays... in the Page Setup screen of Calendar, or click  (Setup Period/Holiday) in the

Edit screen and click Set Holidays... in the Calendar General Settings dialog box to display the Holiday

Settings dialog box.

To add a holiday, click Add.... The Add/Edit Holiday dialog box appears. To edit a saved holiday, select it
and click Edit....

To delete a holiday, select it and click Delete. To delete all the saved holidays within your calendar

period, click Clear.
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Enter the name in Holiday Name and specify the date.

Select the Set as Holiday checkbox to display that day as a holiday in your calendar.

Note

See Help for details on each dialog box.
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Setting Calendar Display

You can customize the calendar display (fonts, lines, colors, position, size, etc.).

Click Settings... in the Page Setup screen of Calendar, or select a calendar in the Edit screen and click 

 (Setup Calendar) to display the Calendar Settings dialog box.

Important

The Position & Size tab is displayed only when the Calendar Settings dialog box is displayed from

the Edit screen.

Note

See Help for details on the Calendar Settings dialog box.
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Saved Files

Opening Saved Files

You can open files created with Easy-PhotoPrint EX.

1. Click Library from Menu.

The Open dialog box appears.

You can check files created and saved with Easy-PhotoPrint EX by icon view (only for Windows Vista)

or thumbnail view.

Important

When using 64bit Edition of Windows Vista or Windows XP, the contents of files cannot be

displayed on Explorer.

2. Select the file you want to open and click Open.

The Edit screen appears.

Note

Easy-PhotoPrint EX supports the following file formats (extensions).

- Easy-PhotoPrint EX Album file (.el1)

- Easy-PhotoPrint EX Stickers file (.el2)

- Easy-PhotoPrint EX Calendar file (.el4)
- Easy-PhotoPrint EX Layout file (.el5)

3. Edit the file if necessary.

Note

See the following sections for details on the editing procedures.
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Editing Album

Editing Calendar
Editing Stickers

Editing Layout Print

Note

You can open files created with Easy-PhotoPrint EX with the following methods, besides from
Library in Menu.

- Double-click or click the file.

- From the File menu, click Open..., then select the file you want to edit.

You can also open a recently used file by clicking the file name shown in the File menu.
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Printing with Other Application Software 

Various Printing Methods

Changing the Print Quality and Correcting Image Data

Overview of the Printer Driver
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Various Printing Methods

Printing with Easy Setup

Setting a Page Size and Orientation

Setting the Number of Copies and Printing Order

Setting the Stapling Margin

Borderless Printing

Fit-to-Page Printing

Scaled Printing

Page Layout Printing

Poster Printing

Booklet Printing

Duplex Printing

Stamp/Background Printing

Registering a Stamp

Registering Image Data to be Used as a Background

Printing an Envelope

Switching the Paper Source to Match the Purpose

Displaying the Print Results before Printing

Setting Paper Dimensions (Custom Size)
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Printing with Easy Setup 

Printing with Easy Setup 

The simple setup procedure for carrying out appropriate printing on this machine, is as follows: 

1. Open the printer driver setup window

2. Select a frequently used profile 

In Commonly Used Settings on the Quick Setup tab, select a printing profile suited for the purpose.

When you select a printing profile, the Additional Features, Media Type, and Printer Paper Size

settings are automatically switched to the values that were preset. 

3. Select the print quality 

Select High, Standard, or Fast that matches your purpose for Print Quality. 

4. Select the paper source 

Select Automatically Select, Rear Tray, Cassette, Continuous Autofeed, or Paper Allocation that
matches your purpose for Paper Source. 

Important 

The paper source settings that can be selected may differ depending on the paper type and
size. 

5. Complete the setup 

Click OK.

When you execute print, the document is printed with settings that matches your purpose. 

Important 

When you check the Always Print with Current Settings check box, all settings on the Quick Setup,

Main, Page Setup, and Effects tabs are saved, and you can print with the same settings from the

next time as well. 
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Click Save... to register the specified settings. For instructions on registering settings, see "

Registering a Frequently Used Printing Profile." 
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Setting a Page Size and Orientation 

Setting a Page Size and Orientation 

The paper size and orientation are essentially determined by the application. When the page size and

orientation set for Page Size and Orientation on the Page Setup tab are same as those set with the

application, you do not need to select them on the Page Setup tab. 

When you are not able to specify them with the application, the procedure for selecting a page size and

orientation is as follows:
You can also set page size and Orientation on the Quick Setup tab. 

1. Open the printer driver setup window

2. Select the paper size 

Select a page size from the Page Size list on the Page Setup tab. 

3. Set Orientation 

Select Portrait or Landscape for Orientation. Check Rotate 180 degrees check box when you want to

perform printing with the original being rotated 180 degrees. 

4. Complete the setup 

Click OK.

When you execute print, the document will be printed with the selected page size and the orientation.
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Setting the Number of Copies and Printing Order 

Setting the Number of Copies and Printing Order 

Default Setting Print from Last Page 

Collate Print from Last Page + Collate

The procedure for specifying the number of copies and printing order is as follows:

You can also set the number of copies on the Quick Setup tab. 

1. Open the printer driver setup window

2. Specify the number of copies to be printed 

For Copies on the Page Setup tab, specify the number of copies to be printed. 

3. Specify the print order 

Check the Print from Last Page check box when you want to print from the last page in order. When

you do this, you do not need to sort pages into their correct order after printing. 

4. Set up collated printing when you specify multiple copies in the Copies box 

Check the Collate check box when you are specifying multiple copy together.
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Uncheck this check box to print all pages with the same page number together. 

5. Complete the setup 

Click OK.

The specified number of copies will be printed with the specified printing order. 

Important 

When the application software that you used to create the document has the same function, give

priority to the printer driver settings. However, if the print results are not acceptable, specify the

function settings on the application software. When you specify the number of copies and the

printing order with both the application and this printer driver, the number of copies may be

multiplied numbers of the two settings or the specified printing order may not be enabled. 
Print from Last Page and Collate appear grayed out and are unavailable when Booklet is selected
for Page Layout. 

Print from Last Page appears grayed out and is unavailable when Poster is selected for Page
Layout. 

Note 

By setting both Print from Last Page and Collate, you can perform printing so that papers are

collated one by one starting from the last page.

These settings can be used in combination with Borderless, Normal-size, Fit-to-Page, Scaled,

Page Layout, and Duplex Printing. 
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Setting the Stapling Margin 

Setting the Stapling Margin 

The procedure for setting the staple side and the margin width is as follows: 

1. Open the printer driver setup window

2. Specify the side to be stapled 

Check the position of the stapling margin from Staple Side on the Page Setup tab.

The printer analyzes the Orientation and Page Layout settings, and automatically selects the best

staple position. When you want to change the setting, select from the list. 

3. Set the margin width 

If necessary, click Specify Margin... and set the margin width, and then click OK. 
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4. Complete the setup 

Click OK on the Page Setup tab.

When you execute print, the data is printed with the specified staple side and margin width. 

Important 

Staple Side and Specify Margin... appear grayed out and are unavailable when: 

Borderless, Poster, or Booklet is selected for Page Layout. 

Scaled is selected for Page Layout (When Duplex Printing is also selected, only Staple Side can

be specified). 
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Borderless Printing 

Borderless Printing 

The borderless printing function allows you to print data without any margin by enlarging the data so that

it extends slightly off the paper. Without the borderless printing function, a margin is provided around the

printed data. When you want to print data such as a photo without providing any margin around it, select

borderless printing. 

The procedure for performing borderless printing is as follows: 

You can also set borderless printing in Additional Features on the Quick Setup tab. 

Setting Borderless Printing 

1. Open the printer driver setup window

2. Set borderless printing 

Select Borderless from the Page Layout list on the Page Setup tab. 

Click OK when the confirmation message appears.

When a message prompting you to change the media type appears, select a media type from the

list and click OK. 

3. Check the paper size 
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Check the Page Size list. When you want to change, select another page size from the list. The list

displays only sizes that can be used for borderless printing. 

4. Adjust the amount of extension from the paper 

If necessary, adjust the amount of extension using the Amount of Extension slider.

Moving the slider to the right makes the amount larger and moving the slider to the left makes the

amount smaller.
It is recommended to set the slider at the second position from the right for most cases. 

Important 

When you set the slider at the rightmost position, the back side of the paper may become

smudged. 

5. Complete the setup 

Click OK.

The data will be printed without any margins on the paper. 

Important 

When a page size that cannot be used for borderless printing is selected, the size is automatically

changed to the valid page sizes for borderless printing. 

When High Resolution Paper, T-Shirt Transfers, or Envelope is selected from the Media Type list on

the Main tab, you cannot perform borderless printing. 

When Borderless is selected, the Printer Paper Size, Staple Side (when Duplex Printing is not

selected) settings, and the Stamp/Background... button on the Page Setup tab appear grayed out

and are unavailable. 

Print quality may deteriorate or the sheet may be stained at the top and bottom depending on the

type of the media used. 

When the ratio of the height to the width differs from the image data, a portion of the image may not

be printed depending on the size of the media used.

In this case, crop the image data with an application software according to the paper size. 

Note 

When Plain Paper is selected for Media Type on the Main tab, borderless printing is not

recommended, and therefore the dialog box for media selection appears.
When you are using plain paper for test printing, select Plain Paper, and click OK. 

Expanding the Range of the Document to Print 

Specifying a large amount of extension allows you to perform borderless printing with no problems.

However, the portion of the document that extends off the paper range will not be printed. Subjects

around the perimeter of a photo may not be printed. 

Try borderless printing once. When you are not satisfied with the result of borderless printing, reduce the

amount of extension. The extension amount becomes shorter as the Amount of Extension slider is
moved to the left. 

Important 

When the amount of extension is shortened, an unexpected margin may be produced on the print,

depending on the size of the paper. 

Note 

When the Amount of Extension slider is set to the leftmost position, image data will be printed in the

full size. 

When Preview before printing is checked on the Main tab, you can confirm before printing whether

there will be no border. 
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to-Page Printing 

Fit-to-Page Printing 

The procedure for printing a document that is automatically enlarged or reduced to fit the page size to be

used is as follows: 

1. Open the printer driver setup window

2. Set fit-to-page printing 

Select Fit-to-Page from the Page Layout list on the Page Setup tab. 

3. Select the paper size for the data 

Using Page Size, select the page size that is set with your application. 

4. Select the print paper size 

Select the size of the paper loaded in the machine from the Printer Paper Size list.

When the Printer Paper Size is smaller than the Page Size, the page image will be reduced. When

the Printer Paper Size is larger than the Page Size, the page image will be enlarged. 

The current settings are displayed in the settings preview on the left side of the printer driver. 
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5. Complete the setup 

Click OK.

When you execute print, the document will be enlarged or reduced to fit to the page size. 
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Scaled Printing 

Scaled Printing 

The procedure for printing a document with pages enlarged or reduced is as follows: 

1. Open the printer driver setup window

2. Set scaled printing 

Select Scaled from the Page Layout list on the Page Setup tab. 

3. Select the paper size for the data 

Using Page Size, select the page size that is set with your application. 

4. Set the scaling rate by using one of the following methods: 

Select a Printer Paper Size 

When the printer paper size is smaller than the Page Size, the page image will be reduced.

When the printer paper size is larger than the Page Size, the page image will be enlarged. 
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Specify a scaling factor 

Directly type in a value into the Scaling box. 

The current settings are displayed in the settings preview on the left side of the printer driver. 

5. Complete the setup 

Click OK.

When you execute print, the document will be printed with the specified scale. 

Important 

When the application software with which you created the original has the scaled printing function,

configure the settings on your application software. You do not need to configure the same setting
in the printer driver. 

When Scaled is selected, the Staple Side list box appears grayed out and is unavailable (when

Duplex Printing is not selected). 

Note 
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Selecting Scaled changes the printable area of the document. 
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Page Layout Printing 

Page Layout Printing 

The page layout printing function allows you to print more than one page image on a single sheet of

paper. 

The procedure for performing page layout printing is as follows: 

1. Open the printer driver setup window

2. Set page layout printing 

Select Page Layout from the Page Layout list on the Page Setup tab.

The current settings are displayed in the settings preview on the left side of the printer driver. 

3. Select the print paper size 

Select the size of the paper loaded in the machine from the Printer Paper Size list.

Setting the layout of two pages of the document from left to right is complete. 

4. Set the number of pages to be printed on one sheet and the page order 

If necessary, click Specify..., specify the following settings in the Page Layout Printing dialog box, and
click OK. 
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Pages 

To increase the number of pages to be included on a single sheet of paper, select a desired

number of pages from the list. 

You can also set 2-Page Print or 4-Page Print on the Quick Setup tab. 

Page Order 

To change the page arrangement order, select an icon from the list to change the page placement

order. 

Page Border 

To print a page border around each document page, check this check box. 

5. Complete the setup 

Click OK on the Page Setup tab.

When you execute print, the specified number of pages will be arranged on each sheet of paper in

the specified order. 
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Poster Printing 

Poster Printing 

The poster printing function allows you to enlarge image data, divide it into several pages, and print

these pages on separate sheets of paper. When the pages are pasted together, they form a large print

like a poster. 

The procedure for performing poster printing is as follows: 

Setting Poster Printing 

1. Open the printer driver setup window

2. Set poster printing 

Select Poster from the Page Layout list on the Page Setup tab.

The current settings are displayed in the settings preview on the left side of the printer driver. 

3. Select the print paper size 

Select the size of the paper loaded in the machine from the Printer Paper Size list.

Setting 2 by 2-page poster printing is complete. 
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4. Set the number of image divisions and the pages to be printed 

If necessary, click Specify..., specify the following settings in the Poster Printing dialog box, and then
click OK. 

Image Divisions 

Select the number of divisions (vertical x horizontal). As the number of divisions increases, the

number of sheets used for printing increases, allowing you to create a larger poster. 

Print "Cut/Paste" in margins 

To leave out words "Cut" and "Paste", uncheck this check box. 

Important 

This feature is unavailable when the 64-bit printer driver is used. 

Print "Cut/Paste" lines in margins 

To leave out cut lines, uncheck this check box. 

Pages 

To reprint only specific pages, enter the page number you want to print. To print multiple pages,

specify by separating the pages with commas or entering a hyphen between the page numbers. 

Note 

You can also specify the print range by clicking the pages in the settings preview. 

5. Complete the setup 

Click OK on the Page Setup tab.

When you execute print, the document will be divided into several pages during printing.

After all poster pages have been printed, paste the pages together to create a poster. 

Printing Only Specific Pages 

If ink becomes faint or runs out during printing, you can reprint specific pages by following the procedure

below: 

1. Set the print range 

In the settings preview on the left of the Page Setup tab, click the pages that do not need to be

printed.

The pages that were clicked are deleted, and only the pages to be printed are displayed. 
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Note 

Click the deleted pages to display them again. 
Right-click the settings preview to select Print all pages or Delete all pages. 

2. Complete the setup 

After completing the page selection, click OK.

When you execute print, only specified pages will be printed. 

Important 

When Poster is selected, the Duplex Printing, Staple Side and Print from Last Page appear grayed

out and are unavailable. 

Since poster printing enlarges the document when printing it, the print results may become coarse. 

Page top

Page 280 of 949 pagesPoster Printing



Advanced Guide  > Printing from a Computer  > Printing with Other Application Software  > Various Printing Methods  >

Booklet Printing 

Booklet Printing 

The booklet printing function allows you to print data for a booklet. Data is printed on both sides of the

paper. This type of printing ensures that pages can be collated properly, in page number order, when the

printed sheets are folded and stapled at the center. 

The procedure for performing booklet printing is as follows: 

1. Open the printer driver setup window

2. Set booklet printing 

Select Booklet from the Page Layout list on the Page Setup tab.

The current settings are displayed in the settings preview on the left side of the window. 

3. Select the print paper size 

Select the size of the paper loaded in the machine from the Printer Paper Size list. 

4. Set the margin for stapling and the margin width 

Click Specify... and specify the following settings in the Booklet Printing dialog box, and then click
OK. 
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Margin for stapling 

Select which side should the stapling margin be on when the booklet is completed. 

Insert blank page 

To leave one side of a sheet blank, check the check box, and select the page to be left blank. 

Margin 

Enter the margin width. The specified width from the center of the sheet becomes the margin width

for one page. 

Page Border 

To print a page border around each document page, check the check box. 

5. Complete the setup 

Click OK on the Page Setup tab. 

When you execute print, the document is automatically printed first on one side of a sheet of paper

and then on the opposite side.
When the printing is complete, fold the paper at the center of the margin and make a booklet. 

Important 

Booklet cannot be selected when a media type other than Plain Paper, Hagaki A or Hagaki is
selected for Media Type. 

When Booklet is selected, Duplex Printing, Staple Side, Print from Last Page, and Collate appear

grayed out and are unavailable. 

Note 

The stamp and background are not printed on blank sheets inserted with the Insert blank page

function of booklet printing. 
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Duplex Printing 

The procedure for printing data on both sides of a sheet of paper is as follows:
You can also set duplex printing in Additional Features on the Quick Setup tab. 

Performing Automatic Duplex Printing 

You can perform the duplex printing without having to turn over the paper. 

1. Open the printer driver setup window

2. Set automatic duplex printing 

Check the Duplex Printing check box on the Page Setup tab and confirm that Automatic is checked. 

3. Select the layout 

Select Normal-size (or Fit-to-Page, Scaled or Page Layout) from the Page Layout list. 

4. Set the print area 

When you perform duplex printing, the print area of the document becomes slightly narrower than

usual and the document may not fit on one page.

Click Print Area Setup..., and select one of the following processing methods. 
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Use normal-size printing 

Print without reducing the page. 

Use reduced printing 

Reduce the page slightly during printing. 

5. Specify the side to be stapled 

The machine analyzes the Orientation and Page Layout settings, and automatically selects the best

Staple Side. When you want to change the setting, select another value from the list. 

6. Set the margin width 

If necessary, click Specify Margin... and set the margin width, and then click OK. 

7. Complete the setup 

Click OK on the Page Setup tab.

When you execute print, duplex printing will be started. 

Performing Duplex Printing Manually 

You can perform the duplex printing manually. 

1. Open the printer driver setup window

2. Set duplex printing 

Check the Duplex Printing check box and uncheck the Automatic check box on the Page Setup tab. 

3. Select the layout 
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Select Normal-size (or Fit-to-Page, Scaled or Page Layout) from the Page Layout list. 

4. Specify the side to be stapled 

The machine analyzes the Orientation and Page Layout settings, and automatically selects the best

Staple Side. When you want to change the setting, select another value from the list. 

5. Set the margin width 

If necessary, click Specify Margin... and set the margin width, and then click OK. 

6. Complete the setup 

Click OK on the Page Setup tab. 

When you execute print, the document will be printed on one side of a sheet of paper. When the

printing of one side is complete, load the paper correctly by following the message and click OK.

The document will be printed on the opposite side. 

Important 

Duplex Printing appears grayed out and is unavailable when: 

A media type other than Plain Paper, Hagaki A or Hagaki is selected from the Media Type list. 

Poster is selected from the Page Layout list. 

When Booklet is selected from the Page Layout list, Duplex Printing and Staple Side appear grayed

out and are unavailable. 

After printing the front page, there is an ink drying wait time before starting to print the back page

(Operation stops temporarily). Do not touch the paper during the time. You can change the ink

drying wait time at Custom Settings on the Maintenance tab. 

When you perform the automatic duplex printing for Hagaki, print an address first and then print your

message. 

Note 

When you select borderless printing during duplex printing, a dialog box for media type selection

may appear. If that happens, select Plain Paper. 

When performing the automatic duplex printing, do not use any plain paper smaller than A5. Also,
do not select any type of paper other than Plain Paper, Hagaki A or Hagaki at Media Type. 

If the back side of the paper becomes smudged during duplex printing, perform Bottom Plate

Cleaning in the Maintenance tab. 

Related Topic 

Cleaning Inside the Machine
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Stamp/Background Printing 

This feature is unavailable when the 64-bit printer driver is used. 

The Stamp function allows you to print a stamp text or a bitmap over or behind document data. It also

allows you to print date, time and user name. The Background function allows you to print a light

illustration behind the document data. 

The procedure for performing stamp/background printing is as follows: 

Printing a Stamp 

"CONFIDENTIAL," "IMPORTANT," and other stamps that are used often in companies are pre-registered.

1. Open the printer driver setup window

2. Click Stamp/Background... on the Page Setup tab 

The Stamp/Background dialog box opens. 

3. Select a stamp 

Check the Stamp check box, and select a desired stamp from the list.
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The current settings are displayed in the settings preview on the left side of the Page Setup tab. 

4. Set the stamp details 

If necessary, specify the following settings, and then click OK. 

Place stamp over text 

To print the stamp on the front of the document, check this check box. 

Note 

The stamp is given priority because the stamp is printed over the document data in the

sections where the stamp and the document data overlap. When this check box is unchecked,

the stamp is printed behind the document data and may be hidden in the overlapping sections

depending on the application used. 

Stamp first page only 

To print the stamp only on the first page, check this check box. 

Define Stamp... button 

To change the stamp text, bitmap, or position, click this (refer to " Registering a Stamp"). 

5. Complete the setup 

Click OK on the Page Setup tab.

When you execute print, the data is printed with the specified stamp. 

Printing a Background 

Two bitmap files are pre-registered as samples. 

1. Open the printer driver setup window

2. Click Stamp/Background... on the Page Setup tab 

The Stamp/Background dialog box opens. 

3. Select the background 

Check the Background check box, and select a desired background from the list.

The current settings are displayed in the settings preview on the left side of the Page Setup tab. 

4. Set the background details 

If necessary, complete the following settings, and then click OK. 

Background first page only 

To print the background only on the first page, check this check box. 

Select Background... button 

To use another background or change the layout or density of a background, click this (refer to "

Registering Image Data to be Used as a Background "). 

5. Complete the setup 

Click OK on the Page Setup tab.

When you execute print, the data is printed with the specified background. 

Important 

When Borderless is selected, the Stamp/Background... button appears grayed out and is

unavailable. 

Note 

The stamp and background are not printed on blank sheets inserted with the Insert blank page

Page 287 of 949 pagesStamp/Background Printing



function of booklet printing. 

Related Topics 

Registering a Stamp

Registering Image Data to be Used as a Background
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Registering a Stamp 

This feature is unavailable when the 64-bit printer driver is used. 

You can create and register a new stamp. You can also change and register some of the settings of an

existing stamp. Unnecessary stamps can be deleted at any time. 

The procedure for registering a new stamp is as follows: 

Registering a New Stamp 

1. Open the printer driver setup window

2. Click Stamp/Background... on the Page Setup tab 

The Stamp/Background dialog box opens. 

3. Click Define Stamp... 

The Stamp Settings dialog box opens. 
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4. Configure the stamp while viewing the preview window 

Stamp tab 

Select Text, Bitmap, or Date/Time/User Name that matches your purpose for Stamp Type. 

For Text registration, the characters must already be entered in Stamp Text. If necessary,
change the TrueType Font, Style, Size, and Outline settings. You can select the color of the

stamp by clicking Select Color.... 

For Bitmap, click Select File... and select the bitmap file (.bmp) to be used. If necessary,

change the settings of the Size and Transparent white area. 

For Date/Time/User Name, the creation date/time and user name of the printed object are

displayed in Stamp Text. If necessary, change the settings of TrueType Font, Style, Size, and

Outline. You can select the color of the stamp by clicking Select Color.... 

Important 

Stamp Text appears grayed out and is unavailable when Date/Time/User Name is selected.

Placement tab 

Select the stamp position from the Position list. You can also select Custom from the Position
list and specify coordinates for X-Position and Y-Position.

You can also change the stamp position by dragging the stamp in the preview window.

To change the stamp position angle, type a value in the Orientation box directly. 

5. Save the stamp 

Click the Save settings tab and enter a title in the Title box, and then click Save.

Click OK when the confirmation message appears. 

6. Complete the setup 

Click OK. The Stamp/Background dialog box opens again.

The registered title appears in the Stamp list. 

Changing and Registering Some of Stamp Settings 

1. Select the stamp for which the settings are to be changed 

Check the Stamp check box in the Stamp/Background dialog box, and then select the title of the

stamp to be changed from the Stamp list. 
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2. Click Define Stamp... 

The Stamp Settings dialog box opens. 

3. Configure the stamp while viewing the preview window 

4. Overwrite save the stamp 

Click Save overwrite on the Save settings tab.
When you want to save the stamp with a different title, type a new title in the Title box and click Save.

Click OK when the confirmation message appears. 

5. Complete the setup 

Click OK. The Stamp/Background dialog box opens again.

The registered title appears in the Stamp list. 

Deleting an Unnecessary Stamp 

1. Click Define Stamp... in the Stamp/Background dialog box 

The Stamp Settings dialog box opens. 

2. Select the stamp to be deleted 

Select the title of the stamp you want to delete from the Stamps list on the Save settings tab. Then

click Delete.

Click OK when the confirmation message appears. 

3. Complete the setup 

Click OK. The Stamp/Background dialog box opens again. 
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Registering Image Data to be Used as a Background 

This feature is unavailable when the 64-bit printer driver is used. 

You can select a bitmap file (.bmp) and register it as a new background. You can also change and

register some of the settings of an existing background. An unnecessary background can be deleted at
any time. 

The procedure for registering image data to be used as a background is as follows: 

Registering New Background 

1. Open the printer driver setup window

2. Click Stamp/Background... on the Page Setup tab 

The Stamp/Background dialog box opens. 

3. Click Select Background... 

The Background Settings dialog box opens. 
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4. Select the image data to be registered to the background 

Click Select File.... Select the target bitmap file (.bmp), and then click Open. 

5. Specify the following settings while viewing the preview window 

Layout Method 

Select how the background image data is to be placed.

When Custom is selected, you can set coordinates for X-Position and Y-Position.

You can also change the background position by dragging the image in the preview window. 

Intensity 

Set the intensity of the background image data with the Intensity slider. To lighten the background,

move the slider to the left. To darken the background, move the slider to the right. To print the

background at the original bitmap intensity, move the slider to the rightmost position. 

6. Save the background 

Click the Save settings tab and enter a title in the Title box, and then click Save.

Click OK when the confirmation message appears. 

7. Complete the setup 

Click OK. The Stamp/Background dialog box opens again.

The registered title appears in the Background list. 

Changing and Registering Some Background Settings 

1. Select the background for which the settings are to be changed 

Check the Background check box in the Stamp/Background dialog box, and then select the title of

the background you want to change from the Background list. 

2. Click Select Background... 

The Background Settings dialog box opens. 

3. Specify the items on the Background tab while viewing the preview window. 

4. Save the background 

Click Save overwrite on the Save settings tab. When you want to save the background with a different
title, enter a new title in the Title box and click Save.

Click OK when the confirmation message appears. 

Page 293 of 949 pagesRegistering Image Data to be Used as a Background



5. Complete the setup 

Click OK. The Stamp/Background dialog box opens again.

The registered title appears in the Background list. 

Deleting an Unnecessary Background 

1. Click Select Background... in the Stamp/Background dialog box 

The Background Settings dialog box opens. 

2. Select the background to be deleted 

Select the title of the background you want to delete from the Backgrounds list on the Save settings

tab, and then click Delete.

Click OK when the confirmation message appears. 

3. Complete the setup 

Click OK. The Stamp/Background dialog box opens again. 
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Printing an Envelope 

For details on how to load an envelope into the machine, refer to "Loading Paper in the Rear Tray" in the

manual: Basic Guide. 

The procedure for performing envelope printing is as follows: 

1. Load an envelope into the machine 

Fold down the envelope flap. 

Orient the envelope so that the flap is on the left and the folded surface is facing down, and load in
the rear tray. 

2. Open the printer driver setup window

3. Select the media type 

Select Envelope from Commonly Used Settings on the Quick Setup tab. 

4. Select the paper size 

Select Comm.Env. #10, DL Env., Youkei 4 105x235mm, or Youkei 6 98x190mm in the Envelope Size

Setting dialog box, and then click OK. 

5. Set the orientation 
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To print the addressee horizontally, select Landscape for Orientation. 

6. Select the print quality 

Select High or Standard that matches your purpose for Print Quality. 

7. Complete the setup 

Click OK.

When you execute print, the information is printed on the envelope. 

Important 

When you execute envelope printing, guide messages are displayed.

To hide the guide messages, check the Do not show this message again. check box.

To show the guide again, click the View Printer Status... button on the Maintenance tab, and start the

Canon IJ Status Monitor.

Then click Envelope Printing from Display Guide Message of the Option menu, and change the

setting to on. 
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Switching the Paper Source to Match the Purpose 

In this machine, there are two paper sources, a rear tray and a cassette.

You can facilitate printing by selecting a paper source setting that matches your print conditions or

purpose. 

The procedure for setting paper source is as follows: 

You can also set the paper source on the Quick Setup tab. 

1. Open the printer driver setup window

2. Select the paper source 

From the Paper Source list on the Main tab, select the paper source that matches your purpose. 

Automatically Select 

Plain paper whose Page Size is Letter 8.5"x11", A5, A4, or B5 is fed from the cassette. Other sizes of

plain paper and paper types other than plain paper are fed from the rear tray. 

Rear Tray 

Paper is always fed from the rear tray. 

Cassette 

Paper is always fed from the cassette. 

Important 

Plain paper that is not Letter 8.5"x11", A5, A4, or B5 and paper types other than plain paper

cannot be fed from the cassette. 

Continuous Autofeed 

When plain paper runs out in the specified paper source, the printer automatically switches the

paper source. 

When printing a large volume of data, load plain paper of the same size in both paper sources. You

can therefore reduce the trouble of having to load paper because the printer automatically switches
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the paper source when paper runs out in one paper source. 

Important 

Continuous Autofeed is unavailable when paper other than Plain Paper is selected for Media
Type. 

Since the printer feeds paper from the paper source that was being used the last time

Continuous Autofeed was selected and printing ended, load the same paper in both the rear
tray and the cassette. 

Paper Allocation 

When the media type for the print data is plain paper and the paper size matches the paper

allocation setting, the printer automatically feeds paper from the cassette. If not, the printer feeds
paper from the rear tray. 

To change the paper allocation settings, click Paper Allocation..., specify the Paper Size to be loaded

in the cassette, and then click OK. 

When you load frequently used plain paper in the cassette, the printer feeds paper from the rear tray

when the print data uses a different type of paper. You can therefore reduce the trouble of having to

load different paper. 

3. Complete the setup 

Click OK.

When you execute print, the printer uses the specified paper source to print the data. 
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Displaying the Print Results before Printing 

You can display and check the print result before printing. 

The procedure for displaying the print result before printing is as follows: 

You can also set the print results display on the Quick Setup tab. 

1. Open the printer driver setup window

2. Set the preview 

Check the Preview before printing check box on the Main tab. 

3. Complete the setup 

Click OK.

The Canon IJ Preview will start and the print result will be displayed before printing. 

Related Topic 

Canon IJ Preview
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Setting Paper Dimensions (Custom Size) 

You can specify the height and width of paper when its size cannot be selected from the Page Size. Such

a paper size is called a custom size. 

The procedure for specifying a custom size is as follows: 

You can also set a custom size in Printer Paper Size on the Quick Setup tab. 

1. Set the custom size in the application software 

On your application's paper size feature, specify the custom size. 

Important 

When the application software that created the document has a function for specifying the

height and width values, use the application software to set the values. When the application

software does not have such a function or if the document does not print correctly, use the

printer driver to set the values. 

2. Open the printer driver setup window

3. Select the paper size 

Select Custom... for Page Size on the Page Setup tab. 

The Custom Paper Size dialog box opens. 
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4. Set the custom paper size 

Specify Units, and enter the Width and Height of the paper to be used. Then click OK. 

5. Complete the setup 

Click OK on the Page Setup tab.

When you execute print, the data is printed with the specified paper size. 
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Correcting Image Data

Changing the Print Quality and Correcting Image Data

Selecting a Combination of the Print Quality Level and a Halftoning Method

Printing a Color Document in Monochrome

Specifying Color Correction

Optimal Photo Printing of Image Data

Adjusting Colors with the Printer Driver

Printing with ICC Profiles

Adjusting Color Balance

Adjusting Brightness

Adjusting Intensity

Adjusting Contrast

Simulating an Illustration

Representing Image Data with a Single Color

Presenting Image Data with Vivid Colors

Smoothing Jagged Outlines

Changing Color Properties to Improve Coloration

Reducing Photo Noise
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Selecting a Combination of the Print Quality Level and a
Halftoning Method 

You can individually set the combined representation method for the print quality level and the halftoning

method. 

The procedure for setting the print quality level and the halftoning method is as follows: 

1. Open the printer driver setup window

2. Select the print quality 

Select Custom for Print Quality on the Main tab, and click Set.... 

The Custom dialog box opens. 
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3. Setting the print quality and halftone expression method 

Move the Quality slider to select the quality level.

Select the expression method in Halftoning and click OK. 

Note 

Halftones refer to color shades between the darkest color and the brightest color.

The printer replaces the color shades with a collection of small dots to express the halftones.

Dither arranges the dots according to fixed rules to express the halftones. Diffusion places the

dots randomly to express the halftones. When you select Auto, the data is printed with the

optimal halftoning method for the selected print quality. 

4. Complete the setup 

Click OK on the Main tab.

When you execute print, the data is printed with the specified quality level and halftoning method. 

Important 

Certain print quality levels and halftoning methods cannot be selected depending on the settings of
Media Type. 

Note 

When the part of the object is not printed, selecting Diffusion for Halftoning may solve the problem. 

Related Topics 

Specifying Color Correction

Adjusting Color Balance

Adjusting Brightness

Adjusting Intensity

Adjusting Contrast
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Printing a Color Document in Monochrome 

The procedure for printing a color document in monochrome is as follows: 

You can also set a grayscale printing in Additional Features on the Quick Setup tab. 

1. Open the printer driver setup window

2. Set grayscale printing 

Check the Grayscale Printing check box on the Main tab. 

3. Complete the setup 

Click OK.

When you execute print, the document is converted to grayscale data. It allows you to print the color

document in monochrome. 

Important 

When the Grayscale Printing check box is checked, the printer driver processes image data as

sRGB data. In this case, actual colors printed may differ from those in the original image data.

When using the grayscale printing function to print Adobe RGB data, convert the data to sRGB data

using an application software. 

Note 
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During Grayscale Printing, color inks may be used as well as black ink. 
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Specifying Color Correction 

You can specify the color correction method suited to the type of document to be printed.

Normally, the printer driver adjusts the colors by using Canon Digital Photo Color so that data is printed

with color tints that most people prefer. This method is suitable for printing sRGB data. 

When you want to print by using the color space (Adobe RGB or sRGB) of the image data effectively,

select ICM. When you want to use an application software to specify a printing ICC profile, select None. 

The procedure for specifying color correction is as follows: 

You can also set color correction on the Quick Setup tab by choosing Photo Printing under Commonly

Used Settings, and then choosing Color/Intensity Manual Adjustment under Additional Features. 

1. Open the printer driver setup window

2. Select the manual color adjustment 

On the Main tab, select Manual for Color/Intensity, and click Set.... 

The Manual Color Adjustment dialog box opens. 

3. Select color correction 

Click Matching tab, select Color Correction setting that matches your purpose from the following,
and click OK. 
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Driver Matching 

By using Canon Digital Photo Color, you can print sRGB data with color tints that most people prefer.

Driver Matching is the default setting for color correction. 

ICM 

You can print by using the color space (Adobe RGB or sRGB) of the image data effectively. 

None 

The printer driver does not perform color correction. Select this value when you are specifying an

individually created printing ICC profile or a printing ICC profile for special Canon paper in an

application software to print data. 

4. Complete the setup 

Click OK on the Main tab.

When you execute print, the data is printed with the specified color correction method. 

Important 

When ICM is disabled in the application software, ICM is unavailable for Color Correction and the

printer may not be able to print the image data properly. 

When the Grayscale Printing check box on the Main tab is checked, Color Correction appears

grayed out and is unavailable. 

Related Topics 

Optimal Photo Printing of Image Data

Adjusting Colors with the Printer Driver

Printing with ICC Profiles
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Optimal Photo Printing of Image Data 

When people print images taken with digital cameras, they sometimes feel that the printed color tones

differ from those of actual image or those displayed on the monitor.

To get the print results as close as possible to the desired color tones, you must select a printing
method that is best suited to the application software used or to your purpose. 

Color Management 

Devices such as digital cameras, scanners, monitors, and printers handle color differently. Color

management (color matching) is a method that manages device-dependent "colors" as a common color
space. For Windows, a color management system called "ICM" is built into the operating system.

Adobe RGB and sRGB are popularly used as common color spaces. Adobe RGB has a wider color

space than sRGB. 

ICC profiles convert device-dependent "colors" into a common color space. By using an ICC profile and

carrying out color management, you can draw out the color space of the image data within the color

reproduction area that the printer can express. 

Selecting a Printing Method Suited to the Image Data 

The recommended printing method depends on the color space (Adobe RGB or sRGB) of the image

data or the application software to be used. There are two typical printing methods. Check the color

space (Adobe RGB or sRGB) of the image data and the application software to be used, and then select

the printing method suited to your purpose. 

Adjusting Colors with the Printer Driver

Describes the procedure for printing sRGB data by using the color correction function of the printer driver.

To print using Canon Digital Photo Color 

The printer prints data with color tints that most people prefer, reproducing colors of the original image

data and producing three-dimensional effects and high, sharp contrasts. 

To print by directly applying editing and touch-up results of an application software 

When printing the data, the printer brings out subtle color difference between dark and light areas,

while leaving the darkest and lightest areas intact.

When printing the data, the printer applies fine adjustment results, such as brightness adjustments
made with an application software. 

Printing with ICC Profiles

Describes the procedure for printing by using the color space of Adobe RGB or sRGB effectively.

You can print with a common color space by setting up the application software and the printer driver so

that the color management matches the input ICC profile of the image data.

The method for setting up the printer driver differs depending on the application software to be used. 
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Adjusting Colors with the Printer Driver 

You can specify the color correction function of the printer driver to print sRGB data with color tints that

most people prefer through the use of Canon Digital Photo Color.

When printing from an application software that can identify ICC profiles and allows you to specify them,

use a printing ICC profile in the application software, and select settings for color management. 

The procedure for adjusting colors with the printer driver is as follows: 

1. Open the printer driver setup window

2. Select the media type 

Select the type of paper loaded in the machine from the Media Type list on the Main tab. 

3. Select the print quality 

Select High, Standard, or Fast that matches your purpose for Print Quality. 

4. Select the manual color adjustment 

Select Manual for Color/Intensity, and click Set....

The Manual Color Adjustment dialog box opens. 

5. Select color correction 

Click Matching tab, and select Driver Matching for Color Correction. 
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6. Set the other items 

If necessary, click Color Adjustment tab, and adjust the color balance of Cyan, Magenta, Yellow, and

adjust Brightness, Intensity, and Contrast settings, and then click OK. 

7. Complete the setup 

Click OK on the Main tab.

When you execute print, the printer driver adjusts the colors when printing the data. 

Related Topics 

Selecting a Combination of the Print Quality Level and a Halftoning Method

Specifying Color Correction

Adjusting Color Balance

Adjusting Brightness

Adjusting Intensity

Adjusting Contrast
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Printing with ICC Profiles 

When the image data has a specified input ICC profile, you can print by using the color space (Adobe
RGB or sRGB) of the data effectively. 

The printer driver setting procedure varies depending on the application software used to print. 

Specify an ICC Profile from the Application Software and Print the Data 

When you print the editing and touch-up results of Adobe Photoshop, Canon Digital Photo Professional,

or any application software that allows you to specify input and printing ICC profiles, you print by

effectively using the color space of the input ICC profile specified in the image data. 

To use this printing method, use your application software to select color management items and

specify an input ICC profile and a printing ICC profile in the image data.

Even if you print using a printing ICC profile that you created yourself or one for special Canon paper from

your application software, be sure to select color management items from your application software.
For instructions, refer to the manual of the application software you are using. 

1. Open the printer driver setup window

2. Select the media type 

Select the type of paper loaded in the machine from the Media Type list on the Main tab. 

3. Select the print quality 

Select High, Standard, or Fast that matches your purpose for Print Quality. 

4. Select the manual color adjustment 

Select Manual for Color/Intensity, and click Set....

The Manual Color Adjustment dialog box opens. 

5. Select color correction 
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Click Matching tab, and select None for Color Correction. 

6. Set the other items 

If necessary, click Color Adjustment tab, and adjust the color balance of Cyan, Magenta, Yellow, and

adjust Brightness, Intensity, and Contrast settings, and then click OK. 

7. Complete the setup 

Click OK on the Main tab.

When you execute print, the printer uses the color space of the image data. 

Specify an ICC Profile with the Printer Driver, and then Print 

Print from a program that cannot identity input ICC profiles or does allow you to specify one by specifying

input ICC profiles from printer profiles of the printer driver. When printing Adobe RGB data, you can print

the data with the Adobe RGB color space even if the application software does not support Adobe RGB. 

1. Open the printer driver setup window

2. Select the media type 

Select the type of paper loaded in the machine from the Media Type list on the Main tab. 
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3. Select the print quality 

Select High, Standard, or Fast that matches your purpose for Print Quality. 

4. Select the manual color adjustment 

Select Manual for Color/Intensity, and click Set....

Manual Color Adjustment dialog box opens. 

5. Select color correction 

Click Matching tab, and select ICM for Color Correction. 

6. Select the input profile 

Select an Input Profile that matches the color space of the image data. 

For sRGB data or data without an input ICC profile: 

Select Standard. 

For Adobe RGB data: 
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Select Adobe RGB (1998). 

Important 

When the application software specifies an input profile, the input profile setting of the printer

driver becomes invalid. 

When no input ICC profiles are installed on your computer, Adobe RGB (1998) is not displayed.

You can install ICC profiles from the Setup CD-ROM that accompanies the machine. 

7. Set the other items 

If necessary, click Color Adjustment tab, and adjust the color balance of Cyan, Magenta, Yellow, and

adjust Brightness, Intensity, and Contrast settings, and then click OK. 

8. Complete the setup 

Click OK on the Main tab.

When you execute print, the data is printed with the color space of the selected image data. 

Related Topics 

Selecting a Combination of the Print Quality Level and a Halftoning Method

Specifying Color Correction

Adjusting Color Balance

Adjusting Brightness

Adjusting Intensity

Adjusting Contrast
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Adjusting Color Balance 

You can adjust the color tints when printing.

Since this function adjusts color balance of the output by changing the ink ratios of each color, it changes

the total color balance of the document. Use the application software if you want to change the color

balance significantly. Use the printer driver only when you want to adjust the color balance slightly.

The following sample shows the case when color balance is used to intensify cyan and to diminish
yellow so that the overall colors are more uniform. 

No adjustment Adjust Color Balance 

The procedure for adjusting color balance is as follows: 

You can also set color balance on the Quick Setup tab by choosing Photo Printing under Commonly

Used Settings, and then choosing Color/Intensity Manual Adjustment under Additional Features. 

1. Open the printer driver setup window

2. Select the manual color adjustment 

On the Main tab, select Manual for Color/Intensity, and click Set.... 

The Manual Color Adjustment dialog box opens. 

3. Adjust color balance 

There are individual sliders for Cyan, Magenta, and Yellow. Each color becomes stronger when the

corresponding slider is moved to the right, and becomes weaker when the corresponding slider is
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moved to the left. For example, when cyan becomes weaker, the color red becomes stronger.

You can also directly enter a value linked to the slider. Enter a value in the range from -50 to 50. 

After adjusting each color, click OK. 

Important 

Adjust the slider gradually. 

4. Complete the setup 

Click OK on the Main tab.

When you execute print, the document is printed with the adjusted color balance. 

Important 

When the Grayscale Printing check box on the Main tab is checked, Cyan, Magenta, and Yellow

appear grayed out and are unavailable. 

Related Topics 

Selecting a Combination of the Print Quality Level and a Halftoning Method

Specifying Color Correction

Adjusting Brightness

Adjusting Intensity

Adjusting Contrast
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Adjusting Brightness 

You can change the brightness of the overall image data during printing.

This function does not change pure white or pure black but it changes the brightness of the intermediate

colors.

The following sample shows the print result when the brightness specification is changed. 

Light is selected Normal is selected Dark is selected 

The procedure for adjusting brightness is as follows: 

You can also set brightness on the Quick Setup tab by choosing Photo Printing under Commonly Used

Settings, and then choosing Color/Intensity Manual Adjustment under Additional Features. 

1. Open the printer driver setup window

2. Select the manual color adjustment 

On the Main tab, select Manual for Color/Intensity, and click Set.... 

The Manual Color Adjustment dialog box opens. 

3. Specify the brightness 

Select Light, Normal, or Dark for Brightness, and click OK. 
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4. Complete the setup 

Click OK on the Main tab.

When you execute print, the data is printed at the specified brightness. 

Related Topics 

Selecting a Combination of the Print Quality Level and a Halftoning Method

Specifying Color Correction

Adjusting Color Balance

Adjusting Intensity

Adjusting Contrast
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Adjusting Intensity 

You can dilute (brighten) or intensify (darken) the colors of the overall image data during printing.

When you want to sharpen the print results, you should intensify the colors.

The following sample shows the case when the intensity is increased so that all colors become more
intense when the image data is printed. 

No adjustment Higher Intensity 

The procedure for adjusting intensity is as follows: 

You can also set intensity on the Quick Setup tab by choosing Photo Printing under Commonly Used

Settings, and then choosing Color/Intensity Manual Adjustment under Additional Features. 

1. Open the printer driver setup window

2. Select the manual color adjustment 

Select Manual for Color/Intensity on the Main tab, and click Set.... 

The Manual Color Adjustment dialog box opens. 

3. Adjust intensity 

Moving the Intensity slider to the right intensifies (darkens) the colors. Moving the slider to the left

dilutes (brightens) the colors.
You can also directly enter a value linked to the slider. Enter a value in the range from -50 to 50. 

After adjusting each color, click OK. 
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Important 

Adjust the slider gradually. 

4. Complete the setup 

Click OK on the Main tab.

When you execute print, the image data is printed with the adjusted intensity. 

Related Topics 

Selecting a Combination of the Print Quality Level and a Halftoning Method

Specifying Color Correction

Adjusting Color Balance

Adjusting Brightness

Adjusting Contrast
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Adjusting Contrast 

You can adjust the image contrast during printing.

To make the differences between the light and dark portions of images greater and more distinct,

increase the contrast. On the other hand, to make the differences between the light and dark portions of

images smaller and less distinct, reduce the contrast. 

No adjustment Adjust the contrast 

The procedure for adjusting contrast is as follows: 

You can also set contrast on the Quick Setup tab by choosing Photo Printing under Commonly Used

Settings, and then choosing Color/Intensity Manual Adjustment under Additional Features. 

1. Open the printer driver setup window

2. Select the manual color adjustment 

On the Main tab, select Manual for Color/Intensity, and click Set.... 

The Manual Color Adjustment dialog box opens. 

3. Adjust the contrast 

Moving the Contrast slider to the right increases the contrast, and moving it to the left decreases the

contrast.

You can also directly enter a value linked to the slider. Enter a value in the range from -50 to 50. 

After adjusting each color, click OK. 
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Important 

Adjust the slider gradually. 

4. Complete the setup 

Click OK on the Main tab.

When you execute print, the image is printed with the adjusted contrast. 

Related Topics 

Selecting a Combination of the Print Quality Level and a Halftoning Method

Specifying Color Correction

Adjusting Color Balance

Adjusting Brightness

Adjusting Intensity
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Correcting Image Data  > Simulating an Illustration 

Simulating an Illustration 

With the Simulate Illustration function, you can print full-color or 256-color image data so that it looks like

a hand-drawn illustration. This function adds different effects to the original profile and colors. 

The procedure for performing Simulate Illustration is as follows: 

1. Open the printer driver setup window

2. Set the Simulate Illustration 

If necessary, check the Simulate Illustration check box on the Effects tab, and adjust the Contrast.

Moving the slider to the right lightens the image data and moving the slider to the left darkens the

image data.
The current settings are displayed in the settings preview on the left side of the printer driver. 

3. Complete the setup 

Click OK.

When you execute print, the image will be printed so that it looks hand-drawn. 
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Representing Image Data with a Single Color 

With the Monochrome Effects function, you can benefit from coloring effects such as changing a

photograph to a sepia tone image. 

The procedure for performing Monochrome Effects is as follows: 

1. Open the printer driver setup window

2. Set Monochrome Effects 

Check the Monochrome Effects check box on the Effects tab and select your desired color.

When you use Select Color, move the Color slider to specify the color you want.

The current settings are displayed in the settings preview on the left side of the printer driver. 

3. Complete the setup 

Click OK.

When you execute print, the image will be printed with a single color. 

Important 

When the Grayscale Printing check box on the Main tab is checked, Monochrome Effects appears

Page 325 of 949 pagesRepresenting Image Data with a Single Color



grayed out and is unavailable. 
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Presenting Image Data with Vivid Colors 

The Vivid Photo function allows you to print image data with vivid colors.

The vivid photo function emphasizes the colors in background sceneries while maintaining the human

skin color natural. By using this function, you can make vivid hues appear even more vivid. 

The procedure for performing Vivid Photo is as follows: 

You can also set vivid photos on the Quick Setup tab by choosing Photo Printing under Commonly Used

Settings, and then choosing Additional Features. 

1. Open the printer driver setup window

2. Set Vivid Photo 

Check the Vivid Photo check box on the Effects tab. 

3. Complete the setup 

Click OK.

When you execute print, the image will be printed with vivid colors. 
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Smoothing Jagged Outlines 

The Image Optimizer function allows you to smooth jagged outlines in photos and graphics that have

been enlarged with your application. This feature is especially useful when printing low-resolution

images from Web pages. 

The procedure for performing Image Optimizer is as follows: 

1. Open the printer driver setup window

2. Set image optimizer 

Check the Image Optimizer check box on the Effects tab. 

3. Complete the setup 

Click OK.

The photos and graphics will be printed with jagged outlines smoothed. 

Note 

Depending on application software or resolution of image data, the image optimizer may have no

discernible effects. 

It may take longer to complete printing when the image optimizer is used. 
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Changing Color Properties to Improve Coloration 

The Photo Optimizer PRO function corrects colors of digital camera images or scanned images. It is

specially designed to compensate for color shift, overexposure, and underexposure. 

The procedure for performing Photo Optimizer PRO is as follows: 

1. Open the printer driver setup window

2. Set Photo Optimizer PRO 

Check the Photo Optimizer PRO check box on the Effects tab. 

Normally there is no need to check the Apply Throughout Page check box.

Images within each page are optimized on an image-by-image basis. 

Note 

Check the Apply Throughout Page check box when printing image data that has been

processed, such as being cropped or rotated. In this case the entire page will be treated as a

single image to be optimized. 

3. Complete the setup 

Click OK.

When you execute print, the images will be printed with color compensation. 
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Important 

Photo Optimizer PRO does not function when: 

Background is set in the Stamp/Background dialog box on the Page Setup tab. 

Define Stamp... is selected in the Stamp/Background dialog box on the Page Setup tab, and the

bitmapped stamp is configured. 

Note 

Depending on images, the Photo Optimizer PRO may have no discernible effect. 
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Reducing Photo Noise 

With the Photo Noise Reduction function, you can reduce the digital camera noise and improve the

image quality of the digital print. 

The procedure for performing Photo Noise Reduction is as follows: 

1. Open the printer driver setup window

2. Set Photo Noise Reduction 

Check the Photo Noise Reduction check box on the Effects tab and select Normal or Strong for the
level. 

3. Complete the setup 

Click OK.

When you execute print, the image will be printed with the digital camera noise being reduced. 

Note 

It is recommended to select Normal for most cases. Select Strong if you have selected Normal and

the noise still bothers you. 
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Depending on application software or resolution of image data, effects of digital camera noise
reduction may not be obvious. 

When this function is used for other than photos taken by digital cameras, image may be distorted. 
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Overview of the Printer Driver

Printer Driver Operations

Canon IJ Printer Driver

How to Open the Printer Driver Setup Window

Maintenance Tab

Canon IJ Status Monitor

Canon IJ Preview
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> Canon IJ Printer Driver 

Canon IJ Printer Driver 

The Canon IJ printer driver is software that is installed on your computer for printing data on this

machine. 

The Canon IJ printer driver converts the print data created by your Windows application into data that your

printer can understand and sends the converted data to the printer. 

Because different models support different print data formats, you need a Canon IJ printer driver for the

specific model you are using. 

How to Use Printer Driver Help 

You can display the Help describing the driver setting items through the printing preferences screen of
the Canon IJ printer driver. 

To view all descriptions of a tab... 

Click the Help button on each tab. A dialog box opens, displaying a description of each item on the
tab.

You can also click the link found in the description of an item to display a description of the linked

dialog box. 

To see a description for each item... 

Right-click the item you want to learn about and then click What's This?.

Alternatively, when the  Help button is found at the right end of the title bar, click that button, and

then click the item you want to learn about.

A description of the item is displayed. 

Related Topic 

How to Open the Printer Driver Setup Window
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How to Open the Printer Driver Setup Window 

The printer driver setup window can be displayed through the application software in use or the Start

menu of the Windows. 

Note 

This guide mainly describes operations on the Windows Vista. Operations may differ depending on

versions of the Windows. 

Open the Printer Driver Setup Window through the Application Software 

Follow the procedure below to configure printing profile when printing. 

1. Select the command you perform printing on the application software in use 

In general, select Print on the File menu to open the Print dialog box. 

2. Select your model name and click Preferences (or Properties) 

The printer driver setup window appears. 

Note 

Depending on application software you use, command names or menu names may vary and

there may be more steps. For details, refer to the user's manual of your application software. 

Open the Printer Driver Setup Window through the Start Menu 

Follow the procedure below to perform maintenance operations such as print head cleaning, or to

configure printing profile that are common for all application software. 

1. Select items from the Start menu as shown below: 

In Windows Vista, select the Start menu -> Control Panel -> Hardware and Sound -> Printers. 

In Windows XP, select the start menu -> Control Panel -> Printers and Other Hardware ->

Printers and Faxes. 

In Windows 2000, select the Start menu -> Settings -> Printers. 

2. Right-click your model name icon, and then select Printing Preferences... from the
displayed menu 

The printer driver setup window appears. 

Important 

Opening the printer driver setup window through Properties displays such tabs regarding the
Windows functions as the Ports (or Advanced) tab. Those tabs do not appear when opening

through Printing Preferences... or application software. For tabs regarding Windows functions,

refer to the user's manual for the Windows. 
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> Canon IJ Printer Driver  > Maintenance Tab 

Maintenance Tab 

The Maintenance tab allows you to perform machine maintenance or change the settings of the

machine. 

Features 

Cleaning the Print Heads

Cleaning the Paper Feed Rollers

Aligning the Print Head Position

Checking the Print Head Nozzles

Setting the Paper Source for Plain Paper

Cleaning Inside the Machine

Managing the Machine Power

Related Features 

Reducing the Machine Noise

Changing the Machine Operation Mode
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> Canon IJ Status Monitor 

Canon IJ Status Monitor 

The Canon IJ Status Monitor is an application software that shows the status of the printer and the

progress of printing on the Windows screen. You will know the status of the printer with graphics, icons,

and messages. 

Launching the Canon IJ Status Monitor 

The Canon IJ Status Monitor launches automatically when data is sent to the printer. When launched, the

Canon IJ Status Monitor appears as a button on the task bar. 

Click the status monitor button displayed on the task bar. The Canon IJ Status Monitor appears. 

Note 

To open the Canon IJ Status Monitor when the printer is not printing, open the printer driver setup

window  and click View Printer Status... on the Maintenance tab. 

When Errors Occur 

The Canon IJ Status Monitor is automatically displayed if an error occurs (e.g., if the printer runs out of

paper or if the ink is low). 

In such cases, take the appropriate action as described. 
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> Canon IJ Preview 

Canon IJ Preview 

The Canon IJ Preview is an application software that displays what the print result will look like before a

document is actually printed. 

The preview reflects the information that is set within the printer driver and allows you to check the

document layout, print order, and number of pages. You can also change the media type and paper

source settings. 

When you want to display a preview before printing, open the printer driver setup window , click the Quick

Setup tab or the Main tab, and check the Preview before printing check box. 

When you do not want to display a preview before printing, uncheck the check box. 

Related Topic 

Displaying the Print Results before Printing
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Printing Using the Operation Panel of the Machine 

Printing Lined Paper or Graph Paper

Copying

Printing from a Memory Card

Printing from a USB Flash Drive

Photo Printing from Printed Photo
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Printing Lined Paper or Graph Paper 

Printing Template Forms Such As Lined Paper or Graph Paper
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Template Forms Such As Lined Paper or Graph Paper

Printing Template Forms Such As Lined Paper or Graph Paper

You can print a template form such as lined paper, graph paper, or check list, etc. on A4, B5, or Letter-

sized plain paper.

Printing template forms

1. Make sure that the machine is turned on.

2. Load A4, B5, or Letter-sized plain paper in the Cassette.

3. Select  Settings on the HOME screen, then press the OK button.

4. Use the Easy-Scroll Wheel or the  button to select  Template print, then

press the OK button.

5. Use the Easy-Scroll Wheel or the  button to select the template you want to print,

then press the OK button.

The following templates are available:

Notebook paper

You can select three line spacing formats.

Notebook paper 1: 8 mm spacing

Notebook paper 2: 7 mm spacing

Notebook paper 3: 6 mm spacing

Graph paper

You can select two square sizes.
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Graph paper 1: Graph 5 mm

Graph paper 2: Graph 3 mm

Checklist

You can print a notepad with checkboxes.

Staff paper

You can print staff paper with 10 or 12 staves.

Staff paper 1: Staff paper 10 staves

Staff paper 2: Staff paper 12 staves

Handwriting paper

You can print handwriting paper.

Weekly schedule

You can print a weekly schedule form.

Monthly schedule

You can print a monthly schedule form.

Note

You cannot print Graph paper on B5 sized paper.

6. Use the  button to specify the paper size, then press the OK button.

Note

Select Duplex printing for Duplex/simplex printing to print on both sides of paper.

7. Use the + or - button to specify the number of copies.

8. Press the OK button to start printing.

The machine starts template printing.
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Copying 

Making Copies

Using Useful Copy Functions
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Making Copies

For the basic procedure to make copies, refer to Copying.

Setting Items

Reducing or Enlarging a Copy

Changing Intensity Setting

Displaying the Preview Screen

Using Useful Copy Functions

1. Make sure that the machine is turned on.

2. Select  Copy on the HOME screen, then press the OK button.

3. Load paper.

4. Load the original on the Platen Glass.

5. Confirm the page size and media type.

Note

To change the settings, select the item and press the OK button.

Setting Items
Page size and media type settings are saved in each mode.

When you make copies, you can specify various layouts on the screen that appears when you

press the left Function button.

Using Useful Copy Functions

6. Press the + or - button to specify the number of copies.
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7. Press the Color button for color copying, or the Black button for black & white

copying.

The machine starts copying.

Remove the original on the Platen Glass after copying is complete.

Important

Do not open the Document Cover or remove the original from the Platen Glass until copying is

complete.

Note

When you press the right Function button while Preview is displayed on the screen, you can

preview an image of the printout on the preview screen.

Displaying the Preview Screen

To cancel copying, press the Stop button.
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Setting Items

Select  Copy on the HOME screen, then press the OK button to display the Copy screen.

Note

Page size and media type settings are saved in each mode.

The settings of the page size, media type, etc. are retained even if the machine is turned off.

Depending on the functions, some setting items cannot be specified in combination.

1. Magnification

Specify the reduction/enlargement method. Reducing or Enlarging a Copy

2. Intensity

Specify the intensity. Changing Intensity Setting

3. Page size

Select the page size of the loaded paper.

4. Media type

Select the media type of the loaded paper.

5. Print quality

Adjust print quality according to the original.

Important

If you used Fast (speed-priority) with media type set to Plain paper and the quality is not as

good as expected, select Standard or High(quality-priority) and try copying again.

Select High(quality-priority) to copy in grayscale. Grayscale renders tones in a range of grays

instead of black or white.
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a Copy

Reducing or Enlarging a Copy

You can select from the following reduction/enlargement methods according to your purpose.

Fit-to-page

The machine automatically reduces or enlarges the image to fit the page size.

Zoom (25 - 400%)

You can specify the copy ratio as a percentage to reduce or enlarge copies.

On the screen that appears when selecting Zoom (25 - 400%), change the ratio using the Easy-

Scroll Wheel or the  button, then press the OK button to finalize the setting.

Preset ratio

You can select one of the preset ratios to reduce or enlarge copies.

On the screen that appears when selecting Preset ratio, select the ratio using the Easy-Scroll Wheel

or the  button, then press the OK button to finalize the setting.

Note

When you select Fit-to-page, the document size may not be detected correctly depending on the

original. In this case, select Preset ratio, Zoom (25 - 400%), or 100%.

When you want to copy at the same size as the original, select 100%.
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Setting

Changing Intensity Setting

Turn the Easy-Scroll Wheel clockwise to increase intensity or counterclockwise to decrease it.

You can also use the  button to perform settings.

Press the right Function button in the Intensity screen to automatically match the intensity to the original

on the Platen Glass and then print the image.

The slide bar for the intensity adjustment on the LCD changes to Auto when it is done.

Important

While Auto is selected, you cannot change the intensity by using the Easy-Scroll Wheel. Press the

right Function button to enable manual intensity settings again and then specify the intensity.
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Preview Screen

Displaying the Preview Screen

When you press the right Function button while Preview is displayed on the screen, you can preview an

image of the printout on the preview screen.

Important

The original will be scanned to display the preview image. Therefore, do not open the Document

Cover until the preview screen appears.

Originals are rescanned after displaying the preview screen and before copying starts. Therefore,

do not open the Document Cover or remove the original from the Platen Glass until copying is

complete.

1. Preview of the original

The original that is set on the Platen Glass is displayed. If the displayed image is skewed, refer to 

Loading Paper / Originals  and reset the original properly, then display the preview screen again and

preview the original.

2. Page size

A frame showing the selected page size appears over the image. The inside of the frame will be

printed.

3. Magnification

The magnification setting, which was set when the preview screen was displayed, is displayed. If

Preset ratio, Zoom (25 - 400%), or 100% is selected, you can change the magnification setting on

the preview screen.
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Using Useful Copy Functions

Special Copy

Choose the copy method according to your purpose.

Note

Refer to Settings for Special Copy for how to select the copy method.

Two-sided copy

You can copy two original pages onto the sides of a single sheet of paper.

Copying onto Both Sides of the Paper (Two-Sided Copy)

Borderless copy

You can copy images so that they fill the entire page without borders.

Copying without Borders (Borderless Copy)

2-on-1 copy

You can copy two original pages onto a single sheet of paper by reducing each image.

Copying Two Pages to Fit onto a Single Page (2-on-1 Copy)

4-on-1 copy

You can copy four original pages onto a single sheet of paper by reducing each image. Four

different layouts are available.

Copying Four Pages to Fit onto a Single Page (4-on-1 Copy)

Image repeat

You can copy an image multiple times onto a single page. You can set the machine to

automatically select the number of times it repeats the image, or you can specify the number.

Repeating an Image on a Page (Image Repeat)

Frame erase

When copying thick originals such as books, you can make a copy without black margins

around the image and gutter shadows.

Copying Thick Originals Such as Books (Frame Erase)

Trimming

You can clip (trim) a necessary part of the original to copy.

Copying a Specified Area (Trimming)

Masking

You can erase (mask) a specified part of the original to copy.

Copying Images with Erasing a Part (Masking)
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Settings for Special Copy

Settings for Special Copy

1. Make sure that the machine is turned on.

2. Select  Copy on the HOME screen, then press the OK button.

3. Load paper.

4. Load the original on the Platen Glass.

Note

For details on the types and conditions of originals which you can copy, refer to Loading Paper /

Originals .

5. Press the left Function button when the print settings confirmation screen is
displayed.

The Special copy screen is displayed.

Note

When you use these functions, you cannot select some of the options for the magnification/

page size/media type settings.

If you perform the Special copy setting first, any unavailable options will be disabled or hidden

in the basic copy settings screen.

If you perform the basic copy settings first, apply any Special copy setting, then return to the

basic copy settings screen, any items that require modification will be corrected automatically

or displayed with .

To cancel Special copy settings, press the Stop button. If the number of copies or the intensity

has been set already, press the Stop button twice.
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Copying onto Both Sides of the Paper (Two-Sided Copy)

You can copy two original pages onto the sides of a single sheet of paper.

(A) Long-side stapling 

(B) Short-side stapling 

Settings for Special Copy

1. Select  Two-sided copy, then press the OK button.

Follow the on-screen instructions.

2. Press the Color button for color copying, or the Black button for black & white

copying.

Note

You can skip scanning of the second page of originals and copy only the first page. After

scanning the first page of originals by pressing the Color or Black button, press the left

Function button to select Print front side on the screen that appears.
If you are copying in black & white, print intensity of a Two-sided copy may differ from that of a

single-sided copy.
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Copying Two Pages to Fit onto a Single Page (2-on-1 Copy)

You can copy two original pages (A) (B) onto a single sheet of paper (C) by reducing each image.

Settings for Special Copy

1. Select  2-on-1 copy, then press the OK button.

Follow the on-screen instructions.

2. Press the Color button for color copying, or the Black button for black & white

copying.

Note

You can skip scanning of the second sheet of originals and copy only the first sheet. After scanning

the first sheet of originals by pressing the Color or Black button, press the left Function button to

select Print first sheet on the screen that appears.

If Device memory is full. appears on the LCD when scanning, set the print quality to Standard and

try copying. If the problem is not resolved, reduce the number of sheets of documents or set the

print quality to Fast (speed-priority) and try copying again.
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Copying Four Pages to Fit onto a Single Page (4-on-1 Copy)

You can copy four original pages onto a single sheet of paper by reducing each image. Four different

layouts are available.

Settings for Special Copy

1. Select  4-on-1 copy, then press the OK button.

Follow the on-screen instructions.

2. Press the Color button for color copying, or the Black button for black & white

copying.

Note

If you want to copy only 1, 2, or 3 pages, press the left Function button to select Print now after

scanning the last page that you want to copy.

If Device memory is full. appears on the LCD when scanning, set the print quality to Standard and

try copying. If the problem is not resolved, reduce the number of sheets of documents or set the

print quality to Fast (speed-priority) and try copying again.
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Copying without Borders (Borderless Copy)

You can copy images so that they fill the entire page without borders.

Settings for Special Copy

1. Select  Borderless copy, then press the OK button.

Follow the on-screen instructions.

2. Press the Color button for color copying, or the Black button for black & white

copying.

Note

Slight cropping may occur at the edges since the copied image is enlarged to fill the whole page.
You can change the width to be cropped from the borders of the original image as needed. For

details, see Extended copy amount.

For details on the paper size and the media type available for borderless copying, see Printing Area .
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Repeating an Image on a Page (Image Repeat)

Repeating an Image on a Page (Image Repeat)

You can copy an image multiple times onto a single page. You can set the machine to automatically

select the number of times it repeats the image, or you can specify the number.

Settings for Special Copy

1. Select  Image repeat, then press the OK button.

Follow the on-screen instructions.

2. Press the Color button for color copying, or the Black button for black & white

copying.

Note

The area scanned from the original depends on the reduction/enlargement setting.
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Copying Thick Originals Such as Books (Frame Erase)

Copying Thick Originals Such as Books (Frame Erase)

When copying thick originals such as books, you can make a copy without black margins around the

image and gutter shadows. Using this function, you can reduce unnecessary ink consumption.

Settings for Special Copy

1. Select  Frame erase, then press the OK button.

Follow the on-screen instructions.

2. Press the Color button for color copying, or the Black button for black & white

copying.

Note

Close the Document Cover.

There may be a narrow black margin that appears around the image. This function removes the

dark margins only. If a scanned book is too thin or when the machine is used near a window or in a

bright environment, a faint black frame may remain. Also, if the color of an original is dark, the

machine cannot distinguish the document color from the shadow and this may cause slight
cropping or a shadow on the crease.
When you press the right Function button while Preview is displayed on the screen, you can preview

an image of the printout on the preview screen.

Displaying the Preview Screen

Page top

Page 359 of 949 pagesCopying Thick Originals Such as Books (Frame Erase)



Advanced Guide  > Printing Using the Operation Panel of the Machine > Copying > Using Useful Copy Functions  >

Copying a Specified Area (Trimming)

Copying a Specified Area (Trimming)

You can clip (trim) a necessary part of the original to copy.

Settings for Special Copy

1. Select  Trimming, then specify the top left and bottom right of the trimming

area using  button by following instructions on the LCD.

2. After specifying the trimming area, press the OK button.

You can preview an image of the printout on the preview screen.

3. Press the Color button for color copying, or the Black button for black & white

copying.

Note

If you press the left Function button after pressing the OK button on the Trimming image screen to

display the print setting screen, you can redo the scanning of the original.

Page top

Page 360 of 949 pagesCopying a Specified Area (Trimming)



Advanced Guide  > Printing Using the Operation Panel of the Machine > Copying > Using Useful Copy Functions  >

Copying Images with Erasing a Part (Masking)

Copying Images with Erasing a Part (Masking)

You can erase (mask) a specified part of the original to copy.

Settings for Special Copy

1. Select  Masking, then specify the top left and bottom right of the masking area

using  button by following instructions on the LCD.

2. After specifying the masking area, press the OK button.

You can preview an image of the printout on the preview screen.

3. Press the Color button for color copying, or the Black button for black & white

copying.

Note

If you press the left Function button after pressing the OK button on the Masking image screen to

display the print setting screen, you can redo the scanning of the original document.
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Advanced Guide  > Printing Using the Operation Panel of the Machine > Printing from a Memory Card 

Printing from a Memory Card 

Printing Photographs Saved on a Memory Card

Using Useful Printing Functions

Using Useful Display Functions

Setting Up the Card Slot as the Memory Card Drive of the Computer
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Photographs Saved on a Memory Card

Printing Photographs Saved on a Memory Card

For the basic procedure to print from a memory card, refer to Printing from a Memory Card .

Setting Items

Printing by Using the Photo Index Sheet

Using Useful Printing Functions
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Photographs Saved on a Memory Card  > Setting Items

Setting Items

Print Settings Confirmation Screen

In the Memory card mode, select the photo to print using the Easy-Scroll Wheel or the 

button, specify the number of copies using the + or - button, press the OK button, then the screen

is displayed.

Note

Depending on the functions, some setting items cannot be specified in combination.

1. Page size

Select the page size of the loaded paper.

2. Media type

Select the media type of the loaded paper.

3. Print quality

Adjust print quality according to the original.

4. Borderless print

Select bordered or borderless print.

Note

When you select Plain paper for the media type, the photo will be printed with bordered

even if you select Borderless.

Advanced Screen

When you press the left Function button in the print settings confirmation screen, the menu screen

to select Date setting, File no. setting, or Auto photo fix is displayed.
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Use the Easy-Scroll Wheel or the  button to select the setting item, then press the OK button

to display the screen for the selected item.

1. Date setting

Activates/deactivates to print the shooting date on a photo.

2. File no. setting

Activates/deactivates to print the file number on a photo.

Note

It is not possible to print both the shooting date and the file number when Layout print is

selected as a print function in the memory card mode. Even if both Date ON and File no.

ON are selected, only the shooting date will be printed. If you want to print the file

number, select Date OFF.

3. Auto photo fix

When Auto photo fix ON is selected, the scene or person's face of a shot photo is recognized

and the most suitable correction for each photo is made automatically. It makes a darkened

face by backlight brighter to print. It also analyzes a scene such as scenery, night scene,

person, etc. and corrects each scene with the most suitable color, brightness, or contrasts
automatically to print.

Page 365 of 949 pagesSetting Items



Note

As a default, Auto photo fix ON is applied when photos on a memory card are printed.
When Auto photo fix ON is applied, you can specify only (1) Red-Eye correction below.

If the print result with Auto photo fix ON selected is not satisfactory, select Manual

correction, then specify each advanced setting item below.

1. Red-Eye correction

Corrects red eyes in portraits caused by flash photography.

Depending on the type of the photo, red eyes may not be corrected or parts other than the

eyes may be corrected.

Note

This setting is available even if Auto photo fix ON is selected.
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2. Vivid photo

Makes green and blue more lively.

3. Photo optimizer pro

Automatically optimizes brightness and tone of a photo.

4. Noise reduction

Reduces the noise on blue areas like the sky as well as on black areas.

5. Face brightener

Brightens a darkened face on the photo taken against the light.

6. Image optimizer

Corrects and smoothes the jagged contours for printing.

7. Brightness

Adjust brightness.

8. Contrast

Adjust contrast.

9. Color hue

Adjust color hue.

For example, you can increase red or yellow to adjust the skin tone.

10. Effects

Applies special effects to the photo, such as printing in sepia tones or with a sketch
illustration like effect.
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Advanced Guide  > Printing Using the Operation Panel of the Machine > Printing from a Memory Card > Printing

Photographs Saved on a Memory Card  > Printing by Using the Photo Index Sheet

Printing by Using the Photo Index Sheet

Photo Index Sheet is an A4 or Letter-sized plain paper on which thumbnail images of photos saved on a

memory card or a USB flash drive are printed. Print out a Photo Index Sheet, mark the images that you

want to print, scan the sheet in, and the machine then prints the selected images. You can also specify

other settings, such as the paper size and the media type, by using this sheet; you do not have to

perform settings by using the Operation Panel on the machine.

* The procedure below is applied both for printing photos on a memory card and for printing photos on a

USB flash drive.

1. Make sure that the machine is turned on.

2. Load A4 or Letter-sized plain paper in the Cassette.
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3. Select  Photo index sheet on the HOME screen, then press the OK button.

4. Make sure that  Index sheet print is selected, then press the OK button.

5. Insert a memory card or a USB flash drive following the instruction on the LCD.

Important

You cannot insert both the memory card and the USB flash drive at the same time.

Do not remove the memory card/USB flash drive until printing the Photo Index Sheet(s) is

complete.

Note

For information on how to insert a memory card/USB flash drive, refer to Printing from a

Memory Card .

6. Select a range of images included in the Photo Index Sheet, then press the OK
button.

The following ranges can be selected.

Print all photos: 

Prints all images.

Set no. of copies: 

Prints the specified number of images from the newest one.

Search: 

Prints images by specifying the shooting date range.

Note

It may take a while to display the Search screen depending on the number of photos saved on

the memory card/USB flash drive.

7. Press the Color button.

The Photo Index Sheet(s) will be printed.

Note

If 31 or more images are selected, two or more Photo Index Sheets will be printed.

8. Fill in the appropriate circles in the Photo Index Sheet.

Fill in the appropriate circles ( ) with a dark pencil or a black ink pen to select the photos to print

and their print options.
Good

Bad

(a) Check mark

(b) Line only

(c) Too light
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A. Select the page size and other printing formats.

B. Select "Date"/"Auto Photo Fix OFF" as necessary.

C. Fill in this circle to print a copy of all photographs.

* If you fill in this circle, any other circles you filled in for the number of copies to print for each

photograph will be disregarded, and one copy each of all photographs will be printed.

D. Select the number of copies (fill in a circle under each photograph to print).

E. Confirm and follow the described printing procedure.

F. Fill in this circle to print the same Photo Index Sheet again.

* If you fill in this circle, all other filled settings will be disregarded.

G. Be careful not to make the bar code dirty.

If the bar code is dirty or has wrinkles, the machine may not scan the Photo Index Sheet

properly.

Important

Be sure to fill in a circle for every setting item except options.

If there are two or more Photo Index Sheets, fill in marks on each sheet.

If the filled circles on the Photo Index Sheet are not dark or vast enough, the machine may

not scan the Photo Index Sheet properly.

9. Load paper to print photos.

Make sure that the page size and media type of the loaded paper match those specified on the
Photo Index Sheet.

Note

When printing images using the Photo Index Sheet, you can select 4" x 6" (101.6 x 152.4 mm),
5" x 7" (127 x 177.8 mm), 8.5" x 11" (Letter), or A4 for the page size.

10. Make sure that  Scan sheet and print is selected, then press the OK button.

11. Place the Photo Index Sheet face-down on the Platen Glass, then press the OK
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button.

When placing the Photo Index Sheet, place the front side down, align the upper left corner of it with

the alignment mark as shown in the figure below, then close the Document Cover.

The Photo Index Sheet is scanned and the specified photos will be printed.

Remove the Photo Index Sheet on the Platen Glass after printing is complete.

Important

If Failed to scan Photo Index Sheet. is displayed on the LCD, press the OK button and confirm

the following:

The Platen Glass and the Photo Index Sheet are not dirty

The Photo Index Sheet is placed in the correct position with its front side facing down

You have filled in all the necessary circles on the sheet

Only one option is selected for items that do not accept two or more selections

Do not remove the memory card/USB flash drive while printing is in progress.

Note

To cancel printing, press the Stop button.

To continue to print photographs using subsequent Photo Index Sheets, repeat the procedure

from step 10.

If the memory card/USB flash drive has been removed and then reinserted before printing with

the Photo Index Sheet, it may take some time before printing starts.
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Printing Functions

Using Useful Printing Functions

Printing Memory Card Photos in Various Layouts

You can select from the following printing methods according to your purpose.

Note

For the procedure to select the printing method, see Settings for Printing a Photo on a

Memory Card.

Layout print

You can paste photos of your choice in the specified layout.

Printing Several Photos on a Single Sheet of Paper (Layout Print)

Sticker print

You can print your favorite photo with a frame on Canon Photo Stickers.

Printing on Stickers (Sticker Print)

DPOF print

If you have specified Digital Print Order Format (DPOF) settings on your digital camera, you

can print photos according to these settings.

DPOF print

Captured info print

You can print shooting information (Exif info) on the margin of the index of photos or selected

individual photos.

Captured info print

Photo index print

You can print an index of all the photos saved on a memory card.

Photo index print

Print all photos

You can print all photos saved on the memory card.

Print all photos

ID photo size print

You can print a photo saved on a memory card in the ID photo size.

Printing ID Photo-ID photo size print

Calendar print

You can print a calendar using photos saved on a memory card.

Creating a Calendar-Calendar print
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Printing Functions > Settings for Printing a Photo on a Memory Card

Settings for Printing a Photo on a Memory Card

1. Make sure that the machine is turned on.

2. Load paper.

3. Select  Memory card on the HOME screen, then press the OK button.

4. Insert the memory card into the Card Slot.

The memory card menu is displayed.

Important

If the USB flash drive is inserted in the Direct Print Port, remove the USB flash drive, then insert

the memory card into the Card Slot.

Note

For information on how to insert a memory card, refer to Printing from a Memory Card .
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Printing Functions > Printing Several Photos on a Single Sheet of Paper (Layout Print)

Printing Several Photos on a Single Sheet of Paper (Layout
Print)

You can paste photos of your choice in the specified layout.

Settings for Printing a Photo on a Memory Card

Settings for Printing a Photo on a USB Flash Drive

* The procedure below is applied both for printing photos on a memory card and for printing photos on a

USB flash drive.

1. Select  Layout print, then press the OK button.

Follow the on-screen instructions.

Note

If you skip a selected frame without pasting a photo on it when selecting Paste one by one,

press the left Function button on the photo layout screen.

When Borderless is selected, the media type cannot be set to Plain paper.
When Mixed 1, Mixed 2, or Mixed 3 is selected, you can select A4 or 8.5"x11"(LTR) for the page

size.

You cannot paste photos over multiple pages at one time. If you have photos for two or more

pages, print each page as you finish pasting photos for the page.

Even if both Date ON and File no. ON are selected, only the shooting date will be printed. If you

want to print the file number, select Date OFF.

Other Options

Printing a Specified Area (Trimming)  (This function is available only when Paste one by one

is selected.)
Searching for Photos with the Shooting Date (Search)
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Printing Functions > Printing on Stickers (Sticker Print)

Printing on Stickers (Sticker Print)

You can print your favorite photo with a frame on Canon Photo Stickers.

Settings for Printing a Photo on a Memory Card

Settings for Printing a Photo on a USB Flash Drive

* The procedure below is applied both for printing photos on a memory card and for printing photos on a

USB flash drive.

1. Select  Sticker print, then press the OK button.

Follow the on-screen instructions.

Note

You cannot use the Cassette to print on stickers. Load stickers on the Rear Tray.

You can load only one sheet of stickers at a time on the Rear Tray.

Select the frame to print using the Easy-Scroll Wheel or the  button.

To print with no frame, press the left Function button when No frame is displayed on the

screen.

When the photo is upside down, use the  button to rotate the frame by 180 degrees to

orient it properly against the photo.

To rotate the photo by 90 degrees to fit it within the frame, use the cropping edit screen to rotate

the cropping area.

Printing a Specified Area (Trimming)

Other Options

Using Useful Display Functions
Printing a Specified Area (Trimming)

Searching for Photos with the Shooting Date (Search)
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Printing Functions > Print all photos

Print all photos

You can print all photos saved on the memory card/USB flash drive.

Settings for Printing a Photo on a Memory Card

Settings for Printing a Photo on a USB Flash Drive

* The procedure below is applied both for printing photos on a memory card and for printing photos on a

USB flash drive.

1. Select  Print all photos, then press the OK button.

Follow the on-screen instructions.

Note

Other Options

Searching for Photos with the Shooting Date (Search)
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Printing Functions > Photo index print

Photo index print

You can print an index of all the photos saved on a memory card/USB flash drive.

Settings for Printing a Photo on a Memory Card

Settings for Printing a Photo on a USB Flash Drive

* The procedure below is applied both for printing photos on a memory card and for printing photos on a

USB flash drive.

1. Select  Photo index print, then press the OK button.

2. Select All photos, then press the OK button.

Follow the on-screen instructions.

Note

The following print methods are available:

Contact print: 35 mm film images are printed in its negative size as in contact print.

Standard: The number of photos printed on a single sheet of paper depends on the size of the

paper.
A4/Letter: 80 photos, 8" x 10"/203.2 x 254.0 mm: 72 photos, 5" x 7"/127.0 x 177.8 mm: 35 photos, 4"

x 6"/101.6 x 152.4 mm: 24 photos, Wide/101.6 x 180.6 mm: 28 photos

4" x 6"/101.6 x 152.4 mm: 24 photos, Wide/101.6 x 180.6 mm: 28 photos

You can search for photos to print with the shooting date.

Search with the shooting date.

Searching for Photos with the Shooting Date (Search)
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Advanced Guide  > Printing Using the Operation Panel of the Machine > Printing from a Memory Card > Using Useful

Printing Functions > DPOF print

DPOF print

If you have specified Digital Print Order Format (DPOF) settings on your digital camera, you can print

photos according to these settings.

Settings for Printing a Photo on a Memory Card

Settings for Printing a Photo on a USB Flash Drive

* The procedure below is applied both for printing photos on a memory card and for printing photos on a

USB flash drive.

1. Select  DPOF print, then press the OK button.

Follow the on-screen instructions.

Note

The machine supports the following DPOF functions:

Version: 

Based on ver. 1.00

Supported image types: 

CIFF, Exif (TIFF), and JFIF

Print Style - Standard Print: 

Prints photos that were specified as "Standard Print" with DPOF

Print Style - Index Print: 

Prints an index of photos that were specified as "Index Print" with DPOF using the machine's

index printing layout

Print Style - Multi-Image Print: 

Prints a photo that was specified as "Multi-Image Print" with DPOF (with the specified number

of copies and layout)

Print Photo Select: 

Prints only photos specified with DPOF

Number of copies: 

Prints the number of copies specified with DPOF

Prints are automatically enlarged or reduced to match the page size. Edges of the photo may

be clipped off depending on the page size.

The shooting date order setting by which photos are sorted follows that of DPOF.

DPOF is a standard format to record the specified information regarding images, such as

which image or number of copies to print.
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Advanced Guide  > Printing Using the Operation Panel of the Machine > Printing from a Memory Card > Using Useful

Printing Functions > Captured info print

Captured info print

You can print shooting information (Exif info) on the margin of the index of photos or selected individual

photos.

Settings for Printing a Photo on a Memory Card

Settings for Printing a Photo on a USB Flash Drive

* The procedure below is applied both for printing photos on a memory card and for printing photos on a

USB flash drive.

1. Select  Captured info print, then press the OK button.

Follow the on-screen instructions.

Note

The following print methods are available:

Single photo: 

Prints the information in the margin of selected individual photos.

List: 

Prints the information in the margin of the Photo index print of all photos or selected photos.

You can select photos to print by the shooting date.

Other Options

Using Useful Display Functions  (This function can only be used when Single photo is

selected.)
Printing a Specified Area (Trimming)  (This function is available only when Single photo is

selected.)
Searching for Photos with the Shooting Date (Search)
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Printing Functions > Printing ID Photo-ID photo size print

Printing ID Photo-ID photo size print

You can print photos on a memory card/USB flash drive in a specified size such as an ID photo.

Settings for Printing a Photo on a Memory Card

Settings for Printing a Photo on a USB Flash Drive

* The procedure below is applied both for printing photos on a memory card and for printing photos on a

USB flash drive.

1. Select  ID photo size print, then press the OK button.

2. Select the photo to print using the Easy-Scroll Wheel or the  button, then press

the OK button.

Follow the on-screen instructions.

Note

The following sizes are available.

Print on the paper larger than the size you specified.
1.18"x0.98"(3.0x2.5 cm)

1.57"x1.18"(4.0x3.0 cm)

1.57"x1.57"(4.0x4.0 cm)

1.57"x2.36"(4.0x6.0 cm)

1.77"x1.38"(4.5x3.5 cm)

1.77"x1.77"(4.5x4.5 cm)

1.97"x1.97"(5.0x5.0 cm)

2.17"x2.17"(5.5x5.5 cm)

2.36"x1.77"(6.0x4.5 cm)

4.72"x4.72"(12x12 cm)
1"x1.43"(2.5x3.6 cm)

1.43"x2"(3.6x5.1 cm)

1.77"x2.17"(4.5x5.5 cm)

Other Options

Using Useful Display Functions
Searching for Photos with the Shooting Date (Search)
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Printing Functions > Creating a Calendar-Calendar print

Creating a Calendar-Calendar print

You can create an original calendar using your favorite photos and a calendar.

Settings for Printing a Photo on a Memory Card

Settings for Printing a Photo on a USB Flash Drive

* The procedure below is applied both for printing photos on a memory card and for printing photos on a

USB flash drive.

1. Select  Calendar print, then press the OK button.

Follow the on-screen instructions.

Important

Be sure to load the paper in portrait orientation.

Note

The following layouts are available.

Paper: Portrait format Photo: Bottom (landscape)

Paper: Portrait format Photo: Top (landscape)

Paper: Landscape format Photo: Right (portrait)

Paper: Landscape format Photo: Left (portrait)

Select the landscape format for a landscape-oriented photo or the portrait format for a portrait-

oriented photo.

Use the Easy-Scroll Wheel or the  button to select the Photo. If the photo is upside-down, you

can use the  button to rotate the photo 180 degrees.

To change the start of the week on the printed calendar, press the left Function button on the print

settings confirmation screen, then select Start of the week.

To confirm or change the settings such as brightness, press the left Function button on the print

settings confirmation screen, then select Auto photo fix.

Even if both Date ON and File no. ON are selected, only the shooting date will be printed. If you want

to print the file number, select Date OFF.

Other Options

Printing a Specified Area (Trimming)

Searching for Photos with the Shooting Date (Search)
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Advanced Guide  > Printing Using the Operation Panel of the Machine > Printing from a Memory Card > Using Useful

Display Functions

Using Useful Display Functions

Changing the Display

When you press the left Function button when Change display is displayed on the screen, you can

change the way photos are displayed.

* The display methods below are available both for printing photos on a memory card and for

printing photos on a USB flash drive.

Normal screen display:

Shows one photo.

Thumbnail display:

Shows nine photos at a time. Select the photo using the Easy-Scroll Wheel or the 

button, then press the + or - button to specify the number of copies.

Full-screen display:

Shows one photo at full-screen.

Enlarged display:

Shows enlarged photo twice as much as the original. Move the area to show using the 

 button. Press the OK button to return to the previous display mode.

Slide show:

Shows next photos automatically. To stop the slide show, press the Stop button.

Page top

Page 382 of 949 pagesUsing Useful Display Functions



Advanced Guide  > Printing Using the Operation Panel of the Machine > Printing from a Memory Card > Using Useful

Display Functions  > Printing a Specified Area (Trimming)

Printing a Specified Area (Trimming)

You can edit images displayed on the LCD by cropping them.

* This function is available both for printing photos on a memory card and for printing photos on a USB

flash drive.

Note

Crop images after specifying the page size, media type, and bordered or borderless printing in the

print settings screen. If you change the paper settings after cropping, the cropped area may be

adjusted to match the paper, or be disabled completely.

1. Select the photo to crop.

2. Press the right Function button when Edit is displayed on the screen.

3. Select Trimming, then press the OK button.

The cropping edit screen is displayed.

4. Choose the area to print.

, , , and  buttons: 

Position the cropping frame.

Easy-Scroll Wheel: 

Sets the cropping frame size.

Turn the Easy-Scroll Wheel clockwise to enlarge the size of the cropping frame or counterclockwise
to reduce it.

Left Function button: 

Changes the aspect ratio of the cropping frame.

Right Function button: 

Rotates the cropping frame.

To switch the cropping frame between portrait and landscape orientations, press this button.

5. Press the OK button to finalize your selection of cropping area.

The area to be cropped is specified, and the original photo is displayed.

Note

The cropped image cannot be newly saved on the memory card/USB flash drive.

The cropping area is displayed only for photos which have been cropped.

To change the cropped area once it has been set, press the right Function button when Edit is

displayed on the screen, select Trimming, then press the OK button.

To cancel cropping after cropping has been complete, press the right Function button again
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when Edit is displayed on the screen, select Cancel trimming, then press the OK button. Select

Displayed images only or All images, then press the OK button.
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Advanced Guide  > Printing Using the Operation Panel of the Machine > Printing from a Memory Card > Using Useful

Display Functions  > Searching for Photos with the Shooting Date (Search)

Searching for Photos with the Shooting Date (Search)

When there are a lot of photos saved on the memory card/USB flash drive, you can choose to display and

print only photos shot on the specified date or within the specified range of dates.

* This function is available both for printing photos on a memory card and for printing photos on a USB

flash drive.

Note

If the number of copies to print is already specified for some photos before searching with the

shooting date, or if some photos are already pasted on a layout, those photos will still be selected

for printing even if they were not shot on the specified date or within the specified date range.

1. Display the search method screen.

Setting in Edit:

1. Press the right Function button when Edit is displayed on the screen.

2. Select Search, then press the OK button.

The Search screen is displayed.
Setting in Search in the Specify print range screen:

1. Select Search, then press the OK button.

The Search screen is displayed.

2. Set the search method.

To specify only one date for search:
Select One date only.

To specify the date range for search:

Select Select date range.

3. Press the OK button.

The date input screen is displayed.

Note

It may take a while for the date input screen to be displayed depending on the number of

photos saved on the memory card/USB flash drive.

4. Specify the date range, then press the OK button.

If you selected One date only:

1. Specify the date to search, then press the OK button.

If you selected Select date range:

1. Specify the start date to search, then press the OK button.

2. Specify the end date to search, then press the OK button.

Note

The date to be specified is displayed according to the settings of Date display in Advanced

settings under Device settings.
Changing the Machine Settings on the LCD

To cancel the selected date range, press the right Function button when Edit is displayed on

the screen, select Cancel selected date, then press the OK button.
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Advanced Guide  > Printing Using the Operation Panel of the Machine > Printing from a Memory Card > Setting Up the

Card Slot as the Memory Card Drive of the Computer

Setting Up the Card Slot as the Memory Card Drive of the
Computer

The Card Slot of the machine can also be used as the memory card drive of the computer.

Note

For details on using the Card Slot over a network, see Using the Card Slot over a Network .

In Macintosh, you cannot write data to a memory card in the Card Slot over a network.

Important

When Read/write attribute in Advanced settings under Device settings is set to Writable from USB

PC or Writable from LAN PC using the Operation Panel of the machine, you cannot print photos on

a memory card using the Operation Panel of the machine. After using the Card Slot as the memory

card drive of the computer, remove the memory card, then be sure to set Read/write attribute to Not

writable from PC. When you turned off the machine, Writable from USB PC or Writable from LAN PC

will be canceled and the setting is returned to Not writable from PC when you turn on the machine
next time.

1. Make sure that the memory card is not set.

If the memory card is set, remove it from the Card Slot. For details, refer to Printing from a Memory

Card.

2. Select  Settings on the HOME screen, then press the OK button.

3. Select  Device settings, then press the OK button.

4. Select Advanced settings, then press the OK button.

5. Select Read/write attribute, then press the OK button.

6. Specify the read/write attribute.

Not writable from PC 

The Card Slot is used only for reading. Be sure to select this mode when printing photos from a

memory card.

Writable from USB PC 

The Card Slot is used as the memory card drive of a computer connected to the machine via USB.

Data can be written on the memory card from the computer.

Writable from LAN PC 

The Card Slot is used as the memory card drive of a computer connected to the machine via a

network. Data can be written on the memory card from the computer.

7. Press the OK button.

Important

If you use the Card Slot as the memory card drive of the computer, you need to perform a "safe

removal" operation on your computer before physically removing the memory card from your

machine.

In Windows, right-click the Removable Disk icon and click Eject. If Eject is not displayed on
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the screen, confirm that the Access lamp is not flashing and remove the memory card.

Over a network, the removal operation is not needed.

On a Macintosh, drag the  Mount drive icon into the Trash.
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Advanced Guide  > Printing Using the Operation Panel of the Machine > Printing from a USB Flash Drive 

Printing from a USB Flash Drive 

Printing Photographs Saved on a USB Flash Drive

Using Useful Printing Functions

Using Useful Display Functions
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Advanced Guide  > Printing Using the Operation Panel of the Machine > Printing from a USB Flash Drive > Printing

Photographs Saved on a USB Flash Drive

Printing Photographs Saved on a USB Flash Drive

For the basic procedure to print from a USB flash drive, refer to Printing from a Memory Card .

Setting Items

Printing by Using the Photo Index Sheet

Using Useful Printing Functions
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Advanced Guide  > Printing Using the Operation Panel of the Machine > Printing from a USB Flash Drive > Printing

Photographs Saved on a USB Flash Drive > Setting Items

Setting Items

Print Settings Confirmation Screen

In the Memory card mode, select the photo to print using the Easy-Scroll Wheel or the 

button, specify the number of copies using the + or - button, press the OK button, then the screen

is displayed.

Note

Depending on the functions, some setting items cannot be specified in combination.

1. Page size

Select the page size of the loaded paper.

2. Media type

Select the media type of the loaded paper.

3. Print quality

Adjust print quality according to the original.

4. Borderless print

Select bordered or borderless print.

Note

When you select Plain paper for the media type, the photo will be printed with bordered

even if you select Borderless.

Advanced Screen

When you press the left Function button in the print settings confirmation screen, the menu screen

to select Date setting, File no. setting, or Auto photo fix is displayed.
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Use the Easy-Scroll Wheel or the  button to select the setting item, then press the OK button

to display the screen for the selected item.

1. Date setting

Activates/deactivates to print the shooting date on a photo.

2. File no. setting

Activates/deactivates to print the file number on a photo.

Note

It is not possible to print both the shooting date and the file number when Layout print is

selected as a print function in the memory card mode. Even if both Date ON and File no.

ON are selected, only the shooting date will be printed. If you want to print the file

number, select Date OFF.

3. Auto photo fix

When Auto photo fix ON is selected, the scene or person's face of a shot photo is recognized

and the most suitable correction for each photo is made automatically. It makes a darkened

face by backlight brighter to print. It also analyzes a scene such as scenery, night scene,

person, etc. and corrects each scene with the most suitable color, brightness, or contrasts
automatically to print.
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Note

As a default, Auto photo fix ON is applied when photos on a USB flash drive are printed.
When Auto photo fix ON is applied, you can specify only (1) Red-Eye correction below.

If the print result with Auto photo fix ON selected is not satisfactory, select Manual

correction, then specify each advanced setting item below.

1. Red-Eye correction

Corrects red eyes in portraits caused by flash photography.

Depending on the type of the photo, red eyes may not be corrected or parts other than the

eyes may be corrected.

Note

This setting is available even if Auto photo fix ON is selected.
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2. Vivid photo

Makes green and blue more lively.

3. Photo optimizer pro

Automatically optimizes brightness and tone of a photo.

4. Noise reduction

Reduces the noise on blue areas like the sky as well as on black areas.

5. Face brightener

Brightens a darkened face on the photo taken against the light.

6. Image optimizer

Corrects and smoothes the jagged contours for printing.

7. Brightness

Adjust brightness.

8. Contrast

Adjust contrast.

9. Color hue

Adjust color hue.

For example, you can increase red or yellow to adjust the skin tone.

10. Effects

Applies special effects to the photo, such as printing in sepia tones or with a sketch
illustration like effect.
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Advanced Guide  > Printing Using the Operation Panel of the Machine > Printing from a Memory Card > Printing

Photographs Saved on a Memory Card  > Printing by Using the Photo Index Sheet

Printing by Using the Photo Index Sheet

Photo Index Sheet is an A4 or Letter-sized plain paper on which thumbnail images of photos saved on a

memory card or a USB flash drive are printed. Print out a Photo Index Sheet, mark the images that you

want to print, scan the sheet in, and the machine then prints the selected images. You can also specify

other settings, such as the paper size and the media type, by using this sheet; you do not have to

perform settings by using the Operation Panel on the machine.

* The procedure below is applied both for printing photos on a memory card and for printing photos on a

USB flash drive.

1. Make sure that the machine is turned on.

2. Load A4 or Letter-sized plain paper in the Cassette.
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3. Select  Photo index sheet on the HOME screen, then press the OK button.

4. Make sure that  Index sheet print is selected, then press the OK button.

5. Insert a memory card or a USB flash drive following the instruction on the LCD.

Important

You cannot insert both the memory card and the USB flash drive at the same time.

Do not remove the memory card/USB flash drive until printing the Photo Index Sheet(s) is

complete.

Note

For information on how to insert a memory card/USB flash drive, refer to Printing from a

Memory Card .

6. Select a range of images included in the Photo Index Sheet, then press the OK
button.

The following ranges can be selected.

Print all photos: 

Prints all images.

Set no. of copies: 

Prints the specified number of images from the newest one.

Search: 

Prints images by specifying the shooting date range.

Note

It may take a while to display the Search screen depending on the number of photos saved on

the memory card/USB flash drive.

7. Press the Color button.

The Photo Index Sheet(s) will be printed.

Note

If 31 or more images are selected, two or more Photo Index Sheets will be printed.

8. Fill in the appropriate circles in the Photo Index Sheet.

Fill in the appropriate circles ( ) with a dark pencil or a black ink pen to select the photos to print

and their print options.
Good

Bad

(a) Check mark

(b) Line only

(c) Too light
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A. Select the page size and other printing formats.

B. Select "Date"/"Auto Photo Fix OFF" as necessary.

C. Fill in this circle to print a copy of all photographs.

* If you fill in this circle, any other circles you filled in for the number of copies to print for each

photograph will be disregarded, and one copy each of all photographs will be printed.

D. Select the number of copies (fill in a circle under each photograph to print).

E. Confirm and follow the described printing procedure.

F. Fill in this circle to print the same Photo Index Sheet again.

* If you fill in this circle, all other filled settings will be disregarded.

G. Be careful not to make the bar code dirty.

If the bar code is dirty or has wrinkles, the machine may not scan the Photo Index Sheet

properly.

Important

Be sure to fill in a circle for every setting item except options.

If there are two or more Photo Index Sheets, fill in marks on each sheet.

If the filled circles on the Photo Index Sheet are not dark or vast enough, the machine may

not scan the Photo Index Sheet properly.

9. Load paper to print photos.

Make sure that the page size and media type of the loaded paper match those specified on the
Photo Index Sheet.

Note

When printing images using the Photo Index Sheet, you can select 4" x 6" (101.6 x 152.4 mm),
5" x 7" (127 x 177.8 mm), 8.5" x 11" (Letter), or A4 for the page size.

10. Make sure that  Scan sheet and print is selected, then press the OK button.

11. Place the Photo Index Sheet face-down on the Platen Glass, then press the OK
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button.

When placing the Photo Index Sheet, place the front side down, align the upper left corner of it with

the alignment mark as shown in the figure below, then close the Document Cover.

The Photo Index Sheet is scanned and the specified photos will be printed.

Remove the Photo Index Sheet on the Platen Glass after printing is complete.

Important

If Failed to scan Photo Index Sheet. is displayed on the LCD, press the OK button and confirm

the following:

The Platen Glass and the Photo Index Sheet are not dirty

The Photo Index Sheet is placed in the correct position with its front side facing down

You have filled in all the necessary circles on the sheet

Only one option is selected for items that do not accept two or more selections

Do not remove the memory card/USB flash drive while printing is in progress.

Note

To cancel printing, press the Stop button.

To continue to print photographs using subsequent Photo Index Sheets, repeat the procedure

from step 10.

If the memory card/USB flash drive has been removed and then reinserted before printing with

the Photo Index Sheet, it may take some time before printing starts.
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Advanced Guide  > Printing Using the Operation Panel of the Machine > Printing from a USB Flash Drive > Using Useful

Printing Functions

Using Useful Printing Functions

Printing USB Flash Drive Photos in Various Layouts

You can select from the following printing methods according to your purpose.

Note

For the procedure to select the printing method, see Settings for Printing a Photo on a USB

Flash Drive .

Layout print

You can paste photos of your choice in the specified layout.

Printing Several Photos on a Single Sheet of Paper (Layout Print)

Sticker print

You can print your favorite photo with a frame on Canon Photo Stickers.

Printing on Stickers (Sticker Print)

DPOF print

If you have specified Digital Print Order Format (DPOF) settings on your digital camera, you

can print photos according to these settings.

DPOF print

Captured info print

You can print shooting information (Exif info) on the margin of the index of photos or selected

individual photos.

Captured info print

Photo index print

You can print an index of all the photos saved on a USB flash drive.

Photo index print

Print all photos

You can print all photos saved on a USB flash drive.

Print all photos

ID photo size print

You can print a photo saved on a USB flash drive in the ID photo size.

Printing ID Photo-ID photo size print

Calendar print

You can print a calendar using photos saved on a USB flash drive.

Creating a Calendar-Calendar print
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Advanced Guide  > Printing Using the Operation Panel of the Machine > Printing from a USB Flash Drive > Using Useful

Printing Functions > Settings for Printing a Photo on a USB Flash Drive

Settings for Printing a Photo on a USB Flash Drive

1. Make sure that the machine is turned on.

2. Load paper.

3. Select  Memory card on the HOME screen, then press the OK button.

4. Insert the USB flash drive into the Direct Print Port.

The memory card menu is displayed.

Important

If the memory card is inserted in the Card Slot, remove the memory card, then insert the USB
flash drive into the Direct Print Port.

Note

For information on how to insert a USB flash drive, refer to Printing from a Memory Card .
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Advanced Guide  > Printing Using the Operation Panel of the Machine > Printing from a Memory Card > Using Useful

Printing Functions > Printing Several Photos on a Single Sheet of Paper (Layout Print)

Printing Several Photos on a Single Sheet of Paper (Layout
Print)

You can paste photos of your choice in the specified layout.

Settings for Printing a Photo on a Memory Card

Settings for Printing a Photo on a USB Flash Drive

* The procedure below is applied both for printing photos on a memory card and for printing photos on a

USB flash drive.

1. Select  Layout print, then press the OK button.

Follow the on-screen instructions.

Note

If you skip a selected frame without pasting a photo on it when selecting Paste one by one,

press the left Function button on the photo layout screen.

When Borderless is selected, the media type cannot be set to Plain paper.
When Mixed 1, Mixed 2, or Mixed 3 is selected, you can select A4 or 8.5"x11"(LTR) for the page

size.

You cannot paste photos over multiple pages at one time. If you have photos for two or more

pages, print each page as you finish pasting photos for the page.

Even if both Date ON and File no. ON are selected, only the shooting date will be printed. If you

want to print the file number, select Date OFF.

Other Options

Printing a Specified Area (Trimming)  (This function is available only when Paste one by one

is selected.)
Searching for Photos with the Shooting Date (Search)
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Advanced Guide  > Printing Using the Operation Panel of the Machine > Printing from a Memory Card > Using Useful

Printing Functions > Printing on Stickers (Sticker Print)

Printing on Stickers (Sticker Print)

You can print your favorite photo with a frame on Canon Photo Stickers.

Settings for Printing a Photo on a Memory Card

Settings for Printing a Photo on a USB Flash Drive

* The procedure below is applied both for printing photos on a memory card and for printing photos on a

USB flash drive.

1. Select  Sticker print, then press the OK button.

Follow the on-screen instructions.

Note

You cannot use the Cassette to print on stickers. Load stickers on the Rear Tray.

You can load only one sheet of stickers at a time on the Rear Tray.

Select the frame to print using the Easy-Scroll Wheel or the  button.

To print with no frame, press the left Function button when No frame is displayed on the

screen.

When the photo is upside down, use the  button to rotate the frame by 180 degrees to

orient it properly against the photo.

To rotate the photo by 90 degrees to fit it within the frame, use the cropping edit screen to rotate

the cropping area.

Printing a Specified Area (Trimming)

Other Options

Using Useful Display Functions
Printing a Specified Area (Trimming)

Searching for Photos with the Shooting Date (Search)
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Advanced Guide  > Printing Using the Operation Panel of the Machine > Printing from a Memory Card > Using Useful

Printing Functions > Print all photos

Print all photos

You can print all photos saved on the memory card/USB flash drive.

Settings for Printing a Photo on a Memory Card

Settings for Printing a Photo on a USB Flash Drive

* The procedure below is applied both for printing photos on a memory card and for printing photos on a

USB flash drive.

1. Select  Print all photos, then press the OK button.

Follow the on-screen instructions.

Note

Other Options

Searching for Photos with the Shooting Date (Search)
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Advanced Guide  > Printing Using the Operation Panel of the Machine > Printing from a Memory Card > Using Useful

Printing Functions > Photo index print

Photo index print

You can print an index of all the photos saved on a memory card/USB flash drive.

Settings for Printing a Photo on a Memory Card

Settings for Printing a Photo on a USB Flash Drive

* The procedure below is applied both for printing photos on a memory card and for printing photos on a

USB flash drive.

1. Select  Photo index print, then press the OK button.

2. Select All photos, then press the OK button.

Follow the on-screen instructions.

Note

The following print methods are available:

Contact print: 35 mm film images are printed in its negative size as in contact print.

Standard: The number of photos printed on a single sheet of paper depends on the size of the

paper.
A4/Letter: 80 photos, 8" x 10"/203.2 x 254.0 mm: 72 photos, 5" x 7"/127.0 x 177.8 mm: 35 photos, 4"

x 6"/101.6 x 152.4 mm: 24 photos, Wide/101.6 x 180.6 mm: 28 photos

4" x 6"/101.6 x 152.4 mm: 24 photos, Wide/101.6 x 180.6 mm: 28 photos

You can search for photos to print with the shooting date.

Search with the shooting date.

Searching for Photos with the Shooting Date (Search)
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Advanced Guide  > Printing Using the Operation Panel of the Machine > Printing from a Memory Card > Using Useful

Printing Functions > DPOF print

DPOF print

If you have specified Digital Print Order Format (DPOF) settings on your digital camera, you can print

photos according to these settings.

Settings for Printing a Photo on a Memory Card

Settings for Printing a Photo on a USB Flash Drive

* The procedure below is applied both for printing photos on a memory card and for printing photos on a

USB flash drive.

1. Select  DPOF print, then press the OK button.

Follow the on-screen instructions.

Note

The machine supports the following DPOF functions:

Version: 

Based on ver. 1.00

Supported image types: 

CIFF, Exif (TIFF), and JFIF

Print Style - Standard Print: 

Prints photos that were specified as "Standard Print" with DPOF

Print Style - Index Print: 

Prints an index of photos that were specified as "Index Print" with DPOF using the machine's

index printing layout

Print Style - Multi-Image Print: 

Prints a photo that was specified as "Multi-Image Print" with DPOF (with the specified number

of copies and layout)

Print Photo Select: 

Prints only photos specified with DPOF

Number of copies: 

Prints the number of copies specified with DPOF

Prints are automatically enlarged or reduced to match the page size. Edges of the photo may

be clipped off depending on the page size.

The shooting date order setting by which photos are sorted follows that of DPOF.

DPOF is a standard format to record the specified information regarding images, such as

which image or number of copies to print.
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Advanced Guide  > Printing Using the Operation Panel of the Machine > Printing from a Memory Card > Using Useful

Printing Functions > Captured info print

Captured info print

You can print shooting information (Exif info) on the margin of the index of photos or selected individual

photos.

Settings for Printing a Photo on a Memory Card

Settings for Printing a Photo on a USB Flash Drive

* The procedure below is applied both for printing photos on a memory card and for printing photos on a

USB flash drive.

1. Select  Captured info print, then press the OK button.

Follow the on-screen instructions.

Note

The following print methods are available:

Single photo: 

Prints the information in the margin of selected individual photos.

List: 

Prints the information in the margin of the Photo index print of all photos or selected photos.

You can select photos to print by the shooting date.

Other Options

Using Useful Display Functions  (This function can only be used when Single photo is

selected.)
Printing a Specified Area (Trimming)  (This function is available only when Single photo is

selected.)
Searching for Photos with the Shooting Date (Search)
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Advanced Guide  > Printing Using the Operation Panel of the Machine > Printing from a Memory Card > Using Useful

Printing Functions > Printing ID Photo-ID photo size print

Printing ID Photo-ID photo size print

You can print photos on a memory card/USB flash drive in a specified size such as an ID photo.

Settings for Printing a Photo on a Memory Card

Settings for Printing a Photo on a USB Flash Drive

* The procedure below is applied both for printing photos on a memory card and for printing photos on a

USB flash drive.

1. Select  ID photo size print, then press the OK button.

2. Select the photo to print using the Easy-Scroll Wheel or the  button, then press

the OK button.

Follow the on-screen instructions.

Note

The following sizes are available.

Print on the paper larger than the size you specified.
1.18"x0.98"(3.0x2.5 cm)

1.57"x1.18"(4.0x3.0 cm)

1.57"x1.57"(4.0x4.0 cm)

1.57"x2.36"(4.0x6.0 cm)

1.77"x1.38"(4.5x3.5 cm)

1.77"x1.77"(4.5x4.5 cm)

1.97"x1.97"(5.0x5.0 cm)

2.17"x2.17"(5.5x5.5 cm)

2.36"x1.77"(6.0x4.5 cm)

4.72"x4.72"(12x12 cm)
1"x1.43"(2.5x3.6 cm)

1.43"x2"(3.6x5.1 cm)

1.77"x2.17"(4.5x5.5 cm)

Other Options

Using Useful Display Functions
Searching for Photos with the Shooting Date (Search)
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Advanced Guide  > Printing Using the Operation Panel of the Machine > Printing from a Memory Card > Using Useful

Printing Functions > Creating a Calendar-Calendar print

Creating a Calendar-Calendar print

You can create an original calendar using your favorite photos and a calendar.

Settings for Printing a Photo on a Memory Card

Settings for Printing a Photo on a USB Flash Drive

* The procedure below is applied both for printing photos on a memory card and for printing photos on a

USB flash drive.

1. Select  Calendar print, then press the OK button.

Follow the on-screen instructions.

Important

Be sure to load the paper in portrait orientation.

Note

The following layouts are available.

Paper: Portrait format Photo: Bottom (landscape)

Paper: Portrait format Photo: Top (landscape)

Paper: Landscape format Photo: Right (portrait)

Paper: Landscape format Photo: Left (portrait)

Select the landscape format for a landscape-oriented photo or the portrait format for a portrait-

oriented photo.

Use the Easy-Scroll Wheel or the  button to select the Photo. If the photo is upside-down, you

can use the  button to rotate the photo 180 degrees.

To change the start of the week on the printed calendar, press the left Function button on the print

settings confirmation screen, then select Start of the week.

To confirm or change the settings such as brightness, press the left Function button on the print

settings confirmation screen, then select Auto photo fix.

Even if both Date ON and File no. ON are selected, only the shooting date will be printed. If you want

to print the file number, select Date OFF.

Other Options

Printing a Specified Area (Trimming)

Searching for Photos with the Shooting Date (Search)
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Advanced Guide  > Printing Using the Operation Panel of the Machine > Printing from a Memory Card > Using Useful

Display Functions

Using Useful Display Functions

Changing the Display

When you press the left Function button when Change display is displayed on the screen, you can

change the way photos are displayed.

* The display methods below are available both for printing photos on a memory card and for

printing photos on a USB flash drive.

Normal screen display:

Shows one photo.

Thumbnail display:

Shows nine photos at a time. Select the photo using the Easy-Scroll Wheel or the 

button, then press the + or - button to specify the number of copies.

Full-screen display:

Shows one photo at full-screen.

Enlarged display:

Shows enlarged photo twice as much as the original. Move the area to show using the 

 button. Press the OK button to return to the previous display mode.

Slide show:

Shows next photos automatically. To stop the slide show, press the Stop button.
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Advanced Guide  > Printing Using the Operation Panel of the Machine > Printing from a Memory Card > Using Useful

Display Functions  > Printing a Specified Area (Trimming)

Printing a Specified Area (Trimming)

You can edit images displayed on the LCD by cropping them.

* This function is available both for printing photos on a memory card and for printing photos on a USB

flash drive.

Note

Crop images after specifying the page size, media type, and bordered or borderless printing in the

print settings screen. If you change the paper settings after cropping, the cropped area may be

adjusted to match the paper, or be disabled completely.

1. Select the photo to crop.

2. Press the right Function button when Edit is displayed on the screen.

3. Select Trimming, then press the OK button.

The cropping edit screen is displayed.

4. Choose the area to print.

, , , and  buttons: 

Position the cropping frame.

Easy-Scroll Wheel: 

Sets the cropping frame size.

Turn the Easy-Scroll Wheel clockwise to enlarge the size of the cropping frame or counterclockwise
to reduce it.

Left Function button: 

Changes the aspect ratio of the cropping frame.

Right Function button: 

Rotates the cropping frame.

To switch the cropping frame between portrait and landscape orientations, press this button.

5. Press the OK button to finalize your selection of cropping area.

The area to be cropped is specified, and the original photo is displayed.

Note

The cropped image cannot be newly saved on the memory card/USB flash drive.

The cropping area is displayed only for photos which have been cropped.

To change the cropped area once it has been set, press the right Function button when Edit is

displayed on the screen, select Trimming, then press the OK button.

To cancel cropping after cropping has been complete, press the right Function button again
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when Edit is displayed on the screen, select Cancel trimming, then press the OK button. Select

Displayed images only or All images, then press the OK button.
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Advanced Guide  > Printing Using the Operation Panel of the Machine > Printing from a Memory Card > Using Useful

Display Functions  > Searching for Photos with the Shooting Date (Search)

Searching for Photos with the Shooting Date (Search)

When there are a lot of photos saved on the memory card/USB flash drive, you can choose to display and

print only photos shot on the specified date or within the specified range of dates.

* This function is available both for printing photos on a memory card and for printing photos on a USB

flash drive.

Note

If the number of copies to print is already specified for some photos before searching with the

shooting date, or if some photos are already pasted on a layout, those photos will still be selected

for printing even if they were not shot on the specified date or within the specified date range.

1. Display the search method screen.

Setting in Edit:

1. Press the right Function button when Edit is displayed on the screen.

2. Select Search, then press the OK button.

The Search screen is displayed.
Setting in Search in the Specify print range screen:

1. Select Search, then press the OK button.

The Search screen is displayed.

2. Set the search method.

To specify only one date for search:
Select One date only.

To specify the date range for search:

Select Select date range.

3. Press the OK button.

The date input screen is displayed.

Note

It may take a while for the date input screen to be displayed depending on the number of

photos saved on the memory card/USB flash drive.

4. Specify the date range, then press the OK button.

If you selected One date only:

1. Specify the date to search, then press the OK button.

If you selected Select date range:

1. Specify the start date to search, then press the OK button.

2. Specify the end date to search, then press the OK button.

Note

The date to be specified is displayed according to the settings of Date display in Advanced

settings under Device settings.
Changing the Machine Settings on the LCD

To cancel the selected date range, press the right Function button when Edit is displayed on

the screen, select Cancel selected date, then press the OK button.
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Advanced Guide  > Printing Using the Operation Panel of the Machine > Photo Printing from Printed Photo 

Photo Printing from Printed Photo 

Printing from Printed Photo

Using Useful Printing Functions

Using Useful Display Functions
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Advanced Guide  > Printing Using the Operation Panel of the Machine > Photo Printing from Printed Photo  > Printing from

Printed Photo

Printing from Printed Photo

For the basic procedure for printing from a printed photo, refer to Printing Photos from Printed Photos.

Setting Items
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Advanced Guide  > Printing Using the Operation Panel of the Machine > Photo Printing from Printed Photo  > Printing from

Printed Photo > Setting Items

Setting Items

Print Settings Confirmation Screen

In the Easy photo reprint mode, select the photo to print using the Easy-Scroll Wheel or the 

button, specify the number of copies using the + or - button, press the OK button, then the screen

is displayed.

Note

Depending on the functions, some setting items cannot be specified in combination.

1. Page size

Select the page size of the loaded paper.

2. Media type

Select the photo paper type to use.

3. Print quality

Adjust print quality according to the original.

4. Borderless print

Select bordered or borderless print.

Advanced Print Settings Screen

When you press the left Function button in the print settings confirmation screen, the Advanced

screen is displayed.

When Auto photo fix ON is selected, the scene or person's face of a shot photo is recognized and

the most suitable correction for each photo is made automatically. It makes a darkened face by
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backlight brighter to print. It also analyzes a scene such as scenery, night scene, person, etc. and

corrects each scene with the most suitable color, brightness, or contrasts automatically to print.

Note

If the print result with Auto photo fix ON selected is not satisfactory, select Manual correction,

then specify each advanced setting item below.

1. Face brightener

Brightens a darkened face on the photo taken against the light.

2. Fade restoration

Corrects the color when printing photos that have faded or color cast over time.

3. Brightness

Adjust brightness.

4. Contrast

Adjust contrast.

5. Color hue

Adjust color hue.

For example, you can increase red or yellow to adjust the skin tone.
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Advanced Guide  > Printing Using the Operation Panel of the Machine > Photo Printing from Printed Photo  > Using Useful

Printing Functions

Using Useful Printing Functions

Special Printing of Photo

Choose the printing method according to your purpose.

Note

Refer to Settings for Printing a Scanned Photo  for how to select the copy method.

Sticker print

You can print your favorite photo on Canon Photo Stickers to create your own stickers.

Printing on Stickers (Sticker Print)

Print all photos

You can print all scanned photos.

Printing All Photos (Print All Photos)
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Advanced Guide  > Printing Using the Operation Panel of the Machine > Photo Printing from Printed Photo  > Using Useful

Printing Functions > Settings for Printing a Scanned Photo

Settings for Printing a Scanned Photo

1. Make sure that the machine is turned on.

2. Select  Easy photo reprint on the HOME screen, then press the OK button.

3. Follow the on-screen instructions, then press the OK button to start scanning a

printed photo.

The Easy photo reprint screen is displayed.

4. Load paper on the Rear Tray.

Note

For the basic procedure for printing from a printed photo, refer to Printing Photos from Printed

Photos.
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Advanced Guide  > Printing Using the Operation Panel of the Machine > Photo Printing from Printed Photo  > Using Useful

Printing Functions > Printing on Stickers (Sticker Print)

Printing on Stickers (Sticker Print)

You can create your own stickers from a scanned photo using Canon Photo Stickers.

Settings for Printing a Scanned Photo

1. Select  Sticker print, then press the OK button.

2. Select the layout, then press the OK button.

Follow the on-screen instructions.

Note

You cannot use the Cassette to print on stickers. Load stickers on the Rear Tray.

You can only load one sheet of stickers at a time on the Rear Tray.

Other Options

Changing the Display
Printing a Specified Area (Trimming)
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Advanced Guide  > Printing Using the Operation Panel of the Machine > Photo Printing from Printed Photo  > Using Useful

Printing Functions > Printing All Photos (Print All Photos)

Printing All Photos (Print All Photos)

You can print all scanned photos.

Settings for Printing a Scanned Photo

1. Select  Print all photos, then press the OK button.

Follow the on-screen instructions.
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Advanced Guide  > Printing Using the Operation Panel of the Machine > Photo Printing from Printed Photo  > Using Useful

Display Functions

Using Useful Display Functions

Changing the Display

When you press the left Function button when Change display is displayed on the screen, you can

change the way photos are displayed.

Normal screen display

Shows one photo.

Full-screen display

Shows one photo at full-screen.

Enlarged display

Shows enlarged photo twice as much as the original. Move the area to show using the 

 button. Press the OK button to return to the previous display mode.

Printing a Specified Area (Trimming)

You can edit images displayed on the LCD by cropping them.

1. Select the photo to crop.

2. Press the right Function button when Edit is displayed on the screen.

3. Select Trimming, then press the OK button.

The cropping edit screen is displayed.

4. Choose the area to print.

, , , and  buttons: 

Position the cropping frame.

Easy-Scroll Wheel: 

Sets the cropping frame size.

Turn the Easy-Scroll Wheel clockwise to enlarge the size of the cropping frame or

counterclockwise to reduce it.

Left Function button: 

Changes the aspect ratio of the cropping frame.

Right Function button: 

Rotates the cropping frame.

To switch the cropping frame between portrait and landscape orientations, press this button.

Page 420 of 949 pagesUsing Useful Display Functions



5. Press the OK button to finalize your selection of cropping area.

The area to be cropped is specified, and the original photo is displayed.

Note

The cropping area is displayed only for photos which have been cropped.

To change the cropped area once it has been set, press the right Function button again

when Edit is displayed on the screen, select Trimming, then press the OK button.

To cancel cropping after cropping has been set, press the right Function button again

when Edit is displayed on the screen, select Cancel trimming, then press the OK button.

Select Displayed images only or All images, then press the OK button.
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Advanced Guide  > Scanning 

Scanning 

Scanning Images

Saving Scanned Data on the USB Flash Drive/Memory Card Using the Operation Panel of the Machine

Forwarding Scanned Data to PC Using the Operation Panel of the Machine

Scanning with the Bundled Application Software

Scanning with Other Application Software

Canon IJ Network Scan Utility Screens

Other Scanning Methods
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Advanced Guide  > Scanning > Scanning Images 

Scanning Images 

Scanning Images

Before Scanning

Placing Documents
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Advanced Guide  > Scanning > Scanning Images > Scanning Images

Scanning Images

You can scan images from the machine to a computer without printing them and save them in popular
image data, such as JPEG, TIFF, bitmaps, or PDF. You can also save scanned images in a PDF or

JPEG data format on the memory card or USB flash drive.

Select the scanning method according to your purpose.

Saving Scanned Data on the USB Flash Drive/Memory Card Using the Operation Panel of the Machine

Forwarding Scanned Data to PC Using the Operation Panel of the Machine

Scanning with the Bundled Application Software

Scanning with Other Application Software

Page top

Page 424 of 949 pagesScanning Images



Advanced Guide  > Scanning > Scanning Images > Before Scanning

Before Scanning

Before scanning images, confirm the following:

Does the original to be scanned meet the requirements for an original to

be set on the Platen Glass?
If you save the data to PC, refer to Placing Documents  for details.
If you save the data to the USB flash drive/memory card, refer to Loading Paper / Originals  for details.

Page top

Page 425 of 949 pagesBefore Scanning



Advanced Guide  > Scanning > Scanning Images > Placing Documents

Placing Documents

Learn how to place documents on the machine's Platen. Place documents correctly according to the type

of document to be scanned. Otherwise, documents may not be scanned correctly.

Important

Do not place objects on the Document Cover. The objects may fall into the machine when the

Document Cover is opened. This may damage the machine.

Placing Documents

Place documents as described below to allow the machine to detect the document type or size

automatically.

Important

When scanning by specifying the document type or size in MP Navigator EX or ScanGear (scanner

driver), align an upper corner of the document with the corner at the arrow (alignment mark) of the

Platen.

Photos that have been cut to various shapes and documents smaller than 1.18 inches (3 cm)

square cannot be cropped accurately when scanning.

Reflective CD/DVD labels may not be scanned properly.

Close the Document Cover when scanning.

When Scanning Photos, Postcards, Business

Cards or CD/DVD

When Scanning Magazines, Newspapers or Text

Documents

Placing a Single Document

Place the document face-down on the Platen, with

3/8 inches (1 cm) or more space between the

edges of the Platen and the document. Portions

placed on the diagonally striped area cannot be

scanned.

Important

Large documents (such as A4 size photos)

Place the document face-down on the Platen and

align an upper corner of the document with the

corner at the arrow (alignment mark) of the Platen.

Portions placed on the diagonally striped area

cannot be scanned.
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that cannot be placed away from the edges/

arrow (alignment mark) of the Platen may be

saved as PDF files. To save in a format other

than PDF, scan by specifying the file format.

Placing Multiple Documents

Allow 3/8 inches (1 cm) or more space between
the edges of the Platen and documents, and

between documents. Portions placed on the

diagonally striped area cannot be scanned.

Note

You can place up to 12 documents.

You can place up to 4 documents when the

Compress scanned images when
transferring checkbox is selected on the

General tab of the Preferences dialog box.

Positions of slanted documents (10 degrees
or less) are corrected automatically.
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Advanced Guide  > Scanning > Saving Scanned Data on the USB Flash Drive/Memory Card Using the Operation Panel of

the Machine 

Saving Scanned Data on the USB Flash Drive/Memory Card
Using the Operation Panel of the Machine 

Saving Scanned Data on the USB Flash Drive/Memory Card Using the Operation Panel of the Machine
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Advanced Guide  > Scanning > Saving Scanned Data on the USB Flash Drive/Memory Card Using the Operation Panel of

the Machine > Saving Scanned Data on the USB Flash Drive/Memory Card Using the Operation Panel of the Machine

Saving Scanned Data on the USB Flash Drive/Memory Card
Using the Operation Panel of the Machine

You can save scanned data on the USB flash drive or memory card using the Operation Panel.

Important

Do not remove the USB flash drive or memory card from the machine under the following

conditions:
While scanning is in progress
Before saving the scanned data

You cannot use the USB flash drive and memory card at the same time. Be sure to use either of

them as a media for saving scanned data.

Scanned data saved on the USB flash drive or memory card cannot be printed in the memory card

mode.
For safety reasons, we recommend storing the scanned data saved on a USB flash drive or

memory card to another media periodically to avoid unexpected accidents.

We assume no responsibility for damage or loss of data for whatever reasons even within the
warranty period.

1. Make sure that the machine is turned on.

2. Select  Scan on the HOME screen, then press the OK button.

The screen for selecting to which you save the data is displayed.

3. Insert the USB flash drive into the Direct Print Port or the memory card into the Card
Slot.

See Inserting the USB Flash Drive  for how to insert the USB flash drive into the Direct Print Port.

For how to insert the memory card into the Card Slot or information on the types of the memory card

compatible with the machine, refer to Printing from a Memory Card .

4. Select  USB flash drive or  Memory card, then press the OK button.

5. Select  Save to USB flash if you selected  USB flash drive in step 4,

or  Save to memory card if you selected  Memory card, then press the 

OK button.

The Scan document screen is displayed.
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6. Specify the necessary settings, then press the OK button.

Setting Items

7. Load the original on the Platen Glass following the instruction on the LCD.

Note

Refer to Loading Paper / Originals  for how to load the original on the Platen Glass.

8. Press the Color button for color scanning, or the Black button for black & white

scanning.

When Preview ON is selected, press the OK button after the preview screen is displayed on the

LCD.

The machine starts scanning and scanned data is saved either on the USB flash drive or the

memory card, which you select as the media for saving scanned data.

Remove the original on the Platen Glass after scanning is complete.

To remove the USB flash drive after scanning is complete, see Removing the USB Flash Drive .

To remove the memory card after scanning is complete, refer to Printing from a Memory Card .

Note

You can scan images continuously only when selecting PDF. Continue scanning following the

confirmation screen. You can save up to 100 pages of images in one PDF file.

If the USB flash drive or the memory card becomes full while scanning images is in progress,

only the images already scanned can be saved.

You can save up to 2000 files of scanned data in both PDF and JPEG data format.

The folder and file name of scanned data saved on the USB flash drive or the memory card is

as follows:
Folder name: (file extension: PDF): CANON_SC\DOCUMENT\0001
Folder name: (file extension: JPG): CANON_SC\IMAGE\0001

File name: Running numbers, starting from SCN_0001
File date: 01/01/2009

Importing the Scanned Data Saved on the Memory Card to the Computer

When you import the scanned data saved on the memory card to the computer, import the data after

performing either of the operations below:

-Turning the machine off, then turn it back on.

-Removing the memory card, then reinsert it into the Card Slot.

You can optimize or print the scanned data saved on the memory card using MP Navigator EX. For

details, refer to Importing Images Saved on a Memory Card .

Importing the Scanned Data Saved on the USB Flash Drive to the Computer

You can import the scanned data saved on the USB flash drive to the computer.

After scanning the data, connect the USB flash drive to the computer, then import the data using

Windows Explorer.

You can import the scanned data saved on the USB flash drive to the computer.

After scanning the data, connect the USB flash drive to the computer, then import the data.

Inserting the USB Flash Drive

Important

Before inserting the USB flash drive:

You may need an extension cable if the USB flash drive cannot be inserted into the

Direct Print Port of the machine. For details, ask an electronics store.

Depending on the type of USB flash drive, the operation may not be guaranteed.

Some USB flash drives with security settings may not be used.

1. Insert the USB flash drive into the Direct Print Port.

Make sure that the USB flash drive is correctly oriented before inserting it straightforward into
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the Direct Print Port.

Removing the USB Flash Drive

1. Make sure that the machine is not writing data to the USB flash drive.

Check if the writing operation is complete on the LCD.

Important

Do not remove the USB flash drive or turn off the power while the machine is operating.

Note

If you use the USB flash drive with the access lamp, refer to the instruction manual

supplied with the USB flash drive to check if the writing operation is complete on the

USB flash drive.

2. Remove the USB flash drive.

Hold the USB flash drive and remove it from the machine straightforward.
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Advanced Guide  > Scanning > Saving Scanned Data on the USB Flash Drive/Memory Card Using the Operation Panel of

the Machine > Saving Scanned Data on the USB Flash Drive/Memory Card Using the Operation Panel of the Machine  >

Setting Items

Setting Items

Scan setting screen

Perform settings in saving scanned data on the USB flash drive or memory card.

1. Document type

Select the type of the original on the Platen Glass.

2. Scan size

Select the size of the original on the Platen Glass.

3. Scan resolution

Select the resolution for scanning.

4. Data format

Select the data format of the scanned data.

Advanced screen

When you press the left Function button in the scan setting screen, the Advanced screen is

displayed.

1. Preview

Select to preview the scanned data or not.

2. Unsharp mask

The outline of small characters or thin objects can be accentuated. Select Unsharp mask ON
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if you want to accentuate the outline of the scanned data.

3. Descreen*

A printout consists of minute dots to make characters or graphs. Interfering with each dot may

result in uneven shades or a striped pattern. Select Descreen ON if you notice any uneven

shades or a striped pattern on the scanned image.

Note

Some moire effects may remain if Unsharp mask ON and Descreen ON are selected at

the same time. In that case, change Unsharp mask ON to Unsharp mask OFF.

4. Show-through*

Characters on the back may show through when scanning a thin document such as a

newspaper. Select Show-through ON if characters seem to show through on the scanned

document.

 

* Not available when scanning a photo.
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Advanced Guide  > Scanning > Saving Scanned Data on the USB Flash Drive/Memory Card Using the Operation Panel of

the Machine > Saving Scanned Data on the USB Flash Drive/Memory Card Using the Operation Panel of the Machine  >

Deleting Scanned Data on USB Flash Drive/Memory Card

Deleting Scanned Data on USB Flash Drive/Memory Card

You can delete scanned data on the USB flash drive or memory card using the Operation Panel.

1. Select  Scan on the HOME screen, then press the OK button.

2. Insert the USB flash drive into the Direct Print Port or the memory card into the Card
Slot.

Important

You cannot use the USB flash drive and memory card at the same time.

3. Select  USB flash drive or  Memory card, then press the OK button.

4. Select  Delete scanned data, then press the OK button.

The file list is displayed.

5. Select the file to delete, then press the OK button.

Note

You can preview the file to delete or switch the file list between PDF and JPEG.

Only the first page of the image is displayed on the LCD.

1. Change display

Switches the display between the list and the preview.

2. Switch data list

Switches the display between the PDF data list and the JPEG data list.

6. Select Yes on the confirmation screen, then press the OK button.

7. Select Yes, then press the OK button again.

The machine starts deleting the file.
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Advanced Guide  > Scanning > Forwarding Scanned Data to PC Using the Operation Panel of the Machine 

Forwarding Scanned Data to PC Using the Operation Panel of
the Machine 

Forwarding Scanned Data to PC Using the Operation Panel of the Machine

Appendix: Various Scan Settings
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Advanced Guide  > Scanning > Forwarding Scanned Data to PC Using the Operation Panel of the Machine  > Forwarding

Scanned Data to PC Using the Operation Panel of the Machine

Forwarding Scanned Data to PC Using the Operation Panel of
the Machine

You can forward scanned data to PC using the Operation Panel of the machine.

Before forwarding scanned data to PC, confirm the following:

The necessary application software (MP Drivers and MP Navigator EX)

are installed.
If the application software (MP Drivers and MP Navigator EX) are not yet installed, insert the Setup

CD-ROM into the computer's disc drive, then perform Custom Install and select MP Drivers and MP
Navigator EX.

The machine is connected to a computer correctly.

Make sure that the machine is connected to the computer correctly.

Do not plug or unplug the USB or LAN cable when scanning images with the machine, or when the

computer is in sleep or standby mode.

If you perform scanning via the LAN connection, make sure that all the required settings have been

specified. For details, refer to Network Scan Settings .

The operation after scanning the original is specified in MP Navigator

EX.
MP Navigator EX enables you to specify the response resulting from pressing the Color or Black

button on the machine. You can specify the response individually for each event. For details, refer to 

Selecting a Response to Commands from the Operation Panel Using MP Navigator EX .

1.  Set the starting application.

If you are using Mac OS X v.10.5.x or Mac OS X v.10.4.x:

This operation is not necessary.
If you are using Mac OS X v.10.3.9:

You need to set MP Navigator EX as the starting application software in Image Capture under
Applications of Mac OS X.

Select Applications on the Go menu, then double-click the Image Capture icon. Click Options at the

lower left of the scanner window, select MP Navigator EX 3 in Application to launch when the

scanner button is pressed:, then click OK. To quit Image Capture, select Quit Image Capture on the

Image Capture menu.

Important

If Options is not displayed, select Preferences on the Image Capture menu, click Scanner, and

click Use TWAIN software whenever possible to clear the option. Then quit Image Capture and
restart it.

2. Make sure that the machine is turned on.

3. Load the original on the Platen Glass.

Note

Refer to Placing Documents  for how to load the original on the Platen Glass.
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4. Select  Scan on the HOME screen, then press the OK button.

The screen for selecting to which you forward the data is displayed.

5. Select  PC, then press the OK button.

6. Use the  button to select the PC to forward the scanned data, then press the 

OK button.

Select USB for a USB connected computer, or select the PC to forward the scanned data for a LAN

connected computer.

The document type selection screen is displayed.

Note

The LAN connected PCs are displayed as "User's name PCs name".

7. Select the document type, then press the OK button.

Auto scan 

This item is available only when the machine is connected to the computer using a USB cable.
The machine detects the type of the original automatically and the image is forwarded in the

optimized data.

Proceed to step 9.

Document 

Scans the original on the Platen Glass applying the optimized settings for scanning a document.

Photo 

Scans the original on the Platen Glass applying the optimized settings for scanning a photo.

Important

Make sure that the document has been loaded correctly according to the document type that
you have selected. Refer to Placing Documents  for how to load the original on the Platen

Glass.

8. If you selected Document or Photo in step 7, select the operation, then press the 

OK button.

Save to PC 

The original is scanned and saved.

Save as PDF file 

The original is scanned and saved as a PDF file. This item can be selected only when Document

has been selected on the Scan screen.

Attach to E-mail 

The original is scanned, and the image is attached to an e-mail using the e-mail application
software.

Open with application 

The original is scanned and displayed on the registered application software.
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Note

Options for scan operations can be specified in MP Navigator EX. For details, refer to Selecting
a Response to Commands from the Operation Panel Using MP Navigator EX .

9. Press the Color or Black button.

The settings configured by MP Navigator EX are applied when scanning.

Remove the original on the Platen Glass after scanning is complete.

Note

When you select Save as PDF file as the operation, you can scan documents from the Platen

Glass continuously. After scanning is complete, select Continue on the confirmation screen.
Load the next document on the Platen Glass, then press the Color button for color scanning, or
the Black button for black & white scanning. You can save up to 100 pages of images in one
PDF file.

10. To specify MP Navigator EX 3.0

If you are using Windows Vista:

The program selection screen may be displayed after pressing the Color or Black button. In this

case, select MP Navigator EX Ver3.0 and click OK.

You can set MP Navigator EX to launch whenever pressing the Color or Black button. For details,

see For Windows Users .

If you are using Windows XP:

The program selection screen may be displayed after pressing the Color or Black button for the first

time. In this case, specify MP Navigator EX Ver3.0 as the application software to use, select Always

use this program for this action, then click OK. From the next time, MP Navigator EX is automatically

started.

Important

If the position or size of an image is not scanned correctly depending on the type of the original,
refer to Scanning Photos and Documents  and change Document Type and Document Size

settings of MP Navigator EX to match the original being scanned.

Note

The operation to be performed after scanning the original depends on the scan operation

setting you have selected in step 8. For details on how to modify the operation settings, refer to 

Selecting a Response to Commands from the Operation Panel Using MP Navigator EX .

If You Want to Edit or Print the Scanned Images

MP Navigator EX enables you to edit the scanned images, such as optimizing or trimming.

You can also start application software from MP Navigator EX to edit or print the scanned images.

Let's Try Scanning

If You Want to Scan Originals with Advanced Settings

ScanGear enables you to scan originals with advanced settings such as the resolution.

Scanning with Advanced Settings Using ScanGear (Scanner Driver)
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Note

You can use a TWAIN- or WIA- (Windows Vista and Windows XP only) compliant application

software and the Control Panel (Windows Vista and Windows XP only) to scan originals with

this machine.
For details, refer to Other Scanning Methods .
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Advanced Guide  > Scanning > Saving Scanned Data to PC Using the Operation Panel of the Machine  > Appendix:

Various Scan Settings

Appendix: Various Scan Settings

Enabling network scanning

Network Scan Settings

Specifying how to respond when scanning using the Operation Panel of the machine

Selecting a Response to Commands from the Operation Panel Using MP Navigator EX

Page top

Page 440 of 949 pagesAppendix: Various Scan Settings



Advanced Guide  > Scanning > Saving Scanned Data to PC Using the Operation Panel of the Machine  > Appendix:

Various Scan Settings  > Network Scan Settings

Network Scan Settings

You can connect the machine to a network to share it among multiple computers or scan images into a

specified computer.

Important

Multiple users cannot scan at the same time.

Note

Complete the network settings of the machine beforehand. (Refer to the printed manual: Getting

Started.)

Complete the following settings to enable scanning over a network.

Setting for Scanning with MP Navigator EX

To scan over a network using MP Navigator EX, follow the steps below and change the connection status

between the computer and the machine.

1. Start MP Navigator EX.

Starting MP Navigator EX

2. Click Preferences.

3. For network connection, select (model name) series (Network: XXXXXXXXXXXX) for
Product Name.

(Where XXXXXXXXXXXX is the MAC address.)

Note
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For USB connection, select (model name) series for Product Name.

4. Click OK.

The Preferences dialog box closes. You can now scan via a network connection.

Go to the Main Menu to check whether network scanning is enabled.

Setting for Scanning Using the Operation Panel

You can make settings for scanning using the Operation Panel of the machine.

1. Check that Canon IJ Network Scan Utility is running.

If Canon IJ Network Scan Utility is running, its icon appears in the notification area of the taskbar.

If Canon IJ Network Scan Utility is not running, from the Start menu, select (All) Programs > Canon IJ

Network Utilities > Canon IJ Network Scan Utility > Canon IJ Network Scan Utility to start it.

2. In the notification area of the taskbar, right-click the Canon IJ Network Scan Utility
icon and select Settings....

The Canon IJ Network Scan Utility dialog box opens.

3. Select Canon (model name) ser_XXXXXXXXXXXX and click OK.

Note
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When multiple scanners are connected via a network, you can select up to three scanners.
See "Canon IJ Network Scan Utility Menu and Setting Screen " for details on Canon IJ Network
Scan Utility.
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Selecting a Response to Commands from the Operation Panel
Using MP Navigator EX

MP Navigator EX enables you to specify the response resulting from pressing a button for scanning on

the Operation Panel of the machine. You can specify the response individually for each event.

1. Start MP Navigator EX.

Starting MP Navigator EX

2. Click Preferences.

The Preferences dialog box opens.

Note

The Preferences dialog box can also be opened by clicking Preferences in the One-click Mode

screen.

3. On the Scanner Button Settings tab, specify Event and Actions.

Page 444 of 949 pagesSelecting a Response to Commands from the Operation Panel Using MP Navig...



Note

See the section below for details.

Scanner Button Settings Tab (Save)

Scanner Button Settings Tab (Attach to E-mail)
Scanner Button Settings Tab (Open with Application)

4. Click OK.

The operation will be performed according to the settings when you press the Color Start or Black

Start button on the machine.
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Scanning with the Bundled Application Software 

What Is MP Navigator EX (Supplied Scanner Software)?

Let's Try Scanning

Useful MP Navigator EX Functions

Utilizing Images in MP Navigator EX

MP Navigator EX Screens

Appendix: Opening Files Other than Scanned Images
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Scanner Software)?

What Is MP Navigator EX (Supplied Scanner Software)?

MP Navigator EX is an application that enables you to easily scan photos and documents. It is suitable

even for beginners.

Important

MP Navigator EX may not start from the Operation Panel of the machine. In that case, restart the

computer.
Use the default display font size of the OS. Otherwise, software screens may not appear correctly.

What You Can Do with This Software

This software allows you to scan multiple documents at one time, or scan images larger than the Platen.

You can also save scanned images, attach them to e-mail or print them using the supplied applications.

Screens

Main Menus

There are two types of MP Navigator EX Main Menu: Navigation Mode screen and One-click Mode screen.

Navigation Mode Screen

You can start various tasks from the Navigation Mode screen, including simple scanning, scanning

using ScanGear (scanner driver), and enhancing/correcting images.

One-click Mode Screen

You can complete from scanning to saving, etc. at one time by simply clicking the corresponding icon in

the One-click Mode screen.
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Scan/Import Window

Use the Scan/Import window to scan photos and documents, or import images saved on memory cards.

View & Use Window

Use the View & Use window to select what you want to do with the scanned images.
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Let's Try Scanning

Try scanning using MP Navigator EX.

Starting MP Navigator EX

Starting MP Navigator EX

Scanning documents, photos, magazines, etc. from the Platen

Scanning Photos and Documents

Scanning two or more photos (small documents) at one time

Scanning Multiple Documents at One Time

Scanning images larger than the Platen

Scanning Images Larger than the Platen (Stitch Assist)

Scanning easily according to purpose (scan and save, attach to e-mail, etc.)

Easy Scanning with One-click
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Navigator EX

Starting MP Navigator EX

Note

To scan via a network connection, start MP Navigator EX and set up the network environment before

scanning.
Network Scan Settings

Starting MP Navigator EX

1. Double-click  Canon MP Navigator EX 3.0 icon on the desktop.

MP Navigator EX starts.

Note

Alternatively, from the Start menu, select (All) Programs > Canon Utilities > MP Navigator EX 3.0
> MP Navigator EX 3.0.

Starting One-click Mode

1. Click  (Switch Mode) at the bottom left of the screen.
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The One-click Mode screen appears.

Note

Select the Show this window at startup checkbox in the Navigation Mode screen to always open

the Navigation Mode screen at startup. If this checkbox is not selected, the last used screen

appears at startup.
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and Documents

Scanning Photos and Documents

Scan photos and documents placed on the Platen.

1. Start MP Navigator EX and open the Navigation Mode screen.

Starting MP Navigator EX

2. Point to Scan/Import and click Photos/Documents (Platen).

3. Place the document on the Platen, then select Document Type.

Placing Documents

Note

When you select Magazine(Color), the Descreen function will be enabled and scanning takes

longer than usual. To disable the Descreen function, deselect the Descreen checkbox in the
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Scan Settings dialog box.
Select Text(OCR) to extract the text in the image and convert to editable text data using MP

Navigator EX.

Color scanning is not available for Text(OCR). To scan in color, use OCR in One-click and scan

with Color Mode set to Color.

4. Click Specify... to set the document size and scanning resolution as required.

When setting is completed, click OK.

Scan Settings Dialog Box (Photos/Documents)

Important

When scanning a large document (such as an A4 size photo), align its corner with the corner at

the arrow (alignment mark) of the platen and specify the document size in the Scan Settings

dialog box.

5. Click Scan.

Scanning starts.

When scanning is completed, the Scan Complete dialog box opens. Select Scan or Exit. Select

Scan to scan the next document, or select Exit to end.

The scanned images appear in the Thumbnail window.
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6. Edit the scanned images as required.

Use Edit Tools to rotate images, select a part of an image, etc.

See the Edit Tools in "Photos/Documents (Platen) Screen (Scan/Import Window) " for details.

Note

First select images to edit. (Selected images are outlined in orange.) Drag the mouse or use

Shift + arrow keys to select multiple images.

7. Save the scanned images.

Saving

Saving as PDF Files
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Multiple Documents at One Time

Scanning Multiple Documents at One Time

You can scan two or more photos (small documents) at one time by setting Document Size to Auto

Detect (Multiple Documents) in the Scan Settings dialog box of MP Navigator EX.

Important

The following types of documents may not be cropped correctly. In that case, start ScanGear

(scanner driver), then adjust the cropping frames (scan areas) in whole image view and scan

again.
- Photos that have a whitish border

- Documents printed on white paper, hand-written text, business cards, etc.

- Thin documents
- Thick documents

Scanning Multiple Documents in Whole Image View

1. Place the document on the Platen.

Placing Documents

2. Start MP Navigator EX and open the Navigation Mode screen.

Starting MP Navigator EX

3. Point to Scan/Import and click Photos/Documents (Platen).

4. Select Document Type according to the document to be scanned.
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5. Click Specify....

Select Auto Detect (Multiple Documents) for Document Size.

When setting is completed, click OK.

Scan Settings Dialog Box (Photos/Documents)

6. Click Scan.
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Multiple documents are scanned at one time.

When scanning is completed, the Scan Complete dialog box opens. Select Scan or Exit. Select

Scan to scan the next document, or select Exit to end.

The scanned images appear in the Thumbnail window.

7. Edit the scanned images as required.

Use Edit Tools to rotate images, select a part of an image, etc.

See the Edit Tools in "Photos/Documents (Platen) Screen (Scan/Import Window) " for details.

Note

First select images to edit. (Selected images are outlined in orange.) Drag the mouse or use

Shift + arrow keys to select multiple images.

8. Save the scanned images.

Saving

Saving as PDF Files

Note

If you want to preview the images before scanning, use ScanGear (scanner driver).

Scanning Multiple Documents at One Time with ScanGear (Scanner Driver)
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Larger than the Platen (Stitch Assist)

Scanning Images Larger than the Platen (Stitch Assist)

Stitch Assist allows you to scan the left and right halves of a large document separately and combine the

scanned images back into one image. You can scan documents that are up to twice as large as the
Platen.

1. Start MP Navigator EX and open the Navigation Mode screen.

Starting MP Navigator EX

Note

You can complete from scanning to saving, etc. at one time by simply clicking the

corresponding icon in the One-click Mode screen. Stitch Assist is available from the One-click

Mode screen as well, by changing the document size. Click the corresponding icon and select

Stitch Assist for Document Size. Then skip ahead to Step 5.

2. Point to Scan/Import and click Photos/Documents (Platen).

3. Select Document Type according to the document to be scanned.
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4. Click Specify....

Select Stitch Assist for Document Size, then specify the scanning resolution as required.

When setting is completed, click OK.

Scan Settings Dialog Box (Photos/Documents)

5. Click Scan.
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The Stitch-assist window opens.

6. Place the left half of the document face-down on the Platen.

7. Click Scan.

The left half of the document is scanned and appears in the Stitch-assist window.

8. Place the right half of the document face-down on the Platen.

9. Click Scan.

The right half of the document is scanned.

10. Adjust the scanned image as required.

Use the icons to swap the left and right halves, rotate the image 180 degrees or enlarge/reduce the

image.
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 (Swap Left & Right)

Swaps the left and right halves.

Important

This function is not available while the image is enlarged/reduced.

 Rotate 180°

Rotates right half of the image 180 degrees.

Important

This function is not available while the image is enlarged/reduced.

 (Enlarge)

Enlarges the displayed image.

 (Reduce)

Reduces the displayed image.

 (Full-screen)

Enlarges/reduces the image to display it full-screen.

Note

Enlarge/Reduce does not affect the actual size of the scanned image.

When the document is scanned upside down, the image displayed in the Stitch-assist window

will also be upside down. Click Rotate 180° to rotate the image to the correct orientation.

You can drag the right half of the image from right to left or up and down to adjust the position.

If the left and right halves do not match due to a slanted document, place the document

correctly and click Back, then scan again.

11. Click Next.

12. Drag the mouse to specify the area to be saved, then click OK.
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The combined image appears in the Thumbnail window.

When scanning is completed, the Scan Complete dialog box opens. Select Scan or Exit. Select

Scan to scan the next document, or select Exit to end.

13. Save the scanned images.

Saving

Saving as PDF Files
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with One-click

Easy Scanning with One-click

You can complete from scanning to saving, etc. at one time by simply clicking the corresponding icon.

1. Place the document on the Platen.

Placing Documents

2. Start MP Navigator EX.

Starting MP Navigator EX

The MP Navigator EX Navigation Mode screen or One-click Mode screen appears.

Navigation Mode Screen

One-click Mode Screen

Note

Skip ahead to Step 4 if One-click Mode screen is open.

3. Point to One-click.
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4. Click the corresponding icon.

Custom Scan with One-click Tab

One-click Mode Screen

5. Select Document Type according to the document to be scanned.

6. Set the document size and scanning resolution as required.

7. Start scanning.

Scanning starts.
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Useful MP Navigator EX Functions

With MP Navigator EX, you can correct/enhance scanned images beautifully, and search saved images
quickly.

Correcting/enhancing images automatically

Correcting/Enhancing Images Automatically

Correcting/enhancing images manually

Correcting/Enhancing Images Manually

Adjusting color characteristics such as brightness and contrast

Adjusting Images

Searching for lost images

Searching Images

Classifying and sorting images

Classifying Images into Categories

Page top

Page 465 of 949 pagesUseful MP Navigator EX Functions



Advanced Guide  > Scanning > Scanning with the Bundled Application Software  > Useful MP Navigator EX Functions >

Correcting/Enhancing Images Automatically

Correcting/Enhancing Images Automatically

MP Navigator EX will analyze and correct/enhance scanned images automatically.

1. Scan documents into MP Navigator EX and save them, then open the View & Use
window from the Navigation Mode screen and select the photos you want to correct/
enhance.

Note

See "Let's Try Scanning" to scan images into MP Navigator EX.

You can also select images saved on a memory card or computer.

Importing Images Saved on a Memory Card

Opening Images Saved on a Computer

2. Click Edit/Convert, then click Fix photo images on the list.

The Correct/Enhance Images window opens.

Note

The Correct/Enhance Images window can also be opened by clicking  (Image Correction/

Enhancement) on the Toolbar or in the Zoom in dialog box. In that case, only the target image

(outlined in orange) can be corrected/enhanced.
See "Correct/Enhance Images Window " for details on the Correct/Enhance Images window.

3. Select the image you want to correct/enhance from the thumbnail list.

The selected image appears in Preview.
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Note

If you selected only one image in the View & Use window, the thumbnail list does not appear

and only the preview image appears.

4. Make sure that Auto is selected.

5. Click Auto Photo Fix, Face Sharpener or Digital Face Smoothing.

Important

Once image is corrected with Auto Photo Fix and saved, it cannot be corrected again with Auto

Photo Fix. Auto Photo Fix may not be available for images edited using an application, digital

camera, etc. manufactured by other companies.

Note

The Face Sharpener and Digital Face Smoothing effect levels can be changed using the slider

that appears by clicking the corresponding buttons.

When you apply Auto Photo Fix, dark backlit photos will be corrected automatically. If the image

is not corrected enough using Auto Photo Fix, it is recommended that you apply Face

Brightener on the Manual tab.

Correcting/Enhancing Images Manually
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6. Click OK.

The entire image is corrected/enhanced automatically and  (Correct/Enhance) appears on the

upper left of the thumbnail and preview image.

Note

Click Reset Selected Image to undo the correction/enhancement.

Select the Apply to all images checkbox to correct/enhance all selected images.

7. Click Save Selected Image or Save All Corrected Images.

You can save corrected/enhanced images as new files.

Note

To save only the images you like, select them and click Save Selected Image. To save all

images, click Save All Corrected Images.

The file format of corrected/enhanced images is JPEG/Exif.

Adobe RGB images are saved as sRGB images.

8. Click Exit.

Important

The corrections/enhancements will be lost if you exit before saving corrected/enhanced

images.
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Correcting/Enhancing Images Manually

Correcting/Enhancing Images Manually

You can correct/enhance scanned images manually.

1. Scan documents into MP Navigator EX and save them, then open the View & Use
window from the Navigation Mode screen and select the photos you want to correct/
enhance.

Note

See "Let's Try Scanning" to scan images into MP Navigator EX.

You can also select images saved on a memory card or computer.

Importing Images Saved on a Memory Card

Opening Images Saved on a Computer

2. Click Edit/Convert, then click Fix photo images on the list.

The Correct/Enhance Images window opens.

Note

The Correct/Enhance Images window can also be opened by clicking  (Image Correction/

Enhancement) on the Toolbar or in the Zoom in dialog box. In that case, only the target image

(outlined in orange) can be corrected/enhanced.
See "Correct/Enhance Images Window " for details on the Correct/Enhance Images window.

3. Select the image you want to correct/enhance from the thumbnail list.

The selected image appears in Preview.
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Note

If you selected only one image in the View & Use window, the thumbnail list does not appear

and only the preview image appears.

4. Click Manual, then click Correct/Enhance.

5. Click Face Brightener, Face Sharpener, Digital Face Smoothing or Blemish
Remover.

Note

The Face Brightener, Face Sharpener and Digital Face Smoothing effect levels can be

changed using the slider that appears by clicking the corresponding buttons.

Move the cursor over the image. The shape of the cursor changes to  (Cross).

6. Drag to select the area you want to correct/enhance, then click OK that appears
over the image.
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The portion in and around the selected area is corrected/enhanced and  (Correct/Enhance)

appears on the upper left of the thumbnail and preview image.

Note

You can also drag to rotate the rectangle.

Click Undo to undo the latest correction/enhancement.

Click Reset Selected Image to cancel all corrections, enhancements and adjustments applied
to the selected image.

7. Click Save Selected Image or Save All Corrected Images.

You can save corrected/enhanced images as new files.

Note

To save only the images you like, select them and click Save Selected Image. To save all

images, click Save All Corrected Images.

The file format of corrected/enhanced images is JPEG/Exif.

8. Click Exit.

Important

The corrections/enhancements will be lost if you exit before saving corrected/enhanced

images.
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Adjusting Images

Adjusting Images

You can make fine adjustments to the overall brightness, contrast, etc. of images.

1. Scan documents into MP Navigator EX and save them, then open the View & Use
window from the Navigation Mode screen and select the photos you want to adjust.

Note

See "Let's Try Scanning" to scan images into MP Navigator EX.

You can also select images saved on a memory card or computer.

Importing Images Saved on a Memory Card

Opening Images Saved on a Computer

2. Click Edit/Convert, then click Fix photo images on the list.

The Correct/Enhance Images window opens.

Note

The Correct/Enhance Images window can also be opened by clicking  (Image Correction/

Enhancement) on the Toolbar or in the Zoom in dialog box. In that case, only the target image

(outlined in orange) can be corrected/enhanced.
See "Correct/Enhance Images Window " for details on the Correct/Enhance Images window.

3. Select the image you want to adjust from the thumbnail list.

The selected image appears in Preview.
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Note

If you selected only one image in the View & Use window, the thumbnail list does not appear

and only the preview image appears.

4. Click Manual, then click Adjust.

5. Move the slider of the item you want to adjust and set the effect level.

When you move a slider,  (Correct/Enhance) appears on the upper left of the thumbnail and

preview image.

Note

Click Defaults to reset all adjustments.

Click Reset Selected Image to cancel all corrections, enhancements and adjustments applied
to the selected image.

6. Click Save Selected Image or Save All Corrected Images.

You can save adjusted images as new files.

Note

To save only the images you like, select them and click Save Selected Image. To save all

images, click Save All Corrected Images.
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The file format of adjusted images is JPEG/Exif.

7. Click Exit.

Important

The adjustments will be lost if you exit before saving adjusted images.
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Searching Images

Searching Images

In the View & Use window of the Navigation Mode screen, you can search images saved on your

computer and open them in MP Navigator EX. Opened images can be printed, edited, etc.

Note

Search images in My Box (Scanned/Imported Images), Recently Saved Images or a selected folder

and its subfolders. You can also specify folder and search in Specify Folder.

See "Starting MP Navigator EX" to start MP Navigator EX.

Quick Search

In  (Text box) on the Toolbar, enter a word or phrase included in the file

name, Exif information or PDF text of the image you want to search for, then click  (Search button).
For Exif information, text in Maker, Model, Description and User Comment is searched.

Advanced Search

Click Search on the left of the screen to open search options. Enter information of the image you want to

search for, then click Start Search.
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Search in

If you know where to look for, select the drive, folder or network from Specify Folder.

File Name

If you know the file name, enter it.

A word or phrase in the file

Enter a word or phrase included in the items selected in More Advanced Options.

Important

For PDF files, you can only search for those created with MP Navigator EX. You cannot search

PDF files created or edited in other applications. Also, searching PDF files is available only

when keyword search is set.
For details of creating PDF files that enables keyword search, see " PDF Settings Dialog Box ."

Password-protected PDF files cannot be searched.

Category

You can search for images by category.

Modified Date

To search for images that have been updated in a specific time period, enter the first and last dates

of the period.

Shooting Date

To search for images captured in a specific time period, enter the first and last dates of the period.

Note

Captured date is the date and time of data creation, which are included in the document's Exif

information.

More Advanced Options

A word or phrase in the file

In A word or phrase in the file, select the items to search. If you select the Exif information
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checkbox, text in Maker, Model, Description and User Comment is searched. If you select the
PDF text checkbox, text in PDF files is searched.

Important

Text in password-protected PDF files cannot be searched.

Search subfolders

Select this checkbox to search subfolders.

Case sensitive

Select this checkbox to match case.

Match all criteria

Searches for files that meet all the specified criteria.

Match any criteria

Searches for files that meet any of the specified criteria.

Start Search

Starts search.

Related Topic

View & Use Window
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Classifying Images into Categories

Display images scanned with MP Navigator EX by category. You can classify unclassified images

automatically, and also create custom categories. You can drag and drop an image to move it from one
category to another.

Note

If you have classified the images in MP Navigator EX 2.0 or later and then upgrade MP Navigator EX

to the latest version, the classification information on the second latest version is transferred upon

initial startup. After the initial startup, the classification information cannot be transferred.

1. Scan documents into MP Navigator EX and save them, then open the View & Use
window from the Navigation Mode screen.

Note

See "Let's Try Scanning" to scan images into MP Navigator EX.

You can also select images saved on a memory card or computer.

Importing Images Saved on a Memory Card

Opening Images Saved on a Computer

2. In  (Sort by), select Categories.

Images are automatically sorted by category and appear in the Thumbnail window.
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Images are sorted into the following categories.

Photos: Portrait, Others

Documents: Business Card, Postcard, Standard Size, PDF File, Others

Custom categories: Displays your custom categories.

To create custom categories, see " Creating Custom Categories ."

Unclassified: Displays images that have not yet been classified.

Note

Click Classify Images to classify images displayed in Unclassified automatically. Click Cancel
to stop.

Classification may take time if there are many images to classify.

Important

Even if you classify images saved in removable media such as USB flash drive and external hard

disk, the classification information will be deleted once you remove the media. From the next time,

the images are classified to Unclassified.
Images cannot be classified when Recently Saved Images is selected in the View & Use window.

Note

Some images may not be detected correctly and thus may be classified into wrong categories. In

that case, drag and drop the image to the correct category.

Images saved in network folders may not be classified.

You can search for images by category. See "Searching Images " for details.

Creating Custom Categories

1. In the View & Use window, sort images by category and click Edit Custom
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Categories.

The Edit Custom Categories dialog box opens.

2. Click Add to List.

The Add Category dialog box opens.

3. Enter Category name and click OK.

Note

You can create up to 20 custom categories.

Up to 50 single-byte characters can be used for a category name.

Double-click a created category to open the Change Category Name dialog box in which you

can change the category name.

Select a custom category and click Delete to delete it.

Related Topic

View & Use Window
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Utilizing Images in MP Navigator EX

You can scan images using MP Navigator EX and edit or print the saved images.

See the corresponding sections below for details on saving scanned images.

Saving scanned images to computer

Saving

Saving scanned image as PDF Files

Saving as PDF Files

See the corresponding sections below for details on using images/files.

Creating/editing PDF files from scanned images

Creating/Editing PDF Files

Printing multiple scanned images at one time or printing at specific size, quality, etc.

Printing Documents

Printing scanned photos

Printing Photos

Sending scanned images via e-mail

Sending via E-mail

Correcting/enhancing scanned images or converting them to text

Editing Files

Setting passwords for created PDF files

Setting Passwords for PDF Files

Opening/Editing Password-protected PDF Files
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Saving

Saving

Save images scanned with MP Navigator EX to a computer.

1. Select the checkboxes of the images you want to save, then click Save.

2. In the Save dialog box, specify the save settings.

Specify the destination folder, file name and file type.

Save Dialog Box

Important

You cannot select JPEG/Exif when Document Type is Text(OCR).

Note

By default, the following folders are specified as the destination folders.
Windows Vista: MP Navigator EX folder in Pictures folder
Windows XP: MP Navigator EX folder in My Pictures folder

Windows 2000: MP Navigator EX folder in My Pictures folder
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3. Click Save.

Scanned images are saved according to the settings.

To further use/edit the scanned images on MP Navigator EX, click Open saved location in the Save

Complete dialog box.

Creating/Editing PDF Files

Printing Documents

Printing Photos

Sending via E-mail

Editing Files

Page top

Page 483 of 949 pagesSaving



Advanced Guide  > Scanning > Scanning with the Bundled Application Software  > Utilizing Images in MP Navigator EX >

Saving as PDF Files

Saving as PDF Files

Save images scanned with MP Navigator EX as PDF files.

1. Select the checkboxes of the images you want to save, then click Save as PDF file.

2. In the Save as PDF file dialog box, specify the save settings.

Specify the file type, file name and destination folder.

Save as PDF file Dialog Box

Select from the following PDF file types:

PDF
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Save each of the selected images as a separate PDF file.

PDF(Multiple Pages)

Save multiple images in one PDF file.

Note

PDF(Multiple Pages) is displayed when multiple images are selected.

PDF(Add Page)

Add the scanned images to a PDF file. The images are added to the end of the PDF file. You

cannot rearrange the pages of the PDF file to which the images are added.

Important

Images can only be added to PDF files created with MP Navigator EX. You cannot specify

PDF files created with other applications. PDF files edited in other applications cannot be

specified as well.
If a password-protected PDF file is edited, the passwords will be deleted. Reset the

passwords.

Note

By default, the following folders are specified as the destination folders.
Windows Vista: MP Navigator EX folder in Pictures folder
Windows XP: MP Navigator EX folder in My Pictures folder

Windows 2000: MP Navigator EX folder in My Pictures folder

You can set passwords for PDF files.

Setting Passwords for PDF Files

3. Click Save.

Scanned images are saved according to the settings.

To further use/edit the scanned images on MP Navigator EX, click Open saved location in the Save

Complete dialog box.

Creating/Editing PDF Files

Printing Documents

Printing Photos

Sending via E-mail

Editing Files
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Creating/Editing PDF Files

Create/edit PDF files using MP Navigator EX. After scanning documents and saving them, open the View

& Use window to create PDF files and add/delete pages, rearrange the page order, etc.

Important

You can create or edit up to 99 pages using MP Navigator EX.

Note

See "Let's Try Scanning" to scan images into MP Navigator EX.

You can also select images saved on a memory card or computer.

Importing Images Saved on a Memory Card

Opening Images Saved on a Computer

Creating/Editing PDF Files with MP Navigator EX

1. Select images and click PDF.

Note

You can select PDF, JPEG, TIFF and BMP files.

2. Click Create/Edit PDF file on the list.

Important

For PDF files, you can only edit those created with MP Navigator EX. You cannot edit PDF files

created with other applications. PDF files edited in other applications cannot be edited as well.
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Note

If a password-protected PDF file is selected, you will be prompted to enter the password.

Opening/Editing Password-protected PDF Files

3. Add/delete pages as required.

To add an existing file, click Add Page and select the file. To delete a page, select it and click Delete

Selected Pages.

Note

You can add PDF, JPEG, TIFF and BMP files.

When adding a password-protected PDF file, you will be prompted to enter the password.

4. Rearrange the page order as required.

Use the icons to rearrange the order. Alternatively, drag and drop the thumbnail to the target location.

Note

See "Create/Edit PDF file Window " for details on the Create/Edit PDF file window.

5. Click Save Selected Pages or Save All Pages.

The Save as PDF file dialog box opens.

Save as PDF file Dialog Box

Important

You cannot save images scanned at 10501 pixels or more in the vertical and horizontal

directions.
If a password-protected PDF file is edited, the passwords will be deleted. Reset the
passwords in the Save as PDF file dialog box.

Setting Passwords for PDF Files

6. Specify the save settings in the Save as PDF file dialog box, then click Save.

Images are saved according to the settings.

Opening PDF Files in an Application

You can open PDF files created with MP Navigator EX in an associated application and edit or print them.

1. Select PDF files and click PDF.

Important
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For PDF files, you can only select those created with MP Navigator EX. You cannot select PDF

files created with other applications. PDF files edited in other applications cannot be selected

as well.

2. Click Open PDF file on the list.

The application associated with the .pdf file extension by the operating system starts.

Important

Password-protected PDF files cannot be opened in applications not supporting PDF security.
Files may not open if an application that can be associated with PDF files is not installed.

3. Use the application to edit/print the file.

For details, refer to the application's manual.

Important

In some applications, the commands (print, edit, etc.) restricted by Permissions Password
may differ from those in MP Navigator EX.
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Printing Documents

You can print multiple scanned images at one time, print at specific quality, etc. using MP Navigator EX.

1. Scan documents into MP Navigator EX and save them, then open the View & Use
window from the Navigation Mode screen and select images.

Note

See "Let's Try Scanning" to scan images into MP Navigator EX.

You can also select images saved on a memory card or computer.

Importing Images Saved on a Memory Card

Opening Images Saved on a Computer

2. Click Print, then click Print Document on the list.

Important

If a password-protected PDF file is selected, you will be prompted to enter the password.

Opening/Editing Password-protected PDF Files

3. Specify print settings as required.

In the displayed dialog box, specify print count, quality, scale, etc.

Print Document Dialog Box
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Important

At normal-size (100%), some images may be printed small or with some portions cropped. In
that case, select Auto to resize the print in proportion to the paper size.

4. Click Print.

Printing starts.

Note

When printing a multiple-page PDF file via Print Document, printing may take time depending

on your computer. In that case, follow these steps and change settings.

1. From the Start menu, select Control Panel.

2. Click Printers.

3. Right-click the icon of your printer and click Properties.

The printer properties dialog box opens.
4. Click the Advanced tab.

5. Select Spool print documents so program finishes printing faster.

6. Select Start printing after last page is spooled.

7. After printing, return the setting on the Advanced tab to Start printing immediately.

To cancel while spooling, click Cancel. To cancel while printing, click Cancel Printing in the

confirmation window for the printer status. To open a confirmation window for the printer status,

click printer icon on the taskbar.
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Printing Photos

You can print photos using MP Navigator EX or an application that accompanies the machine. After

scanning documents and saving them, open the View & Use window to select how you want to print the

photos.

Note

See "Let's Try Scanning" to scan images into MP Navigator EX.

You can also select images saved on a memory card or computer.

Importing Images Saved on a Memory Card

Opening Images Saved on a Computer

When Printing Photos Using Easy-PhotoPrint EX

You can use Easy-PhotoPrint EX to print scanned photos at high quality or to layout and print images.

1. Select images and click Print.

2. Click Print Photo or Print Album on the list.

Easy-PhotoPrint EX starts. See " Printing Photos " for details.

Note

If Easy-PhotoPrint EX is not installed, print with MP Navigator EX.

When Printing Photos Using MP Navigator EX

1. Select images and click Print.

Page 491 of 949 pagesPrinting Photos



2. Click Print Photo on the list.

3. Specify print settings as required.

In the displayed dialog box, specify paper size, print count, etc.

Print Photo Dialog Box

4. Click Print.

Printing starts.

Note

To cancel while spooling, click Cancel. To cancel while printing, click Cancel Printing in the

confirmation window for the printer status. To open a confirmation window for the printer status,

click printer icon on the taskbar.
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Sending via E-mail

Send scanned images via e-mail.

Important

MP Navigator EX is compatible with the following e-mail software programs:

- Windows Mail (Windows Vista)

- Outlook Express (Windows XP/Windows 2000)

- Microsoft Outlook

(If an e-mail software program does not operate properly, check that the program's MAPI is enabled.

To enable MAPI, refer to the manual of the e-mail software program.)

1. Scan documents into MP Navigator EX and save them, then open the View & Use
window from the Navigation Mode screen and select images.

Note

See "Let's Try Scanning" to scan images into MP Navigator EX.

You can also select images saved on a memory card or computer.

Importing Images Saved on a Memory Card

Opening Images Saved on a Computer

2. Click Send, then click Attach to E-mail on the list.

3. Set save options as required.

Specify the destination folder and file name.

Send via E-mail Dialog Box
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Note

You can select a compression type when sending JPEG images via e-mail. Click Set... to open

a dialog box and select a compression type from High(Low Compression), Standard or

Low(High Compression).

4. Click OK.

Files are saved according to the settings, and the e-mail software program starts.

5. Specify the recipient, enter the subject and message, then send e-mail.

For details, refer to the manual of the e-mail software program.
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Editing Files

You can edit images or convert them to text using MP Navigator EX or an application that accompanies

the machine. After scanning documents and saving them, open the View & Use window to select what

you want to do with the images.

Note

See "Let's Try Scanning" to scan images into MP Navigator EX.

You can also select images saved on a memory card or computer.

Importing Images Saved on a Memory Card

Opening Images Saved on a Computer

Correcting Photo Images

You can correct/enhance images in the Correct/Enhance Images window.

1. Select images and click Edit/Convert.

2. Click Fix photo images on the list.

The Correct/Enhance Images window opens.

3. Correct/enhance images in the Correct/Enhance Images window.

Note

See "Correct/Enhance Images Window " for details on the Correct/Enhance Images window.

See the corresponding sections below for correcting/enhancing images.
Correcting/Enhancing Images Automatically

Correcting/Enhancing Images Manually

Page 495 of 949 pagesEditing Files



Converting Documents to Text

Scan text in scanned magazines and newspapers and display it in Notepad (included with Windows).

Important

PDF files cannot be converted to text.

1. Select images and click Edit/Convert.

2. Click Convert to text file on the list.

Notepad (included with Windows) starts and editable text appears.

Note

Only text written in languages that can be selected on the General tab can be extracted to

Notepad (included with Windows). Click Set... on the General tab and specify the language

according to the language of the document to be scanned.

When scanning multiple documents, you can collect the extracted text into one file.

General Tab

Text displayed in Notepad (included with Windows) is for guidance only. Text in the image of

the following types of documents may not be detected correctly.

- Documents containing text with font size outside the range of 8 points to 40 points (at 300 dpi)

- Slanted documents
- Documents placed upside down or documents with text in the wrong orientation (rotated

characters)

- Documents containing special fonts, effects, italics, or hand-written text

- Documents with narrow line spacing
- Documents with colors in the background of text

- Documents containing multiple languages
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Setting Passwords for PDF Files

Set passwords for opening, editing and printing PDF files.

You can set two passwords: one for opening the file and one for editing/printing it.

Important

In Windows 2000, Internet Explorer 5.5 Service Pack 2 or later is required to use this function.

You will not be able to open/edit the file if you forget the password. Record your passwords in a safe

place for future reference.

Password-protected PDF files cannot be opened in applications not supporting PDF security.

In some applications, the commands (print, edit, etc.) restricted by Permissions Password may
differ from those in MP Navigator EX.

Password-protected PDF files cannot be searched by text from the View & Use Window .

1. Scan documents into MP Navigator EX, then click Save as PDF file.

Alternatively, edit existing files in the Create/Edit PDF file window, then click Save
Selected Pages or Save All Pages.

The Save as PDF file dialog box opens.

Important

Passwords cannot be set when images are automatically saved after scanning, such as when

scanning from the One-click Mode screen or scanning using the Operation Panel of the

machine.

Note

See "Let's Try Scanning" to scan images.
See "Creating/Editing PDF Files " to create PDF files from existing images or to edit files.

2. Select the Password security settings checkbox.
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The Password Security -Settings dialog box opens.

Note

You can also open the Password Security -Settings dialog box by clicking Set..., then selecting

Password Security for Security in the PDF Settings dialog box.

3. Select the Require a password to open the document or Use a password to restrict
printing and editing of the document and its security settings checkbox, then enter a
password.

Important

Up to 32 single-byte alphanumeric characters can be used for the password. Passwords are

case sensitive.
Select both checkboxes to set both Document Open Password and Permissions Password.

You cannot use the same password for both.

4. Click OK.

The Confirm Document Open Password or Confirm Permissions Password dialog box opens.
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Document Open Password

Permissions Password

5. Re-enter the password and click OK.

The Save as PDF file dialog box returns.

Important

If you close the Save as PDF file dialog box without clicking Save, the settings in the Password

Security -Settings dialog box will be deleted.

Passwords are deleted once the file is edited. Reset the passwords when saving edited files.

Note

If you set the passwords via the PDF Settings dialog box, the PDF Settings dialog box returns.

Click OK. The Save as PDF file dialog box returns.

6. Click Save.

Files are saved according to the settings.

Related Topic

Opening/Editing Password-protected PDF Files
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Opening/Editing Password-protected PDF Files

Enter a password to open or edit/print password-protected PDF files.

Password entry method varies by operation. The following procedures are examples only.

Important

You can open, edit or print only PDF files whose passwords were set with MP Navigator EX. You

cannot edit PDF files edited in other applications or whose passwords were set with other

applications. Only MP Navigator EX version 1.1 and 2.0 or later supports opening, editing and

printing password-protected PDF files.

In Windows 2000, Internet Explorer 5.5 Service Pack 2 or later is required to open, edit or print

password-protected PDF files.

Passwords are case sensitive.
You can create or edit up to 99 pages using MP Navigator EX.

Entering a Password to Open a File

1. In the View & Use window, select the PDF file you want to open and click  Zoom
in.

Alternatively, double-click the PDF file.

Note

Only the Document Open Password will be required. The Permissions Password will not be

required.
If the Zoom in dialog box with a lock icon opens, click Enter Password.
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2. The Password dialog box opens. Enter the password and click OK.

The PDF file opens in the Zoom in dialog box.

Note

To reopen the file after closing the Zoom in dialog box, re-enter the password.

Entering a Password (Permissions Password) to Edit or Print a File

1. In the View & Use window, select PDF files and click PDF or Print.
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2. To create a PDF file or edit the file, select Create/Edit PDF file on the list. To print
the file, click Print Document.

In the Password dialog box, you will be prompted to enter a password.

Note

If the Document Open Password is set as well, the Document Open Password will be

required, then the Permissions Password will be required.

3. Enter the password and click OK.

The corresponding dialog box opens.

Important

If a password-protected PDF file is edited, the passwords will be deleted. Reset the

passwords.
Setting Passwords for PDF Files

Related Topic

Setting Passwords for PDF Files
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MP Navigator EX Screens

Learn about the screens and functions of MP Navigator EX.

Scan/Import Documents or Images Tab

Photos/Documents (Platen) Screen (Scan/Import Window)

Scan Settings Dialog Box (Photos/Documents)

Save Dialog Box

Save as PDF file Dialog Box

Memory Card Screen (Scan/Import Window)

View & Use Images on your Computer Tab

View & Use Window

Create/Edit PDF file Window
Print Document Dialog Box

Print Photo Dialog Box

Send via E-mail Dialog Box

Correct/Enhance Images Window

Custom Scan with One-click Tab / One-click Mode Screen

Auto Scan Dialog Box

Save Dialog Box (One-click Mode Screen)

PDF Dialog Box

Mail Dialog Box

OCR Dialog Box

Custom Dialog Box

Preferences Dialog Box

General Tab

Scanner Button Settings Tab (Save)

Scanner Button Settings Tab (Attach to E-mail)

Scanner Button Settings Tab (Open with Application)
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Navigation Mode Screen

Navigation Mode Screen

This is one of the startup screens of MP Navigator EX.

Point to the icon at the top of the screen to display each tab. Use each tab depending on what you want to

do.

Scan/Import

You can scan photos and documents, or import images saved on memory cards.

Scan/Import Documents or Images Tab

View & Use

You can open images saved on a computer and print them or attach them to e-mail. You can also edit

them using an application that accompanies the machine.
View & Use Images on your Computer Tab

One-click

You can complete from scanning to saving, etc. at one time by simply clicking the corresponding icon.

Custom Scan with One-click Tab

 (Switch Mode)

Switches to One-click Mode screen. In the One-click Mode screen, you can complete from scanning to

saving, etc. at one time by simply clicking the corresponding icon.

One-click Mode Screen

Show this window at startup

Select this checkbox to open the Main Menu at startup. If this checkbox is not selected, the last used

screen appears.

 Preferences

The Preferences dialog box opens. In the Preferences dialog box, you can make advanced settings to
MP Navigator EX functions.

Preferences Dialog Box

 (Guide)

Opens this guide.
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Import Documents or Images Tab

Scan/Import Documents or Images Tab

Point to Scan/Import in the Navigation Mode screen to display the Scan/Import Documents or Images
tab.

You can scan photos and documents, or import images saved on memory cards.

Photos/Documents (Platen)

Opens the Scan/Import window. Scan photos and documents placed on the Platen.

Photos/Documents (Platen) Screen (Scan/Import Window)

Memory Card

Opens the Scan/Import window with Memory Card selected. Import images saved on memory cards.

Memory Card Screen (Scan/Import Window)

 (Switch Mode)

Switches to One-click Mode screen. In the One-click Mode screen, you can complete from scanning to

saving, etc. at one time by simply clicking the corresponding icon.

One-click Mode Screen

Show this window at startup

Select this checkbox to open the Main Menu at startup. If this checkbox is not selected, the last used

screen appears.

 Preferences

The Preferences dialog box opens. In the Preferences dialog box, you can make advanced settings to
MP Navigator EX functions.

Preferences Dialog Box

 (Guide)

Opens this guide.
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View & Use Images on your Computer Tab

Point to View & Use in the Navigation Mode screen to display the View & Use Images on your Computer
tab.

You can open images saved on a computer and print them or attach them to e-mail. You can also edit

them using an application that accompanies the machine.

My Box (Scanned/Imported Images)

Opens the View & Use window with My Box (Scanned/Imported Images) selected.

You can open and use images saved in My Box.

My Box is a specific folder for saving images scanned with MP Navigator EX.

Note

The following folders are specified by default.

Windows Vista: MP Navigator EX folder in Pictures folder
Windows XP: MP Navigator EX folder in My Pictures folder

Windows 2000: MP Navigator EX folder in My Pictures folder

Specify Folder

Opens the View & Use window with Specify Folder selected.

You can open and use images saved in specific folders.

Recently Saved Images

Opens the View & Use window with Recently Saved Images selected.

You can open and use "Scanned/Imported Images" and images that have been "Attached to E-mail" or
"Sent to Application" recently.

View & Use Window

 (Switch Mode)

Switches to One-click Mode screen. In the One-click Mode screen, you can complete from scanning to

saving, etc. at one time by simply clicking the corresponding icon.

One-click Mode Screen

Show this window at startup

Select this checkbox to open the Main Menu at startup. If this checkbox is not selected, the last used

screen appears.

 Preferences
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The Preferences dialog box opens. In the Preferences dialog box, you can make advanced settings to
MP Navigator EX functions.

Preferences Dialog Box

 (Guide)

Opens this guide.

Related Topic

Opening Images Saved on a Computer
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Scan with One-click Tab

Custom Scan with One-click Tab

Point to One-click in the Navigation Mode screen to display the Custom Scan with One-click tab.

You can complete from scanning to saving, etc. at one time by simply clicking the corresponding icon.

Auto Scan

Scan documents by automatically detecting the document type. File format is automatically set. Files

are saved to a computer. You can apply Auto Photo Fix as required.

When you click this icon, the Auto Scan dialog box opens and you can specify the save settings.
Auto Scan Dialog Box

Save to PC

Scan documents or photos and save them to a computer. The document type can be detected

automatically.

When you click this icon, the Save dialog box opens and you can specify the scan/save settings.

Save Dialog Box (One-click Mode Screen)

Save as PDF file

Scan documents and save them as PDF files.

When you click this icon, the PDF dialog box opens and you can specify the scan/save and application

settings.
PDF Dialog Box

Attach to E-mail

Scan documents or photos and attach them to e-mail.
When you click this icon, the Mail dialog box opens and you can specify the scan/save and e-mail

software program settings.
Mail Dialog Box

OCR

Scan text documents then extract text in the image and display it in Notepad (included with Windows).

When you click this icon, the OCR dialog box opens and you can specify the scan/save settings.

OCR Dialog Box

Note

For further procedures, refer to the application's manual.

Custom

Scan documents and open them in a specified application. Document type is automatically detected.

Page 508 of 949 pagesCustom Scan with One-click Tab



When you click this icon, the Custom dialog box opens and you can specify the scan/save and

application settings.
Custom Dialog Box

Note

For further procedures, refer to the application's manual.

Start scanning by clicking the button

Select this checkbox and click an icon to start scanning immediately.

 (Switch Mode)

Switches to One-click Mode. The One-click Mode screen appears.

One-click Mode Screen

Show this window at startup

Select this checkbox to open the Main Menu at startup. If this checkbox is not selected, the last used

screen appears.

 Preferences

The Preferences dialog box opens. In the Preferences dialog box, you can make advanced settings to
MP Navigator EX functions.

Preferences Dialog Box

 (Guide)

Opens this guide.

Important

The following restrictions apply when you scan with Document Type set to Auto Mode in the Save or

Custom dialog box.
When you want to convert text in the scanned image to text data, specify Document Type (do not

select Auto Mode).

Related Topic

Easy Scanning with One-click
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Documents (Platen) Screen (Scan/Import Window)

Photos/Documents (Platen) Screen (Scan/Import Window)

Point to Scan/Import in the Navigation Mode screen and click Photos/Documents (Platen) to open the

Photos/Documents (Platen) screen (Scan/Import window).

Open this window to scan documents from the Platen.

(1) Settings and Operation Buttons

(2) Toolbar

(3) Thumbnail Window

(4) Selected Images Area

Settings and Operation Buttons

 (View & Use)

Click this when you want to open images and PDF files saved on your computer. The View & Use

window opens.
View & Use Window

Photos/Documents (Platen)

Displays the screen for scanning photos, documents, magazines and other printed materials.

Memory Card

Click this when you want to import images saved on a memory card. The screen for importing

images from a memory card appears.
Memory Card Screen (Scan/Import Window)

Document Type

Select the type of document to be scanned.

Scanning photos: Color Photo or Black and White Photo

Scanning text documents: Color Document, Black and White Document or Text(OCR)

Scanning magazines: Magazine(Color)

Important
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You cannot select Document Type if the Use the scanner driver checkbox is selected.

Specify...

Specify the document size, resolution, and other advanced scan settings.

Scan Settings Dialog Box (Photos/Documents)

Important

Specify... is not available if the Use the scanner driver checkbox is selected.

Use the scanner driver

Select this checkbox when you want to scan with ScanGear (scanner driver). Use ScanGear

(scanner driver) to correct images and adjust colors when scanning.

Scan

Scanning starts.

Note

This button changes to Open Scanner Driver when you select the Use the scanner driver
checkbox.

Open Scanner Driver

ScanGear (scanner driver) starts.
See "ScanGear (Scanner Driver) Screens " for details on ScanGear (scanner driver) screens.

Note

This button changes to Scan when you deselect the Use the scanner driver checkbox.

Clear

Delete all images in the Thumbnail window.

Note

Images not saved on a computer will be deleted. To keep important images, use Save or other

methods to save them to a computer before clicking Clear.

Save

Save the selected images. Click to open the Save dialog box and specify the save settings.

Save Dialog Box

Save as PDF file

Save the selected images as PDF files. Click to open the Save as PDF file dialog box and specify the

save settings.

Save as PDF file Dialog Box

 Jump to Main Menu

Jumps to the Main Menu.

Toolbar

 Preferences

The Preferences dialog box opens. In the Preferences dialog box, you can make advanced settings
to MP Navigator EX functions.

Preferences Dialog Box

 (Guide)

Opens this guide.

Edit Tools

 (Select All)
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Selects all images in the Thumbnail window.

 (Cancel All)

Cancels all image selections in the Thumbnail window.

 (Rotate Left)

Rotates the target image (outlined in orange) 90 degrees counter-clockwise.

 (Rotate Right)

Rotates the target image (outlined in orange) 90 degrees clockwise.

 (Invert)

Inverts the target image (outlined in orange) horizontally.

 (Trimming)

Trims the target image (outlined in orange) in the Thumbnail window. Trimming is the act of

selecting the area you want to keep in a photo and discarding the rest. Click this button to open

the Crop window and specify the trimming frame.

 Zoom in

Enlarges the target image (outlined in orange). You can also enlarge the image by double-

clicking it.

 (Display Size)

Changes the size of images in the Thumbnail window.

 (Sort by)

Sorts the images in the Thumbnail window by category or by date (ascending or descending).

Thumbnail Window

Thumbnail Window

Scanned images are displayed.
When you select the checkbox of an image, the image appears in the Selected Images area.

Note

Thumbnails may appear as "?" when there is not enough memory to display the images.

When Images are Sorted by Categories

Close All / Open All

 Close All

Hides all images.

 Open All

Displays all images.

Note

Click Close All to change to Open All.

Selected Images Area

 (Cancel All)

Cancels the selection of all images in the Selected Images area.
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 (Cancel Selection)

Cancels the selection of the target image (outlined in orange) in the Selected Images area.

Selected Images Area

Images selected in the Thumbnail window are displayed.

Related Topic

Scanning Photos and Documents
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Settings Dialog Box (Photos/Documents)

Scan Settings Dialog Box (Photos/Documents)

The Scan Settings dialog box opens when you click Specify... in the Scan/Import window.

In the Scan Settings dialog box, you can make advanced scan settings.

Document Type

Select the type of document to be scanned.

Scanning photos: Color Photo or Black and White Photo

Scanning text documents: Color Document, Black and White Document or Text(OCR)

Scanning magazines: Magazine(Color)

Important

To scan correctly, select a document type that matches the document to be scanned.

Document Size

Select the size of the document to be scanned.

When you select Custom, a screen in which you can specify the document size appears. Select a

Units, then enter the Width and Height and click OK.

Important

When you select Auto Detect, the image may not be scanned at the correct position and size. In

that case, change the size to the actual document size (A4, Letter, etc.) and align a corner of the

document with the corner at the arrow (alignment mark) of the Platen.

You cannot select Auto Detect (Multiple Documents) or Auto Detect when Document Type is
Text(OCR).

Scanning Resolution

Select the resolution at which to scan documents.

Resolution

Note
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The following scanning resolutions can be specified when Document Type is Text(OCR).

300 dpi / 400 dpi

Descreen

Select this checkbox to reduce moire patterns.

Printed photos and pictures are displayed as a collection of fine dots. "Moire" is a phenomenon where
uneven gradation or a stripe pattern appears when such photos or pictures printed with fine dots are

scanned. Descreen is the function for reducing this moire effect.

Important

You cannot select this checkbox when Document Type is Color Photo, Black and White Photo or
Text(OCR).

Note

Scanning takes longer than usual when you enable Descreen.

Reduce Show-through

Select this checkbox to sharpen text in a document or reduce show-through in newspapers.

Important

You cannot select this checkbox when Document Type is Color Photo, Black and White Photo or
Text(OCR).

Note

Select this checkbox when Document Type is text document and show-through is apparent in the

scanned image.

Unsharp Mask

Select this checkbox to emphasize the outline of the subjects and sharpen the image.

Important

You cannot select this checkbox when Document Type is Text(OCR).

Remove gutter shadow

Select this checkbox to correct shadows that appear between pages when scanning open booklets.

Important

You cannot select this checkbox when Document Size is Auto Detect, Auto Detect (Multiple

Documents) or Stitch Assist.
Align the document correctly with the alignment mark on the Platen.

Note

Use ScanGear's Advanced Mode tab to correct gutter shadows when scanning non-standard size

documents or when custom cropping frames are set.
For details, see Gutter Shadow Correction in " Image Settings " (ScanGear's Advanced Mode tab).

Correct slanted document

Select this checkbox to detect the scanned text and correct the angle (within -0.1 to -10 degrees or +0.1

to +10 degrees) of the document.

Important

You cannot select this checkbox when Document Type is Color Photo or Black and White Photo.

You cannot select this checkbox when Document Size is Stitch Assist.

The inclination of the following types of documents may not be corrected, as the text cannot be
detected correctly.

- Documents in which the text lines are inclined more than 10 degrees or the angles vary by line

- Documents containing both vertical and horizontal text

- Documents with extremely large or small fonts
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- Documents with small amount of text

- Documents containing figures/images or hand-written text

- Documents containing both vertical and horizontal lines (tables)

Note

Scanning takes longer than usual when you enable Correct slanted document.

Detect the orientation of text documents and rotate images

Select this checkbox to detect the orientation of the document from the scanned text and rotate the

scanned image to the correct orientation. Select the language of the document to be scanned in

Document Language.

Important

You cannot select this checkbox when Document Type is Color Photo or Black and White Photo.

You cannot select this checkbox when Document Size is Stitch Assist.

This function may not work properly depending on the document language. Only text documents

written in languages that can be selected from Document Language are supported.
The orientation of the following types of documents may not be corrected, as the text cannot be

detected correctly. In that case, select the scanned image in the Thumbnail window of the "

Photos/Documents (Platen) Screen (Scan/Import Window) " and rotate it with Edit Tools.
- Resolution is outside the range of 300 dpi to 600 dpi
- Font size is outside the range of 8 points to 48 points

- Documents containing special fonts, effects, italics, or hand-written text

- Documents with patterned backgrounds

Note

Scanning takes longer than usual when you enable Detect the orientation of text documents and

rotate images.

Document Language

Select the language of the document to be scanned.

Important

You cannot select this checkbox when Document Type is Color Photo or Black and White Photo.

You cannot select this checkbox when Document Size is Stitch Assist.

Defaults

Restores the default settings.
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Dialog Box

Save Dialog Box

The Save dialog box opens when you click Save in the Scan/Import window.

In the Save dialog box, you can make settings for saving images to a computer.

Save in

Displays the folder in which to save the scanned images. To change the folder, click Browse... to

specify another one.

The following folders are specified by default.

Windows Vista: MP Navigator EX folder in Pictures folder
Windows XP: MP Navigator EX folder in My Pictures folder

Windows 2000: MP Navigator EX folder in My Pictures folder

Important

When saving to a memory card, enable writing on the Card Slot of the machine. For details on

how to enable writing, refer to "Setting Up the Card Slot as the Memory Card Drive of the

Computer." With network connection, map the Card Slot as a network drive. See " Using the Card
Slot over a Network " for details.

File name

Enter the file name of the image to be saved (up to 64 characters). When saving multiple files, 4 digits

are appended to each file name.

Save as type

Select a file type to save the scanned images.
Select JPEG/Exif, TIFF or BMP.

Important

You cannot select JPEG/Exif when Document Type is Text(OCR).

Set...

When Save as type is JPEG/Exif

You can specify a compression type for JPEG files. Select High(Low Compression), Standard or

Low(High Compression).

Important

This setting is not available when the Compress scanned images when transferring checkbox is
selected on the General tab of the Preferences dialog box.

Save to a Subfolder with Current Date
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Select this checkbox to create a subfolder in the folder specified in Save in with the current date and

save scanned files in it. A subfolder with a name such as "2009_01_01" (Year_Month_Date) will be

created.

If this checkbox is not selected, files are saved directly in the folder specified in Save in.

Page top
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Save as PDF file Dialog Box

In the Save as PDF file dialog box, you can make advanced settings for saving scanned images as PDF

files. You can save multiple documents as one PDF file or add pages to a PDF file created with MP
Navigator EX.

Important

You cannot save images scanned at 10501 pixels or more in the vertical and horizontal directions.

Dialog box that opens when Save as PDF file in the Scan/Import window is clicked

Dialog box that opens when Save Selected Pages or Save All Pages is clicked in the
Create/Edit PDF file window

Save as type

Select a PDF file type to save the scanned images.
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PDF

Save each of the selected images as a separate PDF file.

PDF(Multiple Pages)

Save multiple images in one PDF file.

Note

PDF(Multiple Pages) is displayed when multiple images are selected.

PDF(Add Page)

Add the scanned images to a PDF file. The images are added to the end of the PDF file. You

cannot rearrange the pages of the PDF file to which the images are added.

Important

Images can only be added to PDF files created with MP Navigator EX. You cannot specify

PDF files created with other applications. PDF files edited in other applications cannot be

specified as well.
If a password-protected PDF file is edited, the passwords will be deleted. Reset the

passwords.
Setting Passwords for PDF Files

Set...

Make advanced settings for creating PDF files. See " PDF Settings Dialog Box" for details.

Password security settings

Select this checkbox to open the Password Security -Settings dialog box in which you can set

passwords for opening, editing and printing created PDF files.

Setting Passwords for PDF Files

Add to

This is displayed when you select PDF(Add Page) for Save as type and specify the PDF file to which

images are added. To change the file, click Browse... to specify another one.

Important

Images can only be added to PDF files created with MP Navigator EX. You cannot specify PDF

files created with other applications. PDF files edited in other applications cannot be specified

as well.

File name

Enter the file name of the image to be saved (up to 64 characters). When saving multiple files, 4

digits are appended to each file name.

Save in

Displays the folder in which to save the PDF files. To change the folder, click Browse... to specify

another one.

The following folders are specified by default.

Windows Vista: MP Navigator EX folder in Pictures folder
Windows XP: MP Navigator EX folder in My Pictures folder

Windows 2000: MP Navigator EX folder in My Pictures folder

Save to a Subfolder with Current Date

Select this checkbox to create a subfolder in the folder specified in Save in with the current date and

save scanned files in it. A subfolder with a name such as "2009_01_01" (Year_Month_Date) will be

created.

If this checkbox is not selected, files are saved directly in the folder specified in Save in.
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Settings Dialog Box

PDF Settings Dialog Box

In the PDF Settings dialog box, you can specify the PDF compression type and other advanced settings

for creating PDF files.

Enable keyword search

Select this checkbox to convert characters in a document to text data. This will enable an easy search
by keyword.

Document Language

Select the language of the document to be scanned.

Detect the orientation of text documents and rotate images

Select this checkbox to detect the orientation of the document from the scanned text and rotate the

scanned image to the correct orientation.

Important

This function may not work properly depending on the document language. Only text documents

written in languages that can be selected from Document Language are supported.

The orientation of the following types of documents may not be corrected, as the text cannot be
detected correctly.

- Resolution is outside the range of 300 dpi to 600 dpi
- Font size is outside the range of 8 points to 48 points

- Documents containing special fonts, effects, italics, or hand-written text

- Documents with patterned backgrounds

Correct slanted document

Select this checkbox to detect the scanned text and correct the angle (within -0.1 to -10 degrees or +0.1

to +10 degrees) of the document.

Important

The inclination of the following types of documents may not be corrected, as the text cannot be
detected correctly.

- Documents in which the text lines are inclined more than 10 degrees or the angles vary by line

- Documents containing both vertical and horizontal text

- Documents with extremely large or small fonts

- Documents with small amount of text

- Documents containing figures/images or hand-written text

- Documents containing both vertical and horizontal lines (tables)

PDF Compression

Select a compression type for saving.
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Standard

It is recommended that you normally select this setting.

High

Compresses the file size when saving, allowing you to reduce the load on your network/server.

Important

Highly compressed PDF images may degrade if you repeatedly save them with high

compression.

Note

The following images can be compressed with high efficiency.

- Images with resolutions within the range of 75 dpi to 600 dpi.

Security

Set passwords for opening, editing and printing the created PDF files.

Important

In Windows 2000, Internet Explorer 5.5 Service Pack 2 or later is required to use this function.

This function is not available when images are automatically saved after scanning, such as when

scanning from the One-click Mode screen or scanning using the Operation Panel of the machine.

Note

Select Password Security and set passwords in the Password Security -Settings dialog box.

Setting Passwords for PDF Files
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Card Screen (Scan/Import Window)

Memory Card Screen (Scan/Import Window)

Point to Scan/Import in the Navigation Mode screen and click Memory Card, or click Memory Card in the
Scan/Import window to open the Memory Card screen (Scan/Import window).

Open this window to import images (including PDF files created via scanning using the Operation Panel)
saved on a memory card.

(1) Settings and Operation Buttons

(2) Toolbar

(3) Thumbnail Window

(4) Selected Images Area

Settings and Operation Buttons

 (View & Use)

Click this when you want to open images and PDF files saved on your computer. The View & Use

window opens.
View & Use Window

Photos/Documents (Platen)

Click this when you want to scan photos, documents, magazines and other printed materials. The

screen for scanning photos and documents appears.
Photos/Documents (Platen) Screen (Scan/Import Window)

Memory Card

Displays folders of images and PDF files (grouped by year, month/year and month/date/year) on a

memory card in tree view. Select a folder to display its contents in the Thumbnail window to the right.

File date is the captured or updated date.

Import

Imports the selected images and open them in the View & Use window.
View & Use Window
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 Jump to Main Menu

Jumps to the Main Menu.

Toolbar

 Preferences

The Preferences dialog box opens. In the Preferences dialog box, you can make advanced settings
to MP Navigator EX functions.

Preferences Dialog Box

 (Guide)

Opens this guide.

Edit Tools

 (Select All)

Selects all images in the Thumbnail window.

 (Cancel All)

Cancels all image selections in the Thumbnail window.

 Zoom in

Enlarges the target image (outlined in orange). You can also enlarge the image by double-

clicking it. You can check all pages when you select a PDF file.

 (Refresh)

Refreshes the Thumbnail window contents.

 (Display Size)

Changes the size of images in the Thumbnail window.

 (Sort by)

Sorts the images in the Thumbnail window by date (ascending or descending).

Thumbnail Window

Thumbnail Window

Images saved on the memory card are displayed by year or month/year.

When you select the checkbox of an image, the image appears in the Selected Images area.

Selected Images Area

 (Cancel All)

Cancels the selection of all images in the Selected Images area.

 (Cancel Selection)

Cancels the selection of the target image (outlined in orange) in the Selected Images area.

Selected Images Area

Images selected in the Thumbnail window are displayed.

Related Topic

Importing Images Saved on a Memory Card
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Use Window

View & Use Window

Point to View & Use in the Navigation Mode screen and click My Box (Scanned/Imported Images), Specify

Folder or Recently Saved Images to open the View & Use window.

Open this window to display or use scanned images or images saved on a computer.

Important

For PDF files, only those created with MP Navigator EX are displayed. You cannot display PDF files

created with other applications. PDF files edited in other applications cannot be displayed as well.

(1) Display Setting Items

(2) Image Handling Buttons

(3) Toolbar

(4) Thumbnail Window

(5) Selected Images Area

Display Setting Items

 (Scan/Import)

Click this when you want to scan photos, documents, magazines and other printed materials. The
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Scan/Import window opens.
Photos/Documents (Platen) Screen (Scan/Import Window)

My Box (Scanned/Imported Images)

Displays folders of images (grouped by year, year/month and year/month/date) in My Box in tree

view. Select a folder to display its contents in the Thumbnail window to the right.

Image date is the scanned, captured or updated date.

Specify Folder

Displays all hard disks and folders in tree view. Select a folder to display images in the Thumbnail

window to the right.

Selecting a folder and clicking it highlights the folder name, allowing you to rename it.

Recently Saved Images

"Scanned/Imported Images" and images that have been "Attached to E-mail" or "Sent to Application"

recently are displayed in tree view by date. For "Scanned/Imported Images", "From Scanner" and

"From Memory Card" are displayed separately. Select a Month/Date/Year folder to display images by

date in the Thumbnail window to the right.

Image date is the scanned or sent date.

Search

The advanced search options opens.

Searching Images

 Jump to Main Menu

Jumps to the Main Menu.

Image Handling Buttons

Image Handling Buttons

Specify what to do with the selected images. See the corresponding sections below for details on

each button.

Creating/Editing PDF Files

Printing Documents
Printing Photos

Sending via E-mail

Editing Files

Note

The buttons in Image Handling Buttons are displayed when the corresponding applications are

installed.

Toolbar

 Preferences

The Preferences dialog box opens. In the Preferences dialog box, you can make advanced settings
to MP Navigator EX functions.

Preferences Dialog Box

 (Guide)

Opens this guide.

Edit Tools

 (Select All)

Selects all images in the Thumbnail window.

 (Cancel All)

Cancels all image selections in the Thumbnail window.
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 (Image Correction/Enhancement)

Allows you to correct the target image (outlined in orange). Click this button to open the Correct/

Enhance Images window in which you can correct/enhance images and also adjust the

brightness, contrast, etc.

Correct/Enhance Images Window

Important

Image correction/enhancement cannot be applied to PDF files or black and white binary

files.

 Zoom in

Enlarges the target image (outlined in orange). You can also enlarge the image by double-
clicking it. You can check all pages when you select a PDF file.

You can also check file information such as file name, date, size and security setting. A lock icon

appears for PDF files with Document Open Password set.

Opening/Editing Password-protected PDF Files

 (Search)

Enter a word or phrase included in the file name, Exif information or PDF text of the image you

want to search for, then click  (Search button). For Exif information, text in Maker, Model,

Description and User Comment is searched.

Note

Search images in My Box (Scanned/Imported Images), Recently Saved Images or a

selected folder and its subfolders.

 (Refresh)

Refreshes the Thumbnail window contents.

 (Display Size)

Changes the size of images in the Thumbnail window.

 (Sort by)

Sorts the images in the Thumbnail window by category, date (ascending or descending) or

name (ascending or descending).
Images can be sorted by category only when My Box (Scanned/Imported Images) or Specify

Folder is displayed.

Thumbnail Window

Thumbnail Window

Scanned images are displayed.
When you select the checkbox of an image, the image appears in the Selected Images area.

Selecting an image and clicking the file name highlights the file name, allowing you to rename it.

Drag and drop an image to do the following things.
- Move from one category to another within the Thumbnail window

- Move to a category folder displayed in My Box (Scanned/Imported Images)

- Copy to a folder displayed in Specify Folder

Important

In Windows 2000, Internet Explorer 5.5 Service Pack 2 or later is required to open password-

protected PDF files.

You cannot change the extension (.jpg, .pdf, etc.) when renaming a file.

You cannot move or copy images to the date folders displayed in tree view in My Box (Scanned/

Imported Images) or Recently Saved Images.
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Note

A lock icon appears for PDF files with Document Open Password set.

Thumbnails may appear as "?" in the following cases.
- Opening unsupported images
- File size is too large and there is not enough memory to display the image
- The file is corrupted

When Images are Sorted by Categories

Scanned images are displayed by category.

Note

Some images may not be detected correctly and thus may be classified into wrong categories.

In that case, drag and drop an image and move it from one category to another.

Category name Images: N (Selected: n)

Category name

The following categories are provided.

Photos: Portrait, Others

Documents: Business Card, Postcard, Standard Size, PDF File, Others

Custom categories: Displays your custom categories.
Unclassified: Displays images that have not yet been classified.

Images: N

The number of images classified into the category is displayed.

(Selected: n)

The number of images with the checkbox selected is displayed.

Note

This portion is displayed only when one or more images are selected.

Close All / Open All

 Close All

Hides all images.

 Open All

Displays all images.

Note

Immediately after opening the View & Use window or sorting images, all images appear

and Close All is displayed.

Click Close All to change to Open All.

Specific Categories / All Categories

You can narrow down the categories to display only those containing images. If you narrow

down the categories, more images are displayed in the Thumbnail List area, allowing you to

find or move images easily.

This button is displayed only when My Box (Scanned/Imported Images) or Specify Folder is

displayed.

 Specific Categories

Displays categories containing images, along with the contained images.
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 All Categories

Displays all categories and images.

Note

Click Specific Categories to change to All Categories.

 Edit Custom Categories

When My Box (Scanned/Imported Images) or Specify Folder is displayed, the Edit Custom

Categories dialog box opens.
In the Edit Custom Categories dialog box, you can add/delete categories displayed in Custom

Categories.
See "Classifying Images into Categories " for details.

 Classify Images

Images imported from hard disks or memory cards appear in Unclassified. Click Classify
Images to classify them automatically.

This button is displayed only when My Box (Scanned/Imported Images) or Specify Folder is

displayed.

Note

Classification may take time if there are many images to classify.

Selected Images Area

 (Cancel All)

Cancels the selection of all images in the Selected Images area.

 (Cancel Selection)

Cancels the selection of the target image (outlined in orange) in the Selected Images area.

Selected Images Area

Images selected in the Thumbnail window are displayed.

Related Topic

Opening Images Saved on a Computer
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Edit PDF file Window

Create/Edit PDF file Window

Click PDF in the View & Use window, then click Create/Edit PDF file on the list to open the Create/Edit

PDF file window.

In the Create/Edit PDF file window, you can add/delete pages and rearrange the page order of PDF files
created with MP Navigator EX.

Important

You cannot save images scanned at 10501 pixels or more in the vertical and horizontal directions.

If a password-protected PDF file is edited, the passwords will be deleted. Reset the passwords.

Setting Passwords for PDF Files

You can create or edit up to 99 pages using MP Navigator EX.

Rearrange Pages

You can move the selected image (outlined in orange).

Moves the selected image to the top.

Moves the selected image up one page.

Moves the selected image down one page.

Moves the selected image to the end.

Note

You can also drag and drop the image to rearrange the order.

Delete Selected Pages

Deletes the selected image.
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Add Page

Allows you to select and add an existing PDF file.

Note

A password will be required to add a password-protected PDF file.

Undo

Cancels the latest change made.

Reset

Cancels all the changes made.

Save Selected Pages

Opens the Save as PDF file dialog box. Specify the save settings. Only the selected page is saved.

Note

When multiple pages are selected, a multiple-page PDF file is created.
See "Save as PDF file Dialog Box " for details on the Save as PDF file dialog box.

Save All Pages

Opens the Save as PDF file dialog box. Specify the save settings. All PDF files in the list will be saved

as one PDF file.

Finish

Closes the Create/Edit PDF file window.

Toolbar

 (Rotate Left)

Rotates the page 90 degrees counter-clockwise.

 (Rotate Right)

Rotates the page 90 degrees clockwise.

 (Preview Mode)

Switches to Preview Mode.
The selected file appears in Preview.

 (Enlarge)

Enlarges the image displayed in Preview.

 (Reduce)

Reduces the image displayed in Preview.
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 (Full-screen)

Enlarges/reduces the image to display it fully in Preview.

 (Thumbnail Mode)

Switches to Thumbnail Mode. Thumbnails of files are displayed.
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Document Dialog Box

Print Document Dialog Box

Click Print in the View & Use window, then click Print Document on the list to open the Print Document

dialog box.

In the Print Document dialog box, you can make advanced settings for printing multiple scanned images

at one time.

Note

The setting items in the Print Document dialog box vary by printer.

Printer

Select the printer to use.

Paper Source

Select paper source.

Page Layout

Select a print type.

Normal-size Printing

Print one image per sheet.

Scaled Printing

Print images at the selected scale (enlarged or reduced).

Fit-to-Page Printing

Print an image at the paper size (enlarged or reduced).

Borderless Printing

Print the image on an entire sheet of paper without margins.

Page Layout Printing (2 on 1)

Layout and print two images on a sheet of paper.

Page Layout Printing (4 on 1)

Layout and print four images on a sheet of paper.

Auto Duplex

Print on both sides of a sheet of paper automatically.
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Note

Auto Duplex is displayed when Page Layout is Normal-size Printing or Scaled Printing, and

available when Media Type is Plain Paper.

Staple Side

Select a stapling side from the list.

Note

Staple Side is available when Auto Duplex On is set.

Specify Margin...

Specify the width of the margin (0 mm to 30 mm).

Note

Specify Margin... is available when Auto Duplex On is set.

If a page does not fit in one page due to the Specify Margin... setting, the document will be

reduced for printing.

Enlarge/Reduce

Enlarge or reduce images to print.

 (Enlarge/Reduce)

Print a reduced or enlarged image by specifying a scale in increments of 1%.

Auto

Scale is adjusted automatically according to the detected paper width and the selected paper size.

Image may be printed rotated 90 degrees depending on its size.

Scale

Select a scale from the list.

Important

At normal-size (100%), some images may be printed small or with some portions cropped. In
that case, select Auto to resize the print in proportion to the paper size.

Paper Size

Select the size of paper for printing. Match the size to the size of the paper set in the machine.

Note

Selectable paper sizes depend on the selected printer.

Media Type

Select the type of paper for printing. Print quality may be fixed depending on the paper type.

Note

Selectable paper types depend on the selected printer.

Print Quality

Select the print quality.

Density

Click  (Density adjustment) to select the print density.

Copies

Click  (Copy setting) to select the number of copies to be printed.

Grayscale Printing

Select this checkbox to print the document in black and white.

Preview before printing
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Select this checkbox to display the print result before printing.

Defaults

Restores the default settings.

Print

Start printing with the specified settings.

Note

To cancel while spooling, click Cancel. To cancel while printing, click Cancel Printing in the

confirmation window for the printer status. To open a confirmation window for the printer status,

click printer icon on the taskbar.
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Photo Dialog Box

Print Photo Dialog Box

Click Print in the View & Use window, then click Print Photo on the list to open the Print Photo dialog box.

Important

The Print Photo dialog box will not open if Easy-PhotoPrint EX is installed. Easy-PhotoPrint EX starts

instead.
PDF files cannot be printed.

Note

Double-click an image to display it in a different window.

Printer

Select the printer to use.

Properties...

Displays the selected printer's advanced setting screen.

Paper Size

Select the size of paper for printing. Match the size to the size of the paper set in the machine.

Media Type

Select the type of paper for printing. Print quality may be fixed depending on the paper type.

Page Layout

Select a print type.

Normal-size Printing

Print one image per sheet.

Fit-to-Page Printing

Print an image at the paper size (enlarged or reduced).

Borderless Printing
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Select this checkbox to print the image on an entire sheet of paper without margins.

Important

Page Layout setting will be disabled when you select Borderless Printing.

This setting is only available with printers that support borderless printing.

Orientation

Specify the print orientation.

Important

This setting is available only when Page Layout is Normal-size Printing. For others, the image is

automatically rotated according to the aspect ratio of the paper.

Copies

Specify the number of copies to print.

Vivid Photo

Select this checkbox to print the image in vivid colors.

Preview before printing

Select this checkbox to display the print result before printing.

Print

Starts printing.

Note

Only the images in the Thumbnail window with the checkbox selected are printed.

Close

Closes the dialog box without printing the photo.
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E-mail Dialog Box

Send via E-mail Dialog Box

Click Send in the View & Use window, then click Attach to E-mail on the list to open the Send via E-mail

dialog box.

In the Send via E-mail dialog box, you can make advanced settings for attaching images to e-mail.

Important

MP Navigator EX is compatible with the following e-mail software programs:

- Windows Mail (Windows Vista)

- Outlook Express (Windows XP/Windows 2000)

- Microsoft Outlook

(If an e-mail software program does not operate properly, check that the program's MAPI is enabled.

To enable MAPI, refer to the manual of the e-mail software program.)

Mail Program

The e-mail software program set up via Preferences in the Navigation Mode screen is displayed.

Select the e-mail software program you want to use.

Adjust attachment file size

When Save as type is JPEG, selecting this checkbox allows you to resize the images. Select a size
from Size.

Save in

Displays the folder in which to save the images. To change the folder, click Browse... to specify another

one. If resized, the resized images are saved.

The following folders are specified by default.

Windows Vista: MP Navigator EX folder in Pictures folder
Windows XP: MP Navigator EX folder in My Pictures folder

Windows 2000: MP Navigator EX folder in My Pictures folder

File name

Enter the file name of the image to be attached (up to 64 characters). When saving multiple files, 4

digits are appended to each file name.

Set...

You can specify a compression type for JPEG files.

Select High(Low Compression), Standard or Low(High Compression).
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Enhance Images Window

Correct/Enhance Images Window

Click  (Image Correction/Enhancement) in the View & Use window or click Fix photo images in the

Task Button area to open the Correct/Enhance Images window.

In the Correct/Enhance Images window, you can make advanced settings including image correction/

enhancement and brightness/contrast adjustment.

You can also display the source image and corrected image side by side for comparison.

Important

Image correction/enhancement cannot be applied to PDF files or black and white binary files.

Note

The Correct/Enhance Images window can also be opened by clicking  (Image Correction/

Enhancement) in the Zoom in dialog box.

It may take a while to correct large images.

See "View & Use Window" for details on the View & Use window.

(1) Task Area

(2) Toolbar

Task Area

Available tasks and settings vary between the Auto and Manual tabs.

Click Auto or Manual to open the corresponding tab.

Auto Tab

Use the functions in the Auto tab to apply corrections and enhancements to the entire image.

See "Correcting/Enhancing Images Automatically " for details.
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Auto Photo Fix

Applies automatic corrections suitable for photos.

Prioritize Exif Info

Select this checkbox to apply corrections primarily based on the settings made at the time of

shooting.
Deselect this checkbox to apply corrections based on the image analysis results. It is

recommended that you normally select this setting.

Note

Exif is a standard format for embedding various shooting data in digital camera images
(JPEG).

Face Sharpener

Sharpens out-of-focus faces.

You can adjust the effect level using the slider.

Digital Face Smoothing

Enhances skin beautifully by removing blemishes and wrinkles.
You can adjust the effect level using the slider.

Apply to all images

Applies the correction to all images displayed in the thumbnail list.

OK

Applies the selected effect to the selected image or all images.

Reset Selected Image

Cancels all corrections and enhancements applied to the selected image.

Save Selected Image

Saves the corrected images selected.

Save All Corrected Images

Saves all the corrected images displayed in the thumbnail list.

Exit

Closes the Correct/Enhance Images window.

Manual Tab

Use Adjust to adjust brightness and contrast, or to sharpen the entire image.

Use Correct/Enhance to correct/enhance specific areas.

See "Correcting/Enhancing Images Manually " for details.
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Adjustment

Brightness

Adjusts the overall image brightness.
Move the slider to the left to darken and right to brighten the image.

Contrast

Adjusts the contrast of the image. Adjust the contrast when the image is flat due to lack of contrast.

Move the slider to the left to decrease and right to increase the contrast of the image.

Sharpness

Emphasizes the outline of the subjects to sharpen the image. Adjust the sharpness when the

photo is out of focus or text is blurred.

Move the slider to the right to sharpen the image.

Blur

Blurs the outline of the subjects to soften the image.
Move the slider to the right to soften the image.

Show-through Removal

Removes show-through of text from the reverse side or removes the base color. Adjust the show-

through level to prevent text on the reverse side of thin document or the base color of the document

from appearing on the image.

Move the slider to the right to increase the show-through removal effect.

Defaults

Resets all adjustments (brightness, contrast, sharpness, blur, and show-through removal).

Reset Selected Image

Cancels all corrections, enhancements and adjustments applied to the selected image.

Save Selected Image

Saves the corrected images selected.

Save All Corrected Images

Saves all the corrected images displayed in the thumbnail list.

Exit

Closes the Correct/Enhance Images window.

Correction/Enhancement
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Face Brightener

Corrects the entire image so that the selected facial area is brightened.

You can adjust the effect level using the slider.

Face Sharpener

Corrects the entire image to sharpen the face. You can specify the area you want to apply the effect
to.

You can adjust the effect level using the slider.

Digital Face Smoothing

Enhances skin beautifully by removing blemishes and wrinkles. You can specify the area you want
to apply the effect to.

You can adjust the effect level using the slider.

Blemish Remover

Removes moles. You can specify the area you want to apply the effect to.

OK

Applies the selected effect to the specified area.

Undo

Cancels the latest correction.

Reset Selected Image

Cancels all corrections, enhancements and adjustments applied to the selected image.

Save Selected Image

Saves the corrected images selected.

Save All Corrected Images

Saves all the corrected images displayed in the thumbnail list.

Exit

Closes the Correct/Enhance Images window.

Toolbar

Toolbar

 (Rotate Left)

Rotates the image 90 degrees counter-clockwise.

 (Rotate Right)

Rotates the image 90 degrees clockwise.
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 (Invert)

Inverts the image horizontally.

 (Trimming)

Trimming is the act of selecting the area you want to keep in a photo and discarding the rest. In

the displayed window, drag the white frame to specify the trimming area. Move the cursor inside

the white frame and drag to move the trimming area.

Note

Place the main subjects along the broken white lines or at the intersections to create a

balanced image.

 (Enlarge)

Enlarges the displayed image.

 (Reduce)

Reduces the displayed image.

 (Full-screen)

Enlarges/reduces the image to display it full-screen.

 (Compare)

Opens the source image for comparison.
The source image appears on the left and the corrected image appears on the right.
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Mode Screen

One-click Mode Screen

Click  (Switch Mode) at the bottom left of the Navigation Mode screen to display the One-click

Mode screen.

You can complete from scanning to saving, etc. at one time by simply clicking the corresponding icon.

Auto

Scan documents by automatically detecting the document type. File format is automatically set. Files

are saved to a computer. You can apply Auto Photo Fix as required.

When you click this icon, the Auto Scan dialog box opens and you can specify the save settings.
Auto Scan Dialog Box

Save

Scan documents or photos and save them to a computer. The document type can be detected

automatically.

When you click this icon, the Save dialog box opens and you can specify the scan/save settings.

Save Dialog Box (One-click Mode Screen)

PDF

Scan documents and save them as PDF files.

When you click this icon, the PDF dialog box opens and you can specify the scan/save and application

settings.
PDF Dialog Box

Mail

Scan documents or photos and attach them to e-mail.
When you click this icon, the Mail dialog box opens and you can specify the scan/save and e-mail

software program settings.
Mail Dialog Box

OCR

Scan text documents then extract text in the image and display it in Notepad (included with Windows).

When you click this icon, the OCR dialog box opens and you can specify the scan/save settings.

OCR Dialog Box

Note

For further procedures, refer to the application's manual.

Custom

Scan documents and open them in a specified application. Document type is automatically detected.
When you click this icon, the Custom dialog box opens and you can specify the scan/save and

application settings.
Custom Dialog Box

Note

For further procedures, refer to the application's manual.

 (Switch Mode)
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Switches to Navigation Mode. The Navigation Mode screen appears.

Custom Scan with One-click Tab

 Preferences

The Preferences dialog box opens. In the Preferences dialog box, you can make advanced settings to
MP Navigator EX functions.

Preferences Dialog Box

 (Guide)

Opens this guide.

Important

The following restrictions apply when you scan with Document Type set to Auto Mode in the Save or

Custom dialog box.
When you want to convert text in the scanned image to text data, specify Document Type (do not

select Auto Mode).

Related Topic

Easy Scanning with One-click

Page top
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Auto Scan Dialog Box

Click Auto Scan on the Custom Scan with One-click tab or click Auto in the One-click Mode screen to

open the Auto Scan dialog box.

Important

The following types of documents cannot be scanned correctly. In that case, click another icon in

One-click Mode or on the Custom Scan with One-click tab and specify the document type or size.

- Documents other than photos, postcards, business cards, magazines, newspapers, text

documents and CD/DVD

- A4 size photos

- Text documents smaller than 2L (5 inches x 7 inches) (127 mm x 178 mm), such as paperback

pages with the spine cut off

- Documents printed on thin white paper

- Long narrow documents such as panoramic photos
Reflective CD/DVD labels may not be scanned properly.

Place documents correctly according to the type of document to be scanned. Otherwise, documents

may not be scanned correctly.

See "Placing Documents " for details on how to place documents.

Note

To reduce moire, click another icon in One-click Mode or on the Custom Scan with One-click tab

and set Document Type to Magazine.

Scan Settings

Enable Auto Photo Fix

Select this checkbox to analyze the photo image and apply suitable corrections automatically.

This function is available when Auto or JPEG/Exif is selected for Save as type in Save Settings.

Important

When Save as type is Auto, the base color tone of the following types of documents may

change from the source since they are corrected as photos. In that case, deselect the checkbox

and scan.

- Postcards and business cards
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Text documents may not be scanned correctly since they may be corrected as photos

depending on how you place the document. In that case, deselect the checkbox and scan.

Note

If you select a format other than JPEG/Exif for Save as type and then select this checkbox, a

message appears and Save as type will be set to Auto.

Save Settings

File name

Enter the file name of the image to be saved (up to 64 characters). When saving multiple files, 4

digits are appended to each file name.

Save as type

Select a file type to save the scanned images.
Select Auto, JPEG/Exif, TIFF, BMP or PDF.

Important

When Save as type is Auto, the file format may differ depending on how you place the

document.
See "Placing Documents " for details on how to place documents.

Large documents (such as A4 size photos) that cannot be placed away from the edges/arrow

(alignment mark) of the Platen may not be saved in the correct file format when Save as type is

Auto. In that case, select a file format suitable for the document to be scanned.

Images cannot be added to password-protected PDF files.

Note

When Auto is selected, files are saved in the following formats according to the document type.

Photos, postcards, CD/DVD and business cards: JPEG

Magazines, newspapers and text documents: PDF
You can change the file format from Set....

Set...

When Save as type is Auto

You can specify the file format in which to save images. Select a file format for Document and Photo

each.

Important

You cannot select a compression type for JPEG files when the Compress scanned images

when transferring checkbox is selected on the General tab of the Preferences dialog box.

When Save as type is JPEG/Exif

You can specify a compression type for JPEG files. Select High(Low Compression), Standard or

Low(High Compression).

Important

This setting is not available when the Compress scanned images when transferring checkbox
is selected on the General tab of the Preferences dialog box.

When Save as type is PDF

Make advanced settings for creating PDF files. See " PDF Settings Dialog Box" for details.

Save in

Displays the folder in which to save the scanned images. To change the folder, click Browse... to

specify another one.

The following folders are specified by default.

Windows Vista: MP Navigator EX folder in Pictures folder
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Windows XP: MP Navigator EX folder in My Pictures folder

Windows 2000: MP Navigator EX folder in My Pictures folder

Save to a Subfolder with Current Date

Select this checkbox to create a subfolder in the folder specified in Save in with the current date and

save scanned files in it. A subfolder with a name such as "2009_01_01" (Year_Month_Date) will be

created.

If this checkbox is not selected, files are saved directly in the folder specified in Save in.

Start scanning by clicking the one-click button

Select this checkbox to start scanning when you click an icon.

Apply

Saves and applies the specified settings.
Click Cancel instead of Apply to cancel the specified settings.

Cancel

Cancels the specified settings. The current screen closes.

Defaults

Returns all settings in the screen to their defaults.

Scan

Scans and saves documents with the specified settings.
When Save as type is Auto, a confirmation appears. Click Open Manual to open this guide (if it is

installed).
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Dialog Box (One-click Mode Screen)

Save Dialog Box (One-click Mode Screen)

Click Save to PC on the Custom Scan with One-click tab or click Save in the One-click Mode screen to

open the Save dialog box.

Scan Settings

Document Type

Select the type of document to be scanned. When Auto Mode is selected, the document type is

automatically detected. In that case, Color Mode, Document Size and Resolution are automatically

set as well.

Important

The following types of documents cannot be scanned correctly with Auto Mode. In that case,

specify the document type or size.

- Documents other than photos, postcards, business cards, magazines, newspapers, text
documents and CD/DVD

- A4 size photos

- Text documents smaller than 2L (5 inches x 7 inches) (127 mm x 178 mm), such as

paperback pages with the spine cut off

- Documents printed on thin white paper

- Long narrow documents such as panoramic photos
Reflective CD/DVD labels may not be scanned properly.

Place documents correctly according to the type of document to be scanned. Otherwise,

documents may not be scanned correctly.

See "Placing Documents " for details on how to place documents.

Note
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To reduce moire, set Document Type to Magazine.

Color Mode

Select how to scan the document.

Document Size

Select the size of the document to be scanned.

When you select Custom, a screen in which you can specify the document size appears. Select a

Units, then enter the Width and Height and click OK.

Important

When you select Auto Detect, the image may not be scanned at the correct position and size. In

that case, change the size to the actual document size (A4, Letter, etc.) and align a corner of the

document with the corner at the arrow (alignment mark) of the Platen.

Resolution

Select the resolution at which to scan documents.

Resolution

Use the scanner driver

Select this checkbox to display the ScanGear (scanner driver) screen and make advanced scan

settings.
Color Mode, Document Size, Resolution and other settings in the Save dialog box will be disabled.

Specify these settings in the ScanGear (scanner driver) screen.

Specify...

Click to open the Scan Settings dialog box in which you can make advanced scan settings.

Scan Settings Dialog Box

Save Settings

Automatically save the image to your computer after scanning it

Select this to save the images to your computer as specified after scanning them.

The File name, Save as type and Save in settings will be displayed.

Important

If you select this function, you will not be able to set passwords for PDF files.

File name

Enter the file name of the image to be saved (up to 64 characters). When saving multiple files, 4

digits are appended to each file name.

Save as type

Select a file type to save the scanned images.
Select Auto, JPEG/Exif, TIFF or BMP. Auto is displayed when Document Type is Auto Mode. When

saving as PDF files, select PDF, PDF(Multiple Pages) or PDF(Add Page).

Important

When Document Type is Auto Mode and Save as type is Auto, the file format may differ

depending on how you place the document.

See "Placing Documents " for details on how to place documents.

Large documents (such as A4 size photos) that cannot be placed away from the edges/arrow

(alignment mark) of the Platen may not be saved in the correct file format when Save as type is
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Auto. In that case, select a file format suitable for the document to be scanned.

Images cannot be added to password-protected PDF files.

You cannot select JPEG/Exif when Color Mode is Black and White.

Note

When Auto is selected, files are saved in the following formats according to the document type.

Photos, postcards, CD/DVD and business cards: JPEG
Magazines, newspapers and text documents: PDF
You can change the file format from Set....

Images saved as PDF files may not open depending on the application. In that case, select an
option other than Auto in Save as type.

If you select JPEG/Exif when Document Type is not Auto Mode , the Save the JPEG/Exif file in

AdobeRGB checkbox will be selectable.

Set...

When Save as type is Auto

You can specify the file format in which to save images. Select a file format for Document and Photo

each.

Important

You cannot select a compression type for JPEG files when the Compress scanned images

when transferring checkbox is selected on the General tab of the Preferences dialog box.

When Save as type is JPEG/Exif

You can specify a compression type for JPEG files. Select High(Low Compression), Standard or

Low(High Compression).

Important

This setting is not available when the Compress scanned images when transferring checkbox
is selected on the General tab of the Preferences dialog box.

When Save as type is PDF, PDF(Multiple Pages) or PDF(Add Page)

Make advanced settings for creating PDF files. See " PDF Settings Dialog Box" for details.

Save in

Displays the folder in which to save the scanned images. To change the folder, click Browse... to

specify another one.

The following folders are specified by default.

Windows Vista: MP Navigator EX folder in Pictures folder
Windows XP: MP Navigator EX folder in My Pictures folder

Windows 2000: MP Navigator EX folder in My Pictures folder

Save to a Subfolder with Current Date

Select this checkbox to create a subfolder in the folder specified in Save in with the current date and

save scanned files in it. A subfolder with a name such as "2009_01_01" (Year_Month_Date) will be

created.

If this checkbox is not selected, files are saved directly in the folder specified in Save in.

Save the JPEG/Exif file in AdobeRGB

Select this checkbox to save the images in colors that correspond to Adobe RGB.

Important

This function is available only when Save as type is JPEG/Exif and Document Type is not Auto
Mode.

This function is not available if the Adobe RGB profile is not installed.

Note

You cannot select this setting if the Use the scanner driver checkbox is selected.
When you save an image with the Save the JPEG/Exif file in AdobeRGB checkbox selected, an
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underscore is added to the beginning of the file name. (Example: _Image0001.jpg)

Open the save dialog box after scanning the image (Input Exif information)

Select this to open the Save dialog box after scanning the images and specify the save settings

such as destination folder, file name and Exif information.

Save Dialog Box

Note

To set passwords for PDF files, select Open the save dialog box after scanning the image

(Input Exif information). After scanning, you can set the passwords in the Save dialog box.

Setting Passwords for PDF Files

Application Settings

Open with

You can select whether to open the View & Use window or Explorer after saving the images.

Start scanning by clicking the one-click button

Select this checkbox to start scanning when you click an icon.

Apply

Saves and applies the specified settings.
Click Cancel instead of Apply to cancel the specified settings.

Cancel

Cancels the specified settings. The current screen closes.

Defaults

Returns all settings in the screen to their defaults.

Scan

Scans and saves documents with the specified settings.
When Save as type is Auto, a confirmation appears. Click Open Manual to open this guide (if it is

installed).
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Settings Dialog Box

Scan Settings Dialog Box

Make advanced settings for scanning with one-click or scanning using the Operation Panel of the

machine.

The Scan Settings dialog box opens when you click Specify... in a dialog box for making scan settings.

Note

The displayed items vary by document type and how the screen was opened.

Document Type

Select the type of document to be scanned. When Auto Mode or Auto Scan is selected, the document

type is automatically detected.

In that case, Color Mode, Document Size, etc. are automatically set as well.

Important

To scan correctly, select a document type that matches the document to be scanned.

When opened from the Scanner Button Settings tab in the Preferences dialog box, the Document

Type specified in the Scanner Button Settings tab is displayed and cannot be changed in this

dialog box.

Color Mode

Select how to scan the document.

Color

This mode renders the image in 256 levels (8 bit) of R(ed), G(reen), and B(lue).

Grayscale

This mode renders the image in 256 levels (8 bit) of black and white.

Black and White

This mode renders the image in black and white. The contrast in the image is divided at certain

levels (threshold level) into black and white and is rendered in two colors.

Note

Color Mode is not displayed in the Scan Settings dialog box opened from the Scanner Button

Settings tab of the Preferences dialog box.

Document Size
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Select the size of the document to be scanned.

When you select Custom, a screen in which you can specify the document size appears. Select a

Units, then enter the Width and Height and click OK.

Important

When you select Auto Detect, the image may not be scanned at the correct position and size. In

that case, change the size to the actual document size (A4, Letter, etc.) and align a corner of the

document with the corner at the arrow (alignment mark) of the Platen.

Scanning Resolution

Select the resolution at which to scan documents.

Resolution

Descreen

Select this checkbox to reduce moire patterns.

Printed photos and pictures are displayed as a collection of fine dots. "Moire" is a phenomenon where
uneven gradation or a stripe pattern appears when such photos or pictures printed with fine dots are

scanned. Descreen is the function for reducing this moire effect.

Note

Scanning takes longer than usual when you enable Descreen.

Reduce Show-through

Select this checkbox to sharpen text in a document or reduce show-through in newspapers.

Note

Select this checkbox when Document Type is text document and show-through is apparent in the

scanned image.

Unsharp Mask

Select this checkbox to emphasize the outline of the subjects and sharpen the image.

Remove gutter shadow

Select this checkbox to correct shadows that appear between pages when scanning open booklets.

Important

You cannot select this checkbox when Document Size is Auto Detect, Auto Detect (Multiple

Documents) or Stitch Assist.
Align the document correctly with the alignment mark on the Platen.

Note

Use ScanGear's Advanced Mode tab to correct gutter shadows when scanning non-standard size

documents or when custom cropping frames are set.
For details, see Gutter Shadow Correction in " Image Settings " (ScanGear's Advanced Mode tab).

Correct slanted document

Select this checkbox to detect the scanned text and correct the angle (within -0.1 to -10 degrees or +0.1

to +10 degrees) of the document.

Important

You cannot select this checkbox when Document Size is Stitch Assist.

The inclination of the following types of documents may not be corrected, as the text cannot be
detected correctly.

Page 555 of 949 pagesScan Settings Dialog Box



- Documents in which the text lines are inclined more than 10 degrees or the angles vary by line

- Documents containing both vertical and horizontal text

- Documents with extremely large or small fonts

- Documents with small amount of text

- Documents containing figures/images or hand-written text

- Documents containing both vertical and horizontal lines (tables)

Note

Scanning takes longer than usual when you enable Correct slanted document.

Enable Auto Photo Fix (When scanning with Auto Scan using the Operation Panel)

Select this checkbox to analyze the photo image and apply suitable corrections automatically.

This function is available when Auto or JPEG/Exif is selected for Save as type in Save Settings on the

Scanner Button Settings tab of the Preferences dialog box.

Important

When Save as type is Auto, the base color tone of the following types of documents may change

from the source since they are corrected as photos. In that case, deselect the checkbox and scan.

- Postcards and business cards
Text documents may not be scanned correctly since they may be corrected as photos depending

on how you place the document. In that case, deselect the checkbox and scan.

Note

If you select a format other than JPEG/Exif for Save as type and then select this checkbox, a

message appears and Save as type will be set to Auto.

Detect the orientation of text documents and rotate images

Select this checkbox to detect the orientation of the document from the scanned text and rotate the

scanned image to the correct orientation. Select the language of the document to be scanned in

Document Language.

Important

You cannot select this checkbox when Document Size is Stitch Assist.

This function may not work properly depending on the document language. Only text documents

written in languages that can be selected from Document Language are supported.

The orientation of the following types of documents may not be corrected, as the text cannot be
detected correctly.

- Resolution is outside the range of 300 dpi to 600 dpi

- Font size is outside the range of 8 points to 48 points

- Documents containing special fonts, effects, italics, or hand-written text

- Documents with patterned backgrounds

Note

Scanning takes longer than usual when you enable Detect the orientation of text documents and

rotate images.

Document Language

Select the language of the document to be scanned.

Important

You cannot select this checkbox when Document Size is Stitch Assist.

Defaults

Restores the default settings.
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Dialog Box

Save Dialog Box

The Save dialog box opens when you scan from Save to PC on the Custom Scan with One-click tab or

from Save in the One-click Mode screen after selecting Open the save dialog box after scanning the

image (Input Exif information).

You can specify the file type and destination while viewing the thumbnails.

Save as type

Select a file type to save the scanned images.
Select JPEG/Exif, TIFF, BMP, PDF, PDF(Multiple Pages) or PDF(Add Page).

PDF

Save each of the selected images as a separate PDF file.

PDF(Multiple Pages)

Save multiple images in one PDF file.

Note

PDF(Multiple Pages) is displayed when multiple images are scanned.

PDF(Add Page)

Add the scanned images to a PDF file. The images are added to the end of the PDF file. You

cannot rearrange the pages of the PDF file to which the images are added.

Important

Images can only be added to PDF files created with MP Navigator EX. You cannot specify

PDF files created with other applications. PDF files edited in other applications cannot be

specified as well.
If a password-protected PDF file is edited, the passwords will be deleted. Reset the

passwords.
Setting Passwords for PDF Files
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Important

PDF, PDF(Multiple Pages) and PDF(Add Page) cannot be selected for images scanned using the

Operation Panel of the machine.

You cannot select JPEG/Exif when Color Mode is Black and White.

Set...

When Save as type is JPEG/Exif

You can specify a compression type for JPEG files. Select High(Low Compression), Standard or

Low(High Compression).

Important

This setting is not available when the Compress scanned images when transferring checkbox is
selected on the General tab of the Preferences dialog box.

When Save as type is PDF, PDF(Multiple Pages) or PDF(Add Page)

Make advanced settings for creating PDF files. See " PDF Settings Dialog Box" for details.

Exif Settings...

When Save as type is JPEG/Exif, you can input Exif information into the file to be saved.

Exif Settings Dialog Box

Password security settings

Select this checkbox to open the Password Security -Settings dialog box in which you can set

passwords for opening, editing and printing created PDF files.

Setting Passwords for PDF Files

Note

This function is available only when Save as type is PDF, PDF(Multiple Pages) or PDF(Add Page).

Add to

This is displayed when you select PDF(Add Page) for Save as type and specify the PDF file to which

images are added. To change the file, click Browse... to specify another one.

Important

Images can only be added to PDF files created with MP Navigator EX. You cannot specify PDF

files created with other applications. PDF files edited in other applications cannot be specified as

well.

Rotate Left 90°/Rotate Right 90°

Rotates scanned images 90 degrees counter-clockwise or clockwise.
Select the image you want to rotate and click Rotate Left 90° or Rotate Right 90°.

File name

Enter the file name of the image to be saved (up to 64 characters). When saving multiple files, 4 digits

are appended to each file name.

Save in

Displays the folder in which to save the scanned images. To change the folder, click Browse... to

specify another one.

The following folders are specified by default.

Windows Vista: MP Navigator EX folder in Pictures folder
Windows XP: MP Navigator EX folder in My Pictures folder

Windows 2000: MP Navigator EX folder in My Pictures folder

Save to a Subfolder with Current Date

Select this checkbox to create a subfolder in the folder specified in Save in with the current date and

save scanned files in it. A subfolder with a name such as "2009_01_01" (Year_Month_Date) will be

created.

If this checkbox is not selected, files are saved directly in the folder specified in Save in.
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Settings Dialog Box

Exif Settings Dialog Box

You can input Exif information into a file to be saved. Exif is a standard format for embedding various

shooting data in digital camera images (JPEG). Embedding Exif information into scanned images

allows you to organize and print them along with digital camera images.

The Exif Settings dialog box can be opened when Save as type is JPEG/Exif.

Basic Information

Displays the information obtained automatically from the machine or software.

Advanced Information

Displays the information specified on the right side of the screen.

Advanced Information Settings Area

You can input Exif information such as the title and shooting data. Select the checkbox of the items you

want to specify, and select or enter information.

Apply the Same Setting of Input Items Automatically

Select this checkbox to automatically display the information you specified for the previous image.

Apply

After specifying all the information you need, click Apply to embed it into the image. The information

appears in Advanced Information.

OK

Embeds the specified information into the image and closes the screen. The specified information is
saved.

Cancel

Cancels the settings and closes the screen.
Information is embedded when Cancel is clicked after clicking Apply.
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Dialog Box

PDF Dialog Box

Click Save as PDF file on the Custom Scan with One-click tab or click PDF in the One-click Mode screen

to open the PDF dialog box.

Scan Settings

Document Type

Select the type of document to be scanned.

Color Mode

Select how to scan the document.

Document Size

Select the size of the document to be scanned.

When you select Custom, a screen in which you can specify the document size appears. Select a

Units, then enter the Width and Height and click OK.

Important

When you select Auto Detect, the image may not be scanned at the correct position and size. In

that case, change the size to the actual document size (A4, Letter, etc.) and align a corner of the
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document with the corner at the arrow (alignment mark) of the Platen.

Resolution

Select the resolution at which to scan documents.

Resolution

Specify...

Click to open the Scan Settings dialog box in which you can make advanced scan settings.

Scan Settings Dialog Box

Save Settings

Automatically save the image to your computer after scanning it

Select this to save the images to your computer as specified after scanning them.

The File name, Save as type and Save in settings will be displayed.

Important

If you select this function, you will not be able to set passwords for PDF files.

File name

Enter the file name of the image to be saved (up to 64 characters). When saving multiple files, 4

digits are appended to each file name.

Save as type

Select a file type to save the scanned images.

Select PDF, PDF(Multiple Pages) or PDF(Add Page).

PDF

Save each of the selected images as a separate PDF file.

PDF(Multiple Pages)

Save multiple images in one PDF file.

PDF(Add Page)

Add the scanned images to a PDF file. The images are added to the end of the PDF file. You

cannot rearrange the pages of the PDF file to which the images are added.

Important

Images cannot be added to password-protected PDF files.

Note

Click Set... to open the PDF Settings dialog box in which you can specify the PDF compression

type and other advanced settings for creating PDF files.

PDF Settings Dialog Box
See "Creating/Editing PDF Files " to delete or rearrange the pages of saved PDF files.

Save in

Displays the folder in which to save the scanned images. To change the folder, click Browse... to

specify another one.

The following folders are specified by default.

Windows Vista: MP Navigator EX folder in Pictures folder
Windows XP: MP Navigator EX folder in My Pictures folder

Windows 2000: MP Navigator EX folder in My Pictures folder

Save to a Subfolder with Current Date

Select this checkbox to create a subfolder in the folder specified in Save in with the current date and

save scanned files in it. A subfolder with a name such as "2009_01_01" (Year_Month_Date) will be

created.

If this checkbox is not selected, files are saved directly in the folder specified in Save in.

Open the save dialog box after scanning the image

Select this to open the Save as PDF file dialog box after scanning the images and specify the save
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settings such as destination folder and file name.
Save as PDF file Dialog Box

Note

To set passwords for PDF files, select Open the save dialog box after scanning the image. After

scanning, you can set the passwords in the Save as PDF file dialog box.

Setting Passwords for PDF Files

Application Settings

Open with

Specify an application with which to open scanned images. Drag and drop the icon of an application

that supports the file format displayed in Save as type. The specified application starts after images

are scanned.

Important

Depending on the specified application, the images may not appear correctly or the application

may not start.

Reset

Cancels the application setting.

Set...

Allows you to select an application to start.

Start scanning by clicking the one-click button

Select this checkbox to start scanning when you click an icon.

Apply

Saves and applies the specified settings.
Click Cancel instead of Apply to cancel the specified settings.

Cancel

Cancels the specified settings. The current screen closes.

Defaults

Returns all settings in the screen to their defaults.

Scan

Scans and saves documents as PDF files with the specified settings.
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Save as PDF file Dialog Box

The Save as PDF file dialog box opens when you scan from Save as PDF file on the Custom Scan with

One-click tab or from PDF in the One-click Mode screen after selecting Open the save dialog box after

scanning the image.

In the Save as PDF file dialog box, you can make settings for saving images to a computer.

Important

You cannot save images scanned at 10501 pixels or more in the vertical and horizontal directions.

Save as type

Select a PDF file type to save the scanned images.

PDF

Save each of the selected images as a separate PDF file.

PDF(Multiple Pages)

Save multiple images in one PDF file.

Note

PDF(Multiple Pages) is displayed when multiple images are scanned.

PDF(Add Page)

Add the scanned images to a PDF file. The images are added to the end of the PDF file. You

cannot rearrange the pages of the PDF file to which the images are added.

Important

Images can only be added to PDF files created with MP Navigator EX. You cannot specify

PDF files created with other applications. PDF files edited in other applications cannot be

specified as well.
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PDF(Add Page) cannot be selected for images scanned using the Operation Panel of the

machine.
If a password-protected PDF file is edited, the passwords will be deleted. Reset the

passwords.
Setting Passwords for PDF Files

Set...

Make advanced settings for creating PDF files. See " PDF Settings Dialog Box" for details.

Password security settings

Select this checkbox to open the Password Security -Settings dialog box in which you can set

passwords for opening, editing and printing created PDF files.

Setting Passwords for PDF Files

Rotate Left 90°/Rotate Right 90°

Rotates scanned images 90 degrees counter-clockwise or clockwise.
Select the image you want to rotate and click Rotate Left 90° or Rotate Right 90°.

File name

Enter the file name of the image to be saved (up to 64 characters). When saving multiple files, 4 digits

are appended to each file name.

Save in

Displays the folder in which to save the PDF files. To change the folder, click Browse... to specify

another one.

The following folders are specified by default.

Windows Vista: MP Navigator EX folder in Pictures folder
Windows XP: MP Navigator EX folder in My Pictures folder

Windows 2000: MP Navigator EX folder in My Pictures folder

Save to a Subfolder with Current Date

Select this checkbox to create a subfolder in the folder specified in Save in with the current date and

save scanned files in it. A subfolder with a name such as "2009_01_01" (Year_Month_Date) will be

created.

If this checkbox is not selected, files are saved directly in the folder specified in Save in.
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Dialog Box

Mail Dialog Box

Click Attach to E-mail on the Custom Scan with One-click tab or click Mail in the One-click Mode screen to

open the Mail dialog box.

Scan Settings

Document Type

Select the type of document to be scanned.

Color Mode

Select how to scan the document.

Document Size

Select the size of the document to be scanned.

When you select Custom, a screen in which you can specify the document size appears. Select a

Units, then enter the Width and Height and click OK.

Important

When you select Auto Detect, the image may not be scanned at the correct position and size. In

that case, change the size to the actual document size (A4, Letter, etc.) and align a corner of the

document with the corner at the arrow (alignment mark) of the Platen.
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Resolution

Select the resolution at which to scan documents.

Resolution

Use the scanner driver

Select this checkbox to display the ScanGear (scanner driver) screen and make advanced scan

settings.
Color Mode, Document Size, Resolution and other settings in the Mail dialog box will be disabled.

Specify these settings in the ScanGear (scanner driver) screen.

Specify...

Click to open the Scan Settings dialog box in which you can make advanced scan settings.

Scan Settings Dialog Box

Save Settings

File Size

Select a size from Small (fits in a 640 by 480 window), Medium (fits in a 800 by 600 window), Large

(fits in a 1024 by 768 window) and Original.

File name

Enter the file name of the image to be saved (up to 64 characters). When saving multiple files, 4

digits are appended to each file name.

Save as type

Select a file type to save the scanned images.
Select JPEG/Exif, PDF or PDF(Multiple Pages).

Important

You cannot set passwords for PDF files.

You cannot select JPEG/Exif when Color Mode is Black and White.

Set...

When Save as type is JPEG/Exif

You can specify a compression type for JPEG files. Select High(Low Compression), Standard or

Low(High Compression).

Important

This setting is not available when the Compress scanned images when transferring checkbox
is selected on the General tab of the Preferences dialog box.

When Save as type is PDF or PDF(Multiple Pages)

Make advanced settings for creating PDF files. See " PDF Settings Dialog Box" for details.

Save in

Displays the folder in which to save the scanned images. To change the folder, click Browse... to

specify another one.

The following folders are specified by default.

Windows Vista: MP Navigator EX folder in Pictures folder
Windows XP: MP Navigator EX folder in My Pictures folder

Windows 2000: MP Navigator EX folder in My Pictures folder

Save to a Subfolder with Current Date

Select this checkbox to create a subfolder in the folder specified in Save in with the current date and

save scanned files in it. A subfolder with a name such as "2009_01_01" (Year_Month_Date) will be

created.

If this checkbox is not selected, files are saved directly in the folder specified in Save in.

Attachment Settings
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Mail Program

Specify an e-mail software program.

Note

Select Add... to open the Select Mail Program dialog box in which you can select an e-mail

software program. If the e-mail software program you want to use is not listed, click Add to List

and select it.

Start scanning by clicking the one-click button

Select this checkbox to start scanning when you click an icon.

Apply

Saves and applies the specified settings.
Click Cancel instead of Apply to cancel the specified settings.

Cancel

Cancels the specified settings. The current screen closes.

Defaults

Returns all settings in the screen to their defaults.

Scan

Scans documents with the specified settings.
When scanning is completed, the e-mail software program starts automatically and a new message
screen appears with the image attached.
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Dialog Box

OCR Dialog Box

Click OCR on the Custom Scan with One-click tab or in the One-click Mode screen to open the OCR

dialog box.

Scan Settings

Document Type

Select the type of document to be scanned.

Color Mode

Select how to scan the document.

Document Size

Select the size of the document to be scanned.

When you select Custom, a screen in which you can specify the document size appears. Select a

Units, then enter the Width and Height and click OK.

Resolution

Select the resolution at which to scan documents.

Resolution

Use the scanner driver

Select this checkbox to display the ScanGear (scanner driver) screen and make advanced scan
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settings.
Color Mode, Document Size, Resolution and other settings in the OCR dialog box will be disabled.

Specify these settings in the ScanGear (scanner driver) screen.

Specify...

Click to open the Scan Settings dialog box in which you can make advanced scan settings.

Scan Settings Dialog Box

Note

When scanning slanted documents, select the Correct slanted document checkbox to improve
the text recognition accuracy.

Save Settings

File name

Enter the file name of the image to be saved (up to 64 characters). When saving multiple files, 4

digits are appended to each file name.

Save as type

Select a file type to save the scanned images.
Select JPEG/Exif, TIFF or BMP.

Important

You cannot select JPEG/Exif when Color Mode is Black and White.

Set...

When Save as type is JPEG/Exif

You can specify a compression type for JPEG files. Select High(Low Compression), Standard or

Low(High Compression).

Important

This setting is not available when the Compress scanned images when transferring checkbox
is selected on the General tab of the Preferences dialog box.

Save in

Displays the folder in which to save the scanned images. To change the folder, click Browse... to

specify another one.

The following folders are specified by default.

Windows Vista: MP Navigator EX folder in Pictures folder
Windows XP: MP Navigator EX folder in My Pictures folder

Windows 2000: MP Navigator EX folder in My Pictures folder

Save to a Subfolder with Current Date

Select this checkbox to create a subfolder in the folder specified in Save in with the current date and

save scanned files in it. A subfolder with a name such as "2009_01_01" (Year_Month_Date) will be

created.

If this checkbox is not selected, files are saved directly in the folder specified in Save in.

Application Settings

OCR with

Specify an OCR application.

When MP Navigator EX is specified, after the image is scanned, the text in the image is extracted

and appears in Notepad (included with Windows).

Note

Only text written in languages that can be selected on the General tab can be extracted to

Notepad (included with Windows). Click Set... on the General tab and specify the language

according to the language of the document to be scanned.
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When scanning multiple documents, you can collect the extracted text into one file.

General Tab

Text displayed in Notepad (included with Windows) is for guidance only. Text in the image of

the following types of documents may not be detected correctly.

- Documents containing text with font size outside the range of 8 points to 40 points (at 300 dpi)

- Slanted documents
- Documents placed upside down or documents with text in the wrong orientation (rotated

characters)
- Documents containing special fonts, effects, italics, or hand-written text

- Documents with narrow line spacing
- Documents with colors in the background of text

- Documents containing multiple languages

Reset

Cancels the application setting.

Set...

Allows you to select an application.

Important

Depending on the specified application, the text may not be extracted correctly or the application

may not start.

Start scanning by clicking the one-click button

Select this checkbox to start scanning when you click an icon.

Apply

Saves and applies the specified settings.
Click Cancel instead of Apply to cancel the specified settings.

Cancel

Cancels the specified settings. The current screen closes.

Defaults

Returns all settings in the screen to their defaults.

Scan

Scans documents with the specified settings.
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Dialog Box

Custom Dialog Box

Click Custom on the Custom Scan with One-click tab or in the One-click Mode screen to open the

Custom dialog box.

Scan Settings

Document Type

Select the type of document to be scanned. When Auto Mode is selected, the document type is

automatically detected. In that case, Color Mode, Document Size and Resolution are automatically

set as well.

Important

The following types of documents cannot be scanned correctly with Auto Mode. In that case,

specify the document type or size.

- Documents other than photos, postcards, business cards, magazines, newspapers, text

documents and CD/DVD

- A4 size photos

- Text documents smaller than 2L (5 inches x 7 inches) (127 mm x 178 mm), such as
paperback pages with the spine cut off

- Documents printed on thin white paper

- Long narrow documents such as panoramic photos
Reflective CD/DVD labels may not be scanned properly.

Place documents correctly according to the type of document to be scanned. Otherwise,

documents may not be scanned correctly.

See "Placing Documents " for details on how to place documents.

Note
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To reduce moire, set Document Type to Magazine.

Color Mode

Select how to scan the document.

Document Size

Select the size of the document to be scanned.

When you select Custom, a screen in which you can specify the document size appears. Select a

Units, then enter the Width and Height and click OK.

Important

When you select Auto Detect, the image may not be scanned at the correct position and size. In

that case, change the size to the actual document size (A4, Letter, etc.) and align a corner of the

document with the corner at the arrow (alignment mark) of the Platen.

Resolution

Select the resolution at which to scan documents.

Resolution

Use the scanner driver

Select this checkbox to display the ScanGear (scanner driver) screen and make advanced scan

settings.
Color Mode, Document Size, Resolution and other settings in the Custom dialog box will be

disabled. Specify these settings in the ScanGear (scanner driver) screen.

Specify...

Click to open the Scan Settings dialog box in which you can make advanced scan settings.

Scan Settings Dialog Box

Save Settings

Automatically save the image to your computer after scanning it

Select this to save the images to your computer as specified after scanning them.

The File name, Save as type and Save in settings will be displayed.

Important

If you select this function, you will not be able to set passwords for PDF files.

Note

If an application to start is specified in Application Settings, the scanned image opens in the

specified application.

File name

Enter the file name of the image to be saved (up to 64 characters). When saving multiple files, 4

digits are appended to each file name.

Save as type

Select a file type to save the scanned images.
Select Auto, JPEG/Exif, TIFF or BMP. Auto is displayed and selected by default when Document Type

is Auto Mode.

Important

When Document Type is Auto Mode and Save as type is Auto, the file format may differ
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depending on how you place the document.
See "Placing Documents " for details on how to place documents.

Large documents (such as A4 size photos) that cannot be placed away from the edges/arrow

(alignment mark) of the Platen may not be saved in the correct file format when Save as type is

Auto. In that case, select a file format suitable for the document to be scanned.

You cannot select JPEG/Exif when Color Mode is Black and White.

Note

When Auto is selected, files are saved in the following formats according to the document type.

Photos, postcards, CD/DVD and business cards: JPEG

Magazines, newspapers and text documents: PDF
You can change the file format from Set....

Images saved as PDF files may not open depending on the application. In that case, select an
option other than Auto in Save as type.

If you select JPEG/Exif when Document Type is not Auto Mode , the Save the JPEG/Exif file in

AdobeRGB checkbox will be selectable.

Set...

When Save as type is Auto

You can specify the file format in which to save images. Select a file format for Document and Photo

each.

Important

You cannot select a compression type for JPEG files when the Compress scanned images

when transferring checkbox is selected on the General tab of the Preferences dialog box.

When Save as type is JPEG/Exif

You can specify a compression type for JPEG files. Select High(Low Compression), Standard or

Low(High Compression).

Important

This setting is not available when the Compress scanned images when transferring checkbox
is selected on the General tab of the Preferences dialog box.

Save in

Displays the folder in which to save the scanned images. To change the folder, click Browse... to

specify another one.

The following folders are specified by default.

Windows Vista: MP Navigator EX folder in Pictures folder
Windows XP: MP Navigator EX folder in My Pictures folder

Windows 2000: MP Navigator EX folder in My Pictures folder

Save to a Subfolder with Current Date

Select this checkbox to create a subfolder in the folder specified in Save in with the current date and

save scanned files in it. A subfolder with a name such as "2009_01_01" (Year_Month_Date) will be

created.

If this checkbox is not selected, files are saved directly in the folder specified in Save in.

Save the JPEG/Exif file in AdobeRGB

Select this checkbox to save the images in colors that correspond to Adobe RGB.

Important

This function is available only when Save as type is JPEG/Exif and Document Type is not Auto
Mode.

This function is not available if the Adobe RGB profile is not installed.

Note

You cannot select this setting if the Use the scanner driver checkbox is selected.

When you save an image with the Save the JPEG/Exif file in AdobeRGB checkbox selected, an
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underscore is added to the beginning of the file name. (Example: _Image0001.jpg)

Open the save dialog box after scanning the image (Input Exif information)

Select this to open the Save dialog box after scanning the images and specify the save settings

such as destination folder, file name and Exif information.

Save Dialog Box

Application Settings

Open with

Specify an application with which to open scanned images. Drag and drop the icon of an application

that supports the file format displayed in Save as type. The specified application starts after images

are scanned.

Important

Depending on the specified application, the images may not appear correctly or the application

may not start.

Reset

Cancels the application setting.

Set...

Allows you to select an application to start.

Start scanning by clicking the one-click button

Select this checkbox to start scanning when you click an icon.

Apply

Saves and applies the specified settings.
Click Cancel instead of Apply to cancel the specified settings.

Cancel

Cancels the specified settings. The current screen closes.

Defaults

Returns all settings in the screen to their defaults.

Scan

Scans and saves documents with the specified settings.
When Save as type is Auto, a confirmation appears. Click Open Manual to open this guide (if it is

installed).
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Preferences Dialog Box

Preferences Dialog Box

Click Preferences to open the Preferences dialog box.

In the Preferences dialog box, you can make advanced settings to MP Navigator EX functions via the

General and Scanner Button Settings tabs.

Note

See the corresponding sections below for details on each tab.
General Tab

Scanner Button Settings Tab (Save)

Scanner Button Settings Tab (Attach to E-mail)
Scanner Button Settings Tab (Open with Application)
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Tab

General Tab

On the General tab, you can specify general MP Navigator EX settings.

Product Name

Displays the product name of the machine that MP Navigator EX is currently configured to use.

If the displayed product is not the one you want to use, select the desired product from the list.
For network connection, select one with (Network: XXXXXXXXXXXX) after the product name. (Where

XXXXXXXXXXXX is the MAC address.)

Use network connection to share the machine among multiple computers.

Note

To set up a network environment, see " Network Scan Settings ."

Compress scanned images when transferring

Compress and transfer images scanned using MP Navigator EX or the Operation Panel of the

machine. This is useful when the machine is connected via a slow interface such as USB 1.1 or a

network. By default, this checkbox is selected when using a network connection. It is not selected

when using a USB connection.

Important

When Photo is selected for Document Type on the Scanner Button Settings tab, allow 3/8 inches

(1 cm) or more space between the edges of the Platen and the document. If not, some images

may not be scanned at the correct positions and sizes.

Business cards, panorama photos and bordered photos may not be cropped accurately when

scanned. In that case, deselect the Compress scanned images when transferring checkbox and

scan again.

The following restrictions apply when the Compress scanned images when transferring
checkbox is selected.

- Text(OCR) cannot be selected for Document Type in the Scan/Import window.
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- Black and White cannot be selected in the color mode settings for One-click Mode.

- Remove gutter shadow is not available.
- Save the JPEG/Exif file in AdobeRGB for One-click Mode is not available.

- Available resolutions: 75 dpi / 150 dpi / 300 dpi / 600 dpi

- Maximum number of documents that can be scanned at one time: 4

- A compression type (image quality) cannot be selected when saving scanned images in JPEG.

The following images are not compressed even when scanned with the Compress scanned
images when transferring checkbox selected.

- Images scanned using the Operation Panel of the machine by automatically detecting the

document type

- Images scanned in One-click Mode by automatically detecting the document type

- Images scanned using ScanGear (scanner driver)

Note

It is recommended that you scan at 300 dpi or higher resolution when scanning multiple photos

using this function.
When the Compress scanned images when transferring checkbox is selected, Unsharp Mask is

always applied.

Save in (My Box)

Displays the folder in which to save scanned documents. To change the folder, click Browse... to

specify another one.

The following folders are specified by default.

Windows Vista: MP Navigator EX folder in Pictures folder
Windows XP: MP Navigator EX folder in My Pictures folder

Windows 2000: MP Navigator EX folder in My Pictures folder

Location of Temporary Files

Displays the folder in which to save images temporarily. To change the folder, click Browse... to specify

another one.

Important

An error may occur if you set the destination to the root directory of the drive on which the

operating system is installed. Be sure to specify a folder.

An error may occur if you set the destination to a network folder. Be sure to specify a local folder.

Application to run

Displays the applications that can be started via MP Navigator EX. Install the applications from the 
Setup CD-ROM  that accompanies the machine.

For Attach to E-mail, you can select an e-mail software program to start.

For Open PDF file, the application associated with the .pdf file extension by the operating system is

displayed.

Important

You can change which items are installed during installation from the Setup CD-ROM  by

selecting Custom Install. If you choose not to install some applications with Custom Install, the
corresponding MP Navigator EX functions will be unavailable. To use those functions, install the

corresponding applications.

Note

For Convert to text file, Notepad (included with Windows) is displayed. Click Set... to open a dialog

box, then specify Document Language and how to scan multiple documents.

Document Language
Specify the language according to the language of the document to be scanned. Only text

written in languages that can be selected in the Document Language can be extracted to
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Notepad.
Combine multiple text conversion results

When scanning multiple documents, select the checkbox to collect the conversion results (text)

into one file. This checkbox is selected by default.

When the checkbox is selected, you can scan up to 99 pages at one time.

Deselect the checkbox to display each conversion result (text) in a separate file.

When the checkbox is not selected, you can scan up to 10 pages at one time.
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Scanner Button Settings Tab (Save)

On the Scanner Button Settings tab, you can specify the following settings.

This section describes the settings available when Select Event is Save to PC or Save as PDF file.

You can specify how to respond when scanning using the Operation Panel of the machine with the scan

mode set to Save to PC or Save as PDF file.

Event

Select Event

Displays the scan modes that can be selected on the Operation Panel of the machine.

Save to PC

Select this to specify the details for the scan mode Save to PC.

Save as PDF file

Select this to specify the details for the scan mode Save as PDF file.

Document Type

Select the type of document to be scanned.

Note

Auto Scan can be selected only when the machine is connected via USB and Save to PC is

selected for Select Event. When Auto Scan is selected, the document type is automatically

detected. In that case, Document Size and Resolution are automatically set as well.

Important

To scan correctly, select a document type that matches the document to be scanned.

The following types of documents cannot be scanned correctly with Auto Scan. In that case,

Page 579 of 949 pagesScanner Button Settings Tab (Save)



specify the document type or size.

- Documents other than photos, postcards, business cards, magazines, newspapers, text

documents and CD/DVD

- A4 size photos

- Text documents smaller than 2L (5 inches x 7 inches) (127 mm x 178 mm), such as
paperback pages with the spine cut off

- Documents printed on thin white paper

- Long narrow documents such as panoramic photos
Reflective CD/DVD labels may not be scanned properly.

Place documents correctly according to the type of document to be scanned. Otherwise,

documents may not be scanned correctly.

See "Placing Documents " for details on how to place documents.

Actions

Scan Settings

Document Size

Select the size of the document to be scanned.

When you select Custom, a screen in which you can specify the document size appears. Select a

Units, then enter the Width and Height and click OK.

Important

When you select Auto Detect, the image may not be scanned at the correct position and size. In

that case, change the size to the actual document size (A4, Letter, etc.) and align a corner of the

document with the corner at the arrow (alignment mark) of the Platen.

This setting is not available when Select Event is Save to PC with Document Type set to Auto

Scan.

Resolution

Select the resolution at which to scan documents.

Resolution

Important

This setting is not available when Select Event is Save to PC with Document Type set to Auto

Scan.

Specify...

Click to open the Scan Settings dialog box in which you can make advanced scan settings.

Scan Settings Dialog Box

Save Settings

Automatically save the image to your computer after scanning it

Select this to save the images to your computer as specified after scanning them.

The File Name, Save as type and Save in settings will be displayed.

Important

If you select this function, you will not be able to set passwords for PDF files.

File Name

Enter the file name of the image to be saved (up to 64 characters).

Save as type
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Select a file type to save the scanned images.
When saving to a computer, select Auto, JPEG/Exif, TIFF or BMP. Auto is displayed and selected

by default when Document Type is Auto Scan. When saving as PDF files, PDF(Multiple Pages)

is set.

Important

When Document Type is Auto Scan and Save as type is Auto, the file format may differ

depending on how you place the document.

See "Placing Documents " for details on how to place documents.

Large documents (such as A4 size photos) that cannot be placed away from the edges/

arrow (alignment mark) of the Platen may not be saved in the correct file format when Save

as type is Auto. In that case, select a file format suitable for the document to be scanned.

Note

If you select the Enable Auto Photo Fix checkbox in the Scan Settings dialog box and then

select a format other than JPEG/Exif for Save as type, a message appears and the Enable

Auto Photo Fix checkbox will be deselected.
When Auto is selected, files are saved in the following formats according to the document
type.

Photos, postcards, CD/DVD and business cards: JPEG

Magazines, newspapers and text documents: PDF
You can change the file format from Set....

Set...

When Save as type is Auto

You can specify the file format in which to save images. Select a file format for saving Document

and Photo each.

Important

You cannot select a compression type for JPEG files when the Compress scanned
images when transferring checkbox is selected on the General tab of the Preferences

dialog box.

When Save as type is JPEG/Exif

You can specify a compression type for JPEG files. Select High(Low Compression), Standard or

Low(High Compression).

Important

This setting is not available when the Compress scanned images when transferring
checkbox is selected on the General tab of the Preferences dialog box.

When Save as type is PDF(Multiple Pages)

Make advanced settings for creating PDF files. See " PDF Settings Dialog Box" for details.

Save in

Displays the folder in which to save the scanned images. To change the folder, click Browse...

to specify another one.

The following folders are specified by default.

Windows Vista: MP Navigator EX folder in Pictures folder
Windows XP: MP Navigator EX folder in My Pictures folder

Windows 2000: MP Navigator EX folder in My Pictures folder

Save to a Subfolder with Current Date

Select this checkbox to create a subfolder in the folder specified in Save in with the current date

and save scanned files in it. A subfolder with a name such as "2009_01_01"

(Year_Month_Date) will be created.
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If this checkbox is not selected, files are saved directly in the folder specified in Save in.

Open the save dialog box after scanning the image

Select this to open the save dialog box after scanning the images and specify the save settings such

as destination folder, file name and Exif information.

Note

See "Save Dialog Box " (when Select Event is Save to PC) or " Save as PDF file Dialog Box

" (when Select Event is Save as PDF file) for details on each dialog box.

To set passwords for PDF files, select Open the save dialog box after scanning the image. After

scanning, you can set the passwords in the Save as PDF file dialog box.

Setting Passwords for PDF Files

Related Topic

Scanner Button Settings Tab (Attach to E-mail)

Scanner Button Settings Tab (Open with Application)
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Scanner Button Settings Tab (Attach to E-mail)

On the Scanner Button Settings tab, you can specify the following settings.

This section describes the settings available when Select Event is Attach to E-mail.

You can specify how to respond when scanning using the Operation Panel of the machine with the scan

mode set to Attach to E-mail.

Event

Select Event

Displays the scan modes that can be selected on the Operation Panel of the machine. Select Attach

to E-mail.

Document Type

Select the type of document to be scanned.

Important

To scan correctly, select a document type that matches the document to be scanned.

Actions

Scan Settings

Document Size

Select the size of the document to be scanned.

When you select Custom, a screen in which you can specify the document size appears. Select a

Units, then enter the Width and Height and click OK.
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Important

When you select Auto Detect, the image may not be scanned at the correct position and size. In

that case, change the size to the actual document size (A4, Letter, etc.) and align a corner of the

document with the corner at the arrow (alignment mark) of the Platen.

Resolution

Select the resolution at which to scan documents.

Resolution

Specify...

Click to open the Scan Settings dialog box in which you can make advanced scan settings.

Scan Settings Dialog Box

Save Settings

File Size

Specify a size from Small (fits in a 640 by 480 window), Medium (fits in a 800 by 600 window), Large

(fits in a 1024 by 768 window) and Original.

File Name

Enter the file name of the image to be saved (up to 64 characters).

Save as type

Select a file type to save the scanned images.
Select JPEG/Exif or PDF.

Set...

When Save as type is JPEG/Exif

You can specify a compression type for JPEG files. Select High(Low Compression), Standard or

Low(High Compression).

Important

This setting is not available when the Compress scanned images when transferring checkbox
is selected on the General tab of the Preferences dialog box.

When Save as type is PDF

Make advanced settings for creating PDF files. See " PDF Settings Dialog Box" for details.

Save in

Displays the folder in which to save the scanned images. To change the folder, click Browse... to

specify another one.

The following folders are specified by default.

Windows Vista: MP Navigator EX folder in Pictures folder
Windows XP: MP Navigator EX folder in My Pictures folder

Windows 2000: MP Navigator EX folder in My Pictures folder

Save to a Subfolder with Current Date

Select this checkbox to create a subfolder in the folder specified in Save in with the current date and

save scanned files in it. A subfolder with a name such as "2009_01_01" (Year_Month_Date) will be

created.

If this checkbox is not selected, files are saved directly in the folder specified in Save in.

Attachment Settings
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Mail Program

Specify an e-mail software program.

Related Topic

Scanner Button Settings Tab (Save)

Scanner Button Settings Tab (Open with Application)
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Scanner Button Settings Tab (Open with Application)

On the Scanner Button Settings tab, you can specify the following settings.

This section describes the settings available when Select Event is Open with application.

You can specify how to respond when scanning using the Operation Panel of the machine with the scan

mode set to Open with application.

Event

Select Event

Displays the scan modes that can be selected on the Operation Panel of the machine. Select Open

with application.

Document Type

Select the type of document to be scanned.

Important

To scan correctly, select a document type that matches the document to be scanned.

Actions

Scan Settings

Document Size

Select the size of the document to be scanned.

When you select Custom, a screen in which you can specify the document size appears. Select a

Units, then enter the Width and Height and click OK.
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Important

When you select Auto Detect, the image may not be scanned at the correct position and size. In

that case, change the size to the actual document size (A4, Letter, etc.) and align a corner of the

document with the corner at the arrow (alignment mark) of the Platen.

Resolution

Select the resolution at which to scan documents.

Resolution

Specify...

Click to open the Scan Settings dialog box in which you can make advanced scan settings.

Scan Settings Dialog Box

Save Settings

File Name

Enter the file name of the image to be saved (up to 64 characters).

Save as type

Select a file type to save the scanned images.
Select JPEG/Exif, TIFF or BMP.

Set...

When Save as type is JPEG/Exif

You can specify a compression type for JPEG files. Select High(Low Compression), Standard or

Low(High Compression).

Important

This setting is not available when the Compress scanned images when transferring checkbox
is selected on the General tab of the Preferences dialog box.

Save in

Displays the folder in which to save the scanned images. To change the folder, click Browse... to

specify another one.

The following folders are specified by default.

Windows Vista: MP Navigator EX folder in Pictures folder
Windows XP: MP Navigator EX folder in My Pictures folder

Windows 2000: MP Navigator EX folder in My Pictures folder

Save to a Subfolder with Current Date

Select this checkbox to create a subfolder in the folder specified in Save in with the current date and

save scanned files in it. A subfolder with a name such as "2009_01_01" (Year_Month_Date) will be

created.

If this checkbox is not selected, files are saved directly in the folder specified in Save in.

Application Settings

Open with

Specify an application with which to open scanned images. The specified application starts after

images are scanned.

Related Topic

Scanner Button Settings Tab (Save)
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Scanner Button Settings Tab (Attach to E-mail)
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Appendix: Opening Files Other than Scanned Images

You can save or print data other than scanned images using MP Navigator EX.

Using images saved on a memory card

Importing Images Saved on a Memory Card

Using images saved on a computer

Opening Images Saved on a Computer
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Importing Images Saved on a Memory Card

You can import images (including PDF files created via scanning using the Operation Panel) saved on a

memory card, and save them to a computer or print them using MP Navigator EX. You can also attach

them to e-mail, or edit them using an application that accompanies the machine.

When saving PDF files, you can select whether to enable keyword search, and also specify the

compression type and other advanced settings.

Important

Do not remove or insert memory cards while they are being accessed or the Access Lamp of the

machine is flashing.
The machine can only detect one memory card at a time. Do not simultaneously insert multiple

memory cards.
When switching to another memory card of the same type or inserting another memory card in a

different Card Slot, make sure that the Access Lamp of the machine is not flashing, then remove the

memory card. Then, insert another memory card.

The machine's Card Slot (memory card) may become inaccessible. In that case, restart the

machine or turn it off and reconnect the USB cable.

With network connection, check that the Card Slot is mapped as a network drive. See " Using the
Card Slot over a Network " for details.

1. Insert a memory card containing images/PDF files into the machine's Card Slot.

For details on how to insert a memory card into the machine, refer to the on-screen manual: Basic

Guide.

2. Start MP Navigator EX as follows.

Windows Vista/Windows XP

Windows 2000

Windows Vista/Windows XP

The program selection screen appears. Click MP Navigator EX Ver3.0.

Note

If you want to start MP Navigator EX every time a memory card is inserted into the machine,

follow these steps.
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Windows Vista:
Select the Always do this for pictures checkbox and click MP Navigator EX Ver3.0.

Windows XP:

Select MP Navigator EX Ver3.0, then select the Always do the selected action. checkbox and

click OK.

The Memory Card screen of the Scan/Import window appears, and the images and PDF files

saved on the memory card appear in the Thumbnail window.

Note

See "Memory Card Screen (Scan/Import Window) " for details on the Memory Card screen

(Scan/Import window).

Windows 2000

Start MP Navigator EX and open the Navigation Mode screen.

Starting MP Navigator EX

Point to Scan/Import and click Memory Card. The Memory Card screen of the Scan/Import window

appears, and the images and PDF files saved on the memory card appear in the Thumbnail

window.

Important

If you cannot import images from memory cards via a network connection, see " Using the
Card Slot over a Network ."
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Note

With network connection, the Map Network Drive dialog box may open when a memory card

is inserted into the machine for the first time. Specify a drive letter to map.

3. Select the checkboxes of the images and PDF files you want to import, then click
Import.

The Import dialog box opens. Specify the folder in which to save the imported files.

Save in

Displays the folder in which to save the imported images and PDF files. To change the folder,

click Browse... to specify another one.

The following folders are specified by default.

Windows Vista: MP Navigator EX folder in Pictures folder
Windows XP: MP Navigator EX folder in My Pictures folder

Windows 2000: MP Navigator EX folder in My Pictures folder

Save to a Subfolder with Current Date

Select this checkbox to create a subfolder in the folder specified in Save in with the current date

and save imported files in it. A subfolder with a name such as "2009_01_01" (Year_Month_Date)

will be created.

If this checkbox is not selected, files are saved directly in the folder specified in Save in.

Change the PDF file properties

This option is displayed when the memory card contains a PDF file.
Select this checkbox to change the PDF file settings. You can also change the settings of PDF

files created via scanning using the Operation Panel. Click Set... to open a dialog box in which

you can specify advanced settings. See "PDF Settings Dialog Box" for details.

4. Click Save.

The imported images and PDF files appear in the View & Use window.
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See the corresponding sections below for details on using the imported images and PDF files.

Creating/Editing PDF Files

Printing Documents

Printing Photos

Sending via E-mail

Editing Files

Page top
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Opening Images Saved on a Computer

You can open images saved on a computer and print them or attach them to e-mail using MP Navigator

EX. You can also edit them using an application that accompanies the machine.

1. Start MP Navigator EX and open the Navigation Mode screen.

Starting MP Navigator EX

2. In the Navigation Mode screen, point to View & Use and click My Box (Scanned/
Imported Images), Specify Folder or Recently Saved Images.

Click My Box (Scanned/Imported Images) to open images saved in My Box (Scanned/Imported

Images), click Specify Folder to open images saved in a specific folder, or click Recently Saved

Images to open recently saved images.

Note

If the Show this window at startup checkbox is not selected, the last used screen appears. If

the Scan/Import window is displayed, click  (View & Use) on the upper left of the screen.

The View & Use window opens.
See "View & Use Images on your Computer Tab " for details on the View & Use Images on your

Computer tab.

3. Click the folder containing the images you want to open.

Images saved in the folder appear in the Thumbnail window.
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4. Select the images you want to use, then select what you want to do with them.

See the corresponding sections below for details on using images.

Creating/Editing PDF Files

Printing Documents

Printing Photos

Sending via E-mail

Editing Files
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Scanning with Other Application Software 

What Is ScanGear (Scanner Driver)?

Scanning with Advanced Settings Using ScanGear (Scanner Driver)

Correcting Images and Adjusting Colors with ScanGear (Scanner Driver)

ScanGear (Scanner Driver) Screens

Appendix: Useful Information on Scanning

Page top

Page 596 of 949 pagesScanning with Other Application Software



Advanced Guide  > Scanning > Scanning with Other Application Software  > What Is ScanGear (Scanner Driver)?

What Is ScanGear (Scanner Driver)?

ScanGear (scanner driver) is software required for scanning documents. It enables you to specify the

output size and make image corrections when scanning.

ScanGear (scanner driver) can be started from MP Navigator EX or from other applications that are

compatible with a standard interface called TWAIN. (ScanGear (scanner driver) is a TWAIN-compatible
driver.)

What You Can Do with This Software

This software enables you to preview scan results or set document type and output size, etc. when

scanning documents. It is useful when you want to scan in a specific color tone, as it allows you to make

various corrections and adjust brightness, contrast, etc.

Screens

There are three modes: Basic Mode, Advanced Mode and Auto Scan Mode.

Switch modes by clicking a tab on the upper right of the screen.

Note

ScanGear (scanner driver) starts in the last used mode.

Settings are not retained when you switch between modes.

Basic Mode

Use Basic Mode to scan easily by following three simple on-screen steps (  ,  and  ).

Advanced Mode

Use Advanced Mode to specify color mode, output resolution, image brightness, color tone, etc. when

scanning.
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Auto Scan Mode

Use Auto Scan Mode to scan easily by simply placing the document on the Platen and clicking Scan.
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ScanGear (Scanner Driver)

Scanning with Advanced Settings Using ScanGear (Scanner
Driver)

Starting ScanGear (scanner driver)

Starting ScanGear (Scanner Driver)

Scanning documents after making simple image corrections

Scanning in Basic Mode

Scanning documents after making advanced image corrections and brightness/color adjustments

Scanning in Advanced Mode

Scanning with a simple operation

Scanning in Auto Scan Mode

Scanning multiple documents at one time after making image corrections and color adjustments

Scanning Multiple Documents at One Time with ScanGear (Scanner Driver)
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Starting ScanGear (Scanner Driver)

Use ScanGear (scanner driver) to make image corrections and color adjustments when scanning.

ScanGear (scanner driver) can be started from MP Navigator EX or an application.

Note

To scan via a network connection, start ScanGear and set up the network environment before

scanning.
Network Scan Settings

Starting from MP Navigator EX

Navigation Mode Screen

Follow these steps to start ScanGear (scanner driver) from the Navigation Mode screen of MP Navigator
EX.

1. Start MP Navigator EX and open the Navigation Mode screen.

Starting MP Navigator EX

2. Point to Scan/Import and click Photos/Documents (Platen).

The Scan/Import window opens.

3. Select the Use the scanner driver checkbox, then click Open Scanner Driver.

The ScanGear (scanner driver) screen appears.

One-click Mode Screen

Follow these steps to start ScanGear (scanner driver) from the One-click Mode screen of MP Navigator
EX.

1. Start MP Navigator EX and open the One-click Mode screen.
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Starting MP Navigator EX

2. Click the corresponding icon.

The corresponding dialog box opens.

3. Select the Use the scanner driver checkbox in Scan Settings, then click Scan.

The ScanGear (scanner driver) screen appears.

Important

Use the scanner driver is not displayed in the PDF dialog box or Auto Scan dialog box.

Starting from an Application

Follow these steps (example) to start ScanGear (scanner driver) from an application.

The procedure varies depending on the application. For details, refer to the application's manual.

1. Start the application.

2. On the File menu of the application, select Select Source and select the machine.

Important

The scanner name to be selected in the application depends on whether you are scanning via
a network connection or USB connection.

3. Select the command to scan a document (Scan/Import, Acquire image, etc.).

The ScanGear (scanner driver) screen appears.

Page top

Page 601 of 949 pagesStarting ScanGear (Scanner Driver)



Advanced Guide  > Scanning > Scanning with Other Application Software  > Scanning with Advanced Settings Using

ScanGear (Scanner Driver)  > Scanning in Basic Mode

Scanning in Basic Mode

In Basic Mode, you can scan easily by following the on-screen steps.

This section explains how to scan a single document.

See "Scanning Multiple Documents at One Time with ScanGear (Scanner Driver) " to scan multiple

documents at one time.

Important

The following types of documents may not be cropped correctly. In that case, click  (Thumbnail)
on the Toolbar to switch to whole image view and scan.

- Photos that have a whitish border

- Documents printed on white paper, hand-written text, business cards, etc.

- Thin documents
- Thick documents
The following types of documents cannot be cropped correctly.

- Documents smaller than 1.18 inches (3 cm) square
- Photos that have been cut to various shapes

1. Place the document on the Platen, then start ScanGear (scanner driver).

Starting ScanGear (Scanner Driver)

Important

Place the document face-down on the Platen and align an upper corner of the document with

the corner at the arrow (alignment mark) of the Platen.

2. Set Select Source according to the document placed on the Platen.

Note

To scan magazines containing many color photos, select Magazine(Color).
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3. Click Preview.

Preview image appears in the Preview area.

Note

Colors are adjusted based on the document type selected in Select Source.

4. Set Destination.

5. Set Output Size.

Output size options vary by the items selected in Destination.

6. Adjust the scan area (cropping frame) as required.

Adjust the size and position of the cropping frame (scan area) on the preview image.

Adjusting Cropping Frames

7. Set Image corrections as required.

8. Click Scan.

Scanning starts.

Note

Click  (Information) to open a dialog box in which you can check the current scan settings
(document type, etc.).

ScanGear's response after scanning can be specified in Status of ScanGear dialog after scanning
on the Scan tab of the Preferences dialog box.

Scan Tab

Related Topic

Basic Mode Tab
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Scanning in Advanced Mode

In Advanced Mode, you can specify the color mode, output resolution, image brightness, color tone, etc.

when scanning.

This section explains how to scan a single document.

See "Scanning Multiple Documents at One Time with ScanGear (Scanner Driver) " to scan multiple

documents at one time.

Important

The following types of documents may not be cropped correctly. In that case, click  (Thumbnail)
on the Toolbar to switch to whole image view and scan.

- Photos that have a whitish border

- Documents printed on white paper, hand-written text, business cards, etc.

- Thin documents
- Thick documents
The following types of documents cannot be cropped correctly.

- Documents smaller than 1.18 inches (3 cm) square
- Photos that have been cut to various shapes

1. Place the document on the Platen, then start ScanGear (scanner driver).

Starting ScanGear (Scanner Driver)

Important

Place the document face-down on the Platen and align an upper corner of the document with

the corner at the arrow (alignment mark) of the Platen.

2. Click Advanced Mode.

The Advanced Mode tab appears.

Note
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Settings are not retained when you switch between modes.

3. Set Color Mode.

Input Settings

4. Click Preview.

Preview image appears in the Preview area.

Note

If you scan without preview, the show-through reduction function will be active. This function is

useful when scanning magazines. However, when scanning photos, the color tone of the
scanned image may differ from the source due to the show-through reduction function. In that

case, use preview first.

5. Set Output Settings.

Output Settings

6. Adjust the cropping frame (scan area), correct image and adjust colors as required.

Adjusting Cropping Frames

Image Settings

Color Adjustment Buttons

7. Click Scan.

Scanning starts.

Note

Click  (Information) to open a dialog box in which you can check the current scan settings
(document type, etc.).

ScanGear's response after scanning can be specified in Status of ScanGear dialog after scanning
on the Scan tab of the Preferences dialog box.

Scan Tab

Related Topic

Advanced Mode Tab
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Scanning in Auto Scan Mode

You can scan easily in Auto Scan Mode of ScanGear (scanner driver) by letting it automatically determine

the type of document placed on the Platen.

Note

Supported document types are photos, postcards, business cards, magazines, newspapers, text

documents and CD/DVD. To scan other documents, specify the document type on the Basic Mode
tab or the Advanced Mode tab.

Scanning in Basic Mode

Scanning in Advanced Mode

1. Place the document on the Platen, then start ScanGear (scanner driver).

Placing Documents

Starting ScanGear (Scanner Driver)

2. Click Auto Scan Mode.

The Auto Scan Mode tab appears.

3. Click Scan.

Scanning starts.

Note

ScanGear's response after scanning can be specified in Status of ScanGear dialog after scanning
on the Scan tab of the Preferences dialog box.

Scan Tab

Related Topic

Auto Scan Mode Tab
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Scanning Multiple Documents at One Time with ScanGear
(Scanner Driver)

You can scan two or more photos (small documents) on the Platen at one time in Basic Mode and
Advanced Mode of ScanGear (scanner driver).

This section explains how to scan multiple documents from the Basic Mode tab.

Important

To scan multiple documents as a single image, scan in whole image view.
The following types of documents may not be cropped correctly. In that case, adjust the cropping

frames (scan areas) in whole image view and scan.
- Photos that have a whitish border

- Documents printed on white paper, hand-written text, business cards, etc.

- Thin documents
- Thick documents

Scanning Multiple Documents in Whole Image View

The following types of documents cannot be cropped correctly.

- Documents smaller than 1.18 inches (3 cm) square
- Photos that have been cut to various shapes

Note

See "Scanning in Auto Scan Mode " to scan easily by automatically detecting the document type.

You can also scan multiple documents at one time from the Advanced Mode tab. Use the Advanced

Mode tab to make advanced scan settings such as the color mode, output resolution, image

brightness and color tone.
See the corresponding sections below for details on the Basic Mode tab and Advanced Mode tab.

Basic Mode Tab
Advanced Mode Tab

1. Place the document on the Platen, then start ScanGear (scanner driver).

Placing Documents

Starting ScanGear (Scanner Driver)

2. Set Select Source according to the document placed on the Platen.
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3. Click Preview.

Thumbnails of the preview images appear in the Preview area. Images are cropped (scan areas are
specified) automatically according to the document size.

4. Set Destination.

5. Set Output Size.

6. Adjust the scan areas (cropping frames) and set Image corrections as required.

Note

You can correct each image separately. Select the frame you want to correct.

In thumbnail view, you can only create one cropping frame (scan area) per image.

To create multiple cropping frames in an image, scan in whole image view.

Scanning Multiple Documents in Whole Image View

7. Select the images you want to scan.

Select the checkboxes of the images you want to scan.
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8. Click Scan.

Scanning Multiple Documents in Whole Image View

Follow these steps if thumbnails are not displayed correctly when previewed or if you want to scan

multiple documents as a single image.

Note

Positions of slanted documents are not corrected in whole image view.

1. After previewing images, click  (Thumbnail) on the Toolbar.

Switch to whole image view.

Note

When the whole image is displayed, the icon changes to  (Whole Image).

2. Adjust the scan areas (cropping frames).

Adjust the size and position of the cropping frame (scan area) on the preview image. You can also

create two or more cropping frames.

If an area is not specified, the document will be scanned at the document size (Auto Crop). If an area

is specified, only the portion in the specified area will be scanned.

Adjusting Cropping Frames

3. Set Destination.

4. Set Output Size.

5. Set Image corrections as required.

6. Click Scan.

Areas framed by broken lines are scanned.
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Note

ScanGear's response after scanning can be specified in Status of ScanGear dialog after scanning
on the Scan tab of the Preferences dialog box.

Scan Tab
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Correcting Images and Adjusting Colors with ScanGear
(Scanner Driver)

The following sections provide you with tips and know-how on advanced scanning techniques involving

color/brightness adjustment, etc.

Sharpening out-of-focus photos, reducing dust and scratches, and correcting faded colors

Correcting Images (Unsharp Mask, Reduce Dust and Scratches, Fading Correction, etc.)

Previewing and changing the color tone of the entire image to scan

Adjusting Colors Using a Color Pattern

Brightening colors that have faded with time or due to colorcast

Adjusting Saturation and Color Balance

Adjusting images that are too dark or bright, or too flat due to lack of contrast

Adjusting Brightness and Contrast

Adjusting the color tone using histogram (a graph showing brightness distribution)

Adjusting Histogram

Adjusting the image brightness using tone curve (a graph of brightness balance)

Adjusting Tone Curve

Sharpening characters in text documents or reducing show-through effects

Setting Threshold
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Correcting Images (Unsharp Mask, Reduce Dust and
Scratches, Fading Correction, etc.)

The Image Settings functions in Advanced Mode tab of ScanGear (scanner driver) allow you to enhance

the outline of the subjects, reduce dust/scratches and correct faded colors when scanning images.

Setting Items

Click  (Arrow) of a function and select an item from the pull-down menu.

Important

Do not apply these functions to images without moire, dust/scratches or faded colors. The color
tone may be adversely affected.

See "Image Settings " for details and precautions on each function.

Note

See "Scanning in Advanced Mode " to start ScanGear (scanner driver) in Advanced Mode tab and

scan.

Adjusting the image brightness and color tone

Set Image Adjustment to Auto, Photo, Magazine, Newspaper or Document according to the document
type.
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None Auto

Sharpening slightly out-of-focus images

Set Unsharp Mask to ON.

OFF ON

Reducing gradations and stripe patterns

Set Descreen to ON.

OFF ON

Note

"Moire" is a phenomenon where uneven gradation or a stripe pattern appears when such photos or

pictures printed with fine dots are scanned. Descreen is the function for reducing this moire effect.

Reducing dust and scratches

Set Reduce Dust and Scratches to Low, Medium or High according to the degree of dust and scratches.

None Medium

Correcting photos that have faded with time or due to colorcast

Set Fading Correction to Low, Medium or High according to the degree of fading or colorcast.

None Medium
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Reducing graininess

Set Grain Correction to Low, Medium or High according to the degree of graininess.

None Medium

Correcting backlit images

Set Backlight Correction to Low, Medium or High according to the degree of backlight.

None Medium

Correcting shadows that appear between pages when scanning open booklets

Set Gutter Shadow Correction to Low, Medium or High according to the degree of shadows.

None Medium
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Adjusting Colors Using a Color Pattern

You can preview color changes and reproduce natural colors by using the Color Pattern function in

ScanGear's Basic Mode tab.

Color Adjustment

Correct colors that have faded with time or due to colorcast. Colorcast is a phenomenon where a specific

color affects the entire picture due to the weather or ambient strong colors.

Click an arrow in Color Adjustment to emphasize the corresponding color.

Cyan & red, magenta & green and yellow & blue are complementary color pairs (each pair produces a

shade of gray when mixed). You can reproduce the natural colors of the scene by reducing the cast color

and increasing the complementary color.
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It is recommended that you find a portion in the image where it should be white, and adjust the colors so
that the portion turns white.

Preview image appears in the center. Preview image colors change as you adjust them.

Below is an example of correcting a bluish image.

Since Blue and Green are too strong, click the Yellow and Magenta arrows to correct.

Before After

Note

Color adjustments are applied only to the scan area (cropping frame) or the frame selected in

thumbnail view.

You can select multiple frames or cropping frames by clicking them while pressing the Ctrl key.

You can also select a color tone from the color pattern displayed on the left of the Color Pattern

screen.
You can also use this function to add a specific tint to an image. Increase the magenta to add a

warm tint, and increase the blue to add a cool tint.
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Adjusting Saturation and Color Balance

In ScanGear's Advanced Mode tab, click  (Saturation/Color Balance).

Note

Click Defaults to reset all adjustments in the current window.

Saturation

Adjust the image's saturation (vividness). You can brighten colors that have faded with time, etc.

Move  (slider) under Saturation to the left to decrease the saturation (darken the image), and to the

right to increase the saturation (brighten the image). You can also enter a value (-127 to 127).

Saturation decreased Original image Saturation increased

Note

The natural color tone of the original image may be lost if you increase saturation too much.

Color Balance

Adjust images that have a colorcast. Colorcast is a phenomenon where a specific color affects the entire

picture due to the weather or ambient strong colors.
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Move  (slider) under Color Balance to the left or right to emphasize the corresponding color.

Cyan & Red

Magenta & Green

Yellow & Blue

These are complementary color pairs (each pair produces a shade of gray when mixed). You can

reproduce the natural colors of the scene by reducing the cast color and increasing the complementary

color.

It is usually difficult to correct the image completely by adjusting only one color pair. It is recommended

that you find a portion in the image where it should be white, and adjust all three color pairs so that the

portion turns white.

You can also enter a value (-127 to 127).

Below is an example of an image in which the "Cyan & Red" pair has been adjusted.

Cyan is increased Red is increased
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Adjusting Brightness and Contrast

In ScanGear's Advanced Mode tab, click  (Brightness/Contrast).

Note

Click  (Down arrow) to switch to detailed view. Click  (Up arrow) to return to the previous view.

Click Defaults to reset all adjustments in the current window.

Channel

Each dot of an image is a mixture of Red, Green and Blue in various proportions (gradation). These

colors can be adjusted individually as a "channel."

Master

Adjust the Red, Green and Blue combined.

Red

Adjust the Red channel.

Green

Adjust the Green channel.

Blue

Adjust the Blue channel.
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Note

Only Grayscale will be displayed in Channel when Color Mode is Grayscale.

Brightness

Adjust the image brightness. Move  (slider) under Brightness to the left to darken and right to brighten

the image. You can also enter a value (-127 to 127).

Darkened Original image Brightened

Note

Highlights may be lost if you brighten the image too much, and shadows may be lost if you darken

the image too much.

Contrast

"Contrast" is the degree of difference between the brighter and darker parts of an image. Increasing

contrast will increase the difference, thus sharpening the image. Decreasing contrast will decrease the

difference, thus softening the image.

Move  (slider) under Contrast to the left to decrease and right to increase the contrast of the image.

You can also enter a value (-127 to 127).

Decreased contrast Original image Increased contrast

Note

Increasing the contrast is effective in adding a three-dimensional feel to soft images. However,

shadows and highlights may be lost if you increase the contrast too much.
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Adjusting Histogram

In ScanGear's Advanced Mode tab, click  (Histogram).

Note

Click Defaults to reset all adjustments in the current window.

Channel

Each dot of an image is a mixture of Red, Green and Blue in various proportions (gradation). These

colors can be adjusted individually as a "channel."

Master

Adjust the Red, Green and Blue combined.

Red

Adjust the Red channel.

Green

Adjust the Green channel.

Blue

Adjust the Blue channel.

Note

Only Grayscale will be displayed in Channel when Color Mode is Grayscale.

Reading Histograms

You can open Histogram of a specified area for each Channel. The higher the Histogram peak, the more

data is distributed to that level.
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(1) Bright area (2) Dark area (3) Whole image

More data is distributed to the

highlight side.

More data is distributed to the

shadow side.

Data is widely distributed between the

highlight and shadow.

Adjusting Histograms (Using the Slider)

Select a Channel, then move  (Black-point Slider) or  (White-point Slider) to specify the level to be

set as the shadow or highlight.

- All parts to the left of  (Black-point Slider) will be black (level 0).

- The parts at  (Mid-point Slider) will turn to the color exactly between the black-point and white-point.

- All parts to the right of  (White-point Slider) will turn white (level 255).

Image Adjustment is Auto by default. Adjustments shown below are automatically performed.

Moving the Black-point and White-point Sliders

Move the Black-point Slider or White-point Slider to adjust brightness.

Images with more data distributed to the highlight side

Move the Black-point Slider toward the highlight side.

Images with more data distributed to the shadow side

Move the White-point Slider toward the shadow side.

Images with widely distributed data

Move the Black-point Slider toward the highlight side, and White-point Slider toward the shadow side.
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Moving the Mid-point Slider

Move the Mid-point Slider to specify the level to be set as the middle of the tonal range.

Images with more data distributed to the highlight side

Move the Mid-point Slider toward the highlight side.

Images with more data distributed to the shadow side

Move the Mid-point Slider toward the shadow side.

Adjusting Histograms (Using the Droppers)

When you select a Channel and click the Black-point, Mid-point or White-point Dropper, the mouse

pointer on the preview image changes to a dropper. Click a Dropper displayed below the histogram to

change the setting.

- The point clicked with  (Black-point Dropper) will be the darkest point. You can also enter a value (0

to 245).

- The point clicked with  (Mid-point Dropper) will be the middle of the tonal range. You can also enter
a value (5 to 250).

- The point clicked with  (White-point Dropper) will be the brightest point. You can also enter a value

(10 to 255).

- Click  (Dropper) for Gray Balance and click the area you want to adjust the color in the preview

image.

The clicked point will be set as the achromatic color reference, and the rest of the image is adjusted

accordingly. For instance, if snow in a photo appears bluish, click the bluish part to adjust the whole

image and reproduce natural colors.
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Adjusting Tone Curve

In ScanGear's Advanced Mode tab, click  (Tone Curve Settings).

Note

Click Defaults to reset all adjustments in the current window.

Channel

Each dot of an image is a mixture of Red, Green and Blue in various proportions (gradation). These

colors can be adjusted individually as a "channel."

Master

Adjust the Red, Green and Blue combined.

Red

Adjust the Red channel.

Green

Adjust the Green channel.

Blue

Adjust the Blue channel.

Note

Only Grayscale will be displayed in Channel when Color Mode is Grayscale.

Reading Tone Curves

With ScanGear (scanner driver), scanning images via a scanner is the input, and displaying to a monitor

is the output. "Tone Curve" shows the balance of tone input and output for each Channel.
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Adjusting Tone Curve

In Select Tone Curve, select a tone curve from No correction, Overexposure, Underexposure, High

contrast, Reverse the negative/positive image and Edit custom curve.

No correction (No adjustment)

Overexposure (Convex curve)

The midtone data of the input side is stretched toward the highlight of the output side, resulting in a

bright-toned image when viewed on a monitor.

Underexposure (Concave curve)

The midtone data of the input side is stretched toward the shadow of the output side, resulting in a dark-

toned image when viewed on a monitor.

High contrast (S curve)

The highlight and shadow of the input side are enhanced, resulting in a high-contrast image.

Reverse the negative/positive image (Downward-sloping line)

The input and output sides are reversed, resulting in a negative-positive inverted image.
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Edit custom curve

You can drag specific points on the Tone Curve to freely adjust the brightness of the corresponding

areas.
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Setting Threshold

The brightness of color and grayscale images is expressed in a value between 0 and 255. However, in
creating black and white images, all colors are mapped to either black (0) or white (255). "Threshold" is
the borderline value that determines a color as black or white. By adjusting the threshold level, you can

sharpen text in a document or reduce show-through in newspapers.

This function is available when Color Mode is Black and White.

In ScanGear's Advanced Mode tab, click  (Threshold).

Note

Click Defaults to reset all adjustments in the current window.

Adjusting Threshold

Move  (slider) to the right to increase the threshold value and thus increase the black areas. Move the

slider to the left to decrease the value and thus increase the white areas. You can also enter a value (0 to

255).
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ScanGear (Scanner Driver) Screens

The following sections describe ScanGear's screens and functions, and how to use ScanGear (scanner
driver).

Basic Mode Tab

Advanced Mode Tab

Input Settings

Output Settings

Image Settings
Color Adjustment Buttons

Auto Scan Mode Tab

Preferences Dialog Box

Scanner Tab

Preview Tab

Scan Tab

Color Settings Tab
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Basic Mode Tab

This mode allows you to scan easily by following the on-screen steps.

This section describes the settings and functions available in Basic Mode.

(1) Settings and Operation Buttons

(2) Toolbar

(3) Preview Area

Note

The displayed items vary by document type and how the screen was opened.

Settings and Operation Buttons

Select Source

Photo(Color)

Scan color photos.

Magazine(Color)

Scan color magazines.

Newspaper(Grayscale)

Scan text and line drawings in black and white.

Document(Grayscale)

Scan documents and photos in black and white.

Select this mode to create high-resolution black and white images.

Note

When you select a document type, colors are adjusted based on the Unsharp Mask function or

document type.

If you select Magazine(Color), the Descreen function will be active.

Display Preview Image
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Preview

Performs a trial scan.

Note

When using the machine for the first time, scanner calibration starts automatically. Wait a while

until the preview image appears.

Destination

Select what you want to do with the scanned image.

Print

Select this to print the scanned image on a printer.

Image display

Select this to view the scanned image on a monitor.

OCR

Select this to use the scanned image with OCR software.
OCR software is software that converts text scanned as an image into text data that can be

edited in word processors and other programs.

Output Size

Select an output size.

Output size options vary by the item selected in Destination.

Flexible

Allows you to freely adjust the cropping frames.

In thumbnail view

Drag the mouse over a thumbnail to display a cropping frame. When a cropping frame is

displayed, the portion within the cropping frame will be scanned. When no cropping frame is
displayed, each frame is scanned individually.

In whole image view

When no cropping frame is displayed, the entire Preview area will be scanned. When a

cropping frame is displayed, the portion within the cropping frame will be scanned.

Paper Size (L, A4, etc.)

Select an output paper size. The portion within the cropping frame will be scanned at the size of

the selected paper size. You can drag the cropping frame to enlarge/reduce it while maintaining

the aspect ratio.

Monitor Size (1024 x 768 pixels, etc.)

Select an output size in pixels.
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A cropping frame of the selected monitor size will be displayed and the portion within the

cropping frame will be scanned. You can drag the cropping frame to enlarge/reduce it while

maintaining the aspect ratio.

Add/Delete...

Opens the Add/Delete the Output Size dialog box, in which you can specify custom output sizes.

You can select this option when Destination is Print or Image display.

In the Add/Delete the Output Size dialog box, you can specify multiple output sizes and save

them at one time. Saved items will be registered to the Output Size list and can be selected,

along with the predefined items.

Add

To add a size, enter Output Size Name, Width and Height, then click Add. For Unit, you can

select mm or inches when Destination is Print but you can only select pixels when Destination
is Image display. The name of the added size appears in Output Size List. Click Save to save

the items listed in Output Size List.

Delete

To delete an item, select it in Output Size List and click Delete. Click Save to save the items

listed in Output Size List.

Important

You cannot delete predefined output sizes such as A4 and 1024 x 768 pixels.

Note

Save up to 10 items.

An error message appears when you enter a value outside the setting range. Enter a value

within the setting range.

Note

Whether or how the cropping frame is initially displayed on a preview image can be specified

on the Preview tab of the Preferences dialog box. See Cropping Frame on Previewed Images in
"Preview Tab ."

 Invert aspect ratio

This button is available when Output Size is set to anything but Flexible.

Click this button to rotate the cropping frame. Click again to return it to the original orientation.

Adjust cropping frames

You can adjust the scan area within the Preview area.

If an area is not specified, the document will be scanned at the document size (Auto Crop). If an area

is specified, only the portion in the cropping frame will be scanned.

Adjusting Cropping Frames
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Image corrections

Fading correction

Corrects and scans photos that have faded with time or have a colorcast.

Backlight correction

Corrects photos that have been shot against light.

Gutter shadow correction

Corrects shadows that appear between pages when scanning open booklets.

Important

For precautions on using this function, see Gutter Shadow Correction in " Image Settings
" (Advanced Mode tab).

Color Pattern...

Allows you to adjust the image's overall color. You can correct colors that have faded due to

colorcast, etc. and reproduce natural colors while previewing color changes.

Adjusting Colors Using a Color Pattern

Perform Scan

Scan

Scanning starts.

Note

When scanning starts, the progress will be displayed. Click Cancel to cancel the scan.

Preferences...

The Preferences dialog box opens and you can make scan/preview settings.

Preferences Dialog Box

Close

Closes ScanGear (scanner driver).

Toolbar

Toolbar

You can adjust or rotate preview images. The buttons displayed on the Toolbar vary by view.

In thumbnail view

In whole image view
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 (Thumbnail)/  (Whole image view)

Switches the view in the Preview area.
Preview Area

 (Rotate Left)

Rotates the preview image 90 degrees counter-clockwise.

- The result will be reflected in the scanned image.
- The image returns to its original state when you preview again.

 (Rotate Right)

Rotates the preview image 90 degrees clockwise.

- The result will be reflected in the scanned image.

- The image returns to its original state when you preview again.

 (Auto Crop)

Displays and adjusts the cropping frame automatically to the size of the document displayed in

the Preview area. The scan area is reduced every time you click this button if there are cropping

area within the cropping frame.

 (Check All Frames)

This button is available when two or more frames are displayed.

Selects the checkbox of the image in thumbnail view.

 (Uncheck All Frames)

This button is available when two or more frames are displayed.
Deselects the checkbox of the image in thumbnail view.

 (Select All Frames)

This button is available when two or more frames are displayed.

Selects the image in thumbnail view and the image will be outlined in blue.

 (Select All Cropping Frames)

This button is available when there are two or more cropping frames.

All cropping frames will be displayed in thick broken lines. The settings will be applied to all the

cropping frames.

 (Remove Cropping Frame)

Removes the selected cropping frame.

 (Information)

Displays the version of ScanGear (scanner driver) and the current scan settings (document
type, etc.).

 (Open Guide)

This page appears.

Preview Area

Preview Area

This is where a trial image is displayed after you click Preview. You can also check the results of the

settings (image corrections, color adjustments, etc.) made in " Settings and Operation Buttons ."

When  (Thumbnail) is displayed on the Toolbar

Thumbnails of images cropped to the document size are displayed. Only the images with the

Page 635 of 949 pagesBasic Mode Tab



checkbox selected will be scanned.

Note

When multiple images are previewed, different outlines indicate different selection status.

- Focus Frame (thick blue outline): The displayed settings will be applied.

- Selected Frame (thin blue outline): The settings will be applied to the Focus Frame and

Selected Frames simultaneously. You can select multiple images by clicking them while

pressing the Ctrl key.

- Unselected (no outline): The settings will not be applied.

Double-click a frame to zoom in on the image. Click  (Frame Advance) at the bottom of

the screen to display the previous or next frame. Double-click the frame again to return the

display to its non-magnified state.

When  (Whole Image) is displayed on the Toolbar

Items on the Platen are displayed as a single image. All portions in the cropping frames will be

scanned.

Note

You can specify the scan area (cropping frame) on the displayed image. In thumbnail view, you can

only create one cropping frame per image. In whole image view, you can create multiple cropping

frames.

Adjusting Cropping Frames

Related Topic
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Scanning in Basic Mode
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Advanced Mode Tab

Advanced Mode Tab

This mode allows you to make advanced scan settings such as the color mode, output resolution,

image brightness and color tone.

This section describes the settings and functions available in Advanced Mode.

(1) Settings and Operation Buttons

(2) Toolbar

(3) Preview Area

Note

The displayed items vary by document type and how the screen was opened.

Settings and Operation Buttons

Favorite Settings

You can name and save a group of settings (Input Settings, Output Settings, Image Settings and

Color Adjustment Buttons) on Advanced Mode tab, and load it as required. It is convenient to save a

group of settings if you will be using it repeatedly. You can also use this to reload the default

settings.
Select Add/Delete... from the pull-down menu and the Add/Delete Favorite Settings dialog box

opens.
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Enter Setting Name and click Add. The name appears in Favorite Settings List.

When you click Save, the item appears in the Favorite Settings list and can be selected, along with

the predefined items.

To delete an item, select it in Favorite Settings List and click Delete. Click Save to save settings

displayed in Favorite Settings List.

Note

You can set Add/Delete... in Favorite Settings after preview.

Save up to 10 items.

Input Settings

Specify the input settings such as the document type and size.

Input Settings

Output Settings

Specify the output settings such as the output resolution and size.

Output Settings

Image Settings

Enable/disable various image correction functions.
Image Settings

Color Adjustment Buttons

These buttons can be used to make fine corrections to the image brightness and color tones. You

can adjust the image's overall brightness or contrast, and adjust its highlight and shadow values

(histogram) or balance (tone curve).

Color Adjustment Buttons

Zoom

Zooms in on an image or the portion within the cropping frame. When the image is zoomed in,

Zoom changes to Undo. Click Undo to return the display to its non-magnified state.

In thumbnail view

Zooms in on the selected image. Click  (Frame Advance) at the bottom of the screen to

display the previous or next frame.

Note

You can also zoom in on an image by double-clicking the frame. Double-click the frame again

to return the display to its non-magnified state.

In whole image view

Rescans the portion within the cropping frame at higher magnification.

Note

Zoom rescans the image and displays high-resolution image in Preview.

 (Enlarge/Reduce) on the Toolbar zooms in on the preview image quickly. However, the

resolution of the displayed image will be low.

Preview
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Performs a trial scan.

Scan

Starts scanning.

Note

When scanning starts, the progress will be displayed. Click Cancel to cancel the scan.

When scanning is completed, a dialog box prompting you to select the next action may open.

Follow the prompt to complete. For details, see Status of ScanGear dialog after scanning in "

Scan Tab" (Preferences dialog box).

It will take time to process the images if the total size of the scanned images exceeds a certain

size. In that case, a warning message appears. It is recommended that you reduce the total

size. To continue, scan in whole image view.

Preferences...

The Preferences dialog box opens and you can make scan/preview settings.

Preferences Dialog Box

Close

Closes ScanGear (scanner driver).

Toolbar

Toolbar

You can adjust or rotate preview images. The buttons displayed on the Toolbar vary by view.

In thumbnail view

In whole image view

 (Thumbnail)/  (Whole image view)
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Switches the view in the Preview area.
Preview Area

 (Clear)

Click this button to delete the preview image.

It also resets the Toolbar and color adjustment settings.

 (Crop)

Allows you to specify the scan area by dragging the mouse.

 (Move Image)

If an enlarged image is too large to fit in the Preview area, you can click this button and drag the

image across the screen until the part you want to see is displayed. You can also move the

image using the scroll bars.

 (Enlarge/Reduce)

Click this button then click on the image to enlarge it (zoom in). Right-click on the image to

reduce it (zoom out).

 (Rotate Left)

Rotates the preview image 90 degrees counter-clockwise.

- The result will be reflected in the scanned image.

- The image returns to its original state when you preview again.

 (Rotate Right)

Rotates the preview image 90 degrees clockwise.

- The result will be reflected in the scanned image.
- The image returns to its original state when you preview again.

 (Auto Crop)

Displays and adjusts the cropping frame automatically to the size of the document displayed in
the Preview area. The scan area is reduced every time you click this button if there are cropping

area within the cropping frame.

 (Check All Frames)

This button is available when two or more frames are displayed.

Selects the checkbox of the image in thumbnail view.

 (Uncheck All Frames)

This button is available when two or more frames are displayed.

Deselects the checkbox of the image in thumbnail view.

 (Select All Frames)

This button is available when two or more frames are displayed.

Selects the image in thumbnail view and the image will be outlined in blue.

 (Select All Cropping Frames)

This button is available when there are two or more cropping frames.

All cropping frames will be displayed in thick broken lines. The settings will be applied to all the

cropping frames.

 (Remove Cropping Frame)

Removes the selected cropping frame.

 (Information)
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Displays the version of ScanGear (scanner driver) and the current scan settings (document
type, etc.).

 (Open Guide)

This page appears.

Preview Area

Preview Area

This is where a trial image is displayed after you click Preview. You can also check the results of the

settings (image corrections, color adjustments, etc.) made in " Settings and Operation Buttons ."

When  (Thumbnail) is displayed on the Toolbar

Thumbnails of images cropped to the document size are displayed. Only the images with the

checkbox selected will be scanned.

Note

When multiple images are previewed, different outlines indicate different selection status.

- Focus Frame (thick blue outline): The displayed settings will be applied.

- Selected Frame (thin blue outline): The settings will be applied to the Focus Frame and

Selected Frames simultaneously. You can select multiple images by clicking them while

pressing the Ctrl key.

- Unselected (no outline): The settings will not be applied.

When  (Whole Image) is displayed on the Toolbar

Items on the Platen are displayed as a single image. All portions in the cropping frames will be

scanned.
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Note

You can specify the scan area (cropping frame) on the displayed image. In thumbnail view, you can

only create one cropping frame per image. In whole image view, you can create multiple cropping

frames.

Adjusting Cropping Frames

Related Topic

Scanning in Advanced Mode

Page top
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Settings

Input Settings

Input Settings allows you to set the following items:

Select Source

The type of document to be scanned is displayed.

Paper Size

Select the size of the document to be scanned. This setting is available in whole film image view only.

When you select a size, the Preview area size changes accordingly.

Important

Some applications have a limit to the amount of scan data they can receive. ScanGear (scanner

driver) can scan data that is of:

- 21000 pixels x 30000 pixels or less
If you change Paper Size after previewing, the preview image will be deleted.

Note

If you are not sure which size you should select for Paper Size, set Paper Size to Full Platen, then

measure the size of the document and enter the values into  (Width) and  (Height).

Color Mode

Select how to scan the document.

Color

Select this mode to scan color documents or to create color images. This mode renders the

image in 256 levels (8 bit) of R(ed), G(reen), and B(lue).

Grayscale

Select this mode to scan black and white photos, or to create black and white images. This mode
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renders the image in 256 levels (8 bit) of black and white.

Black and White

Select this mode to scan photos and documents in black and white. This mode renders the

image in black and white. The contrast in the image is divided at certain levels (threshold level)

into black and white and is rendered in two colors. The threshold level can be set with 

(Threshold).

Input Size

In thumbnail view, the cropped document size is displayed after preview.

In whole image view, the Paper Size is displayed before preview, and the cropping frame (scan area)

size is displayed after preview.

You can adjust the cropping frame size by entering the values into  (Width) and  (Height).

Click  (Keep Aspect Ratio) and change it to  (Locked) to maintain the aspect ratio when you

specify the cropping frame size.

Important

Input size settings are available only when Output Size in Output Settings is Flexible. If you select

a size other than Flexible, a cropping frame calculated from Output Size and Output Resolution is

displayed, and its aspect ratio is fixed.

Note

The values you can enter will be within the range of the selected document size. The minimum

size is 96 pixels x 96 pixels when Output Resolution is 600 dpi, scaled at 100%.

When Auto Crop is performed in whole image view, the aspect ratio will not be maintained since

the size will be prioritized.

See "Adjusting Cropping Frames" for details on cropping frames.

Page top
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Output Settings

Output Settings

Output Settings allows you to set the following items:

Output Resolution

Select the resolution to scan at.

The higher the resolution (value), the more detail in your image.

Select a resolution from the options displayed by clicking the button, or enter a value within the range

of 25 dpi to 19200 dpi (in 1 dpi increments).

Resolution

Output Size

Select an output size.

Select Flexible to set custom sizes or select a size for printing or displaying. Select Add/Delete... to set

custom size and save it as a new output size option.

Flexible

You can specify the output resolution and scale, and adjust the cropping frame.

In thumbnail view

Drag the mouse over a thumbnail to display a cropping frame. When a cropping frame is

displayed, the portion within the cropping frame will be scanned. When no cropping frame is
displayed, each frame is scanned individually.

In whole image view

When no cropping frame is displayed, the entire Preview area will be scanned. When a cropping

frame is displayed, the portion within the cropping frame will be scanned.

Note

To enlarge/reduce the scanned image, enter values into  (Width) and  (Height) in
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Output Settings or specify a value (by 1%) for %. The maximum value available for %

depends on the Output Resolution. % can be specified for up to 19200 dpi (the maximum

available output resolution).

Paper Size (L, etc.) & Monitor Size (1024 x 768 pixels, etc.)

Width, height and scale cannot be specified. The preview image will be cropped according to the

selected output size and resolution. The portion within the cropping frame will be scanned at the
size of the selected paper/monitor size. You can drag the cropping frame to enlarge, reduce or

move it while maintaining the aspect ratio.

Add/Delete...

Opens the Add/Delete the Output Size dialog box, in which you can specify custom output sizes.

In the Add/Delete the Output Size dialog box, you can specify multiple output sizes and save them

at one time. Saved items will be registered to the Output Size list and can be selected, along with

the predefined items.

Add

To add a size, select Print or Image display for Destination, then enter Output Size Name, Width,

and Height then click Add. The name of the added size appears in Output Size List.

Click Save to save the items listed in Output Size List.

Delete

To delete an item, select it in Output Size List and click Delete. Click Save to save the items listed
in Output Size List.

Important

You cannot delete predefined output sizes such as A4 and 1024 x 768 pixels.

Note

Save up to 10 items for each destination.

An error message appears when you enter a value outside the setting range. Enter a value

within the range displayed in the message.
Unit varies by Destination. For Print, select mm or inches. For Image display, the unit is

pixels.

Note

See "Adjusting Cropping Frames" for details on cropping frames.
Whether or how the cropping frame is initially displayed on a preview image can be specified on

the Preview tab of the Preferences dialog box. See Cropping Frame on Previewed Images in "

Preview Tab ."

 (Switch Aspect Ratio)

Click this button to rotate the cropping frame. Click again to return it to the original orientation.

Data Size

An image file is created when the preview image is scanned. Its size when saved in BMP format is

displayed.

Note

When the file size exceeds a certain size, the value appears in red. In that case, a warning
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message appears when you click Scan. It is recommended that you adjust the settings to reduce
Data Size. To continue, scan in whole image view.

Page top
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Advanced Guide  > Scanning > Scanning with Other Application Software  > ScanGear (Scanner Driver) Screens >

Image Settings

Image Settings

Important

Do not apply these functions to images without moire, dust/scratches or faded colors. The color

tone may be adversely affected.

Image correction results may not be reflected in the preview image.

Note

Selectable settings depend on color mode settings.
Scanning may take longer when you use Image Settings.

Image Settings allows you to set the following items:

Image Adjustment

When Image Adjustment is set, the brightness of the specified portion of the image is optimized.

Images can be adjusted according to the automatically detected document type or the specified

document type. The result of the adjustment will be reflected in the entire image. This setting is Auto by

default.

None

Image Adjustment will not be applied.

Auto

Applies Image Adjustment by automatically detecting the document type. It is recommended that

you normally select this setting.

Photo

Select this to apply Image Adjustment to photos.

Magazine
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Select this to apply Image Adjustment to magazines.

Newspaper

Select this to apply Image Adjustment to newspapers.

Document

Select this to apply Image Adjustment to text documents.

Important

You can set Image Adjustment after preview.

You can set this setting when Recommended is selected on the Color Settings tab of the

Preferences dialog box.

Note

If the image is not adjusted properly with Auto, specify the document type.

The color tone may change from the source image due to the Image Adjustment. In that case, set

Image Adjustment to None.

Unsharp Mask

When this is set to ON, the outline of the subjects is emphasized to sharpen the image. This setting is
ON by default.

Descreen

Printed photos and pictures are displayed as a collection of fine dots. "Moire" is a phenomenon where
uneven gradation or a stripe pattern appears when such photos or pictures printed with fine dots are

scanned. Descreen is the function for reducing this moire effect. This setting is OFF by default.

Note

Even if Descreen is set to ON, some moire effects may remain if Unsharp Mask is set to ON. In

that case, set Unsharp Mask to OFF.

Selecting Magazine(Color) in Select Source in Basic Mode tab has the same effect as setting

Descreen to ON in Advanced Mode tab.

Reduce Dust and Scratches

Scanned photos may contain white dots caused by dust or scratches. Use this function to reduce such

noise. This setting is None by default.

None

Dust and scratches will not be reduced.

Low

Select this to reduce small dust particles and scratches. Large ones may remain.

Medium

It is recommended that you normally select this setting.

High

Select this to reduce small/large dust particles and scratches. Evidence of the reduction process

may remain and may also remove delicate parts of the image.

Important

This function may not be effective for some types of photos.

Note

It is recommended that you select None when scanning printed materials.

Fading Correction

Use this function to correct photos that have faded with time or have a colorcast. Colorcast is a

phenomenon where a specific color affects the entire picture due to the weather or ambient strong

colors. This setting is None by default.

None
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Fading correction will not be applied.

Low

Select this to correct a small amount of fading and colorcast.

Medium

It is recommended that you normally select this setting.

High

Select this to correct a large amount of fading and colorcast. This can affect the tone of the image.

Important

You can set Fading Correction after preview.

Fading Correction may not be effective if the scan area is too small.

You can set this setting when Recommended is selected on the Color Settings tab of the

Preferences dialog box.

Grain Correction

Use this function to reduce graininess (roughness) in photos taken with high-speed or sensitized film.
This setting is None by default.

None

Graininess will not be reduced.

Low

Select this when the photo is slightly grainy.

Medium

It is recommended that you normally select this setting.

High

Select this when the photo is very grainy. This can affect the gradation and sharpness of the

image.

Important

Grain Correction may not be effective if the scan area is too small.

Backlight Correction

Use this function to correct photos that have been shot against light.

When you change the Backlight Correction setting, the result will be reflected in the preview image.

This setting is None by default.

None

Backlight correction will not be applied.

Low

Select this to correct slightly backlit photos. This will not affect the image contrast.

Medium

It is recommended that you normally select this setting.

High

Select this to correct strongly backlit photos. This can affect the image contrast.

Important

You can set Backlight Correction after preview.

You can set this setting when Recommended is selected on the Color Settings tab of the

Preferences dialog box.

Backlight Correction may not be effective if the scan area is too small.

Note

Noise patterns may appear when Backlight Correction is applied. Applying Grain Correction and
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setting Unsharp Mask to OFF may reduce the noise patterns.

Gutter Shadow Correction

Use this function to correct shadows that appear between pages when scanning open booklets.

When you set the Gutter Shadow Correction setting in the preview image, the result will be reflected.

Preview the effects before scanning, as results vary depending on the type of document and how it is

pressed.
Unclear or blurred text/lines caused by curved pages are not corrected. This setting is None by default.

None

Gutter shadow will not be corrected.

Low

Select this when the effect level is too strong with the medium setting.

Medium

It is recommended that you normally select this setting.

High

Select this when the effect level is too weak with the medium setting.

Important

Do not place items that weigh 4.4 lbs (2.0 kg) or more on the Platen. Also, do not press on the

document with a force exceeding 4.4 lbs (2.0 kg). If you press heavily, the scanner may not work

correctly or you might break the glass.

Align the document with the edge of the Platen. If not, the shadow will not be corrected properly.

Shadows may not be corrected properly depending on the document. If the page background is

not white, shadows may not be detected correctly or may not be detected at all.

While scanning, press down on the spine with the same amount of pressure you used to preview

the scan. If the binding part is not even, the shadow will not be corrected properly.

How to place the document depends on your model and the document to be scanned.

Note

Cover the document with black cloth if white spots, streaks, or colored patterns appear in scan

results due to ambient light entering between the document and the Platen.

If the shadow is not corrected properly, adjust the cropping frame on the preview image.

Adjusting Cropping Frames

Page top
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Advanced Guide  > Scanning > Scanning with Other Application Software  > ScanGear (Scanner Driver) Screens > Color

Adjustment Buttons

Color Adjustment Buttons

The Color Adjustment Buttons allow you to make fine corrections to the image brightness and color

tones. You can adjust the image's overall brightness or contrast, and adjust its highlight and shadow
values (histogram) or balance (tone curve).

Important

The Color Adjustment Buttons are not available when you select Color Matching on the Color

Settings tab of the Preferences dialog box.

Note

Selectable settings depend on color mode settings.
When you adjust the image via the Color Adjustment Buttons, the results will be reflected in the

preview image.

Click a Color Adjustment Button to set the following items:

 (Saturation/Color Balance)

Adjust the vividness and color tone of the image. Use this function to brighten colors that have faded

with time or due to colorcast. Colorcast is a phenomenon where a specific color affects the entire

picture due to the weather or ambient strong colors.

Adjusting Saturation and Color Balance

 (Brightness/Contrast)

Adjust the brightness and contrast of the image. If the image is too dark or too bright, or if the image

quality is flat due to lack of contrast, you can adjust the levels of brightness and contrast.

Adjusting Brightness and Contrast
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 (Histogram)

A histogram allows you to see the data concentration at each brightness level of an image. You can

specify the darkest level (shadow) and brightest level (highlight) within an image, cut the levels and

expand the middle of the tonal range of the image.

Adjusting Histogram

 (Tone Curve Settings)

Adjust the brightness of an image by selecting the type of graph (tone curve) showing the balance of

tone input and output. You can make fine adjustments to the brightness of a specific area.

Adjusting Tone Curve

 (Final Review)

Make a final check of color adjustments. The final synthesized tone curve and the histogram derived

from the subsequent image processing will be displayed. There are no settings to make in this

screen.

For a color image, select a color in Channel to check either Red, Green or Blue, or select Master to

check three colors together.

If you place the cursor on the preview image, the portion will be enlarged and its RGB values (only

L when Color Mode is Grayscale) before and after the adjustments will be displayed.

 (Threshold)

Set the boundary (threshold) at which black and white are divided. By adjusting the threshold level, you

can sharpen text in a document or reduce show-through in newspapers.

Setting Threshold

Custom

You can name and save a set of tone curve and threshold settings of the Color Adjustment Buttons.

Select Add/Delete... from the pull-down menu. When Color Mode is set to anything but Black and

White, the Add/Delete Tone Curve Settings dialog box opens. When Color Mode is Black and White,

the Add/Delete Threshold Settings dialog box opens.
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Enter Setting Name and click Add. The name appears in Tone Curve Settings List or Threshold

Settings List.

Click Save to save.

You can load and apply the saved tone curve/threshold settings to a preview image. To load the

settings, select the saved item from the pull-down menu.

To delete an item, select it in Tone Curve Settings List or Threshold Settings List and click Delete.

Click Save to save settings displayed in Tone Curve Settings List or Threshold Settings List.

Note

Save up to 20 items.

Defaults

Reset all adjustments (saturation/color balance, brightness/contrast, histogram and tone curve).

Page top
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Advanced Guide  > Scanning > Scanning with Other Application Software  > ScanGear (Scanner Driver) Screens > Auto
Scan Mode Tab

Auto Scan Mode Tab

This mode allows you to scan easily by simply placing documents on the Platen and clicking a button.

In Auto Scan Mode, documents are automatically detected. You do not need to specify cropping frames

or make image corrections.

Supported Documents

Photos, postcards, business cards, magazines, newspapers, text documents and CD/DVD.

Important

The following types of documents cannot be scanned correctly. In that case, specify the document

type or size on the Basic Mode tab or the Advanced Mode tab and scan again.

- Documents other than photos, postcards, business cards, magazines, newspapers, text
documents and CD/DVD

- Text documents smaller than 2L (5 inches x 7 inches) (127 mm x 178 mm), such as paperback

pages with the spine cut off

- Documents printed on thin white paper

- Long narrow documents such as panoramic photos
Scanning in Basic Mode

Scanning in Advanced Mode

Reflective CD/DVD labels may not be scanned properly.

Place documents correctly according to the type of document to be scanned. Otherwise,

documents may not be scanned correctly.

See "Placing Documents " for details on how to place documents.

Note

Scan from the "Basic Mode Tab" or "Advanced Mode Tab" to reduce moire.

Placing Documents 

"Placing Documents " appears.

View scanned images

Select this checkbox to display the thumbnails of scanned images in a different window.
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Scan

Scanning starts.

Note

When scanning starts, the progress will be displayed. Click Cancel to cancel the scan.

When scanning is completed, a dialog box prompting you to select the next action may open.

Follow the prompt to complete. For details, see Status of ScanGear dialog after scanning in "

Scan Tab" (Preferences dialog box).

Instructions 

This page appears.

Preferences...

The Preferences dialog box opens and you can make scan/preview settings.

Preferences Dialog Box

Close

Closes ScanGear (scanner driver).

Related Topic

Scanning in Auto Scan Mode

Page top
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Preferences Dialog Box

Preferences Dialog Box

Click Preferences... in the ScanGear (scanner driver) screen to open Preferences dialog box.

In the Preferences dialog box, you can make advanced settings to ScanGear (scanner driver) functions

via the Scanner, Preview, Scan and Color Settings tabs.

Scanner Tab

Allows you to specify a folder to save images temporarily and a music file to play during or at the end of a

scan.
Scanner Tab

Preview Tab

Allows you to select what to do with Preview when ScanGear (scanner driver) is started and how to

display cropping frames after previewing images. You can also select the cropping size for thumbnails of

scanned documents.
Preview Tab

Scan Tab

Allows you to select what to do with ScanGear (scanner driver) after scanning images.

Scan Tab

Color Settings Tab

Allows you to select how to adjust color, and specify the monitor gamma value.

Color Settings Tab

Page top
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Scanner Tab

Scanner Tab

On the Scanner tab, you can specify the following settings.

Quiet Mode

Select this checkbox to reduce scanner sound by slowing down the scanner head when previewing or

scanning documents. This checkbox is not selected by default.

Note

Scanning takes longer than usual when you enable this function.

Select Folder Where Temporary Files are Saved

Displays the folder in which to save images temporarily. To change the folder, click Browse... to specify

another one.

Sound Settings

You can set the machine to play music during/at the end of a scan.

Select the Play Music During Scanning or Play Sound When Scanning is Completed checkbox, then

click Browse... and specify a sound file.

You can specify the following files.

- MIDI file (*.mid, *.rmi, *.midi)
- Audio file (*.wav, *.aif, *.aiff)

- MP3 file (*.mp3)

Calibration Settings

When you set Execute at Every Scan to ON, the scanner will be calibrated every time before previewing

and scanning, to reproduce correct color tones in scanned images.

Note

Even when Execute at Every Scan is set to OFF, the scanner may be calibrated automatically in

some cases (such as immediately after you turn the machine on).

Calibration may take time depending on your computer.
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Preview Tab

Preview Tab

On the Preview tab, you can specify the following settings.

Preview at Start of ScanGear

Select what to do with Preview when ScanGear (scanner driver) is started. Display Saved Preview

Image is selected by default.

Automatically Execute Preview

ScanGear (scanner driver) will automatically start previewing at startup.

Display Saved Preview Image

The previously previewed image will be displayed.
The Color Adjustment Button settings, the Toolbar settings, and the Advanced Mode tab settings

are also saved.

None

No preview image will be displayed at startup.

Note

Select None if you do not want to save the preview image.

Cropping Frame on Previewed Images

Select how to display cropping frames after previewing images. Execute Auto Cropping on Previewed

Images is selected by default.

Execute Auto Cropping on Previewed Images

The cropping frame will automatically be displayed in the document size after previewing.

Display the Last Frame on Previewed Images

A cropping frame of the same size as the last used cropping frame will be displayed after

previewing.

None
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No cropping frame will be displayed after previewing.

Cropping Size for Thumbnail View

Select the cropping size for thumbnails of scanned documents. Standard is selected by default.

Larger

Displays 105% (in width and height) of the area displayed for the standard size.

Standard

The standard size.

Smaller

Displays 95% (in width and height) of the area displayed for the standard size.

Note

When you change the Cropping Size for Thumbnail View setting, the preview images will be

refreshed and cropped to the new size. As the preview images are refreshed, the color

adjustments and other settings applied to them are reset.
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Tab

Scan Tab

On the Scan tab, you can specify the following settings.

Status of ScanGear dialog after scanning

Select what to do with ScanGear (scanner driver) after scanning images. Close ScanGear

automatically is selected by default.

Close ScanGear automatically

Select this to return to the original application when scanning is completed.

Do not close ScanGear automatically

Select this to return to the ScanGear (scanner driver) screen for another scan when scanning is

completed.

Display the dialog to select next action

Select this to open a screen and select what to do when scanning is completed.

Note

Even if Do not close ScanGear automatically or Display the dialog to select next action is set,

some applications may not support it.
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Settings Tab

Color Settings Tab

On the Color Settings tab, you can specify the following settings.

Color Adjustment

Select either of the following. Recommended is selected by default.

This function is available when Color Mode is Color or Grayscale.

Recommended

Select this to vividly reproduce the tone of a document on the screen. It is recommended that you

normally select this setting.

Color Matching

Select this to automatically match the scanner, monitor and color printer colors, thus reducing

time and trouble to manually match the monitor and printer colors.

Color Adjustment Buttons will be disabled.

This function is available when Color Mode is Color.
- Source(Scanner): Select scanner profile.
- Target: Select target profile.

- Monitor: Select this to display preview image with optimum correction for monitor.

- Defaults: Returns to the default Color Matching settings.

None

Select this to disable color correction provided by ScanGear (scanner driver).

Note

Color Matching is available when ScanGear (scanner driver), monitor, color management-

compliant application (such as Adobe Photoshop) and printer are set up correctly.

Refer to the corresponding manual for the monitor, printer and application settings.

Monitor Gamma

By setting the gamma value of a monitor, you can adjust the input data to the brightness

characteristics of the monitor. Adjust the value if your monitor's gamma value does not match the
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default value set in ScanGear (scanner driver), and the colors of the original image are not accurately

reflected in the monitor.

Click Defaults to return to the default Monitor Gamma value (2.20).

Note

Refer to the manual of your monitor to check its gamma value. If it is not written in the manual,

contact the manufacturer.
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Appendix: Useful Information on Scanning

Adjusting the cropping frame (scan area)

Adjusting Cropping Frames

Selecting the best resolution

Resolution

Learning about file formats

File Formats

Learning about Color Matching

Color Matching

Matching the colors between the document and monitor

See Monitor Gamma in the following section.

Color Settings Tab
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Adjusting Cropping Frames

You can specify the scan area by creating a cropping frame on the image displayed in the Preview area

of the ScanGear (scanner driver) screen. When you click Scan, only the portion within the cropping frame

will be scanned and passed to the application.

Cropping Frame Types

(1) Focus Cropping Frame (rotating thick broken lines)

The settings in Basic Mode or Advanced Mode will be applied.

(2) Selected Cropping Frame (stationary thick broken lines)

The settings will be applied to the Focus Cropping Frame and Selected Cropping Frames

simultaneously. You can select multiple cropping frames by clicking them while pressing the Ctrl key.

(3) Unselected Cropping Frame (stationary thin broken lines)

The settings will not be applied.

Note

Focus Cropping Frame and Selected Cropping Frames are displayed in whole image view.

Initial Cropping Frame

In thumbnail view

Cropping frame is not displayed initially. Drag the mouse over a frame to create a cropping frame.

In whole image view

A cropping frame (Focus Cropping Frame) is displayed automatically around the preview image

according to the document size. You can also create a cropping frame by dragging the mouse in the

Preview area.

Note

Cropping frames are set according to the document size (Auto Crop) by default. For details, see

Cropping Frame on Previewed Images in " Preview Tab " (Preferences dialog box).

Adjusting a Cropping Frame

The cursor will change into  (Arrow) when it is positioned over a cropping frame. If you

click and drag the mouse in the direction of the arrow, the cropping frame will expand or contract

accordingly.
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The cursor will change into  (Crosshair arrow) when it is positioned within a cropping frame. Click

and drag the mouse to move the entire cropping frame.

Note

In Advanced Mode, you can specify the cropping frame size by entering the values into  (Width)

and  (Height) in Input Settings.

Input Settings

You can rotate a cropping frame 90 degrees by clicking  (Switch Aspect Ratio). However, 

(Switch Aspect Ratio) is not available when Output Size is Flexible.

Creating Multiple Cropping Frames

In thumbnail view

You can only create one cropping frame per image.

In whole image view

Click and drag the mouse in a space outside the existing cropping frame to create a new cropping frame

in the Preview area. The new cropping frame will be the Focus Cropping Frame, and the old cropping

frame will be the Unselected Cropping Frame.
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You can create multiple cropping frames and apply different scan settings to each cropping frame.

You can also select multiple cropping frames by clicking them while pressing the Ctrl key.

If you select multiple cropping frames and change the settings on a tab at the right of ScanGear (scanner

driver), the settings will be applied to all the selected cropping frames.

When you create a new cropping frame, it retains the settings of the latest cropping frame.

Note

Create up to 12 cropping frames.

Scanning takes longer than usual when multiple cropping frames are selected.

Deleting Cropping Frames

In thumbnail view

To delete a cropping frame, click an area outside the cropping frame on an image.

In whole image view

To delete a cropping frame, select it and click  (Remove Cropping Frame) on the Toolbar.
Alternatively, press the Delete key.

When there are multiple cropping frames, all the selected cropping frames (Focus Cropping Frame and

Selected Cropping Frames) are deleted simultaneously.
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Resolution

What is Resolution?

The data in the image you have scanned is a collection of dots carrying information about brightness and

color. The density of these dots is called "resolution", and resolution will determine the amount of detail

your image contains. The unit of resolution is dots per inch (dpi). Dpi is the number of dots per square

inch (2.54 cm square).

The higher the resolution (value), the more detail in your image; the lower the resolution (value), the less

detail.

Setting the Resolution in MP Navigator EX

In MP Navigator EX, you can specify the resolution with Scanning Resolution in the Scan Settings dialog
box.

Images for Printing

Images to be printed should be scanned at a resolution that corresponds to the resolution of the printer.

For example, if you want to print using a 600 dpi black and white printer, you should set the resolution to

600 dpi.

With a color printer, specifying the resolution at half the resolution of the printer should be fine. For

example, if you want to print scanned paper/photos using a 600 dpi color printer, you should set the

resolution to 300 dpi. However, with a high-resolution printer, printing takes longer than usual if you set

the resolution to half the resolution of the printer.

Example of Appropriate Resolution when Printing to Scale

If you print a document at twice the size both vertically and horizontally, the resolution of the document will

be reduced by half. If the resolution of the original document is 300 dpi, the resolution of the enlarged

document will be 150 dpi. If you print the document with a 600 dpi color printer, the lack of detail in the

image may be obvious. In that case, if you scan at the Scanning Resolution of 600 dpi, the resolution will

be 300 dpi even if you double the size of document and you can print the document with sufficient quality.

Conversely, if you print a document at half scale, it should be sufficient to scan at half the resolution.

When Printing Color Photos at Twice the Size

Document resolution: 300

dpi
Scanning resolution: 600

dpi
Scale: 200%

Print at twice the size

Scanning resolution/actual scanning

resolution: 600 dpi

Printing resolution: 300

dpi

Setting the Resolution in ScanGear (Scanner Driver)

In ScanGear (scanner driver), you can specify the resolution with Output Resolution in Output Settings on
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the Advanced Mode tab.

Example of Appropriate Resolution when Printing to Scale

The scanning resolution is automatically set so that the value set in Output Resolution will be the
resolution of the scanned image. If you set Output Resolution to 300 dpi and scan at twice the size, the

document will be automatically scanned at 600 dpi, and the resolution of the scanned image will be 300

dpi. You can print the document with sufficient quality using a 600 dpi color printer.

When Printing L Size (8.9 cm x 12.7 cm) Photos at Twice the Size

Document resolution: 300

dpi
Output resolution: 300 dpi

Scale: 200%

Scan at twice the size

Actual scanning resolution: 600

dpi

Image resolution/printing resolution:

300 dpi

Appropriate Resolution Settings

Set the resolution according to the use of the scanned image.

For displaying on a monitor: 150 dpi

For printing: 300 dpi

When Output Size is set to Flexible in ScanGear's Advanced Mode tab (Select Source is Platen and the

scale is 100%):

Document Use Color Mode Output

Resolution

Color photo Copying

(Printing)
Color 300 dpi

Creating a postcard Color 300 dpi

Saving to a computer Color 75 dpi - 300 dpi

Using on a website or attaching

to e-mail
Color 75 dpi - 150 dpi

Black and white

photo

Saving to a computer Grayscale 75 dpi - 300 dpi

Using on a website or attaching

to e-mail

Grayscale 75 dpi - 300 dpi

Text document Copying Color, Grayscale or Black

and White
300 dpi

Attaching to e-mail Color, Grayscale or Black

and White
300 dpi

Important

If you double the resolution, the file size quadruples. If the file is too large, the processing speed will

slow down significantly, and you will experience inconvenience such as lack of memory. Set the

minimum required resolution according to the use of the image.

Note

Although you can change Output Resolution in ScanGear (scanner driver), it is recommended that
you scan at the default value.
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File Formats

You can select a file format when saving scanned images. You should specify the most suitable format

according to how you want to use the image on which application.

Available file formats vary by application and computer (Windows or Macintosh).

See below for the characteristics of each image file format.

BMP (Standard File Extension: .bmp)

A standard file format for Windows.

BMP is often selected for images that are used only on Windows.

JPEG (Standard File Extension: .jpg)

A file format often used on websites and for digital camera images.

JPEG features high compression rates. JPEG images slightly degrade every time they are saved, and

cannot be returned to their original state.

JPEG is not available for black and white images.

Exif (Standard File Extension: .jpg)

A file format supported by many digital cameras.

It adds information such as the date of image capture, camera model, shutter speed, shooting mode
and comments to JPEG files.

The file format version must be Exif 2.2 or later in order to print on a Direct Print compatible printer.

TIFF (Standard File Extension: .tif)

A file format featuring a relatively high compatibility between various computers and applications. (Some

TIFF files are incompatible.) TIFF is suitable for editing saved images.

Note

MP Navigator EX supports the following TIFF file formats.

- Uncompressed, black and white binary

- Uncompressed, RGB (8 bits per channel)

- Uncompressed, YCC (8 bits per component)

- Uncompressed, RGB (16 bits per channel)

- Uncompressed, YCC (16 bits per component)

- Uncompressed, Grayscale

PDF (Standard File Extension: .pdf)

A file format developed by Adobe Systems. It can be used on various computers and operating systems.

Therefore, PDF files can be exchanged between people who use different operating systems, fonts, etc.

regardless of the differences.

Important

Only PDF files created with MP Navigator EX are supported. PDF files created or edited in other

applications are not supported.
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Color Matching

Color Matching adjusts devices as shown below to match the colors of an image displayed on a monitor

or a printed image with the colors of the original document.

Example: When sRGB is selected as the output profile (target)

Input Profile (Source)

 Scanner  

ScanGear (Scanner Driver)

Output Profile (Target)

 sRGB  

OS

Application

 Application

Printer Driver

Monitor  Printer

ScanGear (scanner driver) converts the image's color space from the scanner's color space to sRGB.

When displaying on a monitor, the image's color space is converted from sRGB to the monitor's color

space based on the operating system's monitor settings and the application's working space settings.

When printing, the image's color space is converted from sRGB to the printer's color space based on the

application's print settings and the printer driver's settings.
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Canon IJ Network Scan Utility Screens 

Canon IJ Network Scan Utility Menu and Setting Screen
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Screen

Canon IJ Network Scan Utility Menu and Setting Screen

Set up Canon IJ Network Scan Utility to scan images into a computer over a network using the Operation

Panel of the machine.

After installation, Canon IJ Network Scan Utility appears in the notification area of the taskbar.

Note

If  (Enabled) is not displayed in the notification area of the taskbar, from the Start menu, select

(All) Programs > Canon IJ Network Utilities > Canon IJ Network Scan Utility > Canon IJ Network
Scan Utility to start it.

Menu

Disable Canon IJ Network Scan Utility or Enable Canon IJ Network Scan Utility

Enables or disables Canon IJ Network Scan Utility.

When you select Disable Canon IJ Network Scan Utility, you will not be able to scan over a network

using the Operation Panel.

Enabled: , Disabled: 

Settings...

The Canon IJ Network Scan Utility dialog box opens. You can select the product you want to use.

About

Displays the version information.

Exit

Exits Canon IJ Network Scan Utility.  (Enabled) disappears from the notification area of the

taskbar.

Canon IJ Network Scan Utility Dialog Box

The machine must be selected with Canon IJ Network Scan Utility before scanning over a network.

In the notification area of the taskbar, right-click the icon and select Settings... to open the Canon IJ

Network Scan Utility dialog box.

Normally, the machine is already selected. In that case, you do not need to select it again.
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Select the product you want to use.

Scanners that are registered to the system are displayed. Select the checkbox of the product you want to

use.

You can select up to three scanners.

Click Instructions to open this page.

Note

If the scanner you want to use is not displayed, check the following conditions and click OK to close

the dialog box, then reopen it and select the scanner.

- The MP Drivers are installed

- Network setup is completed after installing the MP Drivers

- Network communication between the product and computer is enabled

If the scanner is still not displayed, see " Troubleshooting ."

You do not need to use this software when scanning via USB or from a computer. See " Uninstalling
the Canon IJ Network Tool/Canon IJ Network Scan Utility " to delete it. You can scan via USB or from

a computer even if it is not deleted.
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Other Scanning Methods 

Scanning with WIA Driver

Scanning Using the Control Panel (Windows XP Only)
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Scanning with WIA Driver

You can scan an image from a WIA-compliant application and use the image in that application.

The procedure varies depending on the application. The following procedures are examples only.

For details, refer to the application's manual.

Important

In Windows 2000, you cannot scan using the WIA driver.
In Windows XP, you cannot scan using the WIA driver via a network connection.

Complete the following settings to enable scanning over a network.

1. From the Start menu, select Network.

2. Right-click (model name) _MAC address in the displayed screen, then select Install.

Scanning with WIA Driver 2.0

The following is an example of scanning using Windows Photo Gallery.

1. Place the document on the Platen.

Placing Documents

2. In File, click Import from Camera or Scanner..., then double-click WIA Canon (model
name).

For network connection, double-click (model name) _MAC address from the list.

The scan setting screen appears.

3. Specify the settings.

Scanner

The currently set product name is displayed. To change the scanner, click Change... and select

the product you want to use.

Profile

Select Photo (Default) or Documents according to the document to be scanned. To save a new

Profile, select Add profile.... You can specify the details in the Add New Profile dialog box.

Source

Select a scanner type.
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Paper size

This setting is not available for this machine.

Color format

Select how to scan the document.

File type

Select a file format from JPEG, BMP, PNG and TIFF.

Resolution (DPI)

Enter the resolution. Specify a value between 50 dpi and 600 dpi. 300 dpi is set by default.

Resolution

Brightness

Move the slider to adjust the brightness. Move it to the left to darken and right to brighten the

image. You can also enter a value (-100 to 100).

Contrast

Move the slider to adjust the contrast. Moving it to the left will decrease the contrast of the image,

thus softening the image. Moving it to the right will increase the contrast of the image, thus

sharpening the image. You can also enter a value (-100 to 100).

Preview or scan images as separate files

Select this checkbox to preview or scan multiple images as separate files.

See how to scan a picture

Click to open Windows Help and Support.

Note

With network connection, you cannot specify Brightness and Contrast.

4. Click Preview to preview the image.

The preview image appears on the right.

5. Click Scan.

When scanning is completed, the scanned image appears in the application.

Scanning with WIA Driver 1.0

The following is an example of scanning using Paint.

1. Place the document on the Platen.

Placing Documents

2. In File, click From Scanner or Camera.... (Select the command to scan a document
in the application.)

3. Select an image type according to the document to be scanned.
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Note

To scan with the values previously set in Adjust the quality of the scanned picture, select

Custom Settings.

4. Click Adjust the quality of the scanned picture and set the preferences as required.

Brightness

Move the slider to adjust the brightness. Move it to the left to darken and right to brighten the

image. You can also enter a value (-127 to 127).

Contrast

Move the slider to adjust the contrast. Moving it to the left will decrease the contrast of the image,

thus softening the image. Moving it to the right will increase the contrast of the image, thus

sharpening the image. You can also enter a value (-127 to 127).

Resolution (DPI)

Enter the resolution. Specify a value between 50 dpi and 600 dpi.

Resolution

Picture type

Select the type of scan you want for your document.

Reset

Click to restore the original settings.

Note

With network connection, you cannot specify Brightness and Contrast.

5. Click Preview to preview the image.

The preview image appears on the right. Drag  to specify the scan area.

6. Click Scan.

When scanning is completed, the scanned image appears in the application.
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Scanning Using the Control Panel (Windows XP Only)

You can scan images via the Control Panel of Windows XP using the WIA driver.

Windows Image Acquisition (WIA) is a driver model implemented in Windows XP. It allows you to scan

documents without using an application. Scan documents from a TWAIN-compliant application to specify

advanced settings for scanning.

Important

With network connection, you cannot scan using the WIA driver.

1. From the Start menu, select Control Panel.

2. Click Printers and Other Hardware > Scanners and Cameras, then double-click WIA
Canon (model name).

The Scanner and Camera Wizard dialog box opens.

3. Click Next.

4. Select Picture type according to the document to be scanned.

Note

To scan with the values previously set in Custom Settings, select Custom.

5. Click Custom Settings to set the preferences as required.
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Brightness

Move the slider to adjust the brightness. Move it to the left to darken and right to brighten the

image. You can also enter a value (-127 to 127).

Contrast

Move the slider to adjust the contrast. Moving it to the left will decrease the contrast of the image,

thus softening the image. Moving it to the right will increase the contrast of the image, thus

sharpening the image. You can also enter a value (-127 to 127).

Resolution (DPI)

Enter the resolution. Specify a value between 50 dpi and 600 dpi.

Resolution

Picture type

Select the type of scan you want for your document.

Reset

Click to restore the original settings.

6. Click Preview to preview the image.

The preview image appears on the right. Drag  to specify the scan area.

7. Click Next and follow the instructions.
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Printing Photographs Directly from a Compliant Device

Printing Photographs from a Wireless Communication Device
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Photographs Directly from a Compliant Device  > Printing Photographs Directly from a Compliant Device

Printing Photographs Directly from a Compliant Device

You can connect a PictBridge compliant device such as a digital camera, camcorder, or mobile phone

connect to the machine using a USB cable recommended by the device's manufacturer, and print

recorded images directly without using a computer.

Note

When printing photos with the PictBridge compliant device connected to the machine, we

recommend the use of the AC adapter supplied with the device. If you are using the device battery,

be sure to charge it fully.

Depending on the model or brand of your device, you may have to select a print mode compliant

with PictBridge before connecting the device. You may also have to turn on the device or select Play

mode manually after connecting the device to the machine.

Perform necessary operations on the PictBridge compliant device before connecting it to this

machine according to instructions given in the device's instruction manual.

1. Make sure that the machine is turned on.

2. Load paper.

3. Make sure that the proper paper source is selected.

4. Make sure that the PictBridge compliant device is turned off.

5. Connect the PictBridge compliant device to the machine using a USB cable (A)
recommended by the device's manufacturer.

The PictBridge compliant device turns on automatically.

If your device does not turn on automatically, turn it on manually.

When machine is correctly connected to the device, the message that the machine is connected will

be displayed on the LCD of the device. Refer to the device's instruction manual.
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6. Specify the print settings such as the paper type and layout.

You can perform settings using the menu on the LCD of your PictBridge compliant device. Select the

size and type of paper that you loaded in the machine.

Settings on a PictBridge Compliant Device

If your PictBridge compliant device does not have a setting menu, change the setting from the

machine.
Settings on the Machine

7. Start printing from your PictBridge compliant device.

Important

Never disconnect the USB cable during printing unless when explicitly allowed to by the

PictBridge compliant device. When disconnecting the USB cable between the PictBridge

compliant device and machine, follow the instructions given in the device's instruction manual.
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About PictBridge Print Settings

Settings on a PictBridge Compliant Device

Settings on the Machine

Settings on a PictBridge Compliant Device

This section describes the PictBridge function of the machine. For the print settings on a

PictBridge compliant device, refer to the instructions given in the device's instruction manual.

Note

In the following description, names of setting items are given according to those used in

Canon-brand PictBridge compliant devices. Setting item names may be different depending
on the brand or model of your device.

Some setting items explained below may not be available on some devices. In this case, the

settings made on the machine are applied. Also, when some items are set to Default on a

PictBridge compliant device, the machine settings for these items are applied.
Settings on the Machine

The following settings can be used when printing from a PictBridge compliant device.

Paper size 4" x 6"/10 x 15 cm, 5" x 7"*1, 8" x 10"/ 20 x 25 cm, A4, 8.5" x 11"(Letter), 4" x 7.1"/ 10.1

x 18 cm*2

*1 10x15 may appear on some PictBridge compliant device.

*2 Hi Vision may appear on a non-Canon brand PictBridge compliant device.

Paper type Default (Selections based on the machine setting)

Photo:
Photo Paper Plus Glossy II PP-201/Glossy Photo Paper "Everyday Use" GP-501

/Photo Paper Glossy GP-502/Photo Paper Plus Semi-gloss SG-201/Photo

Stickers*

* When printing on sticker paper, select 10 x 15 cm/4" x 6" in Paper size. Do not

set Layout to Borderless.

Fast Photo:

Photo Paper Pro II PR-201

Plain:
A4/Letter

When Paper type is set to Plain, borderless printing will be disabled even when

Layout is set to Borderless.

Layout Default (Selections based on the machine setting), Index, Bordered, Borderless, N-

up (2, 4, 9, 16)*1, 20-up*2, 35-up*3

*1 Layout compatible with A4 or Letter-sized paper and Canon-brand sticker above.
A4/Letter: 4-up

Photo Stickers: 2-up, 4-up, 9-up, 16-up.

*2 With a Canon brand PictBridge compliant device, selecting items with "i" mark

allows you to print shooting info (Exif Data) in list format (20-up) or on the margins

of the specified data (1-up). (May not be available with some Canon-brand

PictBridge compliant devices.)

*3 Printed in 35 mm Film Style Layout (Contact Printing Layout). Available only with

a Canon-brand PictBridge compliant device. (May not be available with some

Canon-brand PictBridge compliant devices.)

Print date &

file no.

Default (Off: No printing), Date, File No., Both, Off

Image
optimize

Default (Selections based on the machine setting), On*1 (Exif Print), Off, NR (Noise

Reduction)*2, VIVID*2, Face*2, Red-Eye*2

*1 Photos are optimized for printing using the Photo optimizer pro function.

*2 Can be selected only on certain Canon-brand PictBridge compliant devices.

(May not be selected depending on the device.)
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Trimming Default (Off: No trimming), On (follow the camera's setting), Off

Settings on the Machine

You can change the PictBridge print settings from the PictBridge print settings screen. Set the print

settings to Default on the PictBridge compliant device when you want to print according to the

settings on the machine.
This section describes the procedure to display the PictBridge print settings screen. For setting

items, see PictBridge print settings .

1. Make sure that the machine is turned on.

2. Select  Settings on the HOME screen, then press the OK button.

3. Select  Device settings, then press the OK button.

4. Select PictBridge print settings, then press the OK button.

The PictBridge print settings screen is displayed.
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Photographs from a Wireless Communication Device  > Printing via Bluetooth Communication

Printing via Bluetooth Communication

This section describes the procedure to print photos through Bluetooth communication from a mobile

phone with the optional Bluetooth Unit BU-30.

When printing from a mobile phone through Bluetooth communication, refer also to your product's

instruction manual.

For the procedure to print through Bluetooth communication from the computer, refer to About Bluetooth

Communication .

Note

Mobile phones supporting OPP (Object Push Profile) or BIP (Basic Imaging Profile) can be used to

print photos.
Depending on your mobile phone, you may not perform printing even if your mobile phone supports

the profiles above. For information on the profiles your mobile phone supports, refer to your

product's instruction manual.

Printing through Bluetooth Communication

1. Make sure that the machine is turned on.

2. Load paper.

3. Attach the optional Bluetooth Unit BU-30.

Insert the Bluetooth Unit BU-30 to the Direct Print Port.

4. Set the page size and layout.

Setting the Page Size, Media Type, and Layout When Printing from a Mobile Phone
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5. Start printing from a mobile phone.

For the device name, select the default value Canon XXX-1 (where "XXX"

is your machine's name).

If you are required to input a passkey, input the default value "0000".

You can change the device name of the machine, passkey, and so on from the

Bluetooth settings screen.

Changing the Bluetooth Settings

Note

Communication is possible in a range of up to about 33 ft. / 10 m depending on
the conditions below. Printing speed may vary depending on the following

conditions:

Presence of obstacles between the communication equipment, and radio
conditions.
Presence of magnetic fields, static electricity, or electromagnetic interference.

Receiver sensitivity and antenna performance of the communication equipment.

Video files cannot be printed.

Depending on your device, data saved on a memory card may not be printed.

About transmittable data

Due to security settings on the mobile phone, downloaded content or

photos downloaded from a URL attached to an E-mail cannot be printed.

Depending on the size of a photo, it may take a while for this machine to

start printing after starting wireless communication.

Printed quality and orientation (portrait or landscape) is determined

automatically according to the shot photo size.

Depending on the photo size shot on the mobile phone, the edges of the
image may be cut off when performing borderless printing; the margin size

may change when printing with borders.

If the photo file is over 1.8 MB in size, it may not be possible to send the

file.
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Advanced Guide  > Printing Photographs Directly from a Compliant Device or a Wireless Communication Device  > Printing

Photographs from a Wireless Communication Device  > Printing via Bluetooth Communication  > Changing the Bluetooth

Settings

Changing the Bluetooth Settings

As preparation for printing through Bluetooth communication, you can change the settings such as the

device name and passkey from the Bluetooth settings screen.

This section describes how to display the Bluetooth settings screen. For each setting item, see 

Bluetooth settings .

1. Make sure that the machine is turned on.

2. Attach the optional Bluetooth Unit BU-30.

Insert the Bluetooth Unit BU-30 to the Direct Print Port.

3. Select  Settings on the HOME screen, then press the OK button.

4. Select  Device settings, then press the OK button.

5. Select Bluetooth settings, then press the OK button.

The Bluetooth settings screen is displayed.
Bluetooth Settings Screen
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Advanced Guide  > Printing Photographs Directly from a Compliant Device or a Wireless Communication Device  > Printing

Photographs from a Wireless Communication Device  > Setting the Page Size, Media Type, and Layout When Printing from

a Mobile Phone

Setting the Page Size, Media Type, and Layout When Printing
from a Mobile Phone

When printing from a mobile phone through Bluetooth communication, select the page size, media type,

layout, and borderless print setting on the Mobile phone print setting screen. For details on how to print

from a computer through Bluetooth communication, refer to About Bluetooth Communication.

* The default is borderless printing on 4" x 6" Photo Paper Plus Glossy II.

Displaying the Mobile phone print setting screen

This section describes how to display the Mobile phone print setting screen. For setting items,

see Mobile phone print setting .

1. Make sure that the machine is turned on.

2. Attach the optional Bluetooth Unit BU-30.

Insert the Bluetooth Unit BU-30 to the Direct Print Port.

3. Select  Settings on the HOME screen, then press the OK button.

4. Select  Device settings, then press the OK button.

5. Select Mobile phone print setting, then press the OK button.

The Mobile phone print setting screen is displayed. For the setting items, see Mobile phone
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print setting .
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Advanced Guide  > Maintenance 

Maintenance 

Cleaning Your Machine

Aligning the Print Head

Performing Maintenance from a Computer
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Cleaning Your Machine 

Cleaning

Cleaning the Exterior of the Machine

Cleaning the Platen Glass and Document Cover

Cleaning the Inside of the Machine (Bottom Plate Cleaning)

Cleaning the Protrusions Inside the Machine
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Cleaning

This section describes the cleaning procedure that is needed to maintain your machine.

Important

Do not use tissue paper, paper towels, rough-textured cloth, or similar materials for cleaning so as

not to scratch the surface. Paper tissue powder or fine threads may remain inside the machine and

cause problems such as print head blockage and poor printing results. Be sure to use a soft cloth.
Never use volatile liquids such as thinners, benzene, acetone, or any other chemical cleaner to

clean the machine, as this may cause a malfunction or damage the machine's surface.

Cleaning the Exterior of the Machine

Cleaning the Platen Glass and Document Cover

Cleaning the Inside of the Machine (Bottom Plate Cleaning)

Cleaning the Protrusions Inside the Machine
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Cleaning the Exterior of the Machine

Be sure to use a soft cloth such as eyeglasses cleaning cloth and wipe off dirt on the surface gently.

Smooth out wrinkles on the cloth if necessary before cleaning.

Important

Be sure to turn off the power and disconnect the power plug before cleaning the machine.

Do not use tissue paper, paper towels, rough-textured cloth, or similar materials, as this may
scratch the surface.
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Cleaning the Platen Glass and Document Cover

Important

Be sure to turn off the power and disconnect the power plug before cleaning the machine.

With a clean, soft, lint-free cloth, wipe the Platen Glass (A) and the inner side of the Document Cover

(white sheet) (B) gently. Be sure not to leave any residue, especially on the Platen Glass.

Important

The inner side of the Document Cover (white sheet) (B) is easily damaged, so wipe it gently.
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Cleaning the Inside of the Machine (Bottom Plate Cleaning)

This section explains how to clean the inside of the machine. If the inside of the machine becomes dirty,

printed paper may get dirty, so we recommend performing cleaning regularly.

1. Make sure that the machine is turned on.

2. Open the Paper Output Tray.

Open the Paper Output Tray gently.

3. Open the Output Tray Extension.

4. Select  Settings on the HOME screen, then press the OK button.

The Settings screen is displayed.

5. Select  Maintenance, then press the OK button.

The Maintenance screen is displayed.

6. Select Bottom plate cleaning, then press the OK button.

The confirmation screen is displayed.

7. Select Yes, then press the OK button.

8. Remove any paper from the Rear Tray, follow the on-screen instructions.

9. Fold a single sheet of A4 or Letter-sized plain paper in half widthwise, then unfold the
paper, follow the on-screen instructions.

10. Load this and only this sheet of paper on the Rear Tray with the open side facing to
the front, follow the on-screen instructions.
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(A) Load the paper after unfolding it.
The paper cleans the inside of the machine as it feeds through the machine.

Check the folded part of the ejected paper. If it is smudged with ink, perform Bottom Plate Cleaning

again.
If the problem is not resolved after performing cleaning again, the protrusions inside the machine

may be stained. Clean them according to instructions.

Cleaning the Protrusions Inside the Machine

Note

When performing Bottom Plate Cleaning again, be sure to use a new sheet of paper.
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Cleaning the Protrusions Inside the Machine

If protrusions inside the machine are stained, wipe off any ink from the protrusions using a cotton swab

or the like.

Important

Be sure to turn off the power and disconnect the power plug before cleaning the machine.
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Aligning the Print Head 

Aligning the Print Head
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Aligning the Print Head

If printed ruled lines are misaligned or print results are otherwise unsatisfactory, adjust the print head

position.

Note

If the remaining ink level is low, the print head alignment sheet will not be printed correctly. Replace

the ink tank whose ink is low.
Routine Maintenance

The print head alignment pattern is printed in black and blue only.

1. Make sure that the machine is turned on.

2. Load a sheet of A4 or Letter-sized plain paper in the Cassette.

3. Open the Paper Output Tray gently, and open the Output Tray Extension.

4. Print the print head alignment sheet.

1. Select  Settings on the HOME screen, then press the OK button.

The Settings screen is displayed.

2. Select  Maintenance, then press the OK button.

The Maintenance screen is displayed.

3. Select Auto head align, then press the OK button.

The confirmation screen is displayed.

4. Select Yes, then press the OK button.

The print head alignment sheet will be printed.
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Important

Do not touch any printed part on the print head alignment sheet.

Do not dirty the print head alignment sheet. If the sheet is stained or wrinkled, the pattern

may not be scanned correctly.

5. When Did the patterns print correctly? is displayed, confirm that the pattern is printed correctly,

select Yes, then press the OK button.

5. Scan the print head alignment sheet to adjust the print head position.

1. Place the print head alignment sheet on the Platen Glass, then close the Document Cover
gently.

Place the print head alignment sheet with the printed side FACING DOWN and align the 

mark on the upper left corner of the sheet with the alignment mark ( ).

2. Press the OK button.

The print head alignment sheet is scanned and the print head position is adjusted
automatically.

Remove the print head alignment sheet on the Platen Glass after the adjusting is complete.
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Important

Do not open the Document Cover or move the loaded print head alignment sheet until

scanning is complete.
If adjusting the auto print head position has failed, Failed to scan. appears on the LCD.

An Error Message Is Displayed on the LCD

Note

Press the HOME button to exit Settings menu and display the HOME screen.
If the print results are still not satisfactory after adjusting the print head position as

described above, adjust the print head position manually from the computer.
Aligning the Print Head Position

Select Head alignment print to confirm the current head position adjustment values.
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Performing Maintenance from a Computer 

Cleaning the Print Heads

Cleaning the Paper Feed Rollers

Aligning the Print Head Position

Checking the Print Head Nozzles

Cleaning Inside the Machine
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Cleaning the Print Heads 

The print head cleaning function allows you to unclog clogged nozzles in the print head. Perform print

head cleaning if printing is faint or a specific color fails to print, even though there is enough ink. 

The procedure for cleaning the print heads is as follows: 

 Cleaning 

1. Open the printer driver setup window

2. Click Cleaning on the Maintenance tab 

The Print Head Cleaning dialog box opens. Follow the instruction shown in the dialog box.

Click Initial Check Items to display the items you need to check before performing Cleaning. 

3. Execute cleaning 

Make sure that the machine is on and then click Execute. 

Print head cleaning starts. 

4. Complete cleaning 

The Nozzle Check dialog box opens after the confirmation message. 

5. Check the results 

To check whether the print quality has improved, click Print Check Pattern. To cancel the check
process, click Cancel. 

If cleaning the head once does not resolve the print head problem, clean it once more. 

 Deep Cleaning 

Deep Cleaning is more thorough than cleaning. Perform deep cleaning when two Cleaning attempts do
not resolve the print head problem. 

1. Open the printer driver setup window

2. Click Deep Cleaning on the Maintenance tab 

The Deep Cleaning dialog box opens. Follow the instruction shown in the dialog box.

Click Initial Check Items to display the items you need to check before performing Deep Cleaning. 

3. Execute deep cleaning 

Make sure that the machine is on and then click Execute.

Click OK when the confirmation message appears. 

Print head deep cleaning starts. 

4. Complete deep cleaning 

The Nozzle Check dialog box opens after the confirmation message. 
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5. Check the results 

To check whether the print quality has improved, click Print Check Pattern. To cancel the check
process, click Cancel. 

Important 

Cleaning consumes a small amount of ink. Deep Cleaning consumes a larger amount of ink than

Cleaning.
Cleaning the print heads frequently will rapidly deplete your printer's ink supply. Consequently,

perform cleaning only when necessary. 

Note 

If there is no sign of improvement after Deep Cleaning, switch off the machine, wait 24 hours, and

then perform Deep Cleaning again. If there is still no sign of improvement, the ink may have run out

or the print head may be worn. For details on the remedial action to be taken, see " Machine Moves

But Ink Is Not Ejected ." 

Related Topic 

Checking the Print Head Nozzles
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Cleaning the Paper Feed Rollers 

Cleans the paper feed roller. Perform feed roller cleaning when there are paper particles sticking to the

paper feed roller and paper is not fed properly. 

The procedure for performing the feed roller cleaning is as follows: 

 Roller Cleaning 

1. Prepare the machine 

Remove all sheets of paper from the paper source from which paper could not be properly fed. 

2. Open the printer driver setup window

3. Click Roller Cleaning on the Maintenance tab 

The Roller Cleaning dialog box opens. 

4. Select Rear Tray or Cassette, and click OK 

The confirmation message appears. 

5. Execute paper feed roller cleaning 

Make sure that the machine is on and click OK.

Paper feed roller cleaning starts. 

6. Complete paper feed roller cleaning 

After the rollers have stopped, follow the instruction in the message, load three sheets of plain

paper into the selected paper source of the machine, and click OK. 

Paper will be ejected and feed roller cleaning will be completed. 
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Aligning the Print Head Position 

Print head alignment corrects the installation positions of the print head and improves deviated colors

and lines. 

This machine supports two head alignment methods: automatic head alignment and manual head
alignment.
To perform automatic head alignment, refer to "Aligning the Print Head" in the manual: Basic Guide and

then execute the function from the operation panel of the machine. 

The procedure for performing manual print head alignment is as follows: 

 Print Head Alignment 

1. Open the printer driver setup window

2. Click Custom Settings on the Maintenance tab 

The Custom Settings dialog box opens. 

3. Switch head alignment to manual 

Check the Align heads manually check box. 

4. Transmit the settings 

Click Send, and click OK when the confirmation message appears. 

5. Click Print Head Alignment on the Maintenance tab 

The Start Print Head Alignment dialog box opens. 

6. Load paper in the machine 

Load three sheets of A4 size or Letter size plain paper into the cassette. 

7. Execute head alignment 

Make sure that the machine is on and click Align Print Head.

Follow the instruction in the message. 

8. Check the printed pattern 

Enter the numbers of the patterns with the least amount of streaks in the associated boxes.

Clicking the patterns with the least amount of streaks in the preview window, will automatically set

their numbers in the associated boxes. 
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When you have entered all the necessary values, click OK. 

Note 

If it is difficult to pick the best pattern, pick the setting that produces the least noticeable vertical

white streaks. 

(A) Less noticeable vertical white streaks 

(B) More noticeable vertical white streaks 

If it is difficult to pick the best pattern, pick the setting that produces the least noticeable

horizontal white streaks. 

(A) Less noticeable horizontal white streaks 

(B) More noticeable horizontal white streaks 

9. Confirm the displayed message and click OK 

The second pattern is printed. 

Important 

Do not open the Scanning Unit (Cover) while printing is in progress. 

10. Check the printed pattern 

Enter the numbers of the patterns with the least amount of streaks in the associated boxes.

Clicking the patterns with the least amount of streaks in the preview window, will automatically set

their numbers in the associated boxes. 
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When you have entered all the necessary values, click OK. 

Note 

If it is difficult to pick the best pattern, pick the setting that produces the least noticeable vertical

white streaks. 

(A) Less noticeable vertical white streaks 

(B) More noticeable vertical white streaks 

11. Confirm the displayed message and click OK 

The third pattern is printed. 

Important 

Do not open the Scanning Unit (Cover) while printing is in progress. 

12. Check the printed pattern 

Enter the numbers of the patterns with the least noticeable horizontal stripes in the associated
boxes.

Clicking the patterns with the least noticeable horizontal stripes in the preview window, will

automatically set their numbers in the associated boxes. 
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When you have entered all the necessary values, click OK. 

Note 

If it is difficult to pick the best pattern, pick the setting that produces the least noticeable

horizontal white stripes. 

(A) Less noticeable horizontal white stripes 

(B) More noticeable horizontal white stripes 

Note 

To print and check the current setting, open the Start Print Head Alignment dialog box, and click

Print Alignment Value. 
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Checking the Print Head Nozzles 

The nozzle check function allows you to check whether the print heads are working properly by printing a

nozzle check pattern. Print the pattern if printing becomes faint, or if a specific color fails to print. 

The procedure for printing a nozzle check pattern is as follows: 

 Nozzle Check 

1. Open the printer driver setup window

2. Click Nozzle Check on the Maintenance tab 

The Nozzle Check dialog box opens.

To display a list of items that you should check before printing the check pattern, click Initial Check

Items. 

3. Load paper in the machine 

Load a sheet of A4 size or Letter size plain paper into the cassette. 

4. Print a nozzle check pattern 

Make sure that the machine is on and click Print Check Pattern.

The nozzle check pattern is printed. 

Click OK when the confirmation message appears.

The Pattern Check dialog box opens. 

5. Check the print result 

Check the print result. When the print result is normal, click Exit.

If the print result is smudged or if there are any unprinted sections, click Cleaning to clean the print

head. 

Related Topic 

Cleaning the Print Heads
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Cleaning Inside the Machine 

Perform bottom plate cleaning before you execute duplex printing to prevent smudges on the back side

of the paper.
Also perform bottom plate cleaning if ink smudges caused by something other than print data appear on

the printed page. 

For details on how to load paper into the machine, see " Cleaning the Inside of the Machine (Bottom Plate

Cleaning) ." 

The procedure for performing bottom plate cleaning is as follows: 

 Bottom Plate Cleaning 

1. Open the printer driver setup window

2. Click Bottom Plate Cleaning on the Maintenance tab 

The Bottom Plate Cleaning dialog box opens. 

3. Load paper in the machine 

As instructed in the dialog box, fold the A4 size or Letter size plain paper in half horizontally, and then

unfold the sheet.

Load the paper into the rear tray in the portrait orientation with the crest of the crease facing down. 

4. Perform the bottom plate cleaning 

Make sure that the machine is on and click Execute.

Bottom plate cleaning starts. 
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About Bluetooth Communication 

Handling Precautions

Preparation to Use the Bluetooth Unit

Printing Data via Bluetooth Communication 

Basic Procedure for Printing via Bluetooth Communication

Bluetooth Settings

Troubleshooting

Specifications
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Handling Precautions 

Shipping the Product
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Shipping the Product

This product may not be used in countries or regions other than the country or region where it was

purchased due to local laws and regulations. Please note that the use of this product in such countries

or regions may lead to penalties and that Canon should not be liable for such punishment.
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Preparation to Use the Bluetooth Unit 

Bluetooth Unit

Attaching to and Removing from the Printer
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Bluetooth Unit

The Bluetooth Unit BU-30 (hereafter referred to as the Bluetooth unit) is an adaptor which can be used

with a Canon IJ printer with Bluetooth interface.

By attaching the Bluetooth unit to a Canon IJ printer with Bluetooth interface, wireless printing from a

Bluetooth enabled device, such as a computer or mobile phone, is possible.

Note

Communication is possible in a range of up to about 33 ft. / 10 m depending on the conditions
below. Printing speed may vary depending on the following conditions:

-Presence of obstacles between the communication equipment and radio wave conditions.

-Presence of magnetic fields, static electricity or electromagnetic interference.

-Software and operating system to be used.

-Receiver sensitivity and antenna performance of the communication equipment.
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from the Printer

Attaching to and Removing from the Printer

Attaching the Bluetooth Unit to the Printer

Removing the Bluetooth Unit from the Printer

Attaching the Bluetooth Unit to the Printer

Attach the Bluetooth unit to the Direct Print Port (A) of the printer in accordance with the following

procedure.

The external appearance may differ depending on the printer you are using.

1. Make sure that the printer is turned on.

Make sure that the Power lamp is lit.

2. Insert the Bluetooth unit to the Direct Print Port of the printer.

Detach the cap from the Bluetooth unit. Store the cap in a safe location.
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Note

When the Bluetooth unit is properly attached to the printer, the Power lamp on the printer

flashes twice.

Removing the Bluetooth Unit from the Printer

Remove the Bluetooth unit from the Direct Print Port of the printer in accordance with the following

procedure.

1. Remove the Bluetooth unit from the Direct Print Port of the printer.

Important

Make sure that the lamp on the Bluetooth unit is neither lit nor flashing before you

remove the Bluetooth unit.

Important

Store the Bluetooth unit with the cap attached.
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Printing Data via Bluetooth Communication 

Preparation

Installing the MP Drivers

Setting the Printer

Registering the Printer

Deleting the Printer
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Preparation

In order to print via Bluetooth communication with Windows, the following system requirements must be

satisfied.

Computer

A computer in which an internal Bluetooth module is installed or a computer to which an optional

Bluetooth adapter (available from various manufacturers) is attached.

OS

Microsoft Windows Vista (Satisfying any one of the following conditions is needed)

Bluetooth Devices is displayed in Hardware and Sound under Control Panel

Bluetooth Stack for Windows by Toshiba Version 5.10.04 or later is installed

Microsoft Windows XP (Satisfying any one of the following conditions is needed)

Windows XP SP2 or later is installed, and Bluetooth Devices is displayed in

Printers and Other Hardware under Control Panel

Bluetooth Stack for Windows by Toshiba Version 3.00.10 or later is installed

For more information about how to confirm the version of Bluetooth Stack for Windows by

Toshiba, see Check 2: Is unsupported Bluetooth driver used? .

In order to connect the Bluetooth unit and print via Bluetooth communication, the following steps are

required.

1. Check that the Bluetooth unit is properly attached to the printer.

See Attaching to and Removing from the Printer .

2. Install the MP Drivers.

See Installing the MP Drivers .

3. Check the device name of the printer using the LCD.

See Setting the Printer.

4. Register the printer as a Bluetooth device using Bluetooth Devices.

When using Windows Vista, and when Bluetooth Devices is displayed in Hardware and

Sound under Control Panel

Authenticate the printer as a Bluetooth device on Bluetooth Devices in Hardware and Sound

under Control Panel.

See Registering the Printer .

When using Windows XP SP2 or later, and when Bluetooth Devices is displayed in Printers

and Other Hardware under Control Panel

Authenticate the printer as a Bluetooth device on Bluetooth Devices in Printers and Other

Hardware under Control Panel.

See Registering the Printer .

When using a Toshiba Windows Vista or Windows XP computer

Authenticate the printer as a Bluetooth device using Bluetooth Settings*.

* When the computer which has Bluetooth Stack for Windows by Toshiba or the program

attached to the Bluetooth adapter of the option manufactured by Toshiba is used, the

computer can register a printer easily.
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Bluetooth Settings can be started by clicking Start and selecting All Programs, TOSHIBA,

Bluetooth, and Bluetooth Settings.

For details on Bluetooth Settings, refer to the software application's instruction manual.

The operations may vary depending on your operating program. In this case, refer to your

computer's operation manual.
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Drivers

Installing the MP Drivers

Note

If you use the printer connecting with a computer, the MP Drivers have already been installed. In this

case, move to the next step.

Setting the Printer

Before connecting the Bluetooth unit to the printer for wireless printing, first the USB cable must be

connected between the printer and computer, and the MP Drivers must be installed.

If you reinstall the MP Drivers, perform Custom Install on the Setup CD-ROM , then select MP Drivers.
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Setting the Printer

This section describes the procedures for checking the settings of the Bluetooth unit on the LCD of the

printer in preparation for Bluetooth printing.

The screens may differ depending on the printer you are using.

If you need more information about the Bluetooth settings, see Setting Bluetooth Printing .

1. Make sure that the Bluetooth unit is attached and the printer is turned on.

For information about how to attach the Bluetooth unit, see Attaching to and Removing from the

Printer.

2. Display the Bluetooth settings screen on the LCD.

For information about how to display the Bluetooth settings screen, refer to Changing the Machine

Settings on the LCD .

Note

If the Bluetooth settings screen is not displayed on the LCD, the Bluetooth unit may not be

attached correctly. Remove the Bluetooth unit from the printer and attach it once again.

For details, see Attaching to and Removing from the Printer .

If the Bluetooth settings screen still is not displayed, the Bluetooth unit may be faulty. In this

case, contact the service center.

3. Select Device name.

The Device name screen is displayed.

4. Check the device name.

The device name is necessary to register the printer as a Bluetooth device. Be sure to note the

device name.

Note

If multiple printer units with the same model name are connected to the system, assigning a
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different device name to each printer is recommended for easy identification of the printer you

will use. See Bluetooth Settings Screen .

After checking the device name, press the OK button on the printer.

After checking the Bluetooth settings using the LCD, register the printer on your computer.

Registering the Printer
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Registering the Printer

Register the printer as a Bluetooth device using Bluetooth Devices under Control Panel.

Note

The following procedure is described assuming that Windows Vista has been installed in your
computer.
Before registering the printer on Bluetooth Devices under Control Panel, enable the Bluetooth

function of your computer.
For more information, refer to your computer's operation manual.

If you want to re-register the printer as a Bluetooth device, first delete the registered printer, and then

re-register it.

See Deleting the Printer .

1. Log into a user account with the administrator privilege.

2. Click Control Panel, then Bluetooth Devices under Hardware and Sound.

In non-Vista Windows, click Control Panel, Printers and Other Hardware, then Bluetooth Devices.

3. Click Add on the Devices sheet.

Add Bluetooth Device Wizard will start.

4. Make sure that the printer is turned on, check the My device is set up and ready to
be found check box and then click Next.
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5. Select the device name of the printer and click Next.

Select the same device name as that checked under Setting the Printer.

Note

If the device name is not displayed, see Check 3: Is the printer name which you want to register

displayed in Printer List? .

6. Select Don't use a passkey, and then Next.

Page 731 of 949 pagesRegistering the Printer



Note

If you set a passkey on the printer, select Use the passkey found in the documentation and

input the passkey then click Next.

For more information about a passkey, see Bluetooth Settings Screen .

7. Click Finish.

8. Check that the device name selected at step 5 is registered on the Devices sheet,
and click OK.
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Now, the settings for printing via Bluetooth communication are ready.

Note

In Windows Vista, the Windows needs to install driver software for your Bluetooth Peripheral

Device screen may be displayed automatically. In this case, click Don't show this message

again for this device.
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Deleting the Printer

This section describes the procedure to delete the registered printer.

If you want to re-register the printer as a Bluetooth device, first follow the procedure below to delete the

printer, and then re-register it.

For the procedure to re-register the printer, see Registering the Printer .

1. Log into a user account with the administrator privilege.

2. Click Control Panel, then Printers under Hardware and Sound.

When using non-Vista Windows, click Control Panel, then Printers and Faxes under Printers and

Other Hardware.

3. Click the icon of the printer used for printing via Bluetooth communication.

4. Select Delete from the Organize menu.

When using non-Vista Windows, select Delete from the File menu.
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Basic Procedure for Printing via Bluetooth Communication 

Printing with Computers

Printing with Bluetooth Compliant Devices other than a Computer
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with Computers

Printing with Computers

When using Bluetooth communication, also refer to the computer's instruction manual.

When printing from a Bluetooth compliant device other than a computer, see Printing with Bluetooth

Compliant Devices other than a Computer.

Note

Depending on your application program, operations may differ. For details, refer to the instruction

manual of your software application.

The steps described in this section are for printing in Windows Vista.

Bluetooth communication distance: Approx. 33 ft./10 m in normal environment.

The distance may vary depending on the radio conditions or the communication equipment.

1. Turn on the printer and load paper.

2. Create a document or open a file to print using an appropriate application software.

3. Open the printer properties dialog box.

1. Select Print on the application software's File menu.

The Print dialog box opens.

2. Select the printer to which you attached the Bluetooth unit such as Canon XXX Printer (Copy X)

from Select Printer.

3. Click Preferences (or Properties).

The Quick Setup sheet of the Printing Preferences dialog box is displayed.

Note

The printer registered on Bluetooth Devices is displayed as Canon XXX Printer (Copy X).

"X" is a device name or a digit. The number of digits may differ depending on the printer.

4. Specify the required settings.
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1. Select the print setting in Commonly Used Settings.

2. Confirm the required print settings in Media Type, Printer Paper Size, and so on.

Note

You can specify the advanced print settings on Main sheet and Page Setup sheet. For

details on the print settings, refer to Various Printing Methods .

3. Click OK.

The Print dialog box is displayed.

5. Click Print (or OK) to print the document.

Printing begins.

Note
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When you use a USB cable for printing, select Canon XXX Printer from Select Printer.

To cancel a print job in progress, press the Stop button on the printer or click Cancel Printing

on the printer status monitor. After printing is canceled, a sheet of paper may be ejected with no

printing results.
To display the printer status monitor, click Canon XXX Printer (Copy X) on the taskbar.

"X" is a device name or a digit. The number of digits may differ depending on the printer.
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with Bluetooth Compliant Devices other than a Computer

Printing with Bluetooth Compliant Devices other than a
Computer

The LCD of the printer allows you to perform settings for printing using Bluetooth compliant devices other

than a computer.

When you print with one of these devices, also refer to your product's instruction manual.

When printing from a computer, see Printing with Computers .

Note

Mobile phones, PDAs and digital cameras supporting OPP (Object Push Profile) or BIP (Basic

Imaging Profile) can print photos.
Depending on your product, you may not perform printing even if your product supports the profiles

above. For details of profiles, refer to your product's instruction manual.

1. Turn on the printer and load paper.

2. Display the Mobile phone print settings screen on the LCD and set the media type
and the paper size.

For information about how to display the Mobile phone print settings screen, refer to Changing the
Machine Settings on the LCD .

3. Start printing from the Bluetooth compliant device.

When you select the device name, select the initial value of the printer "Canon XXX-1" (where "XXX"

is your printer's name).

If you are required to input the passkey, input the initial value "0000".

You can change the device name of the printer or passkey on the Bluetooth settings screen on the

LCD.

Setting Bluetooth Printing
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Bluetooth Settings 

Setting Bluetooth Printing

Bluetooth Settings Screen
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Setting Bluetooth Printing

1. Make sure that the printer is turned on, and attach the Bluetooth unit.

Note

When the Bluetooth unit is properly attached to the printer, the Power lamp on the printer

flashes twice.

2. Display the Bluetooth settings screen on the LCD.

For information about how to display the Bluetooth settings screen, refer to Changing the Machine

Settings on the LCD .

3. Select the contents which you want to set on the LCD.

Bluetooth Settings Screen

Note

For information about how to set a media type and a paper size when printing from a mobile

phone, refer to Changing the Machine Settings on the LCD .
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Bluetooth Settings Screen

The screens may differ depending on the printer you are using.

1. Device name

Displays the device name of the printer to which the Bluetooth unit is attached.

Device name Screen

2. Access refusal

Selecting ON will disable searching of this printer by a Bluetooth-compatible device.

Access refusal Screen

3. Security

Select Enable and then specify the security mode to activate the passkey set on the Passkey screen.
Security Screen

4. Passkey

You can change the passkey. The passkey refers to an identification number to be determined. It is

used to prevent unwanted access from other Bluetooth devices. The initial value is set to 0000.

Passkey Screen

Device name Screen

Allows you to set the device name of the printer on a Bluetooth device.

Ex:

When you select MP990 series-2, the printer name displayed on the Bluetooth device is Canon

MP990 series-2.

The initial value is set to MP990 series-1.

Access refusal Screen
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When you search from a Bluetooth device, you can enable or disable the display of the printer

name.

ON

Disables searching from a Bluetooth device.

OFF (Default setting)

Enables searching and printing from a Bluetooth device.

Security Screen

Enable

Selecting Enable allows you to choose either of the security modes below.

Mode 3(recommended)
This mode is activated on link level enforced security.

The passkey will be required when a Bluetooth device communicates with the printer.

Normally select this mode.
Mode 2

This mode is activated on service level enforced security.

The passkey will be required when printing through the Bluetooth communication.

After setting the security mode, we recommend making a trial print through Bluetooth

communication. If printing does not start, change the security mode and try again.

Setting a passkey will prevent unwanted access from other Bluetooth devices. You can

change the passkey on the Passkey screen.

Disable (Default setting)

When you register the printer, you are not required to input a passkey.

Passkey Screen

When you select Enable on the Security screen, you are required to set a passkey to register the

printer on other Bluetooth devices.

After you change the passkey, you may be asked to input the passkey on the Bluetooth devices you

were able to print from before the passkey was changed. In this case, input the new passkey.
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Troubleshooting 

Troubleshooting

Printer Cannot be Registered

Printing Does Not Start

Page top

Page 744 of 949 pagesTroubleshooting



Advanced Guide  > About Bluetooth Communication > Troubleshooting  > Troubleshooting

Troubleshooting

This section describes how to solve the problems occurred during the use of the Bluetooth unit.

Problems related to the printer's hardware, MP Drivers installation, and so on, are also described in 

Troubleshooting .
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Printer Cannot be Registered

Check 1: Have MP Drivers been installed?

If MP Drivers are not yet installed, insert the Setup CD-ROM  into the computer's disc drive, then

perform Custom Install and select MP Drivers.

Check 2: Is unsupported Bluetooth driver used?

Confirm that the Bluetooth driver installed on your computer is supported.

Toshiba Windows Vista or Windows XP computer

In Windows Vista, click Start, and select All Programs, TOSHIBA, Bluetooth, then Bluetooth

Settings.

On the Bluetooth Settings dialog, click the help button, the version number, then make sure that

the version number is 5.10.04 or later.
In Windows XP, click Start, and select All Programs, TOSHIBA, Bluetooth, then Bluetooth

Settings.

On the Bluetooth Settings dialog, click the help button, the version number, then make sure that

the version number is 3.00.10 or later.

Windows Vista (except for Toshiba Windows Vista computers)

Log into a user account with the administrator privilege, and click Control Panel, then Hardware

and Sound.

Make sure that the  Bluetooth Devices icon is displayed in the dialog.

Windows XP SP2 or later (except for Toshiba Windows XP computers)

Log into a user account with the administrator privilege, click Control Panel, then Printers and

Other Hardware.

Make sure that the  Bluetooth Devices icon is displayed in the dialog.

The operations may vary depending on your operating program. In this case, refer to your computer's

operation manual.

Check 3: Is the printer name which you want to register displayed in

Printer List?
Make sure that the printer is turned on.
Make sure that the Power lamp is lit.
Make sure that the printer is not operating.

Check whether the Bluetooth unit is usable.
Make sure that the Bluetooth settings screen can be displayed on the LCD of the printer. If the

screen cannot be displayed, Bluetooth communication is disabled. Remove the Bluetooth unit

from the printer and attach it again.

Attaching to and Removing from the Printer

Make sure that the Bluetooth settings screen can be displayed on the LCD of the printer, and try

to register again.

Check whether access from a Bluetooth-compatible device is refused.
Check the printer access setting displaying the Bluetooth settings screen on the LCD of the

printer.

1. Display the Bluetooth settings screen on the LCD of the printer.

For information about how to display the Bluetooth settings screen, refer to Changing the
Machine Settings on the LCD .

2. Select Access refusal.

3. Select OFF and press the OK button on the printer.
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Printing Does Not Start

Check 1: Is Bluetooth unit ready for use?

Make sure that the Bluetooth settings screen can be displayed on the LCD of the printer. If the

screen cannot be displayed, Bluetooth communication is disabled. Remove the Bluetooth unit from
the printer and attach it once again.

Attaching to and Removing from the Printer

Make sure that the Bluetooth settings screen can be displayed on the LCD of the printer, and try to

print again.

If the Bluetooth settings screen still is not displayed after you remove the Bluetooth unit from the

printer and attach it again, the Bluetooth unit may be faulty. In this case, contact the service center.

Check 2: Is there a problem with the location of the printer or is the

distance between the printer and computer too great?
The maximum communication distance between the printer and a computer is about 33 ft./10 m, but

it varies depending on the following conditions:

Presence of obstacles between the communication equipment and radio wave conditions

Location where magnetic fields, static electricity, or radio interference occurs

Type of software and operating system used

Receiver sensitivity and antenna performance of the communication equipment

Change the printer installation place or move the printer closer to the computer.

Check 3: Is the printer to be used selected correctly?

Follow the procedure described below to select the printer to which the Bluetooth unit is attached.

1. Log into a user account with the administrator privilege.

2. Click Control Panel, then Printers under Hardware and Sound.

When using non-Vista Windows, click Control Panel, then Printers and Faxes under Printers

and Other Hardware.

3. Click the  icon of the printer to be used for printing via Bluetooth
communication.

By default, the icon name is Canon XXX Printer (Copy X).

Note

"X" is a device name or a digit. The number of digits may differ depending on the printer.

4. Select Properties from the Organize (File in non-Vista Windows) menu. 

5. Click the Ports tab and select an applicable printer from Port.

It may vary depending on how you authenticate the printer.

When authenticating the printer as a Bluetooth device in Control Panel
BTHnnn (Canon XXX Printer (Copy X)) ("n" is a digit).

When authenticating the printer as a Bluetooth device using Bluetooth Settings built in the

computer
TBPnnn (Canon XXX Printer (Copy X)) ("n" is a digit)

For more information about how to register the printer, see Register the printer as a Bluetooth
device using Bluetooth Devices.  in Preparation .
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6. Click OK.

Check 4: Is the message "This document failed to print" displayed?

Do not retry printing. Check the error message on the LCD.

Clear the error according to An Error Message Is Displayed on the LCD .

When you use a Microsoft Bluetooth driver, make sure that the Printing (HCRP) service is
effective on your computer.

Click Control Panel, Bluetooth Devices under Hardware and Sound (Printers and Other

Hardware in non-Vista Windows), then select the printer to be used for Bluetooth

communication and click Properties.

Make sure that Printing (HCRP) on the Services sheet is checked.

If Printing (HCRP) is not checked or the Printing (HCRP) service is not detected, follow the

procedure below and register the printer again.

1. Click Control Panel, then Printers under Hardware and Sound.

When using non-Vista Windows, click Control Panel, then Printers and Faxes under Printers

and Other Hardware.

2. Click the  icon of the printer for printing via Bluetooth communication.

3. Select Delete from the Organize (File in non-Vista Windows) menu.

4. Authenticate the printer as a Bluetooth device on Bluetooth Devices in Control
Panel.

For more information about the procedure, see Registering the Printer .

This message is displayed when the print job is sent from the Bluetooth device while another

print job through the USB port is being printed out.

Printing will begin automatically when the print queue is finished.
Printing cannot be carried out with Bluetooth communication from more than one computer at

the same time. In this case, this message is displayed on the computer during standing by.

Printing will begin automatically when the print queue is finished.

Check 5: Were the MP Drivers installed after printer registration on

Bluetooth Devices?
If you have installed the MP Drivers after registering the printer as a Bluetooth device on Bluetooth

Devices, delete the printer and then register it again.

For more information about the procedure, see Preparation .
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Specifications

Communication

method

Bluetooth v2.0

Maximum Speed 1.44 Mbps

Output Bluetooth Power Class 2

Communication

distance

Line-of-sight distance: approx. 33 ft./10 m *

* It may vary depending on factors including the presence of obstacles between

communication equipment, radio wave conditions, the presence of magnetic

fields around microwave ovens and locations where electrostatic and radio

interference occur, the types of software and operating systems used, and

receiver sensitivity and antenna performance of communication equipment.

Profile SPP (Serial Port Profile)

OPP (Object Push Profile)

BIP (Basic Imaging Profile)

HCRP (Hardcopy Cable Replacement Profile)

Compatible PCs A computer in which an internal Bluetooth module is installed or a computer to

which an optional Bluetooth adapter (available from various manufacturers) is
attached.
OS/Software:

Microsoft Windows Vista (Satisfying any one of the following conditions is needed)

Bluetooth Devices is displayed in Hardware and Sound under Control Panel

Bluetooth Stack for Windows by Toshiba Version 5.10.04 or later is installed

Microsoft Windows XP (Satisfying any one of the following conditions is needed)

Windows XP SP2 or later is installed, and Bluetooth Devices is displayed in

Printers and Other Hardware under Control Panel

Bluetooth Stack for Windows by Toshiba Version 3.00.10 or later is installed

Frequency band 2.4 GHz band (2.400 GHz to 2.4835 GHz)

Power supply Supplied from the Direct Print Port on the printer, DC 4.4 V to 5.25 V

Maximum power

consumption

500 mW (MAX)

Operating

temperature

5 to 35˚C (41 to 95˚F)

Operating humidity 10 to 90% RH (no condensation)

Dimensions (Width
x Depth x Height)

18.5 (W) x 47.5 (D) x 8.7 (H) mm (with cap attached)

0.73 (W) x 1.87 (D) x 0.35 (H) inches

Weight Approx. 7 g (0.25 oz)
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Changing the Machine Settings 

Changing the Machine Settings on the LCD

Changing Machine Settings from Your Computer

Page top

Page 751 of 949 pagesChanging the Machine Settings



Advanced Guide  > Changing the Machine Settings > Changing the Machine Settings on the LCD 

Changing the Machine Settings on the LCD 

Changing the Machine Settings on the LCD

Plain paper feed settings

Print settings

LAN settings

Advanced settings

Mobile phone print setting

Bluetooth settings

PictBridge print settings

Language selection

Reset setting
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Settings on the LCD

Changing the Machine Settings on the LCD

This section describes the procedure to change the settings in the Device settings screen, taking the

steps to specify Extended copy amount as an example.

1. Make sure that the machine is turned on.

2. Select  Settings on the HOME screen, then press the OK button.

The Settings screen is displayed.

3. Select  Device settings, then press the OK button.

The Device settings screen is displayed.

4. Select the setting item, then press the OK button.

The setting screen for the selected item is displayed.

5. Select the menu, then press the OK button.

6. Select the setting item, then press the OK button.
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Plain paper feed settings

Print settings

LAN settings

Advanced settings

Mobile phone print setting

Bluetooth settings

PictBridge print settings

Language selection

Reset setting
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settings

Plain paper feed settings

Specifies the paper source for A4, Letter, A5, and B5 plain paper.

Note

A4, Letter, A5, and B5 paper can be loaded in the Cassette. Load the other sizes of paper on the
Rear Tray.
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Print settings

Prevent paper abrasion

Use this setting only if the print surface becomes smudged.

Important

Be sure to set this back to OFF after printing since it may result in lower printing speed or lower

print quality.

Extended copy amount

Selects the amount of image that extends off the paper when printing in borderless (full).

Important

This setting can be applied only when copy or easy photo reprint mode is selected.

Note

If printouts contain margins even though you are printing in Borderless, specifying Large for

this setting may help solve the problem.

Auto Photo Fix setting

When ON is selected, you can select whether to print photos using the Exif information recorded in

the image files in the following cases.

Auto photo fix ON is selected when printing from a memory card
When a Photo Index Sheet with "Auto Photo Fix OFF" not filled in is used for printing

When printing with PictBridge compliant device that meets both the following conditions:

-The print setting on the PictBridge compliant device is set to Default

-Auto photo fix ON is selected for PictBridge print settings
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LAN settings

WLAN active/inactive

Activates/deactivates wireless LAN.

Wireless LAN setup

Selects the setting method for wireless LAN connection.

Note

You can enter this setting menu by following the procedure below:

1. Select Settings on the HOME screen, then press the OK button.

2. Select Wireless LAN setup.

In this case, activate wireless LAN.

Easy settings
Select when you perform settings for wireless LAN manually.

WPS settings

Select when you perform settings for wireless LAN using Wi-Fi Protected Setup (WPS). Select

Push button method or PIN method according to the method your access point supports, then

follow the on-screen instructions.
WCN settings

Select when you perform settings for wireless LAN using Windows Connect Now (WCN)

feature. You need a USB flash drive on which settings for wireless LAN are saved.

Confirm LAN settings

The list of wireless LAN settings of this machine is displayed on the LCD.
You can print the list from this setting menu.

Wireless LAN setting list

The list of wireless LAN settings of this machine is displayed on the LCD.

The following setting items are displayed.

Items Setting (IPv4) Setting (IPv6)

Connection Active/Inactive Active/Inactive

SSID XXXXXXXXXXXXXXXX

XXXXXXXXXXXXXXXX

XXXXXXXXXXXXXXXX

XXXXXXXXXXXXXXXX

Communication
mode

Infrastructure Infrastructure

Channel XX XX

Wireless LAN

security

Disable/WEP(64bit)/WEP(128bit)/
WPA-PSK(TKIP)/WPA-PSK(AES)/

WPA2-PSK(TKIP)/WPA2-PSK(AES)

Disable/WEP(64bit)/WEP(128bit)/
WPA-PSK(TKIP)/WPA-PSK(AES)/

WPA2-PSK(TKIP)/WPA2-PSK(AES)

IP address XXX. XXX. XXX. XXX XXXX: XXXX: XXXX: XXXX: XXXX: XXXX:

XXXX: XXXX

Subnet mask XXX. XXX. XXX. XXX -

Subnet prefix

length

- XXX

Default gateway XXX. XXX. XXX. XXX XXXX: XXXX: XXXX: XXXX: XXXX: XXXX:

XXXX: XXXX

MAC address XX:XX:XX:XX:XX:XX XX:XX:XX:XX:XX:XX

IPsec setting - Enable (ESP)/Enable (ESP & AH)/

Enable (AH)/Disable

Pre-shared key - XXXXXXXXXXX
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Printer name XXXXXXXXXXXXXXX XXXXXXXXXXXXXXX

Bonjour service

name
Canon MP560 series
_XXXXXXXXXXXX

Canon MP560 series
_XXXXXXXXXXXX

("X" represents an alphanumeric character ranging from 0 to 9 and A to F.)

Print LAN details

You can print out the network settings of the machine such as its IP address and SSID.

For more information on the machine's network setting is printed out, refer to Printing Out
Network Setting Information .

Important

This print out contains valuable information about your computer. Handle it with care.

Other settings

Set printer name

Specifies the printer name. You can use up to 15 characters for the name.

Note

You cannot change this setting with the memory card inserted in the Card Slot.

You cannot use the same printer name as that already used for other LAN connected

devices.

You cannot use a hyphen for the initial or last character of the printer name.

IPv4/IPv6 settings

Selects the IP version (IPv4 or IPv6). It is recommended to use the machine with IPv4.

Set memory card sharing

Selects whether to share the Card Slot with a LAN connected computer.

Note

You cannot change this setting with the memory card inserted in the Card Slot.

WSD settings

Activates/deactivates the WSD (one of the network protocols supported in Windows Vista)

setting.

Note

When you set WSD settings to Active, the printer icon is displayed on the Network Explorer

in Windows Vista.

LLTD setting

Activates/deactivates the Link Layer Topology Discovery (LLTD) setting.

Bonjour settings

Enable/disable Bonjour 

Selecting Enable allows you to use Bonjour to perform the network settings.

Service name 

Specifies the Bonjour service name. You can use up to 48 characters for the name.

Note

You cannot use the same service name as that already used for other LAN connected

devices.

LPR service advertising 

Selects whether to advertise the Line PRinter daemon protocol (LPR).

Note

Select Enable for LPR protocol setting to activate this setting.

LPR protocol setting
Activates/deactivates the LPR setting.
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Reset LAN settings

Initializes the network settings on the machine.

Important

Note that initialization erases all connection settings with computers, and printing or scanning
operation may become impossible. To use the machine over network, refer to your setup

manual. Be careful when you initialize the network settings on the machine.

Note

When you initialize the network settings using the Canon IJ Network Tool, refer to Initializing the

Network Settings of the Machine .
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Advanced settings

Date display

Changes the display format of shooting dates when printed.

Note

When Date ON is selected on the advanced print settings screen in memory card mode, the

shooting date is printed in the date display format you selected. For print settings, see Setting

Items.

The shooting date format is as specified in the DPOF setting from DPOF printing.

Read/write attribute

Selects whether to allow data to be written onto memory cards from a computer.

Important

Remove the memory card before changing this setting. For details, see Setting Up the Card

Slot as the Memory Card Drive of the Computer .

If you set this setting to Writable from USB PC or Writable from LAN PC, you cannot print photos

on a memory card using the Operation Panel of the machine. After you finish operation of the

memory card dedicated drive, be sure to set it back to Not writable from PC. When you turn off

the machine, Writable from USB PC or Writable from LAN PC will be canceled and the setting

is returned to Not writable from PC when you turn on the machine next time.

Quiet mode

Enables this function on the machine if you want to reduce the operating noise, such as when
printing at night.

Enabling this function reduces the noises generated in the following cases:

Copying
Printing from a memory card/USB flash drive

Printing from a PictBridge compliant device

Printing from a wireless communication device
Printing a template form

Important

Operating speed may be reduced compared to when this setting is set to OFF.

This function may not be so effective depending on the machine's setting.

Furthermore, certain noise, such as when the machine is preparing for printing, is not reduced.

Note

The noises generated while scanning or printing from the computer can also be reduced. To

reduce these noises, you need to configure the settings on the computer.

For the noises while scanning, refer to Scanner Tab .

For the noises while printing from the computer, refer to Reducing the Machine Noise .

Guide display settings

Changes the time before the guidance is displayed on the LCD, or selects not to be displayed.

Key repeat

Enables/Disables continuous input by pressing and holding down the , , , , +, or - button

when setting the number of copies, changing the photo displayed on the LCD, setting the zoom
ratio, etc.
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setting

Mobile phone print setting

When printing from a mobile phone through Bluetooth communication, select the print settings such as

page size, media type, layout, and so on. For details on how to print from a mobile phone through

Bluetooth communication, see Printing Photographs from a Wireless Communication Device .

Note

This menu is displayed only when the optional Bluetooth Unit is attached.

1. Select the page size for printing photos saved on a mobile phone.

2. Select the media type for printing photos saved on a mobile phone.

3. Select Image optimizer ON to correct and smooth out the jagged contours when
printing.

4. Select the layout of the photos according to the paper for printing.

Sticker print: 

Stickers x16, Stickers x9, Stickers x4, Stickers x2, Free-cut stickers 1, Free-cut stickers 2, Free-cut

stickers 3, Free-cut stickers 4

Printing on paper other than sticker: 

Bordered x 1, x 2, x 4, x 8

Borderless x 1, x 2, x 4, x 8

Mixed 1, 2, 3

Note

Mixed 1, Mixed 2, or Mixed 3 can be selected only when the page size is set to A4 or

8.5"x11"(LTR).
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Bluetooth settings

You can change the device name of the machine, passkey, and so on in the Bluetooth settings.

For details on how to print from a mobile phone through Bluetooth communication, see Printing
Photographs from a Wireless Communication Device .

For details on how to print from a computer through Bluetooth communication, refer to About Bluetooth

Communication .

Note

This menu is displayed only when the optional Bluetooth Unit is attached.

Device name

Specifies the name of this machine that is displayed on a Bluetooth-compatible device.

For example, if you set it to XXX-2, the machine will be displayed as "Canon XXX-2" on the Bluetooth
device. The default value is XXX-1 (where "XXX" is your machine's name).

Access refusal

Selecting ON will disable searching of this machine by a Bluetooth-compatible device.

Security

When you select Enable, the passkey set on the Passkey screen becomes effective. Setting the

passkey prevents unwanted access from other Bluetooth devices. You can choose either of the

security modes below.

Mode 2

This mode is activated on service level enforced security.

The passkey will be required when printing through the Bluetooth communication.

After setting the security mode, we recommend making a trial print through Bluetooth

communication.
If printing does not start, change the security mode and try again.

Mode 3(recommended)
This mode is activated on link level enforced security.

The passkey will be required when a Bluetooth device communicates with the machine.

Normally select this mode.

Passkey

Changes the passkey. The passkey is a four-digit number used to prevent unwanted access from

other Bluetooth devices.

The initial value is "0000".

After you change the passkey, you may be required to input the new passkey on a Bluetooth device,

even though it had previous access to the machine. In this case, input the new passkey on the
device.
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Advanced Guide  > Changing the Machine Settings > Changing the Machine Settings on the LCD > PictBridge print

settings

PictBridge print settings

You can change the print settings when printing from a PictBridge compliant device.

Set the print settings to Default on the PictBridge compliant device when you want to print according to

the settings on the machine.
See Settings on a PictBridge Compliant Device  to change print settings from the PictBridge compliant
device.

Photo print setting

Select the print quality, when printing directly from a PictBridge compliant device.

1. Select the paper size when printing directly from a PictBridge compliant device.

When you perform PictBridge settings from the machine, set Paper size to Default on the

PictBridge compliant device.

2. Select the media type when printing directly from a PictBridge compliant device.

When you perform PictBridge settings from the machine, set Paper type to Default on the

PictBridge compliant device.

3. Select the print quality when printing directly from a PictBridge compliant device.

4. Select bordered or borderless print.

When you perform PictBridge settings from the machine, set Layout to Default on the

PictBridge compliant device.

5. Select automatic image correction or manual image correction.

When Auto photo fix ON is selected, the scene or person's face of a shot photo is recognized

and the most suitable correction for each photo is made automatically. It makes a darkened

face by backlight brighter to print. It also analyzes a scene such as scenery, night scene,
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person, etc. and corrects each scene with the most suitable color, brightness, or contrasts
automatically to print.

Note

After selecting Auto photo fix ON, select Red-Eye correc. ON or Red-Eye correc. OFF.

When Manual correction is selected, the setting items 6 to 15 below can be specified.

Set Image optimize to Default on the PictBridge compliant device.

6. Photo optimizer pro

Automatically optimizes brightness and tone of a photo.

7. Vivid photo

Makes green and blue more lively.

8. Face brightener

Brightens a darkened face on the photo taken against the light.

9. Noise reduction

Reduces the noise on blue areas like the sky as well as on black areas.

10. Image optimizer

Corrects and smoothes the jagged contours for printing.
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11. Red-Eye correction

Corrects red eyes in portraits caused by flash photography.

Depending on the type of the photo, red eyes may not be corrected or parts other than the

eyes may be corrected.

12. Brightness

Adjust brightness.

13. Contrast

Adjust contrast.

14. Color hue

Adjust color hue. For example, you can increase red or yellow to adjust the skin tone.

15. Effects

Applies special effects to the photo, such as printing in sepia tones or with a sketch

illustration like effect.
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Language selection

Changes the language for LCD messages and menus.
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Advanced Guide  > Changing the Machine Settings > Changing the Machine Settings on the LCD > Reset setting

Reset setting

You can change the settings back to the default.

Note

You cannot change the following setting items back to the default:

The language displayed on the LCD

The current position of the Print Head

The Read/write attribute setting

LAN settings
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Advanced Guide  > Changing the Machine Settings > Changing Machine Settings from Your Computer 

Changing Machine Settings from Your Computer 

Changing the Print Options

Registering a Frequently Used Printing Profile

Setting the Paper Source for Plain Paper

Managing the Machine Power

Reducing the Machine Noise

Changing the Machine Operation Mode
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Advanced Guide  > Changing the Machine Settings > Changing Machine Settings from Your Computer  > Changing the

Print Options 

Changing the Print Options 

You change the detailed print driver settings for print data that is sent from an application software. 

Check this check box if part of the image data is cut off, the paper source during printing differs from the

driver settings, or printing fails. 

The procedure for changing the print options is as follows: 

1. Open the printer driver setup window

2. Click Print Options... on the Page Setup tab 

The Print Options dialog box opens. 

3. Change the individual settings 

If necessary, change the setting of each item, and then click OK. 

The Page Setup tab is displayed again. 
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Frequently Used Printing Profile 

Registering a Frequently Used Printing Profile 

You can register the frequently used printing profile to Commonly Used Settings on the Quick Setup tab.

Unnecessary printing profiles can be deleted at any time. 

The procedure for registering a printing profile is as follows: 

Registering a Printing Profile 

1. Open the printer driver setup window

2. Set the necessary items 

From Commonly Used Settings on the Quick Setup tab, select the printing profile to be used and if

necessary, change the settings after Additional Features.

You can also set necessary items on the Main, Page Setup, and Effects tab. 

3. Click Save... 

The Save Commonly Used Settings dialog box opens. 

4. Save the settings 

Set Name, then click OK. If necessary, set the items in Options.... The printing profile is saved, and

the Quick Setup tab is displayed again.

The name and icon are added to the Commonly Used Settings list. 
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Important 

To save the page size, orientation, and number of copies that was set in each sheet, click

Options..., and check each item. 

Note 

When you install the printer driver again or upgrade the version of the printer driver, the print settings

you registered will be deleted from Commonly Used Settings.

Registered print settings cannot be saved and preserved. If a profile is deleted, register the print

settings again. 

Deleting Unnecessary Printing Profile 

1. Select the printing profile to be deleted 

Select the printing profile you want to delete from the Commonly Used Settings list on the Quick
Setup tab. 

2. Delete the printing profile 

Click Delete. When the confirmation message appears, click OK.

The selected printing profile is deleted from the Commonly Used Settings list. 

Note 

Printing profiles that are registered in the initial settings cannot be deleted. 
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Source for Plain Paper 

Setting the Paper Source for Plain Paper 

When you select Automatically Select from Paper Source, you can use the printer driver to select the

paper source for plain paper. 

The procedure for setting the paper source is as follows: 

 Paper Source Setting for Plain Paper 

1. Open the printer driver setup window

2. Click Paper Source Setting for Plain Paper on the Maintenance tab 

The Paper Source Setting for Plain Paper dialog box opens. 

3. Transmit the settings 

Select the paper source for plain paper, and then click the Send button. 

The selected settings are enabled hereafter. 

Important 

The descriptions in the machine manual assume that the plain paper is supplied from the
cassette. When you change the paper source setting, replace all instances of "cassette" with the

new paper source. 
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Machine Power 

Managing the Machine Power 

This function allows you to manage the machine power from the printer driver. 

The procedure for managing the printer power is as follows: 

 Power Off 

The Power Off function turns off the machine. When you use this function, you will not be able to turn the

machine on from the printer driver. 

1. Open the printer driver setup window

2. Execute power off 

Click Power Off on the Maintenance tab. When the confirmation message appears, click OK. 

The machine power switches off, and the Maintenance tab is displayed again. 
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Machine Noise 

Reducing the Machine Noise 

This function allows you to reduce the operating noise of the machine. Select when you wish to reduce

the operating noise of the printer at night, etc.

Using this function may lower the print speed. 

The procedure for using the quiet mode is as follows: 

 Quiet Mode 

1. Open the printer driver setup window

2. Click Quiet Mode on the Maintenance tab 

The Quiet Mode dialog box opens. 

3. Set the quiet mode 

If necessary, specify one of the following items: 

Do not use quiet mode 

The operating noise of the machine is at normal volume. 

Always use quiet mode 

Select this option when you wish to reduce the operating noise of the machine. 

Use quiet mode within specified time 

The operating noise of the machine can be reduced during a specified period of time.

Set the Start time and End time when you wish the quiet mode to be activated. 

Important 

The time specified in Start time and in End time must be different. 

4. Transmit the settings 

Make sure that the machine is on and click Send.

Click OK when the confirmation message appears. 

The settings are enabled hereafter. 

Note 

Depending on the paper source and the print quality settings, effects of the quiet mode may be

less. 
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Machine Operation Mode 

Changing the Machine Operation Mode 

If necessary, switch between various modes of machine operation. 

The procedure for configuring settings is as follows: 

 Custom Settings 

1. Open the printer driver setup window

2. Make sure that the machine is on, and then click Custom Settings on the
Maintenance tab 

The Custom Settings dialog box opens. 

Note 

If the machine is off or bi-directional communication is disabled, a message may appear
because the computer cannot collect the machine status.

If this happens, click OK to display the most recent settings specified on your computer. 

3. If necessary, complete the following settings: 

Prevent paper abrasion 

The machine can increase the gap between the print head and the paper during high-density

printing to prevent paper abrasion.

Check this check box to use this function. 

Align heads manually 

The Print Head Alignment function on the Maintenance tab is normally set to automatic head

alignment, but you can change it to manual head alignment. If the printing results are unsatisfactory

even after you execute automatic head alignment, see " Aligning the Print Head Position ," and

execute manual head alignment.

Check this check box to perform the manual head alignment. 

Ink Drying Wait Time 

You can set the length of the machine rest time until printing of the next page begins. Moving the

slider to the right increases the pause time and moving the slider to the left decreases the time.

If the paper gets stained because the next page is ejected before the ink on the printed page dries,

increase the ink drying wait time.

Reducing the ink drying wait time speeds up printing. 

4. Transmit the settings 

Click Send, and click OK when the confirmation message appears. 

The machine operates with the modified settings hereafter. 

Page top

Page 776 of 949 pagesChanging the Machine Operation Mode



Advanced Guide  > Troubleshooting 

Troubleshooting 

Troubleshooting

If an Error Occurs

The Machine Cannot Be Powered On

An Error Message Is Displayed on the LCD

LCD Cannot Be Seen At All

An Unintended Language Is Displayed on the LCD

Cannot Install the MP Drivers

Cannot Connect to Computer with a USB Cable Properly

Print Results Not Satisfactory

Printing Does Not Start

Copying/Printing Stops Before It Is Completed

Machine Moves But Ink Is Not Ejected

Printing Speed Is Not as Fast as Expected

Print Head Holder Does Not Move to the Position for Replacing

Paper Does Not Feed Properly

Paper Does Not Feed from the Paper Source Specified in the Printer Driver

Paper Jams

Message Appears on the Computer Screen

Cannot Print Properly with Automatic Duplex Printing

For Windows Users

Error Message Appears on a PictBridge Compliant Device

Cannot Print Properly from a Wireless Communication Device

Cannot Print Properly from a Photo Index Sheet

Cannot Remove a Memory Card

Problems with Scanning

Software Problems

MP Navigator EX Problems

If You Cannot Resolve the Problem

FAQs

Instructions for Use (Printer Driver)

General Notes (Scanner Driver)
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Advanced Guide  > Troubleshooting  > Troubleshooting

Troubleshooting

This section describes troubleshooting tips for problems you may encounter when using the machine.
For troubleshooting tips related to the setup, refer to the Network Setup Troubleshooting .

Page top

Page 778 of 949 pagesTroubleshooting



Advanced Guide  > Troubleshooting  > If an Error Occurs

If an Error Occurs

When an error occurs in printing such as the machine is out of paper or paper is jammed, a

troubleshooting message is displayed automatically. Take the appropriate action described in the
message. The message may vary depending on the version of your operating system.

In Mac OS X v.10.5.x:

In Mac OS X v.10.4.x or Mac OS X v.10.3.9:
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Advanced Guide  > Troubleshooting  > The Machine Cannot Be Powered On

The Machine Cannot Be Powered On

Check 1: Press the ON button.

Check 2: Make sure that the power plug is securely plugged into the

Power Cord Connector of the machine, then turn it back on.

Check 3: Unplug the machine from the power supply, then plug the

machine back in and turn the machine back on after leaving it for at

least 3 minutes.
If the problem is not resolved, contact the service center.
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Advanced Guide  > Troubleshooting > An Error Message Is Displayed on the LCD

An Error Message Is Displayed on the LCD

If an error message is displayed on the LCD, take the corresponding action described below.

Message Action

The following ink may have run out.

Replacing the ink tank is

recommended.

U041

If the lamp on the ink tank is flashing, ink may have run out.

Replacing the ink tank is recommended.
If printing is in progress and you want to continue printing,

press the machine's OK button with the ink tank installed.

Then printing can continue. Replacing the ink tank is

recommended after the printing. The machine may be

damaged if printing is continued under the ink out condition.

Routine Maintenance

Note

If multiple ink lamps are flashing red, see Routine
Maintenance and check the status of each ink tank.

Print head is not installed.

Install the print head.

U051/
The type of print head is incorrect.

Install the correct print head.

U052

Follow the directions given in your setup sheet to install the

Print Head.

If the Print Head is already installed, remove the Print Head

once and then reinstall it.
If the error is not resolved, the Print Head may be damaged.

Contact the service center.

Some ink tanks are not installed in

place.

U072/
More than one ink tank of the following

color is installed.

U071

Some ink tanks are not installed in the correct position.
(The lamp on the ink tank flashes.)

More than one ink tanks of the same color are installed.

(The lamp on the ink tank flashes.)

Confirm that the ink tanks are installed in the appropriate

positions.
Routine Maintenance

The remaining level of the following ink
cannot be correctly detected.

Replace the ink tank.

U130

The remaining ink level cannot be correctly detected. (The

lamp on the ink tank flashes.)

Replace the ink tank and close the Scanning Unit (Cover).

Routine Maintenance

Printing with an ink tank that was once empty may damage

the machine.

If you want to continue printing in this condition, you need to

release the function for detecting the remaining ink level.

Press and hold the machine's Stop button for at least 5
seconds, and then release it.

With this operation, releasing the function for detecting the

remaining ink level is memorized. Please be advised that

Canon shall not be liable for any machine malfunction or

damage caused by refilled ink tanks.

Note

If the function for detecting the remaining ink level is

disabled, the ink tank in gray is displayed on the LCD

when checking the current ink level.

Routine Maintenance

The following ink tank cannot be

recognized.

U043

U140

The ink tank is not installed. Install the ink tank.

Routine Maintenance

The ink tank is not compatible with this machine. (The

lamp on the ink tank is off.)
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U150 Install an appropriate ink tank.

Routine Maintenance

An ink tank error has occurred. (The lamp on the ink tank

is off.)

Replace the ink tank.

Routine Maintenance

The following ink has run out.

Replace the ink tank.

U163

Ink has run out. (The lamp on the ink tank flashes.)

Replace the ink tank and close the Scanning Unit (Cover).

Routine Maintenance

Printing under the current condition may damage the

machine.
If you want to continue printing in this condition, you need to

release the function for detecting the remaining ink level.

Press and hold the machine's Stop button for at least 5
seconds, and then release it.

With this operation, releasing the function for detecting the

remaining ink level is memorized. Please be advised that
Canon shall not be liable for any malfunction or trouble

which may be caused by continuation of printing under the

ink out condition.

Note

If the function for detecting the remaining ink level is

disabled, the ink tank in gray is displayed on the LCD

when checking the current ink level.

Routine Maintenance

There are no photos in memory card./

No photo data in USB flash drive.

There is no image data saved on the memory card or the

USB flash drive that can be read by this machine.

The machine may not recognize the file if the file name or

the folder path contains certain characters. Use only

alphanumeric characters.
Photo data edited or processed on a computer must be

printed from the computer.

Note

When a photo was processed on a computer is

selected, "?" is displayed on the LCD.

The ink absorber is almost full.
Press OK to continue printing.

Contact the service center.

The ink absorber is almost full.

Press the machine's OK button to continue printing. Contact

the service center.

Printer error has occurred

Contact the service center.

The machine error has occurred.

Contact the service center.

Timeout error has occurred.

Press OK.

Some errors occurred while copying and a certain time

passed.
Press the OK button to dismiss the error, and try to copy

again.

The device may be incompatible.

Remove the device and check the

manual supplied with the connected
device.

Check the device connected to the Direct Print Port. Printing

photos directly is possible with a PictBridge compliant device

or the optional Bluetooth Unit BU-30, or a USB flash drive.

A communication time out occurs if an operation takes too

long or if it takes too much time to send data. This may

cancel printing. In such cases, disconnect and reconnect the

USB cable.

When printing from a PictBridge compliant device,

depending on the model or brand of your device, you may

have to select a PictBridge compliant print mode on the

device before connecting it to the machine. You may also
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have to turn on your device or select Play mode manually

after connecting the device to the machine. Perform

necessary operations before connecting your device

referring to its instruction manual.

If the error is still not resolved, check if you can print another

photograph.

Failed to scan.

Check orientation/position and check
that platen/sheet is clean.

<See manual>

Scanning the print head alignment sheet has failed.

Press the OK button to dismiss the error, then take the

actions described below.
Make sure that the print head alignment sheet is set in

the correct position and orientation on the Platen Glass.

Make sure the Platen Glass and the print head alignment

sheet are not dirty.

Make sure the type and size of loaded paper is suitable

for Automatic Print Head Alignment.

For Automatic Print Head Alignment, always load one

sheet of A4 or letter-sized plain paper.

Make sure if Print Head nozzles are clogged.
Print the nozzle check pattern to check the status of the

Print Head.

Routine Maintenance

If the error is not resolved, connect the machine to the

computer and align the Print Head on the printer driver.

Aligning the Print Head Position

An unsupported USB hub is connected.

Remove the hub.

If a PictBridge compliant device is connected via a USB hub,

remove the hub and connect it directly to the machine.

B200
Printer error has occurred.

Unplug the power cord and contact the

service center.

Turn off the machine, and unplug the power cord of the

machine from the power supply.
Contact the service center.

****
Printer error has occurred.

Turn off power then back on again.

If problem persists, see the manual.

"****" is displayed in the alphanumeric character and

depends on the error occurred.

5100/5110 is displayed:
Cancel printing, and turn off the machine. Then clear the

jammed paper or protective material that is preventing

the Print Head Holder from moving, and turn on the

machine again.

Important

Be careful not to touch the components inside the

machine. The machine may not print out properly if
you touch it.

If the problem is not resolved, contact the service

center.

6000 is displayed:
If any object is placed in front of the machine, remove it.
Open the Paper Output Tray gently, then turn the power

off and back on.

In other cases:
Turn off the machine, and unplug the power cord of the

machine from the power supply.
Plug the machine back in and turn the machine back on.

If the problem is not resolved, contact the service center.

Scanner is not operating correctly. Turn off the machine, and unplug the power cord of the

machine from the power supply.
After a while, plug the power cord of the machine back in,

and then turn on the machine. If the same error occurs,
contact the service center.

The card is currently writable from PC. The Card Slot is set to Writable from USB PC or Writable
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Set to [Not writable from PC]. from LAN PC.

You cannot print from the memory card or save the scanned

data to the memory card when the Card Slot is set to
Writable from USB PC or Writable from LAN PC. After writing

on the memory card, set to Not writable from PC again.
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Advanced Guide  > Troubleshooting > LCD Cannot Be Seen At All

LCD Cannot Be Seen At All

If the Power lamp is off:

The machine is not powered on. Connect the power cord and press the ON button.

If the Power lamp is lit:

The LCD may be in the screen-saver mode. On the Operation Panel, press a button other than the 
ON button.
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Advanced Guide  > Troubleshooting > An Unintended Language Is Displayed on the LCD

An Unintended Language Is Displayed on the LCD

Select the language you want to be displayed according to the following procedure.

1. Press the HOME button and wait for about 5 seconds.

2. Select , and then press the OK button.

3. Press the  button to select , then press the OK button.

4. Press the  button 5 times, then press the OK button.

If the Bluetooth unit is connected to the machine, press the  button 7 times, and then press the 
OK button.

5. Use the  button to select the language for the LCD, then press the OK button.
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Cannot Install the MP Drivers

Important

If you cannot install the MP Drivers when you use the machine over LAN, refer to the setup manual.

If the installation does not start even after the Setup CD-ROM  is inserted

into your computer's disc drive:

Start the installation following the procedure below.

1. Click Start then Computer.

In Windows XP, click Start then My Computer.

In Windows 2000, double-click the My Computer icon on the desktop.

2. Double-click the  CD-ROM icon on the displayed window.

If the contents of the CD-ROM are displayed, double-click MSETUP4.EXE.

Double-click the  CD-ROM icon on your desktop to start installation.

Note

If the CD-ROM icon is not displayed, try the following:

Remove the CD-ROM from your computer, then insert it again.

Restart your computer.

If the icon is still not displayed, try different discs and see if they are displayed. If other discs are

displayed, there is a problem with the Setup CD-ROM . In this case, contact the service center.

If you are unable to proceed beyond the Printer Connection screen:
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If you are unable to proceed beyond the Printer Connection screen, make sure that the USB cable is

securely plugged into the USB port of the machine and is connected to the computer, and then

follow the procedure below to reinstall the MP Drivers.

Note

In Windows Vista, The printer is not detected. Check the connection. may be displayed

depending on the computer you use. In this case, wait for a while. If you still cannot proceed to

the next step, follow the procedure below to reinstall the MP Drivers.

1. Click Cancel on the Printer Connection screen.

2. Click Start Over on the Installation Failure screen.

3. Click Back on the screen that appears next.

4. Click Exit on the PIXMA XXX screen, then remove the CD-ROM.

5. Turn the machine off.

6. Restart the computer.

7. Make sure that you have no application software running.

8. Insert the CD-ROM again, then perform Easy Install to install the MP Drivers.

In other cases:

Follow the procedure described in your setup manual to reinstall the MP Drivers.

If the MP Drivers were not installed correctly, uninstall the MP Drivers, restart your computer, and
then reinstall the MP Drivers.

Deleting the Unnecessary MP Drivers
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If you reinstall the MP Drivers, perform Custom Install on the Setup CD-ROM , then select MP Drivers.

Note

If the installer was forced to be terminated due to a Windows error, the system may be in an

unstable condition and you may not be able to install the drivers. Restart your computer before

reinstalling.
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Cannot Connect to Computer with a USB Cable Properly

Printing or Scanning Speed Is Slow/Hi-Speed USB Connection Does Not Work/

"This device can perform faster" Message Is Displayed

If your system environment is not fully compatible with Hi-Speed USB, the machine will operate at

a lower speed provided under USB 1.1. In this case, the machine operates properly but printing

speed may slow down due to communication speed.

Check: Check the following to make sure that your system environment supports

Hi-Speed USB connection.

Does the USB port on your computer support Hi-Speed USB connection?

Do the USB cable, and the USB hub if you are using one, support Hi-Speed USB

connection?
Be sure to use a certified Hi-Speed USB cable. We recommend that the cable is no

longer than around 10 feet / 3 meters.

Does the operating system of your computer support Hi-Speed USB connection?

Obtain and install the latest update for your computer.

Does the Hi-Speed USB driver operate properly?

Obtain the latest version of the Hi-Speed USB driver compatible with your hardware

and reinstall it on your computer.

Important

For details on Hi-Speed USB of your system environment, contact the manufacturer of

your computer, USB cable, or USB hub.
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Print Results Not Satisfactory

If the print result is not satisfactory due to white streaks, misaligned lines, or uneven colors, confirm the

paper and print quality settings first.

Check 1: Do the page size and media type settings match the size and

type of the loaded paper?
When these settings are incorrect, you cannot obtain a proper print result.

If you are printing a photograph or an illustration, incorrect paper type settings may reduce the quality

of the printout color.

Also, if you print with an incorrect paper type setting, the printed surface may be scratched.

In borderless printing, uneven coloring may occur depending on the combination of the paper type

setting and the loaded paper.

The method of confirming the paper and print quality settings differs depending on what you do with

your machine.

To copy by operating the machine Confirm by using the Operation Panel on the

machine.
Setting Items

To print from your memory card by operating the

machine

Confirm by using the Operation Panel on the

machine.
Setting Items

To print from your USB flash drive by operating the

machine

Confirm by using the Operation Panel on the

machine.
Setting Items

To print from printed photo by operating the

machine

Confirm by using the Operation Panel on the

machine.
Setting Items

To print from a PictBridge compliant device Confirm by using your PictBridge compliant
device.

Printing Photographs Directly from a

Compliant Device

Confirm by using the Operation Panel on the

machine.

Changing the Machine Settings on the LCD

To print from a wireless communication device Confirm by using the Operation Panel on the

machine.
Changing the Machine Settings on the LCD

To print from a computer Confirm by using the printer driver.

Printing with Easy Setup

Check 2: Make sure that the appropriate print quality is selected

according to the media type and printing data referring to the table in

Check 1.
Select a print quality option suitable for the paper and image for printing. If you notice blurs or uneven

colors, increase the print quality setting and try printing again.

Note

When printing from a PictBridge compliant device, set the print quality setting by using the

Operation Panel on the machine.

You cannot make this setting from a PictBridge compliant device.

You cannot change the print quality setting when printing from a wireless communication

Page 792 of 949 pagesPrint Results Not Satisfactory



device.

Check 3: If the problem is not resolved, there may be other causes.

See also the sections below:

Cannot Print to End of Job

Part of the Page Is Not Printed

No Printing Results/Printing Is Blurred/Colors Are Wrong/White Streaks

Lines Are Misaligned

Printed Paper Curls or Has Ink Blots

Paper Is Smudged/Printed Surface Is Scratched

Back of the Paper Is Smudged

Vertical Lines Are Printed on the Sides of the Printout

Colors Are Uneven or Streaked
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Cannot Print to End of Job

Check 1: Is the size of the print data extremely large?

Click Print Options on the Page Setup sheet. Then, select the Prevent loss of print data check box in

the displayed dialog.

Check 2: Is the space of your computer's hard disk sufficient?

Delete unnecessary files to free disk space.
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Advanced Guide  > Troubleshooting > Print Results Not Satisfactory  > Part of the Page Is Not Printed

Part of the Page Is Not Printed

Check: When performing automatic duplex printing, the reason below is

possible.
When performing automatic duplex printing, the printable area at the top of the page will be 0.08

inches / 2 mm narrower than the usual.

For this reason, the bottom of the page may not be printed. To prevent this, select Use reduced

printing from the printer driver.

Important

Reduced printing may affect the layout depending on your document.

1. Open the printer properties dialog box.

Opening the Printer Properties Dialog Box (Windows)

Click Here: Printer Driver

* Before clicking here to open the printer properties dialog box, quit the running application

software.

2. Click Print Area Setup in the Page Setup sheet and select Use reduced printing.

1. Open the Print dialog box.

Opening the Page Setup and Print Dialog Box (Macintosh)

2. Select Duplex Printing & Margin in the pop-up menu.

3. Select Automatic Duplex Printing.

4. Click Use reduced printing in Print Area.

Page top

Page 795 of 949 pagesPart of the Page Is Not Printed
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Wrong/White Streaks

No Printing Results/Printing Is Blurred/Colors Are Wrong/White
Streaks
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Check 1: Did you confirm the paper and print quality settings?

Print Results Not Satisfactory

Check 2: Check the status of ink tanks. Replace the ink tank if the ink

has run out.
Routine Maintenance

Check 3: Is the orange tape or protective film remaining?

Make sure that all of the protective film is peeled off and the air hole is exposed, as illustrated in (A).

If the orange tape is left as in (B), pull the orange tape and remove it.

Check 4: Print the Nozzle Check Pattern and perform any necessary

maintenance operations such as Print Head Cleaning.
Print the Nozzle Check Pattern to determine whether the ink ejects properly from the print head
nozzles.

Refer to Routine Maintenance  for the Nozzle Check Pattern printing, Print Head Cleaning, and Print

Head Deep Cleaning.

If the Nozzle Check Pattern is not printed correctly:

Check to see if a particular color's ink tank is not empty.

If the Nozzle Check Pattern is not printed correctly though ink is sufficient, perform the Print Head

Cleaning and try printing the Nozzle Check Pattern again.

If the problem is not resolved after performing the Print Head Cleaning twice:

Perform the Print Head Deep Cleaning.

If the problem is not resolved after performing the Print Head Deep Cleaning, turn off the

machine and perform another Print Head Deep Cleaning after 24 hours.

If the problem is not resolved after performing the Print Head Deep Cleaning twice:

If Print Head Deep Cleaning does not resolve the problem, the Print Head may be damaged.

Contact the service center.

Check 5: When using paper with one printable surface, make sure that

the paper is loaded with the printable side facing up.
Printing on the wrong side of such paper may cause unclear prints or prints with reduced quality.

Refer to the instruction manual supplied with the paper for detailed information on the printable side.

Check 6: Is the Platen Glass dirty?

Clean the Platen Glass.

Cleaning the Platen Glass and Document Cover

When copying, see also the sections below:

Check 7: Make sure that the original is properly loaded on the Platen
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Glass.
Loading Paper / Originals

Check 8: Is the original loaded with the side to be copied facing down

on the Platen Glass?

Check 9: Did you copy a printout done by this machine?

Print from the memory card, from the USB flash drive, or from the digital camera directly, or reprint

from the computer.

If you copy a printout done by this machine, print quality may be reduced.
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Lines Are Misaligned

Check 1: Did you confirm the paper and print quality settings?

Print Results Not Satisfactory

Check 2: Perform Print Head Alignment.

If printed lines are misaligned or print results are otherwise unsatisfactory, adjust the print head

position.

Aligning the Print Head

Note

If the problem is not resolved after performing the Print Head Alignment, perform Print Head

Alignment manually referring to Aligning the Print Head Position .

Check 3: Is the size of the print data extremely large?

Click Print Options on the Page Setup sheet. Then, select the Prevent loss of print data check box in

the displayed dialog.

Check 4: Is the Page Layout Printing performed or the Binding margin

function used?
When the Page Layout Printing or Binding margin function is being used, thin lines may not be

printed. Try thickening the lines in the document.
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Printed Paper Curls or Has Ink Blots

Check 1: Did you confirm the paper and print quality settings?

Print Results Not Satisfactory

Check 2: If the intensity is set high, reduce the Intensity setting in the

printer driver and try printing again.
If you are using plain paper to print images with high intensity, the paper may absorb too much ink

and become wavy, causing paper abrasion.

When printing from your computer

Confirm the intensity using the printer driver.

Adjusting Intensity

When copying

Setting Items

Check 3: Is Photo Paper used for printing photographs?

When printing data with high color saturation such as photographs or images in deep color, we

recommend using Photo Paper Plus Glossy II or other Canon speciality paper.

Loading Paper / Originals
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Paper Is Smudged/Printed Surface Is Scratched

Check 1: Did you confirm the paper and print quality settings?

Print Results Not Satisfactory

Check 2: Is the appropriate type of paper used? Check the followings:

Check to see if the paper you are printing on is suitable for your printing purpose.

Loading Paper / Originals

When performing Borderless Printing, make sure that the paper you are using is suitable for

Borderless Printing.
If the paper you are using is not suitable for Borderless Printing, the print quality may be

reduced at the top and bottom edges of the paper.

Printing Area

Check 3: Load the paper after correcting its curl.

For Plain Paper

Turn the paper over and reload it to print on the other side.

Leaving the paper loaded on the Rear Tray for a long time may cause the paper to curl. In this

case, load the paper with the other side facing up. It may resolve the problem.

We recommend putting unused paper back into the package and keeping it on a level surface.

For Other Paper

If the curl on the four corners of the paper is more than 0.1 inch / 3 mm (A) in height, the paper

may be smudged or may not be fed properly. In such cases, follow the procedure described

below to correct the paper curl.

1. Roll up the paper in the opposite direction to the paper curl as shown below.
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2. Check that the paper is now flat.

We recommend printing curl-corrected paper one sheet at a time.

Note

Depending on the media type, the paper may be smudged or may not be fed properly even if it

is not curled inward. In such cases, follow the procedure described below to curl the paper

outward within 0.1 inch / 3 mm (B) in height before printing. This may improve the print result.

(C) Printing side
We recommend printing paper that has been curled outward one sheet at a time.

Check 4: If you are printing on thick paper, select the Prevent paper

abrasion setting.
Selecting the Prevent paper abrasion setting will widen the clearance between the Print Head and

the loaded paper. If you notice abrasion even with the media type set correctly to match the loaded

paper, set the machine to prevent paper abrasion by using the Operation Panel or the printer driver.

Print speed is reduced if you are selecting the Prevent paper abrasion setting.

* Deactivate the Prevent paper abrasion setting once printing is complete. If not, this setting remains

enabled for all subsequent print jobs.

To set by using the Operation Panel

Press the HOME button, select Settings, Device settings, and Print settings in this order, and

then set Prevent paper abrasion to ON.

Changing the Machine Settings on the LCD

To set by using the printer driver

Open the printer properties dialog box, and in Custom Settings in the Maintenance sheet, select

the Prevent paper abrasion check box, and then click Send.

To open the printer properties dialog box, see Opening the Printer Properties Dialog Box

(Windows).

In the Canon IJ Printer Utility, select Custom Settings in the pop-up menu, select the Prevent

paper abrasion check box, and then click Send.

To open the Canon IJ Printer Utility, see Opening the Canon IJ Printer Utility (Macintosh) .

Check 5: If the intensity is set high, reduce the Intensity setting in the

printer driver and try printing again.
If you are using plain paper to print images with high intensity, the paper may absorb too much ink

and become wavy, causing paper abrasion.

When printing from your computer

Reduce the Intensity setting in the printer driver and try printing again.
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1. Open the printer properties dialog box.

Opening the Printer Properties Dialog Box (Windows)

Click Here: Printer Driver

* Before clicking here to open the printer properties dialog box, quit the running application

software.

2. On the Main sheet, select Manual for Color/Intensity, and then click Set.

3. Drag the Intensity slide bar on the Color Adjustment sheet to adjust the
intensity.

1. Open the Print dialog box.

Opening the Page Setup and Print Dialog Box (Macintosh)

2. Select Color Options in the pop-up menu.

3. Drag the Intensity slide bar to set the intensity.

When copying

Setting Items

Check 6: Is printing performed beyond the recommended printing area?

If you are printing beyond the recommended printing area of your printing paper, the lower edge of

the paper may become stained with ink.

Resize your original document in your application software.

Printing Area

Check 7: Is the Platen Glass dirty?

Clean the Platen Glass.

Cleaning the Platen Glass and Document Cover

Check 8: Is the Paper Feed Roller dirty?

Clean the Paper Feed Roller.

Routine Maintenance

Note

Cleaning the Paper Feed Roller will wear the roller, so perform this procedure only when

necessary.

Check 9: Is inside of the machine dirty?

When performing duplex printing, the inside of the machine may become stained with ink, causing
the printout to become smudged.

Perform the Bottom Plate Cleaning to clean the inside of the machine.

Cleaning the Inside of the Machine (Bottom Plate Cleaning)

Note

To prevent the inside of the machine from stains, set the paper size correctly.
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Check 10: Set Ink Drying Wait Time longer.

Doing so gives the printed surface enough time to dry so that paper smudged and scratched are

prevented.

1. Make sure that the machine is turned on.

2. Open the printer properties dialog box.

Opening the Printer Properties Dialog Box (Windows)

3. Click the Maintenance tab and then Custom Settings.

4. Drag the Ink Drying Wait Time slide bar to set the wait time, and then click Send.

5. Confirm the message and click OK.

1. Make sure that the machine is turned on.

2. Open the Canon IJ Printer Utility.

Opening the Canon IJ Printer Utility (Macintosh)

3. Select Custom Settings in the pop-up menu.

4. Drag the Ink Drying Wait Time slide bar to set the wait time, and then click Send.

5. Confirm the message and click OK.

Check 11: Is the paper scratched by other loaded paper?

Depending on the media type, the paper may be scratched by other loaded paper when feeding from

the Rear Tray. In this case, load one sheet at a time.
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Back of the Paper Is Smudged

Check 1: Did you confirm the paper and print quality settings?

Print Results Not Satisfactory

Check 2: Perform the Bottom Plate Cleaning to clean the inside of the

machine.
Cleaning the Inside of the Machine (Bottom Plate Cleaning)

Note

When performing borderless printing, duplex printing, or too much printing, the inside may

become stained with ink.
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Advanced Guide  > Troubleshooting > Print Results Not Satisfactory  > Vertical Lines Are Printed on the Sides of the

Printout

Vertical Lines Are Printed on the Sides of the Printout

Check 1: Did you confirm the paper type and print quality settings?

Print Results Not Satisfactory

Check 2: Is the size of the loaded paper correct?

The vertical lines may be printed in the margin if the size of the loaded paper is larger than that

specified in the printer driver.

Set the paper size correctly according to the paper you loaded.

Print Results Not Satisfactory

Note

The direction of the vertical line pattern may vary depending on the image data or the print

setting.

This machine performs automatic cleaning when necessary to keep printouts clean. A small
amount of ink is ejected for cleaning.

Although ink is usually ejected on the ink absorber, it may be ejected on the paper if you load

paper larger than that specified with the printer driver.
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Colors Are Uneven or Streaked

Check 1: Did you confirm the paper and print quality settings?

Print Results Not Satisfactory

Check 2: Print the Nozzle Check Pattern and perform any necessary

maintenance operations such as Print Head Cleaning.
Print the Nozzle Check Pattern to determine whether the ink ejects properly from the print head
nozzles.

Refer to Routine Maintenance  for the Nozzle Check Pattern printing, Print Head Cleaning, and Print

Head Deep Cleaning.

If the Nozzle Check Pattern is not printed correctly:

Check to see if a particular color's ink tank is not empty.

If the Nozzle Check Pattern is not printed correctly though ink is sufficient, perform the Print Head

Cleaning and try printing the Nozzle Check Pattern again.

If the problem is not resolved after performing the Print Head Cleaning twice:

Perform the Print Head Deep Cleaning.

If the problem is not resolved after performing the Print Head Deep Cleaning, turn off the

machine and perform another Print Head Deep Cleaning after 24 hours.

If the problem is not resolved after performing the Print Head Deep Cleaning twice:

If Print Head Deep Cleaning does not resolve the problem, the Print Head may be damaged.

Contact the service center.

Check 3: Perform Print Head Alignment.
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Aligning the Print Head

Note

If the problem is not resolved after performing the Print Head Alignment, perform Print Head

Alignment manually referring to Aligning the Print Head Position .
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Printing Does Not Start

Check 1: Make sure that the power plug is securely plugged in, then

turn the machine on.
While the Power lamp is flashing green, the machine is initializing. Wait until the Power lamp stops

flashing and remains lit green.

Note

When printing large data such as a photo or graphics, it may take longer to start printing. While
the Power lamp is flashing green, the computer is processing data and sending it to the

machine. Wait until printing starts.

Check 2: Check the status of ink tanks. Replace the ink tank if ink has

run out.

Check 3: Open the Scanning Unit (Cover) and check to see if the ink

lamps are flashing red.
If there is still sufficient ink but its ink lamp is flashing red, an ink tank may not be installed in a right

position.

Routine Maintenance

Check 4: Open the Scanning Unit (Cover) and make sure that the ink

lamps light up red.

If the ink lamp is not lit, press the  mark on the ink tank until it clicks into place.

Check 5: Make sure that the machine is connected to your computer

properly.
When the machine is connected to your computer with a USB cable, make sure that the USB cable

is securely plugged in to the machine and the computer, then check the followings:

If you are using a relay device such as a USB hub, disconnect it, connect the machine directly to

the computer, and try printing again. If printing starts normally, there is a problem with the relay

device. Consult the reseller of the relay device for details.

There could also be a problem with the USB cable. Replace the USB cable and try printing

again.

When you use the machine over LAN, make sure that the machine is set up to be used over network

correctly. For details, refer to your setup manual.

Check 6: Restart your computer if you are printing from the computer.

If there are any unnecessary print jobs, delete them.

Deleting the Undesired Print Job

Check 7: Make sure that your machine's name is selected in the Print

dialog box.
The machine will not print properly if you are using a driver for a different printer.

In Windows, make sure that your machine's name is selected in the Print dialog box.

In Macintosh, make sure that your machine's name is selected in Printer in the Print dialog box.
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Note

To make the machine the one selected by default, select Set as Default Printer (Windows),

Default Printer or Make Default (Macintosh).

Check 8: Configure the printer port appropriately.

Make sure that the printer port is configured appropriately in the printer driver.

1. Log on as a user account with administrator privilege.

2. Click Control Panel, then Printer under Hardware and Sound.

In Windows XP, click Control Panel, Printers and Other Hardware, then Printers and Faxes.

In Windows 2000, click Control Panel then Printers.

3. Right-click the Canon XXX Printer icon, then select Properties.

4. Click the Ports tab to confirm the port settings.

Make sure that a port named USBnnn (where "n" is a number) with Canon XXX Printer

appearing in the Printer column is selected for Print to the following port(s).

If the setting is incorrect, reinstall the MP Drivers or change the printer port to the correct one.

Note

When the machine is used over LAN, the port name of the machine is displayed as
"CNBJNP_xxxxxxxxxx".

* "xxxxxxxxxx" is the character string generated from the MAC address or a character string

specified by the user when setting up the machine.

Check 9: Is the size of the print data extremely large?

Click Print Options on the Page Setup sheet. Then, select the Prevent loss of print data check box in

the displayed dialog.
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Advanced Guide  > Troubleshooting > Copying/Printing Stops Before It Is Completed

Copying/Printing Stops Before It Is Completed

Check 1: Has the machine been printing continuously for a long

period?
If the machine has been printing continuously for a long time, the Print Head may overheat. To

protect the Print Head, the machine may stop printing at a line break for a period of time and then

resume printing.

In this case, interrupt your print session at a convenient time and turn the machine off for at least 15

minutes.

Additionally, if the machine has been printing graphics or photos with intense colors continuously

over a period of time, the machine may stop printing to protect the Print Head. In this case, printing

will not resume automatically. Turn the machine off for at least 15 minutes.

Caution

The Print Head and the surrounding area can become extremely hot inside the machine. Never

touch the Print Head or nearby components.

Check 2: Is the paper loaded?

Make sure that paper is loaded in the Rear Tray or Cassette.

Confirm the paper source, then reload paper.

Check 3: Do the printing documents have lots of photographs or

illustrations?
Printing large data such as photos or graphics takes time for the machine and the computer to

process, during which the machine may appear to have stopped operating.

In addition, when printing data that uses a large amount of ink continuously on plain paper, the

machine may pause temporarily. In either case, wait until the process is complete.

Note

If you are printing a document with a large printing area or printing multiple copies of a

document, printing may pause to allow the ink to dry.
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Machine Moves But Ink Is Not Ejected

Check 1: Are the Print Head nozzles clogged?

Print the Nozzle Check Pattern to determine whether the ink ejects properly from the print head
nozzles.

Refer to Routine Maintenance  for the Nozzle Check Pattern printing, Print Head Cleaning, and Print

Head Deep Cleaning.

If the Nozzle Check Pattern is not printed correctly:

Check to see if a particular color's ink tank is not empty.

If the Nozzle Check Pattern is not printed correctly though ink is sufficient, perform the Print Head

Cleaning and try printing the Nozzle Check Pattern again.

If the problem is not resolved after performing the Print Head Cleaning twice:

Perform the Print Head Deep Cleaning.

If the problem is not resolved after performing the Print Head Deep Cleaning, turn off the

machine and perform another Print Head Deep Cleaning after 24 hours.

If the problem is not resolved after performing the Print Head Deep Cleaning twice:

If Print Head Deep Cleaning does not resolve the problem, the Print Head may be damaged.

Contact the service center.

Check 2: Has the ink run out?

See An Error Message Is Displayed on the LCD  to identify the ink error, and then take the

appropriate action depending on the error condition.

Check 3: Is the orange tape or protective film remaining?

Make sure that all of the protective film is peeled off and the air hole is exposed, as illustrated in (A).

If the orange tape is left as in (B), pull the orange tape and remove it.
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Printing Speed Is Not as Fast as Expected

Check 1: Is printing performed in Quiet Mode?

Print speed is reduced if you specified to print in Quiet Mode in the printer driver or Operation Panel.

For faster printing, do not print in Quiet Mode.

For information on the printer driver settings, refer to Reducing the Machine Noise .

For information to make setting on the Operation Panel, see Changing the Machine Settings on the

LCD.

Check 2: Is the print quality set too high?

Increase the printing speed setting in the printer driver. Setting to prioritize speed makes printing

faster.

1. Open the printer properties dialog box.

Opening the Printer Properties Dialog Box (Windows)

Click Here: Printer Driver

* Before clicking here to open the printer properties dialog box, quit the running application

software.

2. On the Main sheet, select Fast for the Print Quality setting.

Depending on the media type, the Fast option may not be available.

1. Open the Print dialog box.

Opening the Page Setup and Print Dialog Box (Macintosh)

2. Select Quality & Media in the pop-up menu and then select Fast for the Print
Quality setting.

Depending on the media type, the Fast option may not be available.

Note

Printing speed may not improve noticeably by following the instructions above, depending on your

system environment.
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Print Head Holder Does Not Move to the Position for Replacing

Check 1: Is the Power lamp off?

Check if the Power lamp is lit green.

The Print Head Holder will not move unless the power is on. If the Power lamp is off, close the
Scanning Unit (Cover) and turn the machine on.

While the Power lamp is flashing green, the machine is initializing. Wait until the Power lamp stops
flashing and remains lit green, and then open the Scanning Unit (Cover) again.

Check 2: Is an error message displayed on the LCD?

Close the Scanning Unit (Cover), follow the directions displayed in the error message to resolve the

error, and then reopen it. For details on how to resolve the error, see An Error Message Is Displayed

on the LCD .

Check 3: Has the Scanning Unit (Cover) been left open for 10 minutes or

longer?
If the Scanning Unit (Cover) is left open for more than 10 minutes, the Print Head Holder moves to

the right to prevent the Print Head from drying out. Close and reopen the Scanning Unit (Cover) to

return the Print Head Holder to the center.

Check 4: Has the machine been printing continuously for a long

period?
Close the Scanning Unit (Cover), wait a while, then reopen it.

If the machine has been printing continuously for a long time, the Print Head Holder may not move to

the center since the Print Head may overheat.

Note

Opening the Scanning Unit (Cover) while printing moves the Print Head Holder to the right. Close

the Scanning Unit (Cover), and reopen it after printing finishes.
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Paper Does Not Feed Properly

Check 1: Make sure of the following when you load paper.

When loading two or more sheets of paper, flip through the paper before loading.

When loading two or more sheets of paper, align the edges of the sheets before loading.

When loading two or more sheets of paper, make sure that the paper stack does not exceed the

paper load limit.
However, proper feeding of paper may not be possible at this maximum capacity depending on

the type of paper or environmental conditions (either very high or low temperature and humidity).

In such cases, reduce the sheets of paper you load at a time to less than half of the paper load

limit.
Always load the paper in portrait orientation, either in the Rear Tray or the Cassette, regardless

of the printing orientation.

When you load the paper on the Rear Tray, load the paper with the print side facing UP and

slide the Paper Guides to align with the both sides of the paper.

When loading paper in the Cassette, load the paper with the print side facing DOWN. Align the

right edge of the paper stack against the right edge of the Cassette and slide the Paper Guides

against the left and bottom edges of the stack.

Loading Paper / Originals

Check 2: Check to see if the paper you are printing on is not too thick or

curled.
Loading Paper / Originals

Check 3: Make sure of the following when you load envelopes.

When printing on envelopes, refer to Loading Paper / Originals , and prepare the envelopes before

printing.

Once you have prepared the envelopes, load them in portrait orientation. If the envelopes are placed

in landscape orientation, they will not feed properly.

Check 4: Confirm the paper source setting.

* If the paper source setting is not changed since you purchased this machine, the paper source for

plain paper is the Cassette.

Setting with the Operation Panel on the machine:

Changing the Machine Settings on the LCD

Setting with the printer driver:

Switching the Paper Source to Match the Purpose

For information on the paper source for plain paper when the Paper Source on the printer driver

is set to Automatically Select:

Setting the Paper Source for Plain Paper

Check 5: Remove the foreign object in the Cassette.
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Check 6: Make sure that there are not any foreign objects in the Rear

Tray.

If the paper tears in the Rear Tray, see Paper Jams  to remove it.

If there are any foreign objects in the Rear Tray, be sure to turn off the machine, unplug it from the

power supply, then remove the foreign object.

Check 7: Clean the Paper Feed Roller.

Routine Maintenance

Note

Cleaning the Paper Feed Roller will wear the roller, so perform this procedure only when

necessary.

Check 8: If two or more sheets of paper feed from the Cassette at once,

clean the inside of the Cassette.
For information on cleaning the inside of the Cassette, refer to Routine Maintenance .

Check 9: Is the Rear Cover closed completely?

Paper may be jammed if the Rear Cover is not closed completely. Push the Rear Cover until it is

closed completely.

Refer to Overview of the Machine for the position of the Rear Cover.
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Paper Does Not Feed from the Paper Source Specified in the
Printer Driver

Check: Is the paper source setting inconsistent between the application

program and the printer driver?
Change the application software setting corresponding to the printer driver setting, or click the Print

Options on the Page Setup sheet in the printer driver and select Disable the paper source setting of

the application software on the Print Options screen.

When the paper source setting is inconsistent between an application program and the printer
driver, the application software setting takes precedence.
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Paper Jams

Note

If you need to turn off the machine to remove jammed paper during printing, press the Stop button

to cancel print jobs before turning off the machine.

Paper Is Jammed in the Paper Output Slot or the Rear Tray

Paper Is Jammed inside the Machine at the Transport Unit

Jammed Paper Is Not Removed out When Automatic Duplex Printing

In Other Cases
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Paper Is Jammed in the Paper Output Slot or the Rear Tray

Remove the paper following the procedure below.

1. Slowly pull the paper out, either from the Rear Tray or from the Paper Output Slot,
whichever is easier.

Note

If the paper tears and a piece remains inside the machine, turn the machine off, open the

Scanning Unit (Cover), and remove the paper.

Be careful not to touch the components inside the machine.

After removing all paper, close the Scanning Unit (Cover), and turn the machine back on.

If you cannot pull the paper out, turn the machine off and turn it back on. The paper may be

ejected automatically.

2. Reload the paper, and press the OK button on the machine.

If you turned off the machine in step 1, all print jobs in the queue are canceled. Reprint if necessary.

Note

When reloading the paper, confirm that you are using the correct paper and are loading it
correctly.

Loading Paper / Originals

A5 sized paper is suited to printing documents consisting mainly of text. We do not recommend

using such paper to print documents with photos or graphics, since the printout may curl and

cause paper exit jams.

If you cannot remove the paper or the paper tears inside the machine, or if the paper jam error continues

after removing the paper, contact the service center.
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Paper Is Jammed inside the Machine at the Transport Unit

Remove the paper following the procedure below.

1. Detach the Rear Cover.

2. Pull the paper out slowly.

Note

Be careful not to touch the components inside the machine.

If you cannot pull the paper out, turn the machine off and turn it back on. The paper may be

ejected automatically.

3. Attach the Rear Cover.

Push the left side of the Rear Cover until it is closed completely.

If you were not able to remove the paper out in step 2:

4. Remove the Cassette.

5. Pull the paper out slowly.
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6. If any paper is sticking out of the Cassette, remove the paper, align and reload the
paper in the Cassette.

If you did not remove the jammed paper out in step 1 to 5 when automatic duplex printing, check the

duplex transport section.

Jammed Paper Is Not Removed out When Automatic Duplex Printing

Note

When reloading the paper into the machine, confirm that you are using the correct paper and

are loading it into the machine correctly.

Loading Paper / Originals

7. Insert the Cassette into the machine again, and press the OK button on the

machine.

If you turned off the machine in step 2, all print jobs in queue are canceled. Reprint if necessary.

If you cannot remove the paper or if the paper tears inside the machine, or if the paper jam error

continues after removing the paper, contact the service center.
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Jammed Paper Is Not Removed out When Automatic Duplex
Printing

Before removing the jammed paper, see Paper Is Jammed inside the Machine at the Transport Unit  to

remove it from Transport Unit. If the paper jam error continues, remove the jammed paper following the

procedure below.

1. Turn off the machine, and unplug the power cord of the machine from the power
supply.

2. Remove the Cassette.

If the paper is loaded on the Rear Tray, remove the paper from the Rear Tray and retract the Paper

Support.

3. Set the machine upright with the left side down.

Important

When standing the machine, make sure that the Scanning Unit (Cover) is closed securely.

4. Slowly pull the jammed paper out so that the paper does not tear.

Note

Set the machine back to its original position immediately after removing the jammed paper.

5. Align the paper, then reload it in the Cassette.

Reload paper in the Rear Tray, if necessary.

Note

When reloading the paper into the machine, confirm that you are using the correct paper and

are loading it into the machine correctly.

Loading Paper / Originals

6. Insert the Cassette into the machine again.

7. Plug the machine back in and turn the machine back on.

All print jobs in queue are canceled. Reprint if necessary.

If you cannot remove the paper or the paper tears inside the machine, or if the paper jam error continues

after removing the paper, contact the service center.

Page 822 of 949 pagesJammed Paper Is Not Removed out When Automatic Duplex Printing



Page top

Page 823 of 949 pagesJammed Paper Is Not Removed out When Automatic Duplex Printing



Advanced Guide  > Troubleshooting > Paper Jams > In Other Cases

In Other Cases

Make sure of the following:

Check 1: Are there any foreign objects around the Paper Output Slot?

Check 2: Are there any foreign objects in the Rear Tray?

If there are any foreign objects in the Rear Tray, be sure to turn off the machine, unplug it from the

power supply, then remove the foreign object.

Check 3: Is the Rear Cover closed completely?

Check 4: Is the paper curled?

Check 3: Load the paper after correcting its curl.
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Message Appears on the Computer Screen

Error Number: B200 A printer error has occurred. Turn the printer off and unplug the power cord of the

printer from the power supply. Then contact the service center. Is Displayed

Error Number: **** A printer error has occurred. Turn the printer off and then on again. If this doesn't

clear the error, see the user's guide for more detail. Is Displayed

Error Regarding Automatic Duplex Printing Is Displayed

Writing Error/Output Error/Communication Error

Error Number: 300 Is Displayed

Error Number: 1700 Is Displayed

Ink Info Number: 1600 Is Displayed

Ink Info Number: 1683 Is Displayed

Ink Info Number: 1688 Is Displayed

Error Number: 2001 Is Displayed

Error Number: 2002 Is Displayed

Other Error Messages

The Inkjet Printer/Scanner/Fax Extended Survey Program Screen Is Displayed

The Inkjet Printer/Scanner/Fax Extended Survey Program Icon Appears

Error Number: B200 A printer error has occurred. Turn the printer off and unplug the

power cord of the printer from the power supply. Then contact the service center. Is

Displayed

Turn off the machine, and unplug the power cord of the machine from the power supply.

Contact the service center.

Error Number: **** A printer error has occurred. Turn the printer off and then on again. If

this doesn't clear the error, see the user's guide for more detail. Is Displayed

"****" is displayed in the alphanumeric character and depends on the error occurred.

5100 or 5110 Is Displayed

Confirm the movement of the Print Head Holder blocked.

Cancel printing from your computer and turn off the machine. Then clear the jammed paper or

protective material that is preventing the Print Head Holder from moving, and turn on the

machine again.

Important

Be careful not to touch the components inside the machine. The machine may not print
out properly if you touch it.

If the problem is not resolved, contact the service center.

6000 Is Displayed

If any object is placed in front of the machine, remove it.

Open the Paper Output Tray gently, then turn the power off and back on.

Four-Digit Alphanumeric and "Printer error has occurred." Is Displayed

Turn off the machine, and unplug the power cord of the machine from the power supply.
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Plug the machine back in and turn the machine back on.

If the problem is not resolved, contact the service center.

Error Regarding Automatic Duplex Printing Is Displayed

Check: See Cannot Print Properly with Automatic Duplex Printing  and take the
appropriate action.

Writing Error/Output Error/Communication Error

Check 1: If the Power lamp is off, make sure that the power plug is plugged in,

then turn the machine on.

While the Power lamp is flashing green, the machine is initializing. Wait until the Power lamp
stops flashing and remains lit green.

Check 2: Make sure that the printer port is configured appropriately in the printer

driver.

* In the following instructions, " XXX" signifies your machine's name.

1. Log on as a user account with administrator privilege.

2. Click Control Panel, then Printer under Hardware and Sound.

In Windows XP, click Control Panel, Printers and Other Hardware, then Printers and

Faxes.

In Windows 2000, click Control Panel then Printers.

3. Right-click the Canon XXX Printer icon, then select Properties.

4. Click the Ports tab to confirm the port settings.

Make sure that a port named USBnnn (where "n" is a number) with Canon XXX Printer

appearing in the Printer column is selected for Print to the following port(s).

If the port setting is not correct, reinstall the MP Drivers or change the port setting

according to the interface you are using.

Note

When the machine is used over LAN, the port name of the machine is displayed as
"CNBJNP_xxxxxxxxxx".

* "xxxxxxxxxx" is the character string generated from the MAC address or a character string

specified by the user when setting up the machine.

Check 3: Make sure that the machine is connected to your computer properly.

When the machine is connected to your computer with a USB cable, make sure that the USB

cable is securely plugged in to the machine and the computer, then check the followings:

If you are using a relay device such as a USB hub, disconnect it, connect the machine

directly to the computer, and try printing again. If printing starts normally, there is a

problem with the relay device. Consult the reseller of the relay device for details.

There could also be a problem with the USB cable. Replace the USB cable and try

printing again.

When you use the machine over LAN, make sure that the machine is set up to be used over

network correctly. For details, refer to your setup manual.

Check 4: Make sure that the MP Drivers are installed correctly.

Uninstall the MP Drivers following the procedure described in Deleting the Unnecessary MP

Drivers, insert the Setup CD-ROM  into the computer's disc drive and perform Custom Install

and select MP Drivers to install again.
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Check 5: When the machine is connected to your computer with a USB cable,

check the status of the device on your computer.

Follow the procedure below to check the status of the device.

1. Click Control Panel, Hardware and Sound, then Device Manager.

If the User Account Control screen is displayed, follow the on-screen instructions.

In Windows XP, click Control Panel, Performance and Maintenance, System, then click

Device Manager on the Hardware sheet.

In Windows 2000, click Control Panel, System, then Device Manager on the Hardware

sheet.

2. Double-click Universal Serial Bus controllers then USB Printing Support.

If USB Printing Support is not displayed, make sure that the machine is correctly

connected to the computer.

Check 3: Make sure that the machine is connected to your computer properly.

3. Click the General tab and make sure that there is no indication of a problem with the

device.

If a device error is displayed, refer to Windows help to resolve the error.

Error Number: 300 Is Displayed

Check 1: If the Power lamp is off, make sure that the power plug is plugged in,

then turn the machine on.

While the Power lamp is flashing green, the machine is initializing. Wait until the Power lamp
stops flashing and remains lit green.

Check 2: Make sure that the machine is connected to your computer properly.

When the machine is connected to your computer with a USB cable, make sure that the USB

cable is securely plugged in to the machine and the computer, then check the followings:

If you are using a relay device such as a USB hub, disconnect it, connect the machine

directly to the computer, and try printing again. If printing starts normally, there is a

problem with the relay device. Consult the reseller of the relay device for details.

There could also be a problem with the USB cable. Replace the USB cable and try

printing again.

When you use the machine over LAN, make sure that the machine is set up to be used over

network correctly. For details, refer to your setup manual.

Check 3: Make sure that your machine's name is selected in the Print dialog

box.

Opening the Page Setup and Print Dialog Box (Macintosh)

Error Number: 1700 Is Displayed

Check: See The ink absorber is almost full.  in An Error Message Is Displayed on

the LCD and take the appropriate action.

Ink Info Number: 1600 Is Displayed

Check: See The following ink may have run out.  in An Error Message Is

Displayed on the LCD and take the appropriate action.
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Ink Info Number: 1683 Is Displayed

Check: See The remaining level of the following ink cannot be correctly

detected. in An Error Message Is Displayed on the LCD  and take the appropriate
action.

Ink Info Number: 1688 Is Displayed

Check: See The following ink has run out.  in An Error Message Is Displayed on

the LCD and take the appropriate action.

Error Number: 2001 Is Displayed

Check: See The device may be incompatible.  in An Error Message Is Displayed

on the LCD and take the appropriate action.

Error Number: 2002 Is Displayed

Check: See An unsupported USB hub is connected.  in An Error Message Is

Displayed on the LCD and take the appropriate action.

Other Error Messages

Check: If an error message is displayed outside the printer status monitor, check

the following:

"Could not spool successfully due to insufficient disk space"

Delete any unnecessary files to increase the amount of free space on the disk.

"Could not spool successfully due to insufficient memory"

Quit other running applications to increase available memory.
If you still cannot print, restart your computer and retry printing.

"Printer driver could not be found"
Uninstall the printer driver according to the procedure described in Deleting the

Unnecessary MP Drivers , and then reinstall it.

"Could not print Application name - File name"

Try printing again once the current job is complete.

The Inkjet Printer/Scanner/Fax Extended Survey Program Screen Is Displayed

If the Inkjet Printer/Scanner/Fax Extended Survey Program is installed, a confirmation screen

asking for permission to send the printer usage information will be displayed three months and
then six months after the installation. After that, it will be displayed every six months for about four

years.

Read the instructions on the screen and follow the procedure below.
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If you agree to participate in the survey program:

Click Agree, then follow the on-screen instructions. The printer usage information will be sent
via the Internet. If you have followed the on-screen instructions, the information will be sent

automatically from the second time onward and the confirmation screen will not be displayed

again.

Note

When the information is being sent, a caution screen such as an Internet security screen

may be displayed. In this case, confirm that the program name is "IJPLMUI.exe", then

allow it.

If you deselect the Send automatically from the next time check box, the information will

not be sent automatically from the second time onward and a confirmation screen will be

displayed at the time of the next survey. To send the information automatically, see 

Changing the confirmation screen setting: .

If you do not agree to participate in the survey program:

Click Do not agree. The confirmation screen will be closed, and the survey at that time is

skipped. The confirmation screen will be displayed again three months later.

To uninstall the Inkjet Printer/Scanner/Fax Extended Survey Program:

To uninstall the Inkjet Printer/Scanner/Fax Extended Survey Program, click Uninstall, then

follow the on-screen instructions.

Changing the confirmation screen setting:

1. Select items the Start menu as shown below.

In Windows Vista, select the Start menu > Control Panel > Uninstall a program.

In Windows XP, select the Start menu > Control Panel > Add or Remove

Programs.
In Windows 2000, select the Start menu > Settings > Control Panel > Add/Remove

Programs.

Note

In Windows Vista, a confirmation/warning dialog box may appear when installing,

uninstalling or starting up software.

This dialog box appears when administrative rights are required to perform a task.

If you are logged on to an administrator account, click Continue or Allow to continue.

2. Select Canon Inkjet Printer/Scanner/Fax Extended Survey Program.

3. Select Change.
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If you select Yes after you have followed the on-screen instructions, the confirmation

screen will be displayed at the time of the next survey.

If you select No, the information will be sent automatically.

Note

If you select Uninstall (or Remove), the Inkjet Printer/Scanner/Fax Extended Survey

Program is uninstalled. Follow the on-screen instructions.

The Inkjet Printer/Scanner/Fax Extended Survey Program Icon Appears

If the Inkjet Printer/Scanner/Fax Extended Survey Program is installed, the printer usage

information is scheduled to be sent three months and then six months after the installation. After
that, it is scheduled to be sent every six months for about four years. The Inkjet Printer/Scanner/Fax

Extended Survey Program icon appears in the Dock when it is time to send the printer usage

information.

In Mac OS X v.10.3.9, the Inkjet Printer/Scanner/Fax Extended Survey Program is not installed.

Read the instructions on the screen after clicking the icon, then follow the procedure below.

If you agree to participate in the survey program:

Click Agree, then follow the on-screen instructions. The printer usage information will be sent
via the Internet. If you have followed the on-screen instructions, the information will be sent

automatically from the second time onward and the confirmation screen will not be displayed

again.

Note

If you deselect the Send automatically from the next time check box, the information will

not be sent automatically from the second time onward and the Inkjet Printer/Scanner/
Fax Extended Survey Program icon will appear in the Dock at the time of the next survey.
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If you do not agree to participate in the survey program:

Click Do not agree. The confirmation screen will be closed, and the survey at that time is

skipped. The confirmation screen will be displayed again three months later.

To stop sending the information:

Click Turn off. The Inkjet Printer/Scanner/Fax Extended Survey Program is stopped, and the

information will not be sent. To resume the survey, see Changing the setting: .

To uninstall the Inkjet Printer/Scanner/Fax Extended Survey Program:

1. Stop the Inkjet Printer/Scanner/Fax Extended Survey Program.

Changing the setting:

2. Select Applications from the Go menu, and double-click the Canon Utilities folder, then
the Inkjet Extended Survey Program folder.

3. Place the Canon Inkjet Printer/Scanner/Fax Extended Survey Program.app file into the

Trash.

4. Restart the computer.

Empty the Trash and restart your computer.

Changing the setting:

To display the confirmation screen every time the printer usage information is sent or to

resume surveying, follow the procedure below.

1. Select Applications from the Go menu, and double-click the Canon Utilities folder, then
the Inkjet Extended Survey Program folder.

2. Double-click the Canon Inkjet Printer/Scanner/Fax Extended Survey Program icon.

Do not display the confirmation screen when information is sent:

If the check box is selected, the information will be sent automatically.
If the check box is not selected, the Inkjet Printer/Scanner/Fax Extended Survey

Program icon will appear in the Dock at the time of the next survey. Click the icon,

then follow the on-screen instructions.
Turn off/Turn on button:

Click the Turn off button to stop the Inkjet Printer/Scanner/Fax Extended Survey

Program.
Click the Turn on button to restart the Inkjet Printer/Scanner/Fax Extended Survey

Program.
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Cannot Print Properly with Automatic Duplex Printing

Check: Is the paper size or media type appropriate?

Make sure that the actual size of the paper is suitable for automatic duplex printing.

The sizes of media suitable for automatic duplex printing are A4, Letter, A5, and 5" x 7".

Load paper of suitable size, then press the OK button on the machine.

Make sure that the Page Size or Paper Size setting matches the actual size of the paper with a

size suitable for automatic duplex printing.

First, check the Page Size setting in the application software you are printing from.

Then, check the Page Size setting on the Page Setup sheet in the printer properties dialog box

(Windows) or the Paper Size on the Page Setup dialog box (Macintosh).

Note

Duplex printing may not be available depending on the version of the application software.

Make sure that the type of loaded paper is suitable for automatic duplex printing on the Main

sheet (Windows) or the Quality & Media sheet on the Print dialog box (Macintosh).

To switch to manual duplex printing, follow the procedure below.

Open the printer properties dialog box, clear the Automatic check box on the Page Setup sheet, and

reprint.

When performing manual duplex printing, note the following.

If you are printing three or more pages of a document with manual duplex printing, one side of

all sheets of paper will be printed first. Turn over the paper and reload the paper in the machine,

and then the reverse side of all sheets of paper will be printed. Be careful not to change the

order of paper in the stack.

The procedure for reversing the paper varies depending on the staple side and printing

orientation. Follow the on-screen instructions.

Manual duplex printing is not available.
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For Windows Users

Printer Status Monitor Is Not Displayed

Check: Is the printer status monitor enabled?

Make sure that Enable Status Monitor is selected on the Option menu of the printer status

monitor.

1. Open the printer properties dialog box.

Opening the Printer Properties Dialog Box (Windows)

2. On the Maintenance sheet, click View Printer Status.

3. Select Enable Status Monitor on the Option menu if it is not selected.

If you are using Windows Vista:

Launching MP Navigator EX Whenever Pressing the Color or Black Button on the Machine

Check: Specify the response from pressing the Color or Black button on the

machine.

Follow the procedure below to specify the response on your computer.

1. Log on as a user account with administrator privilege.

2. Click Control Panel, Hardware and Sound, then Scanners and Cameras.

3. Select WIA Canon XXX ser, then click the Properties button.

If the User Account Control screen appears, click Continue.

4. Click the Events tab on the WIA Canon XXX ser Properties screen.

5. Select Start this program for Actions, then select MP Navigator EX Ver3.0 from the

pull-down menu.

Choose an event from the Select an event pull-down menu, then select MP Navigator EX
Ver3.0 to launch for each event. If MP Navigator EX Ver3.0 is already selected for each

event, click Cancel.

6. Click OK.
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Error Message Appears on a PictBridge Compliant Device

The following are the possible errors that may occur when printing directly from a PictBridge compliant

device and the countermeasures to clear them.

Note

This section describes errors that are indicated on Canon-brand PictBridge compliant devices. The

error messages and operations may vary depending on the device you are using. For errors on non

-Canon PictBridge compliant devices, check the error message on the LCD and take the

appropriate action to clear the error. For details, see An Error Message Is Displayed on the LCD .

For the errors indicated on the PictBridge compliant device and their solution, also refer to the

instruction manual of the device. For other troubles on the device, contact the manufacturer.

Error Message on the PictBridge

Compliant Device
Action

"Printer in use" If the machine is printing from the computer or warming up,

wait until the job ends.

When it is ready, the machine starts printing automatically.

"No paper" Load paper on the Rear Tray, and select Continue* in the

display on your PictBridge compliant device.

* To resume printing, you can also press the OK button on

the machine instead of selecting Continue on the device.

"Paper jam" Select Stop in the display on your PictBridge compliant

device to stop printing.

Remove the jammed paper, load new paper, press the OK

button on the machine, and try printing again.

"Printer cover open" Close the Scanning Unit (Cover) on the machine.

"No print head" The Print Head is defective or is not installed.

Check: See Print head is not installed.  in An Error Message

Is Displayed on the LCD  and take the appropriate action.

"Waste tank full"/"Ink absorber full" The ink absorber is nearly full.

Check: See The ink absorber is almost full.  in An Error

Message Is Displayed on the LCD  and take the appropriate

action.

"No ink"/"Ink cassette error" The ink tank is not installed properly or empty.

Check the error message on the LCD and take the

appropriate action to resolve the error.

An Error Message Is Displayed on the LCD

"Ink Error" An ink tank that was once empty is installed.

Check: See The remaining level of the following ink cannot
be correctly detected.  in An Error Message Is Displayed on

the LCD and take the appropriate action.

"Hardware Error" Ink tank errors have occurred.

Replace the ink tank.

Routine Maintenance
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Cannot Print Properly from a Wireless Communication Device

Check: Is printing possible through Bluetooth communication?

Printing via Bluetooth Communication
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Cannot Print Properly from a Photo Index Sheet

Failed to scan Photo Index Sheet. Is Displayed

Check: Check the following, press the OK button, then perform the Scan sheet

and print menu again.

Did you set Photo Index Sheet in the correct position and orientation on the Platen

Glass?
Are the Platen Glass and the Photo Index Sheet dirty?

Are all required circles on the Photo Index Sheet filled in?

Note

If the filled circles on the Photo Index Sheet are not dark or vast enough, the machine

may not scan the Photo Index Sheet properly.

Cannot print the selected photo. Is Displayed/Differ Photo or Blank Is Printed out/Paper

Feeds Before Printing Is Complete

Check 1: Make sure that the photo you want to print is displayed on the LCD.

Press the HOME button, select Memory card and Select and print in this order, then select the

photo you want to print to make sure that it is saved on the memory card or USB flash drive.

Check 2: Reprint out the Photo Index Sheet.

Note

The machine may not scan the Photo Index Sheet properly even though Print a blank

Photo Index Sheet circle is filled in. Press the HOME button, select Photo index sheet,

follow the on-screen instructions to reprint out the Photo Index Sheet.

Check 3: Make sure that the photo saved on the memory card or USB flash drive

can be read by this machine.

Printing from a Memory Card

Check 4: Was the photo saved on the memory card or USB flash drive processed

on a computer?

A photo processed on a computer may not be printed.

Note

When a photo was processed on a computer is selected, "?" is displayed on the LCD.

Check 5: Did you make any changes to the memory card or USB flash drive after

printing the Photo Index Sheet?

If you added photos to or deleted photos from the memory card or USB flash drive, reprint out
the Photo Index Sheet.

Important

Do not rewrite the contents of the memory card or USB flash drive until printing and

scanning of the Photo Index Sheet are complete.

Check 6: Did you remove the memory card or USB flash drive while printing?

Do not remove the memory card or USB flash drive before printing is complete.

Important
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If the memory card or USB flash drive is removed while printing, the stored data may be

damaged or the selected photo may not be printed as the reading of the photo on the

memory card or USB flash drive and the printing of the photo are simultaneous.
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Cannot Remove a Memory Card

Contact the service center.

Important

Never attempt to remove a memory card using a thin stick or tweezers. Doing so may damage the

machine.

Note

Exclusive adapters are required for the following memory cards. Insert these cards in the machine

with adapters attached.

miniSD Card/miniSDHC Card/microSD Card/microSDHC Card/xD-Picture Card/xD-Picture Card
Type M/xD-Picture Card Type H/Memory Stick Micro/RS-MMC
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Problems with Scanning

Scanner Does Not Work

ScanGear (Scanner Driver) Does Not Start

Error Message Appears and the ScanGear (Scanner Driver) Screen Does Not Appear

Scan Quality (Image Displayed on the Monitor) Is Poor

Scanned Image Is Surrounded by Extra White Areas

Cannot Scan Multiple Documents at One Time

Cannot Scan Properly in Auto Scan Mode

Slow Scanning Speed

"There is not enough memory." Message Is Displayed

Computer Stops Operating during Scanning

Scanner Does Not Work After Upgrading Windows
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Scanner Does Not Work

Check 1: Make sure that the machine is turned on.

Check 2: Connect the USB cable to a different USB port on the computer.

Check 3: If the USB cable is connected to a hub, remove it from the hub
and connect it to a USB port on the computer.

Check 4: Restart the computer.
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ScanGear (Scanner Driver) Does Not Start

Check 1: Make sure that the MP Drivers is installed.

If it is not installed, insert the Setup CD-ROM  into the computer's disc drive, then select Custom Install
and install MP Drivers.

Check 2: On the File menu of the application, select Select Source and
select the machine.

Important

Do not select the model name that includes WIA in it.

Note

The operation may differ depending on the application.

Check 3: Start from a TWAIN-compliant application.
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Driver) Screen Does Not Appear

Error Message Appears and the ScanGear (Scanner Driver)
Screen Does Not Appear

Check 1: Make sure that the machine is turned on.

Check 2: Connect the USB cable to a different USB port on the computer.

Check 3: If the USB cable is connected to a hub, remove it from the hub
and connect it to a USB port on the computer.

Check 4: Make sure that the MP Drivers is installed.

If it is not installed, insert the Setup CD-ROM  into the computer's disc drive, then select Custom Install
and install MP Drivers.

Check 5: On the File menu of the application, select Select Source and
select the machine.

Note

The operation may differ depending on the application.

Check 6: Make sure that the application is TWAIN-compliant.

You cannot open ScanGear (scanner driver) from applications not supporting TWAIN.

Check 7: Exit ScanGear (scanner driver) if it is running on another
application.
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Scan Quality (Image Displayed on the Monitor) Is Poor

Check 1: Increase the scanning resolution.

Resolution

Check 2: Set the scale to 100%.

Some applications do not display images clearly if the image is too small.

Check 3: If moire (stripe pattern) appears, take the following measures and

scan again.

On the Basic Mode tab of ScanGear (scanner driver), select Magazine(Color) in Select Source.

Basic Mode Tab

On the Advanced Mode tab of ScanGear (scanner driver), set Descreen in Image Settings to ON.

Image Settings

Note

If moire appears when you scan a digital print photo, take the above measures and scan again.

If you use MP Navigator EX, set Document Type to Magazine(Color) or enable Descreen in the Scan

Settings dialog box and scan again.

Scan Settings Dialog Box (Photos/Documents)

Check 4: Check the monitor's color depth.

From the Start menu, select Control Panel > Appearance and Personalization > Adjust screen resolution

to open the Display Settings dialog box. Set the color depth to Medium (16 bit) or Highest (32 bit).

Windows XP:

From the Start menu, select Control Panel > Display to open the Display Properties dialog box. On

the Settings tab, set Colors to Medium (16 bit) or Highest (32 bit).

Windows 2000:

From the Start menu, select Settings > Control Panel > Display to open the Display Properties dialog

box. On the Settings tab, set Colors to High Color (16 bit) or True Color (32 bit).

Check 5: Clean the Platen and Document Cover.

Cleaning the Platen Glass and Document Cover

Check 6: If the document is in poor condition (dirty, faded, etc.), use

Reduce Dust and Scratches, Fading Correction, Grain Correction, etc. in
Image Settings on the Advanced Mode tab of ScanGear (scanner driver).

Image Settings

Check 7: If the color tone of images is different from the original document,

take the following measures and scan again.

On the Advanced Mode tab of ScanGear (scanner driver), set Image Adjustment in Image Settings to

None.

Image Settings

Open the Preferences dialog box from the Advanced Mode tab of ScanGear (scanner driver) and set

Color Matching on the Color Settings tab.

Color Settings Tab
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Scanned Image Is Surrounded by Extra White Areas

Check: Specify the scan area.

Click  (Auto Crop) in ScanGear (scanner driver) to automatically display the cropping frame (scan

area) according to the document size. You can also manually specify the scan area, for example when

there are white margins along the document or when you want to create custom cropping frames.

Adjusting Cropping Frames
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Cannot Scan Multiple Documents at One Time

Check 1: Make sure that the documents are placed correctly on the Platen.

Placing Documents

Check 2: Scan each item individually.

Some applications do not support multiple image scanning.

Page top

Page 845 of 949 pagesCannot Scan Multiple Documents at One Time



Advanced Guide  > Troubleshooting > Problems with Scanning  > Cannot Scan Properly in Auto Scan Mode

Cannot Scan Properly in Auto Scan Mode

Check 1: Make sure that the documents are placed correctly on the Platen.

Placing Documents

Check 2: Multiple image scanning may not be supported.

Some applications do not support multiple image scanning. In that case, scan each item individually.
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Slow Scanning Speed

Check 1: To view the image on a monitor, set the output resolution to
around 150 dpi. To print, set it to around 300 dpi.

Resolution

Check 2: Set Fading Correction, Grain Correction, etc. to None.

Image Settings

Check 3: In MP Navigator EX, deselect the Correct slanted document

checkbox and scan again.

Scan Settings Dialog Box

Check 4: In MP Navigator EX, deselect the Detect the orientation of text
documents and rotate images checkbox and scan again.

Scan Settings Dialog Box
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"There is not enough memory." Message Is Displayed

Check 1: Exit other applications and try again.

Check 2: Reduce the resolution or output size and scan again.

Resolution
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Computer Stops Operating during Scanning

Check 1: Restart the computer, reduce the output resolution in ScanGear
(scanner driver) and scan again.

Check 2: Delete unnecessary files to obtain sufficient free hard disk space,
then scan again.

Error message may appear if there is not enough hard disk space to scan and save, when the image

size is too large (such as when scanning a large document at high resolution.)

Check 3: For Location of Temporary Files in MP Navigator EX, specify a
folder on a drive with sufficient free space.

General Tab

Check 4: Multiple devices may be connected to USB ports.

Disconnect other devices.
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Scanner Does Not Work After Upgrading Windows

Check: Disconnect the machine from the computer, then uninstall and
reinstall the MP Drivers and MP Navigator EX.

Step 1: Uninstall the MP Drivers.

See "Deleting the Unnecessary MP Drivers " for details.

Step 2: Uninstall MP Navigator EX.

1. From the Start menu, select (All) Programs > Canon Utilities > MP Navigator EX 3.0 > MP

Navigator EX Uninstall.

2. When a confirmation appears, click Yes.

3. When uninstallation is complete, click OK.

MP Navigator EX is uninstalled.

Step 3: Reinstall the MP Drivers and MP Navigator EX.

Insert the Setup CD-ROM  into the computer's disc drive, then select Custom Install and reinstall the
MP Drivers and MP Navigator EX.
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Software Problems

E-mail Software Program You Want to Use Does Not Appear in the Screen for Selecting an E-mail

Software Program

Scanned Image Is Printed Enlarged (Reduced)

Scanned Image Is Enlarged (Reduced) on the Computer Monitor

Scanned Image Does Not Open
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in the Screen for Selecting an E-mail Software Program

E-mail Software Program You Want to Use Does Not Appear in
the Screen for Selecting an E-mail Software Program

Check 1: MP Navigator EX may not support the e-mail software program.

The following e-mail software programs are supported. (Image are attached to the mail message
automatically.)

- Windows Mail (Windows Vista)

- Outlook Express (Windows XP/Windows 2000)

- Microsoft Outlook

Check 2: If an e-mail software program does not operate properly, check
that the program's MAPI is enabled.

To enable MAPI, refer to the manual of the e-mail software program.

Check 3: If using an e-mail software program other than the ones listed
above, select None (Attach Manually) when prompted to select a program
and attach the scanned image manually.
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Scanned Image Is Printed Enlarged (Reduced)

Check: Set the printing size in the application.
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Monitor

Scanned Image Is Enlarged (Reduced) on the Computer
Monitor

Check 1: Change the display setting in the application.

You cannot reduce the display size in "Paint." To reduce the display size, open the images in an

application.

For details, refer to the application's manual. If you have any questions, contact the manufacturer of the

application.

Check 2: Change the resolution setting in ScanGear (scanner driver) and
scan again.

The higher the resolution, the larger the resulting image will be.

Resolution
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Scanned Image Does Not Open

Check: If the file format is not supported by the application, scan the image

again and save it in a popular file format such as JPEG.

For details, refer to the application's manual. If you have any questions, contact the manufacturer of the

application.
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MP Navigator EX Problems

Cannot Scan at the Correct Size

Position or Size of the Image Cannot be Detected Correctly When Scanning Using the Operation Panel

Document Is Placed Correctly, but the Scanned Image Is Slanted

Document Is Placed Correctly, but the Orientation Changes in the Scanned Image
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Cannot Scan at the Correct Size

Check 1: Make sure that the documents are placed correctly on the Platen.

Placing Documents

Check 2: Set Document Size to the actual document size and scan again.

If the matching size is not found, scan at a larger size and trim the image.

See the Toolbar (Trimming) in " Correct/Enhance Images Window " for details.

Page top

Page 857 of 949 pagesCannot Scan at the Correct Size



Advanced Guide  > Troubleshooting > MP Navigator EX Problems > Position or Size of the Image Cannot be Detected

Correctly When Scanning Using the Operation Panel

Position or Size of the Image Cannot be Detected Correctly
When Scanning Using the Operation Panel

Check 1: Make sure that the documents are placed correctly on the Platen.

Placing Documents

Check 2: Check that the MP Navigator EX settings are correctly set
according to the document.

If you cannot scan properly with Auto Scan using the Operation Panel, specify the document type on the

Scanner Button Settings tab of the Preferences dialog box.

Scanner Button Settings Tab (Save)

Page top

Page 858 of 949 pagesPosition or Size of the Image Cannot be Detected Correctly When Scanning U...



Advanced Guide  > Troubleshooting > MP Navigator EX Problems > Document Is Placed Correctly, but the Scanned Image

Is Slanted

Document Is Placed Correctly, but the Scanned Image Is
Slanted

Check: In MP Navigator EX, deselect the Correct slanted document

checkbox and scan again.

Scan Settings Dialog Box (Photos/Documents)

Page top

Page 859 of 949 pagesDocument Is Placed Correctly, but the Scanned Image Is Slanted



Advanced Guide  > Troubleshooting > MP Navigator EX Problems > Document Is Placed Correctly, but the Orientation

Changes in the Scanned Image

Document Is Placed Correctly, but the Orientation Changes in
the Scanned Image

Check: In MP Navigator EX, deselect the Detect the orientation of text
documents and rotate images checkbox and scan again.

Scan Settings Dialog Box (Photos/Documents)
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If You Cannot Resolve the Problem

If you cannot resolve the problem with any of the workarounds in this chapter, please contact the seller of

the machine or the service center.

Canon support staff are trained to be able to provide technical support to satisfy customers.

Caution

If the machine emits any unusual sound, smoke, or odor, turn it off immediately. Unplug the power

cord from the outlet and contact the seller or the service center. Never attempt to repair or

disassemble the machine yourself.
Attempts by customers to repair or take apart the machine will invalidate any warranty regardless of

whether the warranty has expired.

Before contacting the service center, confirm the following:

Product name:

* Your machine's name is located on the front cover of the setup manual.

Serial number: please refer to the setup manual

Details of the problem
What you tried to solve the problem, and what happened
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FAQs

No Printing Results/Printing Is Blurred/Colors Are Wrong/White Streaks

Machine Moves But Ink Is Not Ejected

Cannot Install the MP Drivers

Printing Does Not Start

Copying/Printing Stops Before It Is Completed

Writing Error/Output Error/Communication Error

Print Results Not Satisfactory

Paper Jams

Paper Does Not Feed Properly
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Instructions for Use (Printer Driver) 

This printer driver is subject to the following restrictions. Keep the following points in mind when using
the printer driver. 

Restrictions on the Printer Driver 

Depending on the document type to be printed, the paper feed method specified in the printer driver
may not operate correctly.

If this happens, open the printer driver setup screen from the Print dialog box of the application

software, and check the setting in the Paper Source field on the Main tab. 

With some applications, the Copies setting in the Page Setup tab of the printer driver may not be

enabled.
In this case, use the copies setting in the Print dialog box of the application software. 

If the selected Language in the About dialog box does not match the operating system interface

language, the driver screen may not be displayed properly. 

Do not change the Advanced tab items of the printer properties. If you change any of the items, you

will not be able to use the following functions correctly.

Also, if Print to file is selected in the Print dialog box of the application software and with applications

that prohibit EMF spooling, such as Adobe Photoshop LE and MS Photo Editor, the following

functions will not operate. 

Preview before printing on the Main tab 

Prevent loss of print data in the Print Options dialog box 

Page Layout, Poster, Booklet, Duplex Printing (manually), Specify Margin..., Print from Last Page,

Collate, and Stamp/Background... on the Page Setup tab 

Since the resolution in the preview display differs from the printing resolution, text and lines in the

preview display may appear different from the actual print result. 

With some applications, the printing is divided into multiple print jobs.

To cancel printing, delete all divided print jobs. 

If image data is not printed correctly, display the Print Options dialog box from the Page Setup tab

and change the setting of Disable ICM required from the application software. This may solve the

problem. 

When you use the Bluetooth option and perform one of the actions listed below, the print job may not

end and "Printing" may remain displayed on the status monitor even after printing ends and the

printout is ejected. If this happens, either click the Cancel Printing button on the status monitor or

cancel that print job from the print job queue of the printer. 

When you move the machine during printing to a location where radio waves cannot reach or

when the radio wave status becomes poor 

When you turn off the machine 

When you are using a Bluetooth printer and you cancel printing after a printer error occurs, you may

not be able to execute subsequent printing operations. If this happens, turn off the machine and turn

it back on again. 

When you are using Bluetooth, you cannot use the operation panel on the machine while the status

monitor is displayed from View Printer Status... on the Maintenance tab. 

Software windows may not appear correctly on Windows Vista when fonts are set to Larger scale.

When you want to display the windows with Larger scale fonts, set the desktop theme to Windows

Classic as follows: 
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1. Select Control Panel from the Start menu. 

2. Select Appearance and Personalization -> Personalization -> Theme.

The Theme Settings dialog box opens. 

3. At the Theme Settings dialog box, click the Themes tab, and select Windows Classic from

Theme. 

4. Click OK.

Desktop changes to Windows Classic display. 

Do not start up the Canon IJ Network Tool while printing. 

Do not print when the Canon IJ Network Tool is running. 

The card slot (memory card) of the machine may become inaccessible. In such cases, restart the

machine or turn it off and reconnect the USB cable. 

Points to Note with Applications 

There are following restrictions in Microsoft Word (Microsoft Corporation). 

When Microsoft Word has the same printing functions as the printer driver, use Word to specify

them. 

When selecting Scaled, Fit-to-Page, or Page Layout from the Page Layout list on the Page Setup

tab, the selected printing function may not be effective, depending on the version of Word.

If this happens, follow the procedure below. 

1. Open Word's Print dialog box. 

2. Open the printer driver setup window, specify Page Layout on the Page Setup tab, and click
OK. 

3. Without starting printing, close the Print dialog box. 

4. Open Word's Print dialog box again. 

5. Open the printer driver setup window again and click OK. 

6. Start printing. 

Illustrator/Adobe Systems Inc.

If bitmap printing takes effect, printing may take time or some data may not be printed. Print after

unchecking the Bitmap Printing check box in the Print dialog box. 
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General Notes (Scanner Driver)

ScanGear (scanner driver) is subject to the following restrictions. Keep these points in mind when using
it.

Scanner Driver Restrictions

When using the NTFS file system, the TWAIN data source may not be invoked. This is because the

TWAIN module cannot be written to the winnt folder for security reasons. Contact the computer's

administrator for help.

Some computers (including laptops) connected to the machine may not resume correctly from

standby mode. In that case, restart the computer.

Do not connect two or more machines or multifunction printers with scanner function to the same
computer simultaneously. If multiple scanning devices are connected, you cannot scan from the

Operation Panel of the machine and also may experience errors while accessing the devices.

Software screens may not appear correctly on Windows Vista when font size is set to Larger scale. If

you want to display the screens with Larger scale fonts, change the theme in Appearance and

Personalization to Windows Classic as follows:
1. From the Start menu, select Control Panel.

2. Select Appearance and Personalization > Personalization > Theme.

The Theme Settings dialog box opens.

3. On the Themes tab of the Theme Settings dialog box, select Windows Classic under Theme.
4. Click OK.

Desktop changes to Windows Classic view.

Use the default display font size of the OS. Otherwise, software screens may not appear correctly.

Scanning may fail if the computer has resumed from sleep or standby mode. In that case, follow

these steps and scan again.
1. Turn off the machine.

2. Exit ScanGear (scanner driver), then disconnect the USB cable from the computer and reconnect
it.

3. Turn on the machine.

ScanGear (scanner driver) cannot be opened in multiple applications at the same time. Within an

application, ScanGear (scanner driver) cannot be opened for the second time when it is already

open.

Be sure to close the ScanGear (scanner driver) window before closing the application.

With network connection, the machine cannot be accessed from multiple computers at the same

time.

With network connection, scanning takes longer than usual.

Make sure that you have adequate disk space available when scanning large images at high
resolutions. For example, at least 300 MB of free space is required to scan an A4 document at 600

dpi in full-color.

ScanGear (scanner driver) and WIA driver cannot be used at the same time.

Do not enter the computer into sleep or hibernate state during scanning.

Calibration may take time if the machine is connected via USB 1.1.

Applications with Restrictions on Use

If you start Media Center included in Windows XP Media Center Edition 2005, you may not be able to

scan using the Operation Panel of the machine. In that case, restart the computer.
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You cannot scan images with Media Center included in Windows Vista and Windows XP Media

Center Edition 2005. Scan with other applications such as MP Navigator EX.

In some applications, you may encounter a problem when you switch to thumbnail view in the

Advanced Mode tab of ScanGear (scanner driver). In that case, scan each document individually,

changing Paper Size according to the document.

In some applications, if you select the View scanned images checkbox in the Auto Scan Mode tab of

ScanGear (scanner driver), the window displaying the thumbnails of the scanned images may close

automatically.

Some applications may not display the TWAIN user interface. In that case, refer to the application's

manual and change the settings accordingly.

Some applications do not support continuous scanning of multiple documents. In some cases, only

the first scanned image is accepted, or multiple images are scanned as one image.

When scanning platen size images into a Microsoft Office application (such as Word, Excel or

PowerPoint), click Custom Insert in the Insert Picture from Scanner or Camera screen. Otherwise,

images may not be scanned correctly.

Images may not be scanned correctly in some applications. In that case, increase the operating

system's virtual memory and retry.

When image size is too large (such as when scanning large images at high resolution), your

computer may not respond or the progress bar may remain at 0% depending on the application. In

that case, cancel the action (for example by clicking Cancel on the progress bar), then increase the

operating system's virtual memory or reduce the image size/resolution and retry. Alternatively, scan

the image via MP Navigator EX first, then save and import it into the application.
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Appendix 

Printing Area

How to Detach/Attach the Document Cover

Deleting the Undesired Print Job

Updating the MP Drivers

Uninstalling the On-Screen Manuals

Transporting the Machine

Opening the Printer Properties Dialog Box (Windows)

Opening the Page Setup and Print Dialog Box (Macintosh)

Opening the Canon IJ Printer Utility (Macintosh)
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Printing Area

To ensure the best print quality, the machine allows a margin along each edge of media. The actual

printable area will be the area inside these margins.

Recommended printing area : Canon recommends that you print within this area.

Printable area : The area where it is possible to print.

However, printing in this area can affect the print quality or the paper feed precision.

Note

Borderless Printing
By selecting Borderless Printing option, you can make prints with no margins.
When performing Borderless Printing, slight cropping may occur at the edges since the printed

image is enlarged to fill the whole page.

For Borderless Printing, use the following paper:

Glossy Photo Paper "Everyday Use" GP-501

Photo Paper Glossy GP-502

Photo Paper Plus Semi-Gloss SG-201

Photo Paper Pro Platinum PT-101

Photo Paper Plus Glossy II PP-201

Photo Paper Pro II PR-201
Matte Photo Paper MP-101

Performing Borderless Printing on any other type of paper may substantially reduce printing

quality and/or result in printouts with altered color hues.

Borderless Printing on plain paper may result in printouts with reduced quality. Use them only

for test printing. You can perform Borderless Printing on plain paper only when printing from

your computer.

Borderless Printing is not available for legal, A5, or B5 sized paper, or envelopes.

Depending on the type of paper, Borderless Printing may reduce the print quality at the top and

bottom edges of the paper or cause these parts to become smudged.

With performing Automatic Duplex Printing and Duplex (Two-sided) Copying, the printable area will

be 0.08 inches / 2 mm smaller at the top margin.
When performing Borderless Printing in copy or easy photo reprint mode, you can specify the

amount of images that extends off the paper by Extended copy amount in Print settings under

Device settings.

Changing the Machine Settings on the LCD

Letter, Legal

Envelopes

Other Sizes than Letter, Legal, Envelopes
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Other Sizes than Letter, Legal, Envelopes

Size Printable Area (width x height)

A5 5.56 x 7.95 inches / 141.2 x 202.0 mm

A4 8.00 x 11.38 inches / 203.2 x 289.0 mm

B5 6.90 x 9.80 inches / 175.2 x 249.0 mm

4" x 6" / 10 x 15 cm 3.73 x 5.69 inches / 94.8 x 144.4 mm

4" x 8" / 10 x 20 cm* 3.73 x 7.69 inches / 94.8 x 195.2 mm

5" x 7" / 13 x 18 cm 4.73 x 6.69 inches / 120.2 x 169.8 mm

8" x 10" / 20 x 25 cm 7.73 x 9.69 inches / 196.4 x 246.0 mm

Wide 3.73 x 6.80 inches / 94.8 x 172.6 mm

* This page size can be used only when printing from your computer.

Recommended printing area

Printable area

Page top

Page 869 of 949 pagesOther Sizes than Letter, Legal, Envelopes



Advanced Guide  > Appendix > Printing Area > Letter, Legal

Letter, Legal

Size Printable Area (width x height)

Letter 8.00 x 10.69 inches / 203.2 x 271.4 mm

Legal* 8.00 x 13.69 inches / 203.2 x 347.6 mm

* This page size can be used only when printing from your computer.

Recommended printing area

Printable area
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Envelopes

Size Recommended Printing Area (width x height)

European DL* 4.06 x 7.07 inches / 103.2 x 179.6 mm

US Comm. Env. #10* 3.86 x 7.91 inches / 98.0 x 200.9 mm

* This page size can be used only when printing from your computer.

Recommended printing area
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How to Detach/Attach the Document Cover

Detaching the Document Cover:

Hold up the Document Cover vertically and then pull up it.

Attaching the Document Cover:

Fit both hinges (A) of the Document Cover into the holder (B) and insert both hinges of the Document

Cover vertically as illustrated below.
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Deleting the Undesired Print Job 

If the printer does not start printing, the print job data cancelled or failed may be remaining.

Delete the undesired print job by using the Canon IJ Status Monitor. 

1. Display the Canon IJ Status Monitor 

Click the status monitor button displayed on the task bar.

The Canon IJ Status Monitor appears. 

2. Display the print jobs 

Click Display Print Queue....

The print queue window opens. 

3. Delete the print jobs 

Select Cancel All Documents from the Printer menu.

When the confirmation message appears, click Yes. 

The deletion of the print job is complete. 

Important 

Users who have not been granted access permission for printer management cannot delete the

print job of another user. 

Note 

When you perform this operation, all print jobs are deleted. If the print queue list contained a

necessary print job, start the printing process over from the beginning. 
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Updating the MP Drivers 

Obtaining the Latest MP Drivers

Deleting the Unnecessary MP Drivers

Before Installing the MP Drivers

Installing the MP Drivers
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Obtaining the Latest MP Drivers 

The MP Drivers include a printer driver and scanner driver (ScanGear). 

By updating the MP Drivers to the latest version of the MP Drivers, unresolved problems may be solved. 

Access our web site through the Internet and download the latest MP Drivers for your model. 

Important 

You can download the MP Drivers for free, but any Internet access charges incurred are your

responsibility. 
Before installing the latest MP Drivers, delete the previously installed version.

For information on how to delete the MP Drivers, see " Deleting the Unnecessary MP Drivers ." 

Related Topics 

Before Installing the MP Drivers

Installing the MP Drivers
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Deleting the Unnecessary MP Drivers 

The MP Drivers you no longer use can be deleted.

When deleting the MP Drivers, first exit all programs that are running. 

The procedure to delete the unnecessary MP Drivers is as follows: 

When There is an Uninstaller 

1. Start the uninstaller 

In Windows Vista, select the Start menu -> All Programs -> "Your model name" -> MP Drivers

Uninstaller. 

In Windows XP, select the start menu -> All Programs -> "Your model name" -> MP Drivers

Uninstaller. 

In Windows 2000, select the Start menu -> Programs -> "Your model name" -> MP Drivers

Uninstaller. 

The MP Drivers Uninstaller dialog box is displayed. 

Important 

In Windows Vista, a confirmation/warning dialog box may appear when installing, uninstalling

or starting software.

This dialog box appears when administrative rights are required to perform a task.
When you are logged on to an administrator account, click Continue or Allow to continue.

Some applications require an administrator account to continue. When you are logged on to a

standard account, switch to an administrator account, and restart the operation from the

beginning. 

2. Execute the uninstaller 

Click Execute. When the confirmation message appears, click Yes.

When all the files have been deleted, click Complete. 

The deletion of the MP Drivers is complete. 

Important 

Printer driver and scanner driver (ScanGear) will be deleted when you uninstall the MP Drivers. 

When There is No Uninstaller 

When there is no uninstaller in the Start menu of Windows Vista, follow these steps: 

1. Select the printer to be deleted 

Select the Start menu -> Control Panel -> Hardware and Sound -> Printers.

Click the model to delete, then press the Alt key on your keyboard. On the File menu, click Delete. 

2. Delete the printer 

When the User Account Control dialog box appears, click Continue. Then when the confirmation

message appears, click Yes.
The icon is deleted. 

3. Select the printer driver to be deleted 
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Press the Alt key. On the File menu, select Run as administrator, and then click Server Properties....

When the User Account Control dialog box appears, click Continue. 

Click the Drivers tab. In the Installed printer drivers list, click the printer to delete. 

4. Delete the printer driver 

When you click Remove..., Remove Driver And Package dialog box is displayed.

Select Remove driver and driver package, and then click OK.

In the confirmation dialog box, click Yes. 

When data collection is completed in the Remove Driver Package dialog box, click Delete. 

5. Click OK 

The deletion of the printer driver is complete. 

Important 

You may not be able to delete the printer driver properly from the Installed printer drivers list.

If this happens, restart your computer, and try again. 
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Before Installing the MP Drivers 

This section describes the items that you should check before installing the MP Drivers. You should also
refer to this section if the MP Drivers cannot be installed. 

Checking the Machine Status 

Properly connect the personal computer and the machine. For details on connection instructions,

refer to the "Setup the Machine and the Computer" in the manual: Getting Started. 

Turn off the machine. 

Checking the Personal Computer Settings 

Terminate all running applications. 

In Windows Vista, log on as a user who has the administrator rights.

In Windows XP, log on as the computer administrator.

In Windows 2000, log on as a member of the Administrators group. 

Note 

When an old version of the MP Drivers is already installed, first delete (uninstall) that version. For

instructions on deleting the MP Drivers, see " Deleting the Unnecessary MP Drivers ." 

Related Topics 

Obtaining the Latest MP Drivers

Installing the MP Drivers
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Installing the MP Drivers 

You can access our web site through the Internet and download the latest MP Drivers for your model. 

The procedure for installing the downloaded MP Drivers is as follows: 

1. Turn off the machine 

Important 

When you turn on the computer while the machine is on, the Windows Plug and Play function is

executed automatically, and the Found New Hardware window (Windows Vista) or Found New

Hardware Wizard window (Windows XP, Windows 2000) is displayed. In this case, click

Cancel. 

2. Start the installer 

Double-click the icon of the downloaded file.

The installation program starts. 

Important 

In Windows Vista, a confirmation/warning dialog box may appear when installing, uninstalling

or starting software.

This dialog box appears when administrative rights are required to perform a task.

When you are logged on to an administrator account, click Continue or Allow to continue.

Some applications require an administrator account to continue. When you are logged on to a

standard account, switch to an administrator account, and restart the operation from the

beginning. 

3. Install the driver 

At the Welcome window, click Next.

Read the contents of the License Agreement window. After checking the contents, click Yes.

Installation of the MP Drivers begins. 

After the Installation Complete window is displayed, check that the machine and the computer are

connected through a cable. 

When the machine is connected directly to the network, follow the procedure below to select the

connection destination. 

1. Check the Select printer port check box, and click Manual Selection. 

2. At the Select Port window, select printer output port (FILE) as connection destination, and then
click OK. 

4. Complete the installation 

Click Complete.
Turn on the machine, and wait awhile until the connection is recognized. 

When you are using a USB connection, the installation of the MP Drivers is complete. 

Depending on the environment you are using, a message prompting you to restart the computer may be

displayed. To complete the installation properly, restart the computer. 

If a problem occurs, such as not being able to scan through a network connection, reinstall Canon IJ

Network Tool. To do so, download the latest Canon IJ Network Tool from our web site, and then set up

the software. 

Important 

You can download the MP Drivers for free, but any Internet access charges incurred are your
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responsibility. 

Related Topics 

Obtaining the Latest MP Drivers

Before Installing the MP Drivers
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Uninstalling the On-Screen Manuals

Follow the procedure below to uninstall all of the installed on-screen manuals from your computer.

All of the installed on-screen manuals will be deleted at the same time.

1. Click Start > All Programs (Programs in Windows 2000) > Canon XXX Manual

(where "XXX" is your machine's name) > Uninstall.

2. Click OK when the confirmation message appears.

Note

When the message prompting you to restart your computer is displayed, click OK to restart your

computer.

On-screen manuals other than printer driver's help and scanner driver's help are uninstalled at a time.

1. Select Applications on the Go menu.

2. Double-click the Canon Utilities folder, and then the IJ Manual folder.

3. Drag the folder of your machine's name into the trash.

4. Drag the  Canon XXX On-screen Manual icon (where " XXX" is your machine's
name) on your desktop into the trash.
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Transporting the Machine

When relocating the machine, pack the machine using the original packing materials.

If you do not have the original packing materials, pack the machine carefully using protective material

and place it inside a sturdy box.

Important

Do not transport or store the machine slanted, vertically, or upside-down, as the ink may leak and

damage the machine.

1. Turn the machine off.

2. Confirm that the Power lamp is off and unplug the machine.

Important

Do not unplug the machine while the Power lamp is lit or flashing green, as it may cause

malfunction or damage to the machine, making the machine unable to print.

3. Retract the Paper Support and the Output Tray Extension, close the Paper Output
Tray, then close the Operation Panel.

4. Disconnect the printer cable from the computer and from the machine, and then
disconnect the power plug from the machine.

5. Use adhesive tape to secure all the covers on the machine to keep them from
opening during transportation. Then pack the machine in the plastic bag.

6. Attach the protective material to the machine when packing the machine.

Important

Pack the machine with the Print Head and ink tanks left installed in the machine.

Note

Clearly label the box as "FRAGILE" or "HANDLE WITH CARE".
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Opening the Printer Properties Dialog Box (Windows)

The printer driver setup window can be displayed through the application software in use or the Start

menu of the Windows.

Open the Printer Properties Dialog Box through the Application Software

Follow the procedure below to configure print settings when printing.

1. Select the command you perform printing on the application software in use.

In general, select Print on the File menu to open the Print dialog box.

2. Select your model name and click Preferences (or Properties).

The printer properties dialog box opens.

Note

Depending on application software you use, command names or menu names may vary

and there may be more steps. For details, refer to the user's manual of your application

software.

Open the Printer Properties Dialog Box through the Start Menu

Follow the procedure below to perform maintenance operations such as print head cleaning, or to

configure print settings that are common for all application software.

1. Select items from the Start menu as shown below.

In Windows Vista, select the Start menu > Control Panel > Hardware and Sound > Printers.

In Windows XP, select the Start menu > Control Panel > Printers and Other Hardware >

Printers and Faxes.

In Windows 2000, select the Start menu > Settings > Printers.

2. Right-click your model name icon and then select Printing Preferences from the displayed

menu.

The printer properties dialog box opens.

Important

Opening the printer properties dialog box through Properties displays such tabs

regarding the Windows functions as the Ports (or Advanced) tab. Those tabs do not

appear when opening through Printing Preferences or application software. About tabs

regarding Windows functions, refer to the user's manual for the Windows.
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Opening the Page Setup and Print Dialog Box (Macintosh)

You can open the Page Setup dialog box and the Print dialog box from the application program you are

using.

Opening the Page Setup Dialog Box

Open the Page Setup dialog box to specify page (paper) settings before printing.

1. Select Page Setup... on the File menu in your application program.

The Page Setup dialog box opens.

Opening the Print Dialog Box

Open the Print dialog box to specify print settings before printing.

1. Select Print... on the File menu in your application program.

The Print dialog box opens.
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Opening the Canon IJ Printer Utility (Macintosh)

To open the Canon IJ Printer Utility, follow the procedure below.

In Mac OS X v.10.5.x

1. Select System Preferences on the Apple menu.

2. Click Print & Fax.

3. Select your machine's name in the Printers and click Open Print Queue....

The job list of your machine is displayed.

4. Click Utility.

The Printer List opens.

5. Select your machine's name in the Product list and click Maintenance.

The Canon IJ Printer Utility starts up.
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In Mac OS X v.10.4.x or Mac OS X v 10.3.9

1. Select Applications on the Go menu.

2. Double-click the Utilities folder, and then double-click the Printer Setup Utility icon.

The Printer List opens.

3. Select your machine's name in the Name list and click Utility.

4. Select your machine's name in the Product list and click Maintenance.

The Canon IJ Printer Utility starts up.
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Using Easy-PhotoPrint EX

--- Transforming Your Photos into Creative Works of Art ---

Easy-PhotoPrint EX allows you to create albums, calendars and stickers easily using photos taken with

digital cameras.

You can also print borderless photos easily.

Start Easy-PhotoPrint EX

Click Here: Easy-PhotoPrint EX

Note

See the section below for details on how to use Easy-PhotoPrint EX.

Printing with the Bundled Application Software

Create a Personalized Photo Album

Creating a personalized photo album is an easy task if you use Easy-PhotoPrint EX!

All you need to do is select which photos to use, select a layout, then load paper into your printer and

print. After you bind the printed sheets, you'll have the one and only album of your memories!

You can change the layout and background, and attach

comments to photos.

You can also select the size and orientation.
You can arrange a photo across the left and right

pages.

CHECK! 

Select a theme (background design) to create a single-themed album.

Decorate Items with Text and Frames

You can add text and frames to photos. Attach a description of the photo in an album, and add a frame to

enhance the photo's atmosphere.
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CHECK! 

Select Album to add text and frames. You cannot decorate photos with Photo Print.

Create a Calendar Using Your Favorite Photos

Create calendars easily with Easy-PhotoPrint EX. Create your own calendar using your favorite photos!

It'll be exciting to turn the calendar pages.

You can use all kinds of photos.
You can also create 2-month, 6-month and 12-month

calendars.

Create Stickers

Create stickers easily with Easy-PhotoPrint EX!

Create stickers of your favorite photos and share them with your friends!

CHECK! 

You can add text to photos.

Page 888 of 949 pagesUsing Easy-PhotoPrint EX



Page top

Page 889 of 949 pagesUsing Easy-PhotoPrint EX



Advanced Guide  > Using MP Navigator EX

Using MP Navigator EX

MP Navigator EX is an application that enables you to easily scan photos and documents. It is suitable

even for beginners.

Start MP Navigator EX

Click Here: MP Navigator EX

Note

See "Let's Try Scanning" for details on how to scan images using MP Navigator EX.

Scan Photos and Documents

You can scan easily by navigating through MP Navigator EX screens. You can also save/print scanned

images using MP Navigator EX.

Scan Small Documents at One Time

You can scan multiple small documents (photos, cards, etc.) at one time. It is useful as you do not need

to scan multiple times.

Scan Large Documents

You can easily scan documents that are larger than the Platen using MP Navigator EX. It allows you to

scan the left and right halves of a document separately and combine them back into one image.
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Scan with One-click

In One-click Mode, MP Navigator EX completes from scanning to saving, with a click of an icon. One-click

Mode also allows you to scan and save images as PDF files or attach them to e-mail automatically.

Scan and Correct/Enhance Photos

You can easily correct/enhance scanned photos using MP Navigator EX. You do not need to use other

applications.

For details on how to use MP Navigator EX, refer to " Scanning with the Bundled Application Software ."
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About Solution Menu

Quick Shortcut!! Solution Menu

Solution Menu is a menu window that provides quick access from your desktop to Canon applications,

manuals, and online product information.

Important

The number and types of buttons displayed in the window may vary depending on your printer and

region.

Starting Solution Menu

Click Here: Solution Menu

To start from desktop, see below.

Double-click the Canon Solution Menu icon on the desktop. Alternatively, from the Start menu, select (All)

Programs > Canon Utilities > Solution Menu > Solution Menu.

From the next time, Solution Menu starts when Windows starts.

If the Start Solution Menu when Windows starts checkbox at the bottom left of the window is not selected,

Solution Menu does not start when Windows starts.

Note

Solution Menu will start automatically when you install it using the Setup CD-ROM  that

accompanies the printer.

Changing the Window Size

Click  (window size: large) or  (window size: small) on the title bar to change the window size
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(large or small).

Solution Menu opens with the last used window size next time it is started.

When screen size is small

Starting an Application

1. Point to a button on the window to display the description of each application.

2. By clicking each button, the introduced application starts.

Follow the same steps to view the manuals or online product information.

Important

Internet connection is required to access the online information. Internet connection fees apply.

Exiting Solution Menu

Click  (Close) on the title bar.

Restriction on Use of Solution Menu

This software is subject to the following restriction. Keep this point in mind when using it.

All icons of the installed applications that support Solution Menu are displayed in the window. After

the installation, you cannot rearrange the icons or delete only the icons.

Page top

Page 893 of 949 pagesAbout Solution Menu



Advanced Guide  > About Network Communication 

About Network Communication 

Changing and Confirming Network Settings

Troubleshooting

Appendix

Glossary
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Changing and Confirming Network Settings 

Canon IJ Network Tool

Canon IJ Network Tool Dialog Box

Canon IJ Network Tool Menus

Changing the Settings in the Wireless LAN Sheet

Changing the WPA or WPA2 Detailed Settings

Changing the Settings in the Admin Password Sheet

Monitoring Wireless Network Status

Initializing the Network Settings of the Machine

Viewing the Modified Settings

Printing Out Network Setting Information
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Canon IJ Network Tool

The Canon IJ Network Tool is a utility that enables you to display and modify the machine network

settings. It is installed when the machine is set up.

Important

Do not start up the Canon IJ Network Tool while printing.

Do not print when the Canon IJ Network Tool is running.

If the firewall function of your security software is turned on, a message may appear warning that

Canon software is attempting to access the network. If the warning message appears, set the

security software to always allow access.

Canon IJ Network Tool has been verified to work on Windows XP, however, it does not support Fast

User Switching. It is recommended to exit Canon IJ Network Tool when switching users.

Starting up Canon IJ Network Tool

1. Double-click the  Canon IJ Network Tool shortcut icon on the desktop.

Click Start and select All programs (or Programs), Canon IJ Network Utilities, Canon IJ

Network Tool, and then Canon IJ Network Tool.
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Dialog Box

Canon IJ Network Tool Dialog Box

This section describes the items displayed on the Canon IJ Network Tool dialog box.

Important

To use the machine over LAN, make sure you have the equipment necessary for the connection

type, such as an access point.

1. Printers

The printer name, status, printer model name, and port name are displayed.

A check mark next to the printer in the Name list indicates it is set as the default printer.

Configuration changes are applied to the selected printer.

2. Update

Performs printer detection again. Click this button if the target printer is not displayed.

Important

To change the printer's network settings using the Canon IJ Network Tool, it must be
connected via a LAN.

If No Driver is displayed for the name, associate the port with the printer.

If Not Found is displayed for the status, make sure that the access point is turned on.

If the printer on a network is not detected, make sure that the printer is turned on, then click

Update. It may take several minutes to detect printers. If the printer is still detected, connect the

machine and the computer with a USB cable, then click Update.

If the printer is being used from another computer, a dialog box is displayed informing you of

this condition.

Note

This item has the same function as Refresh in the View menu.

3. Configuration

Click to configure settings of the selected printer.

Note

You cannot configure a printer that has the status Not Found.

This item has the same function as Configuration in the Settings menu.
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Menus

Canon IJ Network Tool Menus

This section describes the menus in the Canon IJ Network Tool dialog box.

1. File menu

Exit 

Exits the Canon IJ Network Tool.

2. View menu

Status 

Displays the Status dialog box to confirm the printer connection status and wireless communication

status.

Refresh 

Updates and displays the contents of Printers to the latest information.

Important

To change the printer's network settings using the Canon IJ Network Tool, it must be
connected via a LAN.

If No Driver is displayed for the name, associate the port with the printer.

If Not Found is displayed for the status, make sure that the access point is turned on.

If the printer on a network is not detected, make sure that the printer is turned on, then click

Update. It may take several minutes to detect printers. If the printer is still detected, connect the

machine and the computer with a USB cable, then click Update.

If the printer is being used from another computer, a dialog box is displayed informing you of

this condition.

Note

This item has the same function as Update in the Canon IJ Network Tool dialog box.

Network Information 

Displays the Network Information dialog box to confirm the network settings of the printer and the

computer.

Display Warning Automatically 

Enables or disables automatic display of warnings.
When this menu is selected, a warning is displayed if one or more ports are unavailable for printing.
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3. Settings menu

Configuration 

Displays the Configuration dialog box to configure settings of the selected printer.

Note

This item has the same function as Configuration in the Canon IJ Network Tool dialog box.

Associate Port 

Displays the Associate Port dialog box and you can associate a port with the printer.

This menu is available when No Driver is displayed for the selected printer. Associating a port with

the printer enables you to use it.

Maintenance 

Displays the Maintenance dialog box to revert the network settings of the printer to factory default and

to mount the Card Slot as the network drive.

4. Help menu

Help Topics 

Displays the application's online help.

About 

Displays the version of the Canon IJ Network Tool.
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in the Wireless LAN Sheet

Changing the Settings in the Wireless LAN Sheet

To change the wireless network settings of the printer, connect the printer and the computer with a USB

cable temporarily. If you modify the wireless network settings of the computer over wireless connection

without USB connection, your computer may not be able to communicate with the machine after

modifying the settings.

Note

Select Wireless LAN active in the WLAN active/inactive on the Operation Panel to change the

settings in the Wireless LAN sheet.
Changing the Machine Settings on the LCD

1. Start up the Canon IJ Network Tool.

Starting up Canon IJ Network Tool

2. Select the printer in Printers.

3. Select Configuration from the Settings menu.

4. Click the Wireless LAN tab.

Click OK after changing configuration. A dialog box is displayed asking you for confirmation before

the settings are sent to the printer. If you click Yes, the settings are sent to the printer and the

Transmitted Settings dialog box is displayed.

1. Network Type

Infrastructure 

Connects the printer to the wireless LAN with an access point.

2. SSID

The SSID of the wireless LAN is displayed.

Note

Enter the same SSID that the access point is configured to use. The SSID is case

sensitive.
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3. Search

The Search dialog box is displayed to select an access point to connect to.

Search dialog box

Note

When the Canon IJ Network Tool runs over a LAN, the button is grayed out and cannot be

selected. Connect the printer and the computer with a USB cable temporarily to change

the settings.

4. Encryption Method

Select the encryption method used over the wireless LAN.

Important

If all encryption types of the access point, printer, or computer do not match, the printer

cannot communicate with the computer. If the printer cannot communicate with the

computer after the encryption type of the printer was switched, make sure that encryption

types for the computer and the access point matches that set to the printer.
How to Set a WEP/WPA/WPA2 Key

If you connect to a network that is not protected with security measures, there is a risk of

disclosing data such as your personal information to a third party.

Do not use 

Select to disable encryption.

Use WEP 

Transmission is encrypted using a WEP key you specified.

If a WEP key has not been set, the WEP Details dialog box is displayed automatically. To

change WEP settings set before, click Configuration to display the dialog box.

WEP Details dialog box

Use WPA/Use WPA2 

Transmission is encrypted using a WPA or WPA2 key you specified.

The security has been strengthened more than WEP.
If a WPA or WPA2 key has not been set, the Authentication Type Confirmation dialog box is

displayed automatically. To change WPA or WPA2 settings set before, click Configuration to

display the WPA Details dialog box or WPA2 Details dialog box.
Changing the WPA or WPA2 Detailed Settings

5. Configuration

The detailed settings dialog box is displayed. The WEP, the WPA, or the WPA2 key selected in

Encryption Method can be confirmed and changed.

For details on WEP setting: 

WEP Details dialog box

For details on WPA or WPA2 setting: 

Changing the WPA or WPA2 Detailed Settings

6. TCP/IP Setup

Sets the IP address of the printer to be used over the LAN. Set a value appropriate for your

network environment.

Get IP address automatically 

Select this option to use an IP address automatically assigned by a DHCP server. DHCP server

functionality must be enabled on your wireless LAN router or access point.

Use next IP address 

If no DHCP server functionality is available in your setup where you use the printer or you want

to use a particular IP address, select this option to use a fixed IP address.

Search dialog box
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1. Detected Access Points

The signal strength from the access point, encryption type, name of access point, and the radio

channel can be confirmed.

Important

If you connect to a network that is not protected with security measures, there is a risk of

disclosing data such as your personal information to a third party.

Note

Signal strength is displayed as follows.

: Good

: Fair

: Poor

Type of encryption is displayed as follows.

Blank: No encryption
WEP: WEP is set

WPA: WPA is set

WPA2: WPA2 is set

2. Update

Click to update the list of access points when your target access point is not detected.

If the target access point is set to the stealth mode, click Cancel to return to the previous screen

and enter the access point's Service Set Identifier in SSID.

Note

Make sure that the access point is turned on.

3. Set

Click to set the access point's SSID in SSID on the Wireless LAN sheet.

Note

Depending on your settings, WEP Details dialog box, WPA Details dialog box, or WPA2
Details dialog box appears when you click the Set button. In the dialog box, configure the

details to use the same encryption settings set to the access point.

Access points that cannot be used by this machine (including those configured to use
different encryption methods) are displayed grayed out and cannot be configured.

WEP Details dialog box
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Specify the printer WEP settings. When changing the password (WEP key), the same change must

be made to the password (WEP key) of the access point.

1. WEP Key

Enter the same key as the one set to the access point.

The number of characters and character type that can be entered differ depending on the key

length and key format.

 Key Length

64 bit 128 bit

Key Format ASCII 5 characters 13 characters

Hexadecimal (Hex) 10 digits 26 digits

2. Key Length

Select either 64bit or 128bit.

3. Key Format

Select either ASCII or Hex.

4. Key ID

Select the Key ID (index) set to the access point.

5. Authentication

Select the authentication method to authenticate the printer's access to the access point.

Normally, select Auto. If you want to specify the method manually, select Open System or

Shared Key according to the setting of the access point.

Important

If the printer cannot communicate with the computer after the encryption type of the printer

was switched, make sure that encryption types for the computer and the access point

matches that set to the printer.
How to Set a WEP/WPA/WPA2 Key
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WPA2 Detailed Settings

Changing the WPA or WPA2 Detailed Settings

To change the wireless network settings of the printer, connect the printer and the computer with a USB

cable temporarily. If you modify the wireless network settings of the computer over wireless connection

without USB connection, your computer may not be able to communicate with the machine after

modifying the settings.

The example screenshots in this section refer to the WPA detailed settings.

1. Start up the Canon IJ Network Tool.

Starting up Canon IJ Network Tool

2. Select the printer in Printers.

3. Select Configuration from the Settings menu.

4. Click the Wireless LAN tab.

5. Select Use WPA or Use WPA2 in Encryption Method and click Configuration.

Go to step 7 if encryption is not set to the printer.

6. Click Change Settings.

1. Authentication Type

Displays the type of authentication used for client authentication.

This machine supports the PSK authentication method.

2. Dynamic Encryption Type

Displays the dynamic encryption method as either TKIP (Basic Encryption), or AES (Secure
Encryption).

3. Change Settings

Displays a dialog box to change WPA or WPA2 settings.

7. Check the client authentication type and click Next.
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1. Authentication Type

Type of authentication used for client authentication is displayed.

This machine supports the PSK authentication method.

PSK 

This authentication type uses a passphrase entered in the next screen.

8. Enter the passphrase, confirm the type of dynamic encryption and click Next.

1. Passphrase

Enter the passphrase set to the access point. The passphrase should be a string of 8 to 63

alphanumeric characters or a 64-digit hexadecimal value.

If you do not know the access point passphrase, refer to the manual provided with the access

point or contact its manufacturer.

2. Dynamic Encryption Type

Select the dynamic encryption method from either TKIP (Basic Encryption), or AES (Secure
Encryption).

9. Click Finish.
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Important

If the printer cannot communicate with the computer after the encryption type of the printer was

switched, make sure that encryption types for the computer and the access point matches that

set to the printer.
How to Set a WEP/WPA/WPA2 Key
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in the Admin Password Sheet

Changing the Settings in the Admin Password Sheet

1. Start up the Canon IJ Network Tool.

Starting up Canon IJ Network Tool

2. Select the printer in Printers.

3. Select Configuration from the Settings menu.

4. Click the Admin Password tab.

1. Use admin password

Set a password for the administrator with privileges to set up and change detailed options. To
use this feature, select this check box and enter a password.

Important

The password should consist of alphanumeric characters and be no longer than 32
characters. The password is case-sensitive. Do not forget the password you set.

2. Password

Enter the password to set.

3. Password Confirmation

Enter the password again for confirmation.

5. Click OK.

A dialog box is displayed asking you for confirmation before the settings are sent to the printer. If you

click Yes, the settings are sent to the printer and the Transmitted Settings dialog box is displayed.
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Network Status

Monitoring Wireless Network Status

1. Start up the Canon IJ Network Tool.

Starting up Canon IJ Network Tool

2. Select the printer in Printers.

3. Select Status from the View menu.

1. Signal Strength

Indicates the strength of the signal received by the printer, ranging from 0% to 100%.

2. Link Quality

Indicates the signal quality excluding the noise while communicating, ranging from 0% to 100
%.

Important

If the indicated value is low, move your printer closer to the wireless network device.

3. Advanced Measurement

Click to examine the connection performance between the printer and the access point. Follow

the instructions on the screen to start measuring and display the status. Measurement takes a

few minutes.

When  is displayed in Connection Performance between the Printer and the Access Point,

the printer can communicate with the access point. Otherwise, refer to displayed comments

and Help for improving the status of communication link.

Note

If any messages appear on Overall Network Performance, move the machine and access

point as instructed to improve the performance.
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Settings of the Machine

Initializing the Network Settings of the Machine

Important

Note that initialization erases all network settings on the machine, and printing or scanning

operation from a computer over network may become impossible. To use the machine over

network, refer to the setup manual of the machine to set up the machine again.

1. Start up the Canon IJ Network Tool.

Starting up Canon IJ Network Tool

2. Select the printer in Printers.

3. Select Maintenance from the Settings menu.

1. Setting Initialization

Initialize 

Reverts all the network settings of the printer to factory default. Click Initialize to display the

Initialize Settings dialog box and click Yes to initialize the network settings of the printer. Do not

turn off the printer during initialization. Click OK when initialization is complete.

Performing initialization when connected over wireless LAN will break the connection, so refer

to your setup manual of the machine to set up the machine again.

2. Network Setup of the Card Slot

Displays the status of the Card Slot. For details on how to mount the Card Slot as a network

drive, see Using the Card Slot over a Network .

Note

You can change the network settings of the printer using Canon IJ Network Tool with USB

connection after initializing the LAN settings. To change the network settings using Canon IJ
Network Tool, set WLAN active/inactive in Device settings to Wireless LAN active.
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Settings

Viewing the Modified Settings

The Confirmation dialog box is displayed when you modified the printer settings on the Configuration

dialog box. When you click Yes on the Confirmation dialog box, the following screen is displayed for

confirming the modified settings.

1. Settings

A list of changes made in the Configuration dialog box is displayed.
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Setting Information

Printing Out Network Setting Information

You can print out the network settings of the machine such as its IP address and SSID.

Important

This print out contains valuable information about your computer. Handle it with care.

1. Make sure that the machine is turned on.

2. Load a sheet of A4 or Letter-sized plain paper in the Cassette.

3. Select  Settings on the HOME screen, then press the OK button.

4. Select  Device settings, then press the OK button.

5. Select LAN settings, then press the OK button.

6. Select Confirm LAN settings, then press the OK button.

7. Select Print LAN details, then press the OK button.

8. Select Yes, then press the OK button.

The following information on the machine's network setting is printed out.

Item Explanations of the item Setting

Wireless LAN Wireless LAN Enable/Disable

Link Status Status of the Wireless LAN Active/Inactive

MAC Address MAC Address XX:XX:XX:XX:XX:XX

SSID SSID SSID of the wireless LAN

Connection Mode Connection Mode Infrastructure

Channel Channel XX (1 to 13)

Encryption Method of the Encryption none/WEP/TKIP/AES

WEP Key Length WEP Key Length Inactive/128/64

Authentication Method of the Authentication auto/open/shared/WPA-PSK/WPA2-PSK

Signal Strength Signal Strength 0 to 100 [%]

TCP/IP Version TCP/IP Version IPv4/IPv6

IP Address Selected IP Address XXX.XXX.XXX.XXX

Default Gateway Default Gateway XXX.XXX.XXX.XXX

Subnet Mask*1 Subnet Mask XXX.XXX.XXX.XXX

Subnet Prefix

Length*2

Subnet Prefix Length XXX

IPsec*3 IPsec setting Active

Security Protocol*3 Method of the Security Protocol ESP/ESP & AH/AH

Printer Name Printer name Printer name (Up to 15 characters)
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Shared Memory Card Memory card sharing Enable/Disable

WSD WSD setting Enable/Disable

WSD Timeout Timeout 1/5/10/15/20 [min]

LLTD LLTD setting Enable/Disable

LPR Protocol LPR protocol setting Enable/Disable

Bonjour Bonjour setting Enable/Disable

Bonjour Service

Name

Bonjour service name Bonjour service name (Up to 52

characters)

Bonjour LPR Service Bonjour LPR service

advertising
Enable/Disable

("X" represents an alphanumeric character ranging from 0 to 9 and A to F.)

*1 Only when IPv4 is selected on IPv4/IPv6 settings, the status of the network is printed.

*2 Only when IPv6 is selected on IPv4/IPv6 settings, the status of the network is printed.

*3 Only when IPv6 is selected on IPv4/IPv6 settings and Active is selected on IPsec Settings, the

status of the network is printed.
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Troubleshooting 

Troubleshooting

How to Set a Network Key/Network Password 

Cannot Communicate With the Machine/Cannot Print from the Machine

The Following Screen Is Displayed During Setup

Printer Status Monitor of the Machine Does Not Operate

Cannot Print, Scan, or Access the Card Slot from a Computer Connected to the Network

It Takes a Long Time for Printing to Start

The Admin Password Set to the Machine Was Forgotten

Checking Information about the Network

Restoring the Machine's Network Settings to Factory Default

Updating the MP Drivers

Uninstalling the Canon IJ Network Tool/Canon IJ Network Scan Utility

Cannot Mount the Card Slot

Cannot Use the Card Slot

Cannot Access to the Memory Card in the Card Slot Using MP Navigator EX

Cannot Access to the Card Slot Because of Some Security Settings on the Computer

Date Modified of Files Changes When Saving Them on the Memory Card over Network
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Troubleshooting

This section describes troubleshooting tips for problems you may encounter when using the machine.
For troubleshooting tips related to the setup, refer to the Network Setup Troubleshooting .
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How to Set a Network Key/Network Password

Cannot Connect with an Access Point to Which a WEP/WPA/WPA2 Key Is Set (You Forgot the WEP/

WPA/WPA2 Key)

How to Set a WEP/WPA/WPA2 Key

Cannot Connect with an Access Point to Which a WEP/WPA/WPA2 Key Is Set (You Forgot

the WEP/WPA/WPA2 Key)

For information on how to set up the access point, refer to the manual provided with the access

point or contact its manufacturer. Make sure that the computer and the access point can

communicate with each other, then set up the machine to match the settings of the access point.

How to Set a WEP/WPA/WPA2 Key

Refer to the manual provided with the access point or contact its manufacturer and check the

access point settings. Make sure that the computer and the access point can communicate with
each other, then set up the machine to match the settings of the access point.

When using WEP

The key length, key format, the key to use (out of 1 to 4), and the authentication method must

match among the access point, the printer, and the computer.

For access points that use automatically generated WEP keys, use the hexadecimal key

format for the machine.

Example:

Using 64 bit key length, when the string "canon" is entered, an access point generates the

following codes.

Key 1: C9 42 28 B8 AE

Key 2: 87 C0 FB 05 6B

Key 3: 9A 15 FB F6 F3

Key 4: 62 56 67 58 44

In order to communicate with such an access point, you must configure the machine to use
the key generated by the access point by entering it in hexadecimal format.

Normally, select Auto for the authentication method. Otherwise, select Open System or

Shared Key according to the setting of the access point.

When the WEP Details dialog box appears after clicking Set on the Search dialog box, follow

the on-screen instructions and set the key length, the key format, the key number, and the
authentication to enter a WEP key.

For details, see WEP Details dialog box .

When using WPA or WPA2

The authentication method, passphrase, and dynamic encryption type must match on the

access point, the machine, and the computer.

Enter the passphrase configured on the access point (a sequence of between 8 and 63

alphanumeric characters, or a 64-character hexadecimal number).

Select either TKIP (Basic Encryption) or AES (Secure Encryption) for the dynamic encryption

method.

For details, see Changing the WPA or WPA2 Detailed Settings.

Note

This machine supports WPA-PSK (WPA-Personal) and WPA2-PSK (WPA2-Personal).

WPA-Enterprise and WPA2-Enterprise are not supported.
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Print from the Machine

Cannot Communicate With the Machine/Cannot Print from the
Machine

Cannot Communicate with the Machine after Applying MAC/IP Address Filtering or Entering a WEP/
WPA/WPA2 Key to the Access Point

Cannot Communicate with the Machine After the Network Settings Are Changed

Cannot Connect to the Target Access Point

When Encryption Is Enabled, Cannot Communicate With the Machine After the Encryption Type Was

Switched on the Access Point

Cannot Communicate with the Machine with USB Connection

Cannot Communicate with the Machine over the Network

The Machine Cannot Be Detected in the Network

Cannot Communicate with the Machine after Applying MAC/IP Address Filtering or

Entering a WEP/WPA/WPA2 Key to the Access Point

Check 1: Confirm the access point setting.

Refer to the manual provided with the access point or contact its manufacturer to confirm the

access point setting. Make sure that the computer and the access point can communicate

with each other under this setting.

Check 2: If you are performing MAC address filtering at the access point, confirm

that the MAC addresses for both the computer or the network device and the

printer are registered.

Check 3: If you are using a WEP/WPA/WPA2 key, make sure that the key for the

computer or the network device and the printer matches that set to the access

point.

Besides the WEP key itself, the key length, key format, the key ID to use, and the

authentication method must match among the machine, the access point, and the computer.

Normally, select Auto for the authentication method. If you want to specify the method

manually, select Open System or Shared Key according to the setting of the access point.

How to Set a WEP/WPA/WPA2 Key

Cannot Communicate with the Machine After the Network Settings Are Changed

Wait until the IP address is assigned to the computer. You may need to restart your computer.

Search for the printer again after confirming a valid IP address is assigned to the computer.

Cannot Connect to the Target Access Point

Check 1: Make sure that the SSID/network name of the target access point and

the machine are identical.

For the procedures to connect an access point and set it up, refer to the manual of your

access point or contact its manufacturer.

For the procedures to set up the printer, see Changing the Settings in the Wireless LAN 

Sheet.

Check 2: Make sure that Wireless LAN active is selected in the WLAN active/

inactive on the Operation Panel.

Changing the Machine Settings on the LCD
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Check 3: If a network key is set to the access point, set the machine to match it.

How to Set a WEP/WPA/WPA2 Key

Check 4: Make sure that the valid wireless channel is used.

The wireless channel to be used may be limited depending on wireless network devices
installed in the computer. Refer to the manual provided with your computer or your wireless

network device to specify the valid wireless channel.

Check 5: Make sure that the channel set to the access point is valid to

communicate with the computer, confirmed in Check 4.

If not, change the channel set to the access point.

For placement:

Make sure that there is no barrier or obstacle between the access point and the machine.

When using the printer in a multiple access point setup, make sure that the

access point to be used can communicate with the machine and the computer.

Make sure that the wireless channel of the access point is far enough away with those of

other access points.

Windows XP may automatically connect to an unintended access point. Follow the steps

below to make your access point the highest priority.

1. Select Start and Connect To.

2. Right click Wireless Network Connection and select Properties.

3. Click the Wireless Networks tab and confirm that Use Windows to configure my

wireless network settings is checked.

4. Confirm that the target access point is displayed in the Preferred networks list.

When Encryption Is Enabled, Cannot Communicate With the Machine After the Encryption

Type Was Switched on the Access Point

If the printer cannot communicate with the computer after the encryption type of the printer was

switched, make sure that encryption types for the computer and the access point matches that set
to the printer.

Cannot Communicate with the Machine after Applying MAC/IP Address Filtering or Entering a
WEP/WPA/WPA2 Key to the Access Point

Cannot Communicate with the Machine with USB Connection

Check 1: Make sure that the machine is turned on.

Check 2: Make sure that the USB cable is connected properly.

Refer to the setup manual of the machine to connect the USB cable properly.

Check 3: Do not start up the Canon IJ Network Tool while printing.

Check 4: Do not print while the Canon IJ Network Tool is running.

Check 5: Make sure that Enable bidirectional support is selected in the Ports

sheet of the properties dialog box of the printer driver.

Opening the Printer Properties Dialog Box (Windows)

Cannot Communicate with the Machine over the Network
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Check 1: Make sure that the machine is turned on.

Check 2: Is WLAN active/inactive in Device settings set to Wireless LAN active?

Changing the Machine Settings on the LCD

Check 3: Make sure that the network settings in the machine are identical with

those of the access point.

Refer to the manual provided with the access point or contact its manufacturer to check the

access point settings, and then modify the machine settings.

How to Set a WEP/WPA/WPA2 Key

Check 4: Make sure that the machine is not place as far away from the access

point.

The access point is located indoors within the effective range for wireless communication.

Locate the machine within 50 m from the access point.

Check 5: Make sure that there is no obstruction.

Wireless communication between different rooms or floors is generally poor. Adjust the

location of the devices.

Check 6: Make sure that there is no source of radio wave interference in your

vicinity.

There may be a device such as a microwave oven using the same frequency bandwidth as

the wireless station. Place the wireless devices as far away from the interference source as

possible.

Check 7: Make sure that the network settings of the computer are correct.

For the procedures to connect a network device to the computer and set them up, refer to the

manual of your network device or contact its manufacturer.

Check 8: Make sure that the radio status is good and adjust the installation

positions while monitoring the radio status with Canon IJ Network Tool.

Monitoring Wireless Network Status

Check 9: Make sure that the valid wireless channel is used.

The wireless channel to be used may be limited depending on wireless network devices
installed in the computer. Refer to the manual provided with your computer or your wireless

network device to specify the valid wireless channel.

Check 10: Make sure that the channel set to the access point is valid to

communicate with the computer, confirmed in Check 9.

If not, change the channel set to the access point.

Check 11: Make sure that the firewall of the security software is disabled.

If the firewall function of your security software is turned on, a message may appear warning

that Canon software is attempting to access the network. If the warning message appears,

set the security software to always allow access.

If using any programs that switch the network environment, check their settings. Some

programs will enable a firewall by default.

Check 12: When using a router, connect the printer and computer to the LAN

side (same network segment).

For placement:

Make sure that there is no barrier or obstacle between the access point and the machine.

The Machine Cannot Be Detected in the Network
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Check 1: Make sure that the machine is turned on.

Check 2: Make sure that the machine setup is completed.

If not, refer to your setup manual of the machine to complete the machine setup.

Check 3: When using Canon IJ Network Tool, click Update to search for the

printer again.

Canon IJ Network Tool Dialog Box

Check 4: When searching for a printer over a network, make sure that the

machine is associated with the port driver.

When No Driver is displayed under Name in the Canon IJ Network Tool, there is no

association. Select Associate Port on the Settings menu, then associate the port with the

printer.

Canon IJ Network Tool Menus

Check 5: Make sure that the network settings in the printer are identical with

those of the access point.

Refer to the manual provided with the access point or contact its manufacturer to check the

access point settings, and then modify the machine settings.

How to Set a WEP/WPA/WPA2 Key

Check 6: Make sure that there is no obstruction.

Wireless communication between different rooms or floors is generally poor. Adjust the

location of the devices.

Check 7: Make sure that the machine is not place as far away from the access

point.

The access point is located indoors within the effective range for wireless communication.

Locate the machine within 50 m from the access point.

Check 8: Make sure that there is no source of radio wave interference in your

vicinity.

There may be a device such as a microwave oven using the same frequency bandwidth as

the wireless station. Place the wireless devices as far away from the interference source as

possible.

Check 9: Make sure that the network settings of the computer are correct.

Make sure that the computer can communicate with the printer and the access point over the

wireless LAN.

Check 10: Make sure that Enable bidirectional support is selected in the Ports

sheet of the properties dialog box of the printer driver.

Opening the Printer Properties Dialog Box (Windows)

Check 11: Make sure that the firewall of the security software is disabled.

If the firewall function of your security software is turned on, a message may appear warning

that Canon software is attempting to access the network. If the warning message appears,

set the security software to always allow access.

If using any programs that switch the network environment, check their settings. Some

programs will enable a firewall by default.

Check 12: When using a router, connect the printer and computer to the LAN

side (same network segment).
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The Following Screen Is Displayed During Setup

The Enter Password Dialog Box Is Displayed During Setup

The Dialog Box for Setting the Encryption Is Displayed After Selecting the Access Point in the Search

Dialog Box

"You are connecting the machine to the non encrypted wireless network" Is Displayed

The Enter Password Dialog Box Is Displayed During Setup

The following dialog box is displayed if an administrator password is set to the machine which

has already been set up.

Enter the administrator password you have set.

Changing the Settings in the Admin Password Sheet

The Dialog Box for Setting the Encryption Is Displayed After Selecting the Access Point in

the Search Dialog Box

This dialog box is displayed automatically if the encryption settings are changed on the access

point. You need to change the machine's encryption settings to match those of the access point.

For information on the encryption settings, see Changing the Settings in the Wireless LAN Sheet .

"You are connecting the machine to the non encrypted wireless network" Is Displayed

Security is not configured on the access point. The machine can still be used, so continue the

setup procedure to complete it.

Important

If you connect to a network that is not protected with security measures, there is a risk of

disclosing data such as your personal information to a third party.
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Operate

Printer Status Monitor of the Machine Does Not Operate

Use the printer driver with bidirectional communication.

Select Enable bidirectional support in the Ports sheet of the properties dialog box of the printer driver.

Opening the Printer Properties Dialog Box (Windows)
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a Computer Connected to the Network

Cannot Print, Scan, or Access the Card Slot from a Computer
Connected to the Network

Check 1: Make sure that the network settings of the computer are

correct.
For the procedures to set up the computer, refer to the manual of your computer or contact its

manufacturer.

Check 2: If the MP Drivers is not installed, install the MP Drivers.

Insert the Setup CD-ROM  into the computer's disc drive and perform Custom Install and select MP

Drivers to install again.

Check 3: Make sure that access control is not set to the access point.

For the procedures to connect an access point and set it up, refer to the manual of your access point

or contact its manufacturer.

Note

Print out the network setting information of the computer to check whether the MAC address or

the IP address is registered or not. For details, see Checking the IP Address or the MAC

Address of the Computer .
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It Takes a Long Time for Printing to Start

Check 1: The machine may be printing out or scanning a large job

issued from another computer.

Check 2: Make sure that the radio status is good and adjust the

installation positions while monitoring the radio status with Canon IJ

Network Tool.
Monitoring Wireless Network Status

Make sure that there is no barrier or obstacle between the access point and the machine. Wireless

communication between different rooms or floors is generally poor. The metal, concrete, or timber

including the metallic material, mud wall, or insulator may interrupt a wireless communication. If the

machine cannot communicate with the computer over a Wireless LAN for the wall material, place the

machine and the computer in the same room or floor.

Check 3: Make sure that there is no source of interference in your

vicinity.
Since a device such as a microwave oven uses the same frequency bandwidth, it may cause

interference. Place the wireless devices as far away from the source of interference as possible.
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Forgotten

The Admin Password Set to the Machine Was Forgotten

Initialize the LAN settings.

Restoring the Machine's Network Settings to Factory Default

After initializing the LAN settings, refer to your setup manual of the machine to set up the machine again.
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Checking Information about the Network

Checking the IP Address or the MAC Address of the Machine

Checking the IP Address or the MAC Address of the Computer

Checking If the Computer and the Machine, or Computer and the Access Point Can Communicate

Checking the Network Setting Information

Checking the IP Address or the MAC Address of the Machine

To check the IP address or the MAC address of the machine, display the network setting

information using the Operation Panel of the machine or print out the network setting information

of the machine.

Changing the Machine Settings on the LCD

Printing Out Network Setting Information

To display the network setting information using the Canon IJ Network Tool, select Network

Information on the View menu.

Canon IJ Network Tool Menus

Checking the IP Address or the MAC Address of the Computer

To check the IP address or MAC address assigned to the computer, follow the procedure below.

1. Click Start > All Programs (or Programs) > Accessories > Command Prompt.

2. Enter "ipconfig/all" and press the Enter key.

The IP addresses and the MAC addresses of the network devices installed on your computer

are displayed. When the network device is not connected to the network, the IP address is not

displayed.

Checking If the Computer and the Machine, or Computer and the Access Point Can

Communicate

To check that communication is available, perform the ping test.

1. Display the command prompt.

Windows Vista or Windows XP 

From the Start menu, select All Programs, Accessories, and Command Prompt.

Windows 2000 

From the Start menu, select Programs, Accessories, and Command Prompt.

2. Type the ping command and the IP address of the target printer or the target access point,

and then press the Enter key.

ping XXX.XXX.XXX.XXX

"XXX.XXX.XXX.XXX" is the IP address of the target device.

If the communication is available, a message such as the following is displayed.
Reply from XXX.XXX.XXX.XXX: bytes=32 time=10ms TTL=255

When Request timed out is displayed, the communication is not available.

Checking the Network Setting Information

To check the IP address or the MAC address of the machine, display the network setting

information using the Operation Panel of the machine or print out the network setting information
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of the machine.

Changing the Machine Settings on the LCD

Printing Out Network Setting Information
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Factory Default

Restoring the Machine's Network Settings to Factory Default

Important

Note that initialization erases all network settings on the machine, and printing or scanning

operation from a computer over network may become impossible. To use the machine over

network, refer to the setup manual of the machine to set up the machine again.

Select Reset LAN settings on the Operation Panel of the machine to initialize the network setting.

Changing the Machine Settings on the LCD
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Updating the MP Drivers

Download the latest MP Drivers in advance.

After uninstalling the MP Drivers, install the latest MP Drivers according to the regular procedure. When

the connection method selection screen is displayed, select Use the printer on network. The machine

will be detected automatically in the network.

After making sure that the machine is detected, install the MP Drivers following the on-screen

instructions.

Note

You can use the machine over a LAN without performing setup again.
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Uninstalling the Canon IJ Network Tool/Canon IJ Network Scan
Utility

Uninstalling the Canon IJ Network Tool

Follow the procedure below to uninstall the Canon IJ Network Tool from your computer.

Important

Even if the Canon IJ Network Tool is uninstalled, you can print over network and scan from the

computer. However, you cannot change the network settings and use the Card Slot of the

machine over network.

Log into a user account with administrator privilege.

1. Click Start > All Programs (or Programs) > Canon IJ Network Utilities > Canon IJ
Network Tool > Uninstaller.

2. Click Yes when the confirmation message appears.

When the message prompting you to restart your computer is displayed, click OK to restart your

computer.

Note

You can also use Uninstall a program (or Add or Remove Programs, or Add/Remove

Applications) on Control Panel to uninstall the Canon IJ Network Tool.

Uninstalling the Canon IJ Network Scan Utility

Follow the procedure below to uninstall the Canon IJ Network Scan Utility from your computer.

Important

Even if the Canon IJ Network Scan Utility is uninstalled, you can print and scan from a computer

over network. However, you cannot scan over network using the Operation Panel on the

machine.
Log into a user account with administrator privilege.

1. Click Start > All Programs (or Programs) > Canon IJ Network Utilities > Canon IJ
Network Scan Utility > Uninstaller.

2. Click Yes when the confirmation message appears.

When the message prompting you to restart your computer is displayed, click OK to restart your

computer.

Note

You can also use Uninstall a program (or Add or Remove Programs, or Add/Remove

Applications) on Control Panel to uninstall the Canon IJ Network Scan Utility.
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Cannot Mount the Card Slot

The Available Drive Letter Cannot Be Selected on the Network Setup of the Card Slot Dialog Box

The Card Slot Cannot Be Mounted with the Canon IJ Network Tool

The Available Drive Letter Cannot Be Selected on the Network Setup of the Card Slot

Dialog Box

On this dialog box, only D to Z can be selected as the network drive for the Card Slot.

When the Card Slot has been set up to be used over network, you cannot select a drive letter. If you

want to assign another drive letter to the network drive for the Card Slot, disconnect it from the

network, then set up the Card Slot again using the Canon IJ Network Tool.

Using the Card Slot over a Network

The Card Slot Cannot Be Mounted with the Canon IJ Network Tool

If you cannot mount the Card Slot to use it over network with the Canon IJ Network Tool, follow the

procedure below to mount the Card Slot manually.

1. Check the Default Name of the machine by selecting Network Information on the View

menu of the Canon IJ Network Tool.

2. Click Start > All Programs > Accessories > Run.

In Windows XP and Windows 2000, click Start > Run.

3. Input "\\xxxxxxxxxxxx\", then click OK.

For example, if the Default Name is "0000000847B6\canon_memory", then input only "\\

0000000847B6\".

Note

If you cannot mount the Card Slot with the method above, input the IP address of the

machine instead of the 12 alphanumeric characters of the Default Name, and try again.
For example, "\\192.168.1.1\". If you mount the Card Slot with the IP address, you have to

remount it whenever the machine's IP address changes.

4. When the  canon_memory icon appears, right-click the icon, then select Map Network

Drive.

5. Select the drive letter, then click Finish.
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Cannot Use the Card Slot

Check 1: Is the icon of the Card Slot displayed?

To use the Card Slot over network, you have to mount the Card Slot as the network drive of the

computer.

The canon_memory (\\xxxxxxxxxxxx) (or canon_memory on `xxxxxxxxxxxx') icon with the mapped drive

letter appears on Computer (or My Computer).

"xxxxxxxxxxxx" is a string of 12 alphanumeric characters.

The icon name may vary depending on the language version of Windows you are using.

If the icon is not displayed, mount the Card Slot.

Mounting the Card Slot as the Network Drive

Check 2: Is the memory card inserted in the Card Slot?

Make sure that a memory card is inserted in the Card Slot. If it is not inserted, insert it.

For information on how to insert a memory card, refer to Printing from a Memory Card .

Check 3: Is Read/write attribute set to Writable from USB PC?

When Read/write attribute in Device settings is set to Writable from USB PC, you cannot access the

memory card over network. Set Read/write attribute to Writable from LAN PC to write data to the

memory card over network.

Changing the Machine Settings on the LCD

Check 4: Is Read/write attribute set to Not writable from PC?

When Read/write attribute in Device settings is set to Not writable from PC, you can read data on the

memory card, but cannot write data to it. To write data to the memory card in the Card Slot over

network, set Read/write attribute to Writable from LAN PC.

Changing the Machine Settings on the LCD

Check 5: To share the printer's Card Slot with multiple computers over a

network, set Set memory card sharing in Device settings to Enable.
Changing the Machine Settings on the LCD

Check 6: Is another computer writing data to the memory card?

While one computer is writing a file into the memory card, other computers cannot access the same
file. Wait for a while, then try again.
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Slot Using MP Navigator EX

Cannot Access to the Memory Card in the Card Slot Using MP
Navigator EX

If "Cannot access the memory card" is displayed when you click Memory Card under Scan/Import

Documents or Images on MP Navigator EX, confirm what the message says, then click Retry. If the

message appears again, mount the Card Slot as the network drive. For details on how to mount the

Card Slot, see Mounting the Card Slot as the Network Drive . Confirm the icon for the Card Slot appears

on Computer (or My Computer), and try to access using MP Navigator EX.
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Some Security Settings on the Computer

Cannot Access to the Card Slot Because of Some Security
Settings on the Computer

Check 1: Make sure that Read/write attribute in Device settings is set to

Writable from LAN PC.
Changing the Machine Settings on the LCD

Check 2: Make sure that the memory card is inserted in the Card Slot.

Check 3: To share the printer's Card Slot with multiple computers over a

network, set Set memory card sharing in Device settings to Enable.
Changing the Machine Settings on the LCD

Check 4: Disable the Windows Firewall function, or open port 137:139

to allow communication with the machine following the procedure

below.
For information on other security software, refer to its instruction manual or manufacturer.

Important

If you disabled the firewall function, disconnect your network from the Internet. You can do this
by configuring your access point or router not to connect to the Internet or WAN. 

To disable the Windows Firewall:

1. Click Start > Control Panel > Security > Windows Firewall > Change
settings.

In Windows XP, click Start > Control Panel > Security Center > Windows Firewall.

2. Select Off and click OK.

To open port 137:139:

1. Click Start > Control Panel > Security > Windows Firewall > Change
settings.

In Windows XP, click Start > Control Panel > Security Center > Windows Firewall.

2. Click the Exceptions tab, and click Add port.

3. On the Add a Port dialog box, input the following information, and click OK.

Name: Input any name for the port.

Port number: Input "137".
Protocol: Select TCP.

4. Repeat steps 2 and 3.

On the Add a Port dialog box, input the same information as you did in step 3 except for

selecting UDP in Protocol.
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5. Use the same procedure to open the other ports (138TCP, 138UDP,
139TCP, and 139UDP).

6. Confirm that the port names are added on the Exceptions sheet, and click
OK.

Check 5: Change the workgroup name to "WORKGROUP" following the

procedure below.

1. Right-click Computer (or My Computer), select Properties, then click Change
settings.

In Windows XP, right-click My Computer, then select Properties.

2. Click the Computer Name tab, then click Change.

3. Change the workgroup name to "WORKGROUP", then click OK.

Check 6: Disconnect the network drive for the Card Slot and mount it

again following the procedure below.

1. Right-click Computer (or My Computer), and select Disconnect Network Drive.

2. Select the network drive to disconnect, then click OK.

3. Remount the Card Slot using the Canon IJ Network Tool.

Using the Card Slot over a Network
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Them on the Memory Card over Network

Date Modified of Files Changes When Saving Them on the
Memory Card over Network

Check: Does the Canon IJ Network Scan Utility run?

If you write files to a memory card over a network when the Canon IJ Network Scan Utility is not

running, the Date Modified of the files will change. Make sure to start up the Canon IJ Network Scan

Utility before you write files to a memory card over the network.
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Appendix 

Restrictions

Initial Values Set at Factory (Network)

Using the Card Slot over a Network
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Restrictions

If you use a printer over the wireless LAN, the printer may recognize nearby wireless systems, you

should set a network key (WEP, WPA, or WPA2) to the access point to encrypt wireless transmission.

Wireless communication with a product that does not comply with the Wi-Fi standard cannot be

guaranteed.

Connecting with too many computers may affect the printer performance, such as printing speed.
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Initial Values Set at Factory (Network)

Item Initial Values

WLAN active/inactive Disable LAN

SSID BJNPSETUP

Communication mode Infrastructure

Wireless Security Disable

IP address Getting automatically

Printer name setting* XXXXXXXXXXXXXXX

IPv4/IPv6 setting IPv4

Set memory card sharing Enable

Enable/disable WSD (WSD settings) Active

Timeout setting (WSD settings) 1 minute

LLTD setting Enable

Enable/disable Bonjour (Bonjour settings) Enable

Service name (Bonjour settings)* Canon XXX series _XXXXXXXXXXXX

LPR service advertising (Bonjour settings) OFF

LPR protocol setting Enable

* The initial value in this item varies by machine. You can check the value in this item using the Operation

Panel on the machine.
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Using the Card Slot over a Network

Confirming Whether the Card Slot is Mounted

Mounting the Card Slot as the Network Drive

Restrictions on Card Slot Use over a Network

Confirming Whether the Card Slot is Mounted

The Card Slot must be mounted to use it over a network.

When the Card Slot is mounted, the following icon appears on Computer (or My Computer). If the

icon does not appear, see Cannot Use the Card Slot .

If these icons are not found, the network drive for the Card Slot is not mounted yet. For details on

how to mount the Card Slot, see Mounting the Card Slot as the Network Drive .

Mounting the Card Slot as the Network Drive

1. Start up the Canon IJ Network Tool.

Double-click the  Canon IJ Network Tool icon on the desktop.

You can also click Start > All Programs (or Programs) > Canon IJ Network Utilities > Canon IJ

Network Tool > Canon IJ Network Tool to start up the tool.

2. Select the machine.

3. Select Maintenance on the Settings menu.

4. Click Setup.

5. Specify the drive letter, then click OK.
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6. Confirm that the  canon_memory icon for the Card Slot appears on Computer (or My

Computer).

Note

If the Card Slot cannot be mounted properly, see Cannot Mount the Card Slot.

Restrictions on Card Slot Use over a Network

The Card Slot can be shared by multiple computers, if the machine is connected

to a network. Multiple computers can read files from a memory card in the Card

Slot at the same time. However, while one computer is writing a file into a
memory card, other computers cannot access the same file.

If your computer joins a domain, the Card Slot may not be mounted as the

network drive.

If you use the memory card stored the large size files or many files, a large

amount of card access may be generated. In this case, the operation in the

memory card may be impossible or slow. Operate after the Access lamp of the

machine is lit.

When you access the network drive for the Card Slot over the network, file

names consisting of eight or less lowercase letters (not including its extension)

may be shown in uppercase.

For example, a file name such as "abcdefg.doc" will be "ABCDEFG.DOC", while

a name such as "AbcdeFG.doc" will appear the same.

The file is not actually renamed, but merely appears to be changed.

When the Read/write attribute setting of the machine is set to Writable from USB

PC, you cannot access the network drive of the Card Slot. On the other hand,
when this setting is set to Writable from LAN PC, the Card slot is not detected via

USB. Make sure that the Read/write attribute setting is set properly depending

on your connection type. Select Not writable from PC to read files from a

memory card via USB and over a network, although you cannot write files to a

memory card in either way with this setting.

For details on how to change the machine setting, refer to Changing the
Machine Settings on the LCD.

When the Read/write attribute setting of the machine is set to Writable from LAN

PC, you can write files to a memory card from a computer connected to a

network. Note that it may increase the risk that the data on the memory card is

infected by computer viruses or accessed illegally.

It is recommended to use the access control function of the machine or connect

Page 942 of 949 pagesUsing the Card Slot over a Network



to the Internet via a router. For information on using a router, contact your

Internet service provider or a network device manufacturer.

If you write files to a memory card over a network when the Canon IJ Network

Scan Utility is not running, the Date Modified of the files may not be proper.

Make sure to start up the Canon IJ Network Scan Utility before you write files to

a memory card over the network. For details on how to use the Canon IJ

Network Scan Utility, refer to the online help of the Canon IJ Network Scan

Utility.

Note

If the following occurs when using the network drive for the Card Slot over a network, see 

Cannot Use the Card Slot .

Cannot access the Card Slot after the network setup of the Card Slot is complete

Can read the memory card in the Card Slot, but cannot write to it

The Card Slot is disconnected

The Date Modified of files changes when saving them in the network drive for the

Card Slot
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About Technical Terms

In this section, technical terms used in the manual are explained.

A

B

C

D

F

I

K

L

M

O

P

R

S

T

U

W

A

Access Point

A wireless transceiver or base station that receives information from wireless clients/the

machine and rebroadcasts it. Required in an infrastructure network.

Ad-hoc

Client computer and machine setting where wireless communication occurs on a peer-to-
peer basis, i.e., all clients in with the same SSID/network name communicate directly with

each other. No access point is required. This machine does not support ad-hoc

communication.

Admin Password

Administration password in Canon IJ Network Tool to restrict access to network users. It must
be entered to access the printer and change printer settings.

When the printer's network settings are factory default, the admin password does not have to

been entered.

AES

An encryption method. It is optional for WPA. Strong cryptographic algorithm adopted within

U.S. government organizations for information processing.

Authentication Method

The method that an access point uses to authenticate a printer through a wireless LAN. The

methods are agreeable each other.

When using WEP as an encryption method, the authentication method is able to fix to Open

System or Shared Key. (The default authentication method is Auto.)

For WPA/WPA2, authentication method is PSK.

Auto

The printer automatically changes its authentication method to match the access
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point.
Open System

In this authentication method, the communication partner is authenticated without
using WEP key even if "Use WEP" is selected.

Shared Key

In this authentication method, the communication partner is authenticated using the
WEP key that was set for encryption.

B

Bonjour

A service built into Mac OS X operating system to detect the connectable devices on a network
automatically.

C

Channel

Frequency channel for wireless communication. In the infrastructure mode, the channel is
automatically adjusted to match that set to the access point. This machine supports channels

1 to 13. Note that the number of channels that can be used for your wireless LAN varies

depending on the region or country.

D

Default Gateway

A relay device to connect to another network such as a router or a computer.

DHCP server functionality

The router or the access point assigns an IP address automatically whenever the printer or

the personal computer on a network starts up.

F

Firewall

It is a system that prevents an unlawful computer access in the network. To prevent, you can

use the firewall function of a broadband router, the security software installed in the computer,

or operation system for computer.

I

IEEE 802.11b

International standard for wireless LAN using the 2.4 GHz frequency range with a throughput

of up to 11 Mbps.

IEEE 802.11g

International standard for wireless LAN using the 2.4 GHz frequency range with a throughput

of up to 54 Mbps. Compatible with 802.11b.

Infrastructure

Client computer and machine setup where all wireless communications pass through an

access point.

IP Address

A unique number with four parts separated by dots. Every network device that is connected to

the Internet has an IP address. Example: 192.168.0.1

An IP address is usually assigned by an access point or a DHCP server of the router
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automatically.

For the procedure to check the IP address of the printer, see Checking the IP Address or the
MAC Address of the Machine .

IPv4/IPv6

They are internetwork-layer protocol used on the internet. IPv4 uses 32-bit addresses and

IPv6 uses 128-bit addresses.

K

Key Format

Select either ASCII or Hex as the WEP key format. The character that can be used for the WEP

key differs depending on the selected key formats.

ASCII

Specify with a 5 or 13-character string that can include alphanumeric and underscore

"_" characters. It is case-sensitive.

Hex

Specify a 10-digit or 26-digit string that can contain hexadecimal (0 to 9, A to F, and a to
f).

Key Length

Length of the WEP key. Select either 64 bits or 128 bits. Longer key length allows you to set a
more complex WEP key.

L

Link Quality

The status of connection between the access point and the printer excluding noise

(interference) is indicated with a value from 0 to 100%.

LLTD

A Link Layer protocol built in Windows Vista for network topology discovery and quality of

service diagnostics.

LLTD is used by its Network Map feature to display a graphical representation of the local

network.

LPR

A platform-independent printing protocol used in TCP/IP networks. It is not supported

bidirectional communication.

M

MAC Address

Also known as the physical address. A unique and permanent hardware identifier that is

assigned to network devices by its manufacturer. MAC addresses are 48 bits long and are

written as a hexadecimal number separated by colons, i.e., 11:22:33:44:55:66. To check the

MAC address of this machine, see Checking the IP Address or the MAC Address of the

Machine.

O

Operation Status

Indicates the status on whether the printer can be used.

P
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PSK

An encryption method employed by WPA/WPA2.

R

Router

A relay device to connect to another network.

S

Signal Strength

The strength of the signal received by the printer from the access point is indicated with a

value from 0 to 100%.

SSID

Unique label for wireless LAN. It is often represented such as a network name or a access

point name.

SSID distinguishes one wireless LAN from another to prevent interference.

The printer and all clients on a wireless LAN must use the same SSID in order to
communicate with each other. The SSID can be up to 32 characters long, and is made up of

alphanumeric characters. The SSID may also be referred to by its network name.

Stealth

In the stealth mode, an access point hides itself by not broadcasting its SSID. The client must

specify the SSID set to the access point to detect it.

Subnet Mask

IP address has two components, the network address and the host address. Subnet Mask

used to calculate the Subnet Mask address from the IP address. A Subnet Mask is usually

assigned by an access point or a DHCP server of the router automatically.

Example:

IP Address: 192.168.127.123

Subnet Mask: 255.255.255.0

Subnet Mask Address: 192.168.127.0

T

TCP/IP

Suite of communications protocols used to connect hosts on the Internet or the LAN. This

protocol allows different terminals to communicate with each other.

TKIP

An encryption protocol employed by WPA/WPA2.

U

USB

Serial interface designed to enable you to "hot-swap" devices, i.e., by plugging and

unplugging them without turning off the power.

W

WCN (Windows Connect Now)

Users running Windows Vista can easily create network configuration settings and transmit

them to the access point using the USB flash memory.
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WEP/WEP Key

An encryption method employed by IEEE 802.11. Shared security key used to encrypt and

decrypt data sent over wireless networks. This printer supports key length of 64 bits or 128
bits, key format of ASCII code or Hexadecimal, and key number of 1 to 4.

Wi-Fi

International association that certifies interoperability of wireless LAN products based on the

IEEE 802.11 specification.

This machine is a Wi-Fi authorized product.

Wireless LAN

A network that, instead of being connected by physical wires, is connected by a wireless

technology, such as Wi-Fi.

WPA

Security framework announced by the Wi-Fi Alliance in October 2002. The security has been

strengthened more than WEP.

Authentication

WPA defines the following authentication methods: PSK that can be used without an

authentication server, plus WPA-802.1x that do require an authentication server.

This machine supports WPA-PSK.

Passphrase
This encrypted key is used to perform WPA-PSK authentication.

The passphrase should be a string of 8 to 63 alphanumeric characters or a 64-digit

hexadecimal value.

WPA2

Security framework released by the Wi-Fi Alliance in September in 2004 as a later version of

WPA. Provides a stronger encryption mechanism through Advanced Encryption Standard
(AES).

Authentication

WPA defines the following authentication methods: PSK that can be used without an

authentication server, plus WPA2-802.1x that do require an authentication server.

This machine supports WPA2-PSK.

Passphrase
This encrypted key is used to perform WPA2-PSK authentication.

The passphrase should be a string of 8 to 63 alphanumeric characters or a 64-digit

hexadecimal value.

WPS (Wi-Fi Protected Setup)

WPS is a standard for easy and secure establishment of a wireless network.

There are 2 primary methods used in the Wi-Fi Protected Setup:

PIN entry: a mandatory method of setup for all WPS certified devices

Push button configuration (PBC): an actual push button on the hardware or through a

simulated push button in the software.
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